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Table editor layout

What is it?

A table editor layout is now incorporated into commands and dialog boxes in the user interface. This
provides a quicker use of commands with fewer mouse clicks and easier use of dialog boxes when
you have multiple objects involved in the operation.

The table editor layout provides a spreadsheet style of user input so you can input values for multiple
items without leaving an item in the dialog box to proceed to the next one. You can also input values
for multiple attributes in a cohesive table of attributes and values.

The following are some examples of the table editor layout:

• File tab→New→Item

o The red asterisk indicates the value is required.

o You can highlight the cell and enter a value, or double-click to get the insert mode and type
in the cell.

o If the cell has auto-assign , you can double-click to automatically assign a value.
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o You can right-click and use the Edit dialog box to add or change an attribute.

• File tab→Save→Save As

o You can filter a column listing to display parts based on your selection criteria.

• Bulk edit of attributes (example from Design Element Properties dialog box)

Note

The table editor layout for attributes is applicable when you are running in Teamcenter
Integration and native NX.

o Use the Bulk Edit view to get the table editor layout.

o For items that have the same attribute, you can select the cells in the attribute column for the
items and make the same edit for all of the items.

o You can hide a column and decrease the size of the table.
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• File tab→Import Assembly into Teamcenter

o The table editor layout is applicable for single or multiple items.

Why should I use it?

You can more easily enter values for multiple items and multiple attributes.

Where do I find it?

Application

Applies to all applications when using Teamcenter Integration.

Table editor layout for bulk edit of attributes also applies to native NX.

Import assembly into Teamcenter

What is it?

The Import Assembly into Teamcenter command is redesigned to provide improved performance,
an easier-to-use interface, and added functionality.

The new interface eliminates multiple tabs and includes all of the options in the dialog box on one
page. The existing functionality for the command is preserved, and in addition you can now list
multiple objects at once with their associated attributes in a spreadsheet style format.
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Additional options are added to support the new import functionality in the Import tab in the
Teamcenter Integration for NX customer defaults.

Also, a new command-line utility, tcin_import, is added that incorporates the options and features
of the redesign.

Note

The new Import Assembly into Teamcenter command can be more memory intensive when
importing parts with the Select Log File to Set Up Import and Import from Folder options.
More memory is also used when the Publish Optional Information option is selected. If
memory is a concern, the old Import Assembly into Teamcenter (legacy) command is
hidden but can be found by using Command Finder.

Why should I use it?

You can more easily import a part or assembly into Teamcenter from the operating system.

Where do I find it?

Application Teamcenter Integration
Ribbon bar File tab→Import Assembly into Teamcenter

UTF-8 encoding supported

What is it?

UTF-8 character encoding is now always supported in NX by default. NX internally stores all data in
the UTF-8 character encoding and the NX user interface supports UTF-8. This lets you author NX
data in any supported language and view it correctly in any another supported language. Previously,
NX was running character encoding as determined by the operating system.

1-4 What's new in NX

Chapter 1: Teamcenter Integration for NX



Teamcenter Integration for NX

You can enter data in NX and have it stored in Teamcenter regardless of the language of the character
set that is used, as long as character encoding for the character set is supported by Teamcenter.

The Teamcenter setup may or may not support UFT-8 character encoding, which can cause issues if
NX supports encoding of a character set and Teamcenter does not. In these cases, an error message
notifies you that the character set is not supported by Teamcenter.

If you are running NX against a Teamcenter database that supports UTF-8 character encoding,
all characters that are supported by UTF-8 are valid. If you are running NX against a non-UTF-8
Teamcenter database, then validation occurs before NX accepts the characters. At key locations
in NX, user input is immediately evaluated as being valid input for the character encoding that is
supported by your Teamcenter installation. At other locations, user input is evaluated when you
perform a Save or Save As on the item.

There are many places within NX where data is input, so only the most common or key data input
locations are immediately evaluated. For example, in the New Item dialog box, the ID, Name, and
Revision, boxes are immediately evaluated for language compliance.

Why should I use it?

You can enter data in NX regardless of the language and have it stored correctly in Teamcenter,
especially multi-byte characters, provided that Teamcenter supports the character encoding.

Where do I find it?

Application Applies to all applications when using Teamcenter Integration.

Using Teamcenter multifield keys

What is it?

Teamcenter multifield keys are typically used for non-design data such as documents and are rarely
used for the design data itself. When there are many types of documents associated with a design,
multifield keys provides a convenient way in Teamcenter to assign the same item ID to all of the
various documents while using a second field to differentiate between the types of documents. It is
the combination of a Teamcenter’s object item ID and the item type that provides the unique key in
Teamcenter for identifying a particular document associated with a design’s item ID. For example,
the multifield key can be defined as Item ID, Item Type where the item type could be requirements,
certification, data sheet, quality tests, analysis results, and so on.

For design data, each design item typically represents a unique component in the product, which in
turn must be uniquely identified in downstream configurations by a single key, such as manufacturing
systems, procurement systems, ERP, and so on. Therefore, using multifield keys for design items
poses definite risks to end-to-end business processes.

Using the Teamcenter concept of domains, you can have design data exist in a domain where only a
single key (item ID) is used to identify uniqueness. And you can have a second domain for document
data where a multifield key (item ID, item type) is used to identify uniqueness. By using this method,
design data cannot become ambiguous or pose risks to downstream systems, while all document
data can be managed using the same item ID as the design data to which it is associated.
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Caution

Using multifield keys for design data should be carefully considered prior to actual use within
a production environment. Prior to implementing multifield keys you should assess your
business processes and take every step to remove the risk of introducing ambiguity into the
way design data is identified and managed.

Work with objects in all Teamcenter MFK domains
What is it?

NX utilizes Teamcenter multifield key (MFK) functionality so that you can now view and work with
objects that are in all Teamcenter domains, not just the default domain.

The Teamcenter MFK is a set of key attributes that serve as the unique identifier for an item object.
These can include item_id, object_name, supplier_code, and so on. The Teamcenter Part Identifier
property on an object contains the names and values of all key properties for the MFK. The NX
part attribute DB_PART_MFKID corresponds to the Teamcenter Part Identifier property and is
automatically added to all parts as a hard-coded attribute.

In Teamcenter, you can add customizations which include properties and creation descriptors to the
item type in the BMIDE so that you can further identify and differentiate parts to utilize the MFK
functionality. These customizations, or key properties, comprise the MFK.

The required key properties are shown in NX dialog boxes as attributes when you create a new item.
The following are examples where you would have to add values for additional attributes for MFK:

• File tab→New→Item

o In the Name and Attributes group, another key attribute (with a default value) is added in
addition to ID, Revision, and Name.

• File tab→Save→Save As
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o In the Name and Attributes group, another key attribute column is added in addition to ID,
Name, Revision, Projects, and Reason.

Command line programs, such as utilities, are also updated to accept the Teamcenter Part Identifier
(contains the MFK) as input.

You can configure NX so that NX data is only in the Teamcenter default domain where all NX items
have only item_id as the key attribute. In this configuration, NX accepts the item ID as the unique
identifier and NX runs as it did prior to NX 10.

Why should I use it?

You can use the Teamcenter MFK functionality to more specifically identify an item with a domain
in Teamcenter.

Where do I find it?

Prerequisite Your site is setup to utilize the MFK functionality.

MFK for part families

What is it?

Teamcenter multifield key functionality (MFK) is now supported by NX and the part family functionality
also supports MFK. Any Teamcenter customization attributes or creation descriptors created for
MFK are added in the Part Families dialog box and spreadsheet. This lets you easily find which
attributes are required for part creation.

In the Part Families dialog box, the MFK attributes are added and identified as required for part
creation in the new Category column. As with the existing required attributes, the attributes specific
to MFK cannot be deleted, reordered, or copy/pasted.

In the spreadsheet, when you use item names for components and materials, you specify
the attributes of the MFK with a user-friendly format. For example, for an MFK specified as:
”%#MFK#%,=mfk9Const=C,item_id=MFKC2–AA00054,object_type=MFK9C2T1”, you enter it as
(where Alt+Enter is the keyboard entry):

• mkf9Const=C Alt+Enter

• item_id=MFKC2–AA00054 Alt+Enter

• object_type=MFK9C2T1

In addition, part attributes mapped from Teamcenter can now have both internal names and display
names. If an attribute has different display and internal names, in the spreadsheet the part family
column is changed to show display_name(internal_name). The same combination is also shown for
the attribute in the Available Columns and Chosen Columns list.

Why should I use it?

You can ensure that all part family members have the required MFK attributes.
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Where do I find it?

Application Teamcenter Integration
Dialog box Part Families

Operation descriptors

What is it?

In Teamcenter, you can add operation descriptors to a business object in the BMIDE, such as Item,
Item Revision, Item Master Form, and so on, to let you customize the inputs that are collected based
on the operation performed, such as creating a new part or performing a Save As on an existing part.

When you add Teamcenter operation descriptors, these are now reflected in NX where you need
to input values for these properties when you are creating an object. Teamcenter can designate
operation descriptors as required or not required, but NX displays only the descriptors that are
required.

The operation descriptors are shown as additional attributes and are in addition to the typical required
attributes. For example, when you create a new item, you could have the following required attributes:

ID (typical required attribute)

Revision (typical required attribute)

Name (typical required attribute)

Make or Buy (operation descriptor)

Why should I use it?

You can use operation descriptors to require values for additional attributes for specific NX operations.

Where do I find it?

Prerequisite You must be creating a new object or performing a Save As.

Active Workspace data synchronization

What is it?

Active Workspace is enhanced to support data synchronization between NX and Active Workspace
when you are using Active Workspace in NX.

Data synchronization ensures that when object level information for a part, assembly, or other item is
modified in NX, Active Workspace is automatically refreshed to show the change and vice versa.
For example, if you check out a part in Active Workspace, it is shown as checked out in NX, or if
you add a component to an assembly in NX, Active Workspace refreshes and the BOM for the
assembly is automatically updated.
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Why should I use it?

When you use Active Workspace in NX, you are provided with more up-to-date and accurate
information.

Where do I find it?

Application Active Workspace in NX

Reconnect to Teamcenter

What is it?

If you lose your connection to Teamcenter, NX automatically reconnects to enable you to continue
working. A disconnection can occur due to an idle session, a timeout policy at your site, a server that
goes down due to network problems, or other issues.

A message is displayed when you are reconnected. You have the option of continuing the current
session or exiting the session. If you continue, depending on the last NX command you initiated,
the command may have not completed before you were disconnected and you may have to run
that command again.

This functionality is available only when you are running Teamcenter 4–tier deployment architecture.

In addition, depending on the setup at your site, NX may attempt to connect to a new Teamcenter
server, especially if you lost connection due to a network problem.

Why should I use it?

You can automatically reconnect to a Teamcenter server if connection is lost.

Display names

What is it?

The display names (not the internal names) that are defined for properties in Teamcenter are used in
NX. The properties are defined in the Teamcenter BMIDE and shown in NX as attributes on dialog
boxes. Previously, the attribute names used in NX were determined by the Teamcenter mapping file
definition.

This provides a consistent naming between properties in Teamcenter and the corresponding attributes
in NX. The most noticable attributes affected are ID and Revision for item ID and item revision as
these are used throughout NX. All dialog boxes that contain attributes are affected, such as New
Item, Save Parts As, and Import Assembly into Teamcenter.

In addition, the attribute names in NX are localized if the localization language is supported.

Why should I use it?

You can more easily locate similar attributes in Teamcenter and NX due to the consistent display of
attribute names.
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Localizable attributes

What is it?

When you are running NX in a language other than the master locale (the main language used for data

input in the Teamcenter database), the translation available and no translation available
icons are displayed to identify whether your input can be translated into another language (localized).
These translation icons are displayed only when you are using the bulk edit layout of attributes.

Attributes are defined in Teamcenter and used in NX. In Teamcenter, you can define an attribute as
localizable, which lets your Teamcenter administrator enter localized text for the attribute values
(string values only). You could have several localized values for an attribute depending on the
number of languages supported. The attributes that are localizable and the languages supported are
determined by the requirements at your site.

If you are running NX in a language that is the same as the master locale, or is different than the
master locale but the attribute is not localizable, then a translation icon is not displayed.

If you are running NX in a language that is different than the master locale and localized text is
available for the input value, then the translation available icon is displayed next to the value.

If localized text is not available for the attribute, then the no translation available icon is displayed next
to the value and the value is shown in the master locale language.

Why should I use it?

You can see whether an attribute value is localizable.

Where do I find it?

Application Applies to all applications when using Teamcenter Integration.

Drawing booklets in Teamcenter

Configuring Item Types for a Booklet Rule part

What is it?

You can now specify the Teamcenter item type that is used to create a drawing booklet.

Why should I use it?

Previously, a Teamcenter drawing booklet always created an item in the Teamcenter database using
the Item type for the Booklet Rule. This could cause problems if you tried to create a drawing
booklet while using a customized Teamcenter database where the Item type was discouraged or

1-10 What's new in NX

Chapter 1: Teamcenter Integration for NX



Teamcenter Integration for NX

unavailable. Now that you can specify which item type is used, you can create drawing booklets
that comply with your database rules.

Where do I find it?

Application Drafting
Command Finder Customer Defaults
Location in dialog
box

Drafting→Drawing Automation→General tab→Item Types
group→Booklet Rule

Configuring revisions for drawing parts in drawing booklets

What is it?

When you edit a drawing booklet, you can now designate the Teamcenter revision for the drawing
parts.

If the part used as the basis for the booklet has the part attribute
DRAWING_BOOKLET_ITEM_REVISION, its setting is assigned to the following:

• A new booklet and its drawings.

• New drawings that are created when an existing booklet is edited.

If the attribute DRAWING_BOOKLET_ITEM_REVISION is not used:

• Teamcenter revision rules determine the default revision.

• The assigned revision matches the revision number of the drawing booklet.

Where do I find it?

Application Drafting

Menu

Menu→Tools→Drawing Automation→Edit Drawing Booklet

Menu→Tools→Drawing Automation→Create Drawing Booklet
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New NX look

What is it?

Siemens PLM Software products are adopting a consistent look. This look is now the default for
the NX user interface.

Theme = Light

In NX, the Theme preference for the user interface layout controls the look.

You can use the following new preferences to set the theme:

• Light

This is the default preference.

• Light Gray

Where do I find it?

Command Finder User Interface Preferences
Location in dialog
box Theme node→NX Theme group→Type list→Light or Light Gray
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Help and search enhancements
What is it?

The NX Help is provided as a web application which allows you to more easily serve a single copy of
the help to multiple users and also includes an improved web-based Search.

Benefits include:

• NX Help Search no longer requires Java applets and no longer breaks due to Java security
updates.

• The Search is faster.

• Filtering is more intuitive.

o The Search sorts the results by content area.

o The Filter by pane displays the number of results found in each content area. Select one
or more content areas to filter the results.

o The Selected pane lists the filters you select. In this pane, you may deselect one or more
filters or clear all your filters.

• One copy of the help can be served to multiple users.

Note

We recommend you install and serve the NX Help to multiple users via an intranet. You
can install the NX Help locally on individual workstations but this requires the additional
installation of a web service to run the search on each local system and also incurs additional
maintenance to each workstation if a newer version of the help is made available.

Where do I find it?

Command Finder Help
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Resource bar enhancements

What is it?

You can now use the Resource Bar Options menu to control the location, display behavior, and

content of the Resource bar. NX displays the Resource Bar Options menu on the top left corner
of the Resource bar with the following options.

Pin Open Turns on or off the auto-hide behavior of the navigators or palettes. This option

replaces the and buttons in pre-NX 10 versions.

Maximize tab Maximizes or restores the selected navigator or palette. The maximized
navigator or palette covers the graphics window.

Left Positions the Resource bar to the left of the graphics window.

Right Positions the Resource bar to the right of the graphics window.

Overlap on Second
Monitor

Positions the Resource bar on a second monitor at the edge nearest the NX
window. If you maximize an application on the second monitor, the Resource
bar is overlapped.

Dock on Second
Monitor

Docks the Resource bar on a second monitor in a reserved space at the edge
nearest the NX window. Applications that you maximize on the second monitor
will not overlap the Resource bar.

Tabs Lets you hide or display the selected tab.

Tip

To hide a tab or undock a navigator or palette, right-click the tab and choose the option you
want. To show a hidden tab, right-click in an empty space on the Resource bar, and select
the tab.

Customize line widths
You can customize the line widths in NX using customer defaults and user preferences.

You can:

• Specify labels for each line width in NX.

• Set the pixel width to display the corresponding new line width in NX. You can also set multiple
lines with the same pixel width.

• Map the legacy line widths such as Thin, Normal, and Thick to the current line widths in NX.

• Set the scale factor for the line widths for printing.

• Define labels and pixel widths for the line for plotting and for PDF export.
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Note

• You must map the legacy line widths in a logical way. For example, the line width to which
you map a Thin width must be lower than the line width to which you map a Normal width.
NX ignores invalid line width mapping and reports the details in the system log.

• To ensure that NX uses the new line widths in the newly created parts, you must update or
recreate the templates with the new line widths.

Where do I find it?

Command Finder Customer Defaults

Location in dialog
box

• Defining line width labels

Gateway→Line Widths→Presentation tab, Width Names group

• Defining line width pixels

Gateway→Visualization→Line tab, Pixel Widths group

• Mapping legacy line widths

Gateway→Line Widths→Conversion tab, Legacy Width Conversion
group

Defining line width pixels using user preference

Command Finder Visualization Preference
Location in dialog
box Line tab, Pixel widths group

Defining legacy line width mapping using user preference

Command Finder Object Preferences
Location in dialog
box Line Widths tab, Legacy Width Conversion group

Creating output geometry for measurement features

What is it?

You can now create associative geometry for measurement features.

To do this, use the Create Output Geometry option for the following commands:

• Measure Distance

• Measure Angle

• Measure Extremes
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For the Measure Bodies command, use the Create Principal Axes option.

Example

A line and two points created as an output of
the distance measurement feature.

A point and a coordinate system created as an
output of the body measurement feature.

Why should I use it?

Use the associative geometry to:

• Get visual feedback for the measurement features.

• Make associative references to the output geometry.

Where do I find it?

Prerequisite

All command dialog boxes:

In the Associative Measure and Checking group, you must select the
Associative check box.

Measure Distance dialog box:

Set Type to one of the following:

• Distance

• Between Object Sets
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• Projected Distance

• Projected Distance Between Object Sets

Measure Angle dialog box:

Set Type to :

• By 3 Points

Command Finder

Measure Distance , Measure Angle , Measure Bodies ,

Measure Extremes

Location in dialog
box

All commands except Measure Bodies:

Results Display group→Create Output Geometry

Measure Bodies:

Results Display group→Create Principal Axes

Collaborating on NX issues
NX teams at different sites can collaborate on issues using an issue briefcase, regardless of whether
the team members work in native NX or Teamcenter Integration. An issue briefcase package file
(.ibp) contains multiple issues and their attachments.

A typical workflow for collaboration on issues is as follows.
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Example

An Original Equipment Manufacturer (OEM) site with Teamcenter or Teamcenter Community
can use an issue briefcase to collaborate on issues with a supplier who does not have
Teamcenter or Teamcenter Community issue management facilities. For multiple suppliers,
the OEM site can create multiple issue briefcases to collaborate on issues.

You can create and open an issue briefcase, and also modify the issues in an issue briefcase without
logging in to Teamcenter or Teamcenter Community. However, you must log in to Teamcenter or
Teamcenter Community to add issues to the briefcase. If the originating site uses native NX, you can
create the issues directly in the issue briefcase.

When you create an issue briefcase and add issues to it, or open a received briefcase, NX creates a
node and sub-nodes in the Issue Management tool tree to list the issue briefcase and its content.
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1 Issue briefcase

2 Issues added to the issue briefcase

3 Issue attachments

Note

• Teams at different sites cannot open an issue briefcase at the same time.

• Multiple users at a site cannot work on an issue briefcase at the same time.

• Team members at the receiving site cannot add or remove issues.

• You cannot collaborate on issues in 4GD.

• You cannot attach a bookmark or a snapshot of an issue in the issue briefcase.

Where do I find it?

Resource bar HD3D Tools →Issue Management

Location in dialog
box

Create Issue Briefcase

Open Issue Briefcase
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Hosting custom windows in NX

What is it?

You can now create custom Resource bar tabs to host your own windows. Use the following new NX
Open APIs, which are in the ResourceBarManager class, to define and control the window.

Create
Creates a tab, which is added to the Resource bar when you set the visibility.

RegisterActivationCallback
Activates and displays the custom window when you click the tab.

ActivateTab
Activates and displays the custom window immediately; you do not need to click the tab.

GetWindowHandle
Creates an NX docking window, which is used as the parent to host your custom window.

SetTabAvailability
Controls the visibility of the tab in the Resource bar area.

Destroy
Removes your custom window and tab from NX.

You can specify a title and bitmap for your custom tab. Your custom window has standard Resource
bar capabilities, such as the ability to dock and undock the window.

Note

The application that is being hosted controls the behavior inside the host window.

Why should I use it?

Use the APIs to seamlessly integrate third-party applications and dialog boxes into NX. For example,
if you have your own add-in application or navigator that you use in conjunction with NX, you
no longer need a separate window.

Where do I find it?

The new NX Open APIs are in the new ResourceBarManager class.

Zoom operation enhancements

What is it?

The default direction in which to scroll the mouse wheel to zoom in and zoom out, is changed.

• To zoom in, scroll forward.

You can also hold the left and middle mouse buttons or hold Ctrl and the middle mouse button
and move the mouse forward to zoom in.
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• To zoom out, scroll backward.

You can also hold the left and middle mouse buttons or hold Ctrl and the middle mouse button
and move the mouse backward to zoom out.

To change the default scroll and drag direction, use the Mouse Wheel Scrolling customer default.
This customer default is available only in NX running on Windows or the Linux operating system.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Customize dialog box enhancements

What is it?

The following enhancements make it easier for you to locate commands that you want to add to
the Ribbon bar:

• All NX commands are available under the new All Commands node in the Categories list on
the Commands tab.

To find an item under a category node, select the node, and enter your search term in the
Search box.

• All the Ribbon bar drop-down lists are available under the All Dropdowns node.

You can change the size of icons in dialog boxes. To do this, on the Icon/Tooltips tab, under Icon
Sizes, select an option from the Dialog Boxes list.

Dialog Boxes = Normal Dialog Boxes = Large (200%)
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Usability enhancements include the following:

• The Layout and Roles tabs are removed. These options are now available in the User Interface
Preferences dialog box.

• The Options tab is now called Icon/Tooltips.

• The new Tabs/Bars tab lists all the tabs and bars in the NX interface. To show or hide a tab or a
bar, select or clear the check box next to its name in the list.

Where do I find it?

Command Finder Customize

Location in dialog
box

Customize dialog box→Commands tab→Search

Customize dialog box→Icons/Tooltips tab→Dialog Boxes

Ribbon bar enhancements

What is it?

You can customize the Ribbon bar in the following ways when the Customize dialog box is open. To
open this dialog box, right-click the Ribbon bar and choose Customize.

• You can control the display of command buttons using enhanced command button display styles.

To do this, right-click a command and choose a style from a size style option.

To return to the default display, use the Reset option on the same menu.

• You can track and reuse recently used commands in a gallery.

To do this, right-click a gallery and choose Recently Used→Enable Recently Used.

• You can collapse a group or gallery.

To do this, right-click the name of the group or gallery and choose Collapsed.
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• You can add new tabs using the button.

To add a tab, click this button and add the name you want in the Name box in the Tab Properties
dialog box.

You can also undock the Ribbon bar or hide tabs on the Ribbon bar. The Customize dialog box
need not be open when you do this.

• To undock the Ribbon bar, right-click it and choose Undock Ribbon.

• To hide tabs, right-click the tab name and choose Hide Tab.

Cue and Status line enhancements

What is it?

You can now control the visibility of the Cue and Status lines. To do this, right-click the Ribbon bar
and choose Cue/Status Line.

By default, the Cue and Status lines are not displayed in Full Screen mode. To turn on its display,
right-click the Ribbon bar and choose Cue/Status Line.

User Interface Preferences enhancements

What is it?

You can now access all the interface preferences from the User Interface Preferences dialog box.
These preferences are reorganized into logical groups.

To locate a specific user interface preference quickly, use the Find option.

Where do I find it?

Application Gateway
Command Finder User Interface Preferences
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View Section enhancements

What is it?

When you create or edit a section view, you can specify the location and extent of the section box by
selecting one or more objects and control the size of the section box by setting a margin. NX applies
the margin to all sides of the section box. NX automatically updates the display of the section box
unless you delay the update.

• To select one or more objects, use the Select Object option in the Extent group or select
the component in the Assembly Navigator.

Tip

To select an object outside the box, turn off Clip Section on the Top Border bar.

• To specify a margin, enter a value in the Margin box.
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Margin = 0 Margin = 3

The Box Margin customer default controls the default margin value.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click

Find Default .

• To stop the dynamic update of the section box, select the Delay Box Update check box. If
you want to update the section box when the Delay Box Update check box is selected,

click Update Box .

Why should I use it?

In a large assembly, you can quickly define the section areas by creating section boxes around the
selected components.

Where do I find it?

Command Finder

New Section

Edit Section
Location in dialog
box View Section dialog box→Extent group

CSYS and View Triad enhancements
What is it?

You can now control the size of the CSYS and Datum CSYS display and also control its visibility
through the model. You can display the View Triad on the bottom right corner of the graphics window.
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• To automatically update the size of the CSYS or Datum CSYS when you zoom in or zoom out,
clear the Fixed Size on Screen check box.

Fixed Size on Screen Fixed Size on Screen

• To hide the visibility of the CSYS and the Datum CSYS through solid and non-transparent
models, clear the Show Through check box.
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Show Through Show Through

• To display the View Triad on the bottom right corner of the graphics window, use the Bottom
Right option.

Where do I find it?

Application Gateway
Command Finder Visualization Preferences
Location in dialog
box

Visualization Preferences dialog box→View/Screen tab→Part Settings
group

Rendering enhancements

What is it?

Scene Editor enhancements

You can now:

• Use non image-based advanced light effects such as highlights and shadows to obtain more
realistic renderings.

To do this, use the following options.

o Use with Advanced Studio Image-based Lighting

o Use with Ray Traced Image-based Lighting

The Generate High Quality Image Shadows option on the Shadows tab is no longer available.
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• Align the direction of the environment image with the floor plane direction.

To do this, set the following.

o Up Vector = Align with Floor Plane

• Use the same stage settings such as size, offset, and floor plane for different system scenes.

NX retains the stage settings when you change the system scene.

System Scenes and System Materials enhancements

You can now use various industry specific visualization system scenes and system materials. The
system scenes are organized under the new Indoor, Outdoor, and Studio categories.

English and Metric materials are no longer available.

Studio Task enhancements

You can now access the following commonly used commands using the Studio Task shortcut menu.

• Select All Objects with this Material

• Edit Material

• Remove Material Assignment

• Apply Selected Material

• Inherit Material

Where do I find it?

Scene Editor

Command Finder Scene Editor

Location in dialog
box

Lights tab→Use with Advanced Studio Image-based Lighting and Use
with Ray Traced Image-based Lighting

Global Illumination tab→Up Vector list→Align with Floor Plane

System Scenes and System Materials

Resource bar System Scenes tab, System Materials tab

Command Finder System Scenes , System Materials

Studio Task

Command Finder Studio Task
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Graphics window Right-click the object→[command]

Displaying facets

What is it?

You can now:

• Control the amount of memory that NX uses for the display facet cache.

To do this, use the Facet Cache Memory option. You can set the default value using the Facet
Cache Memory Level customer default.

• Save display facets for advanced visualization views of solid bodies in the part file.

To do this, use the Save Advanced Display Facets option. You can set the default value using
the Save Advanced Display Facets customer default.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Why should I use it?

Use these settings for faster rendering of solid bodies.

Where do I find it?

Command Finder Visualization Performance Preferences

Location in dialog
box

General Graphics tab:

Session Settings group→Shaded Views sub group →Facet Cache
Memory

Part Settings group→Save Advanced Display Facets

Roles enhancements

What is it?

The icon for the Roles tab has changed from to .

The System Defaults category is now called Content. The icons for the roles are updated. A
new Layout role in this category replaces the Power Drafting Essentials and Power Drafting
Advanced roles. The Layout role provides a wider set of commands required for 2D conceptual
design in the Drafting application.
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An additional Presentation category is available. Select a role from this category that best suits your
display device. The roles in this category do not change the commands that are displayed on the
Ribbon bar. That content is specified by the role you select in the Content category. The available
options in the Presentation category are:

• Default

• Touch Panel

• Touch Tablet

For more information related to these roles, see Touchscreen gestures for NX.

Where do I find it?

Resource bar Roles tab

Touchscreen gestures for NX
Use the Touch Mode command to work efficiently in NX on touchscreen devices. Select the NX
presentation role for your device from the Presentation category in the Roles palette.

Touch Panel Optimizes the NX interface presentation to best match a touch panel monitor.
This role displays the undocked Ribbon bar at the bottom of the interface and
increases size and space around the interface elements such as Ribbon bar
tabs, dialog box buttons, and so on.

Touch Tablet Optimizes the NX interface presentation to best match a small touch tablet.
This role displays the Ribbon bar without text, removes the Border bars and
the Title bar, and increases size and space around the interface elements such
as Ribbon bar tabs, dialog box buttons, and so on.

Default Optimizes the NX interface presentation to best match a non-touch monitor.
This role displays the default NX interface.

To manipulate views by panning, zooming, and so on, use touch gestures. To scroll, move on-screen
handles, and so on, use a stylus or touch gestures.

In addition to the simple tap gesture, there are two press gestures that you use for different actions.

Short press Touch the screen briefly as if you are pressing a keyboard button.

Long press Touch the screen for about a second.

Action Gesture Description
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Pan Drag the object in the view with
two fingers.

Rotate

Drag the object in the view with
one finger.

To rotate about an individual
view axis, drag inside the view
borders.

Fit Double-tap anywhere in the view
background.

Zoom

Touch the object with two fingers
and move your fingers towards
each other to zoom out. To zoom
in, move your fingers away from
each other.

Orient the view Tap with three fingers anywhere
in the view.

Rotate about a point

Short press at the location to
rotate about and then move your
finger in the direction in which
you want to rotate the object.
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Move an object or an on-screen
handle Drag the object with one finger.

View shortcut menu and shortcut
toolbar

Long press and release
anywhere in the view
background.

View object-specific shortcut
menu and shortcut toolbar

Long press the object and then
release.

Select the next option in a dialog
box or complete an action

Tap with two fingers anywhere in
the view.

Select an object Tap the object.

Deselect an object
Hold any location in the view with
one finger, and then tap each
object that you want to deselect.

What's new in NX 2-21

Fundamentals



Chapter 2: Fundamentals

Deselect all objects Tap anywhere in the view
background.

Select multiple objects using the
lasso or rectangular selection

Long press, and then form a
rectangle or a lasso around the
objects that you want to select.

Deselect multiple objects using
the lasso or rectangular selection

Hold any location in the view
with one finger, and then with
another finger, long press first
and then form a rectangle or a
lasso around the objects that you
want to deselect.

View the QuickPick list for
selection objects

Short press the desired object
and then release.

Select an item in the QuickPick
list

Tap the item and then either tap
the OK button or tap two fingers
anywhere in the view.

View the QuickPick list for
deselection objects

Hold any location in the view with
one finger, and then short press
the desired object and release.
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Browse to an item in the
QuickPick list

Tap the item or tap anywhere in
the view to advance to the next
item.

Return to the previous item in the
QuickPick list

Hold any location in the view
with one finger, and then tap
anywhere in the view with
another finger.

Input numeric values in the
graphics window

Tap the numeric input field to

display Numeric Keypad
and Full Keyboard .

Tap the Numeric Keypad or
Full Keyboard to display the
respective touchpad and then
tap the desired buttons.

Scroll ribbon tabs Swipe the ribbon horizontally
with one finger.

Select a view command on a
radial toolbar

Tap the Radial Spot to
display the radial toolbar with
view commands, and then tap
the desired command.

You can also swipe from the

Radial Spot in the direction
of the desired command.
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Select an object-specific
command on a radial toolbar

Tap the Object-specific radial

spot to display the radial
toolbar with object specific
commands, and then tap the
desired command.

You can also swipe from the

Object-specific radial spot
in the direction of the desired
command.

Move the Radial Spot

Press and hold the Radial Spot

with one finger until its
appearance changes, and then
drag it.

Where do I find it?

Prerequisite Touchscreen

Command Finder Touch Mode

Accessing image files from Teamcenter
What is it?

You can now import raster image files from Teamcenter to start your CAD geometry. You can also
use image files stored in Teamcenter as decals on a face or body.

• To import a raster image file, use the Raster Image command.

• To use a stored image file as a decal, use the Decal command.

The image file is embedded in the NX part file and retains no associativity to the image file in
Teamcenter.

Where do I find it?

Application Gateway and Modeling
Prerequisite Teamcenter Integration for NX

Command Finder

Raster Image

Decal
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Saving display settings in a bookmark for the displayed part
What is it?

Bookmarks are enhanced in the following ways.

• Bookmarks are now available in an HD3D tool.

• Bookmarks now capture many display settings of the current displayed part.

Applying a bookmark does not change the current application. For example, suppose you create
a bookmark in the Modeling application and then switch to the Drafting application. If you open
your bookmark, NX returns to the display state and displayed part captured by the bookmark but
remains in the Drafting application.

Why should I use it?

Use bookmarks to quickly return to previous displayed states. For example, as you analyze your
model, you can create a bookmark whenever you find a problem. Later, when you discuss your
results with others, you can open each bookmark to show the problems that you found.

Where do I find it?

Resource Bar HD3D Tools→Bookmarks

System attributes in NX
NX now provides system attributes related to material and mass properties and their templates.

You can use the customer defaults categorized under Gateway→Materials/Mass→Attributes tab to
let NX set the system attributes. You can also set the title aliases such that they appear in the dialog
boxes with the titles set in the previous releases. NX uses the same default strings for the title aliases
as the pre-NX 10 default strings for the titles.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

NX 10 title for system attributes NX 10 default for title aliases (pre-NX 10 default title)
NX_Density MassPropDensity
NX_Mass MassPropMass
NX_Weight MassPropWeight
NX_Volume MassPropVolume
NX_Area MassPropArea
NX_Material Material
NX_ObjectMaterial ObjectMaterial
NX_MaterialMultipleAssigned MaterialMultipleAssigned
NX_MaterialMissingAssignments MaterialMissingAssignments
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NX_MaterialPreferred MaterialPreferred

Note

As system attributes may affect applications that use existing titles, you can use NX Open API
to set the system attributes using the aliases set in the customer default.
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Sketching

Resize Chamfer Curve

What is it?

Use this command to resize one or more chamfers in a sketch. You edit the chamfer using the
customary chamfer offset distance, regardless of how the sketch was dimensioned and constrained.
NX makes the edited chamfers symmetric using your specified offset distance.

Why should I use it?

You can edit sketch chamfers with or without constraints.

Where do I find it?

Application Any application that uses Direct Sketch or the Sketch Task Environment
Prerequisite You must be working in an active sketch.

Command Finder Resize Chamfer Curve
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Curve Finder options

What is it?

The Curve Finder options in the 2D Synchronous Technology Move Curve and Offset Move Curve
commands now recognize the following geometric conditions.

Select Tangent

Select Parallel

Select Collinear

Select Concentric

Select Equal Radius

Select Symmetric

Select Offset

Select Coincident Vertex

Select Vertex on Curve

Select Chamfer

The settings Select Offset, Select Coincident Vertex, Select Vertex on Curve, and Select
Chamfer are new in this release.

When you edit curves, the selected geometric conditions are maintained during the edit.

Why should I use it?

The support of these new geometric conditions is useful when you need to edit large sketches
that do not have constraints.

Where do I find it?

Application Any application that uses Direct Sketch or the Sketch Task Environment
Prerequisite You must be working in an active sketch.

Command Finder

Move Curve

Offset Move Curve
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2D Synchronous Technology settings

What is it?

In 2D Synchronous Modeling command dialog boxes, new options are added to the Settings group
to control the angle of adjacent sides, and to control the behavior of arcs.

Size Lets you trim and extend the length of curves as you move them, or to maintain
their original size and adjust adjacent curves.

Size = Trim and Extend Size = Maintain

Keep Tangent Controls how NX maintains tangency of arcs when you edit curves.

Keep Orthogonal Keeps adjacent sides orthogonal when you move curves.

Clear this check box to allow NX to change the angle of adjacent sides.

Where do I find it?

Application Any application that uses Direct Sketch or the Sketch Task Environment.
Prerequisite You must be working in an active sketch.
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Command Finder

Move Curve

Offset Move Curve

Resize Curve

Optimize 2D Curve

What is it?

Use Optimize 2D Curve to clean up and simplify imported 2D curve geometry and points, letting
you work more efficiently with migrated 2D data.

You can specify Distance Threshold and Angle Threshold limit values to restrict which points
and curves are optimized.

The optimize process:

• Cleans up curves and points

o Removes overlapping curve chains (connected sets of curves that are part of other curve
chains).

o Removes small curve segments whose length is within the specified distance threshold.

o Removes selected points if the Include Point option is active.

• Simplifies splines and conic curves

o Replaces splines or conic curves with lines that meet the distance threshold.

o Converts splines or conic curves to arcs that meet the distance threshold.

o Refits splines to remove C0 knot points or self-intersections when needed.

o Splits splines at their C0 knot points when they are 1 degree polylines.

• Connects and merges splines and lines

o Removes gaps between lines that fall within the specified distance threshold.

o Removes overlaps between lines that fall within the specified distance threshold.

o Merges connected collinear lines.

o Removes gaps between splines or conic curves and other curves if the gap is within the
specified distance threshold.

o Removes overlaps between splines or conic curves and other curves if the gap is within
the specified distance threshold.
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o Removes the gap or overhead between the end of a curve and the middle of a curve (point
on curve) if the gap or overhead is within the specified distance threshold.

• Aligns arcs and circles

o Merges connecting arcs and circles with the same radius within the specified distance
threshold.

o Recreates arcs that are tangent to two curves within the angle threshold with the same radius.

o When two such arcs are tangent to each other, recreates the arc with the larger radius
first using the same radius.

o When an arc is tangent to one curve within the angle threshold, recreates the arc tangent to
the curve with the same radius.

o If a circle is concentric to an arc within distance threshold, it is made concentric to the arc.

• Updates downstream features that reference the selected curves after the optimization if they
are outside a sketch.

• Creates a new sketch if the Create Sketch option is selected and there is no sketch currently
active.

You can perform the optimization on a sketch before or after you import it.

Why should I use it?

Imported curve geometry that is not first optimized may be of insufficient quality for synchronous edit.

Where do I find it?

Application Modeling

Command Finder Optimize 2D Curve

Creating sketch splines

What is it?

NX is enhanced to allow more control over spline poles when you create or edit splines in a sketch.
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Studio Spline
command

When you create or edit splines by poles, you can infer G1 and G2 Tangent
Continuity constraint at the start and end poles.

You can drag the defining poles of the spline to create constraints.

Top Border bar A new Poles snap option is added to the Top Border bar to allow
snapping to poles. For example, use this option when creating dimensional
constraints to the pole locations.

Point construction In commands that allow you to create or select a point, a new Spline Pole

option is available in the point list. Use this option to select spline poles.

Where do I find it?

Application Modeling
Prerequisite You must be working in an active sketch.

Command Finder Studio Spline

Trimming sketch recipe curves

What is it?

When you use the commands Quick Trim, Make Corner, Fillet, and Chamfer, you can trim
recipe curves without breaking the associativity from their parent geometry, if the Create Inferred
Constraints option is turned on. If a recipe curve is extended using one of these commands, an
alert message warns you that the associativity will be removed.

Recipe curves are curves that are associatively projected to the sketch using either the Project
Curve or Intersection Curve command.
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Where do I find it?

Application Modeling

Prerequisite

You must be working in an active sketch.

The Home tab→Direct Sketch group→Create Inferred Constraints option
must be turned on.

Command Finder

Quick Trim

Make Corner

Fillet

Chamfer

Creating WAVE links in a sketch

What is it?

You can create links to geometry outside the work part, using constraint and dimension Sketch
commands.

• To select geometry outside the work part, set the Selection Scope option to Entire Assembly.

• To create a WAVE link to the selected geometry, turn on the option Create Interpart Link. If a
non-associative link is desired, turn off the option Create Interpart Link.

In this example, a sketch is used to create pads in the handle of a cordless drill to support the trigger
assembly. With the handle as the work part, the sketch is constrained to geometry in the trigger
assembly part.
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Why should I use it?

These options allow you to create associative or non-associative links from a sketch to geometry in
another assembly component.

Where do I find it?

The options Selection Scope and Create Interpart Link are located in the Top Border bar when you
create sketch dimensions or geometric constraints.

Application Modeling
Prerequisite You must be working in an active sketch in an assembly.

Command Finder

Rapid Dimension

Geometric Constraints

Part Module

Part Module enhancements in the Part Navigator

What is it?

In the Part Navigator, you can now:

• Right-click a part module and choose Activate, Show Only, and Expand. This new shortcut
activates the selected part module, shows only objects in the part module, and expands the part
module features to make the part module easier to work on. You can also double-click on a
part module to invoke this command.

• Drag features from one part module to another part module to reorder or reorganize the structure
in a part module.

• Drag features into an existing part module to add structure to a part.

• Delete a part module without deleting its features to remove structure from a part.

• Drag a part module into another part module to nest them. You can also drag a nested part
module out of part module to un-nest the part modules. This functionality replaces the Nest Part
module and Un-nest Part Module commands.

• Update out of date linked part modules when you click the out-of-date icon in the Up to Date
column. When you click the out-of-date icon for a feature, NX updates that feature and any
out-of-date parents. When you click the out-of-date icon for a part module, NX updates that
part module, all its member features, and any out of date parents.
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Save linked part module enhancement

What is it?

Linked part module files can no longer be saved in an active state. When you save a linked part
module part, NX determines if the linked part module is active. If the linked part module is active,
NX will automatically:

1. Deactivate the linked part module.

2. Save the linked part module file.

3. Activate the linked part module.

Note

When NX deactivates the linked part module, the module may update if it has pending
changes. For a complex linked part module, this could take some time, and all the normal
ramifications of an update will be encountered. Beyond the linked part module itself, normal
NX interpart update behavior will apply.

Where do I find it?

Application Modeling, Sheet Metal Design, and Shape Studio

Command Finder Save

Update Input References and Update Output References enhancements

What is it?

The Update Input References and Update Output References commands check if the latest
version of the parent is loaded into memory.

While working on linked part module parts, the Update Input References command now does the
following:

• If the main part is closed, NX will display the following message which gives you the opportunity
to open a read only version of it:

The operation attempted cannot be executed because the corresponding Linked Part Module

file is not loaded in the session.

Do you want to load the corresponding Linked Part Module file?

• If the main part is open but it's not the latest version on disk, NX displays the following message
which can open a read only version of it:

The command will load the latest disk version of the main and/or associated linked part

module parts. Unsaved changes in locally loaded parts will be lost.

Do you want to continue with the operation?

While working on main parts, the Update Output References command now does the following:
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• If the linked part module part is closed, NX displays the following message which gives you the
opportunity to open a read only version of it:

The operation attempted cannot be executed because the corresponding Linked Part Module

file is not loaded in the session.

Do you want to load the corresponding Linked Part Module file?

• If the linked part module part is open but it's not the latest version on disk, NX displays the
following message which can open a read only version of it:

The command will load the latest disk version of the main and/or associated linked part

module parts. Unsaved changes in locally loaded parts will be lost.

Do you want to continue with the operation?

Where do I find it?

Application Modeling, Sheet Metal Design, and Shape Studio

Command Finder

Update Input References

Update Output References

Shared Body enhancement

What is it?

When you activate a part module that contains a Shared Body, all the modifiable objects are
emphasized. This makes it easier to locate shared bodies in the graphics window.

In this example, the five pockets are modifiable objects in a part module.
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Modeling

Fill Surface enhancements

What is it?

The Fill Surface command has three changes to the Method list in the Shape Control group of
the dialog box.

• Pass Through Curves is now named Fit to Curves.

• Fit to Facet Body is a new shape control method. The fill is fitted to an existing facet body.
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o Select of a set of facet body edges that are used to shape the surface.

o Specify the Area of Control and the Attraction.

o See the reports of the Average and Maximum errors.

You can set the Default Edge Continuity.

Why should I use it?

Use Fill surface to fill gaps or holes in any surface.

Where do I find it?

Application Modeling

Command Finder Fill Surface

Section Surface enhancements

What is it?

A Body Type option is added to the Settings group of the dialog box. The options are:
• Solid

• Sheet

The choice is made at creation or when editing the section body.

Why should I use it?

There is no longer a need to use the Modeling Preferences dialog box to make this choice.

Where do I find it?

Application Modeling and Shape Studio

Command Finder Section Surface

Aero Design

What is it?

Aero Design is a group of four new commands specifically designed to help you create vehicular
support structures but the commands are not limited to those applications.

Aero Flange
Use the Aero Flange command to create a flange body by offsetting from a specified region of a
skin which forms the exterior of a vehicle or vessel.
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To create flanges, both open and closed, you can specify parameters such as width, thickness,
and offset.

Open flange as part of web Closed flange as part of access panel

Aero Rib
Use the Aero Rib command to create a thin-wall body by extruding from a face chain using a
guide curve. You can create both open and closed ribs. You specify parameters such as height,
length (non-closed ribs), thickness, and offset.

When referencing a planar skin, the rib body is created by extruding. For general cases, the rib
body is generated by extending the guide curve from skin.
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Aero ribs as part of web Closed aero rib as part of web

Aero Shelf
Use the Aero Shelf command to offset faces that neighbor an edge to form a shelf along the
edge of a support structure.

Closed aero shelf
Aero shelf extension (two reference

objects)

Aero Step
Use the Aero Step command to create a step feature that offsets a face region to add clearance
where the part would mate with another part.
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To create steps, you can specify parameters such as length, depth, thickness, and offset.

Aero step middle offset Aero step offset to plane

Where do I find it?

Application Modeling

Command Finder Aero Flange , Aero Rib , Aero Shelf , Aero Step

Face Blend enhancements

What is it?

The Face Blend command is enhanced in the following ways:

• Multiple blend solutions

You now have more choices in how multiple-solution face blends are created when specifying
Rolling Ball, Naturally Varying, Circular, or Constant Radius blends that do not have any
constraining or limiting geometry.
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o In multiple-solution situations, all possible
face blends that meet selection criteria
are initially generated.

o In this example, both face blends yield
one Face Blend feature.

o You can bypass the default behavior
by indicating which blend to keep by
specifying a location.

o In this example, the blend is created as a
non-associative Body feature.

• Blend Face continuity

You can now create face blends that are either tangent continuous or curvature continuous
to all face chains that define the face blend.

• Blend constraint curves

You can now limit the extent of the face blend by selecting constraint curves that act as hold lines,
one on each defining face.

Face chains selected Constraint curves selected Face blend to constraint
curves

• New Trimming option

When the Blend Faces option is set to Trim to Short Input Faces, you can optionally extend
the blend rail or hold line to the edges of the face chain on which it resides, and trim the long
face chain to the extended rail or hold line.
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Trim Input Faces to Blend Faces
Trim Long Input Faces to Extended Rail

Trim Input Faces to Blend Faces
Trim Long Input Faces to Extended Rail

• Option name changes

The following Shape options in the Cross Section group are renamed from previous releases:

Tangent Symmetric replaces Symmetric Conic.

Tangent Asymmetric replaces Asymmetric Conic.

• Forced constant width method

You can now create face blends that have a constant rail-to-rail width. You can create both
symmetric and asymmetric forced constant-width blends.

Symmetric AsymmetricSkew ratio determines
asymmetric positioning
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Example of symmetric constant-width face blend

Note

These enhancements to Face Blend replace the Soft Blend command of previous releases.

To exactly mimic the behavior of Soft Blend, use the Face Blend options Swept Section with
the Two Constraining Curves blend method.

Why should I use it?

• To determine how face blends are created when there are multiple possible solutions.

• To specify the type of continuity the blend has to its defining face chains.

• To define the blend using constraint curves.

• To trim the long face chain of a face blend to an extended rail or hold line.

• To create a symmetric or asymmetric constant-width blend.

Where do I find it?

Application Modeling

Command Finder Face Blend

Edge Blend enhancements

The Edge Blend command is enhanced in the following ways:

• Curvature continuity

You can now create edge blends that are curvature continuous (G2) with their adjacent faces.
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Blend Face Continuity = Tangent Blend Face Continuity = Curvature

Note

Curvature continuity is typically used by class A surface modelers to attain ideal aesthetic
reflection quality.

• Segment blending

You can now segment a blend face to match the segmentation of edge adjacent faces.

Segment Blend to Match Face Segments Segment Blend to Match Face Segments

Where do I find it?

Application Modeling

Command Finder Edge Blend

Edge Blend enhancement (10.0.1)

When creating an Edge Blend with variable radius points, you can now specify that the radius
function has zero slope at each end of the blended edge chain.
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Zero Slope Radius Function at Chain Ends

Zero Slope Radius Function at Chain Ends

Where do I find it?

Application Modeling

Command Finder Edge Blend
Location in dialog
box Settings→Zero Slope Radius Function at Chain Ends

Replace Face enhancement

The Replace Face command is enhanced so that you can now select a datum plane as the
Replacement Face.
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Where do I find it?

Application Modeling

Command Finder Replace Face

Wrap/Unwrap Curve enhancements

What is it?

The Wrap/Unwrap Curve command now supports the wrapping and unwrapping of points and
multiple ruled developable surfaces.
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For Wrap Curve, the inputs are:

• Any set of curves, including points.

• Any set of developable surfaces onto which the wrapping is wanted.

• A plane tangent to any of the selected developable surfaces.

For Unwrap Curve, the inputs are:

• Any set of curves, including points, which lies on the given set of developable surfaces.

• Any set of developable surfaces from which the unwrapping is desired.

• A plane tangent to any of the those selected developable surfaces.

Why should I use it?

You can wrap and unwrap points from a cylindrical, conical, or ruled developable surface from or to
a plane. You can also wrap and unwrap selected sets of curves lying on multiple ruled developed
surfaces.

Where do I find it?

Application Modeling

Command Finder Wrap/Unwrap Curve

3-22 What's new in NX

Chapter 3: CAD



CAD

Offset Curve in Face enhancements

What is it?

Offset Curve in Face has the following improvements:

• A new Split Curve at Face Boundary option to let you segment the output feature curve at each
face boundary it crosses.

• Better curve fitting with Advanced Curve Fit methods.

These enhancements bring improved performance, accuracy, and new cross-face continuity and
case handling capabilities to Offset Curve in Face feature curves, making them of the same high
quality as that of other derived curves.

Offset Curve in
Face curvature result
previous to NX 10

NX 10 Result

Where do I find it?

Application Modeling

Command Finder Offset Curve in Face

Preview a failed or missing face during feature edit

What is it?

If a missing object error appears when editing a body or a face, a preview can now show where in the

model the missing object was located. You can view the preview using the Show Previous State
option in the dialog box of the feature you are editing.

The missing object error could be due to any of the following:

• A previously existing face was consumed in a subsequent operation.

• The shape of a face or body was changed.

• A face or body was reordered to a different position in the Part Navigator.
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The following sequence shows an example of how a previous state preview can be viewed during a
feature edit:

1. A 15° Draft feature is added to an extruded
solid body.

2. The body is trimmed with a Trim Body
feature.

In the Part Navigator the Trim Body feature
becomes the current feature.

Model History
Datum Coordinate System (0)
Extrude (1)
Draft (2)
Trim Body (3)

3. In the Part Navigator the Trim Body feature
is reordered before the Draft feature.

The Draft feature becomes the current feature
and its icon displays an alert indicating faces
have been consumed.

Model History
Datum Coordinate System (0)
Extrude (1)
Trim Body (2)
Draft (3)
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4. The Draft feature is edited and the Show
Previous State option in the Draft dialog
box is selected.

The previous state preview of the consumed
faces appears.

This new capability is similar to the existing behavior in Edit Parameters, where a missing edge error
displays the preview of an edge that was consumed or missing from an earlier operation.

To support this enhancement the old Save Data For Fast Rollback on Edit customer default has
been replaced by the new Save Data for Feature Edit customer default, with the following option
choices:

• None

• Fast Rollback

• Fast Rollback and Previous State of Failed Feature

Use this new customer default to specify what additional data will be saved in the part to enhance
feature edit.

Features that currently support Previous State Preview

Face Blend Offset Face
Trim Body Draft
Trim and Extend Delete Face
Trim Sheet Draft Body

Where do I find it?

Command Finder Customer Defaults
Menu File→ Utilities→ Customer Defaults

Location in dialog
box

To activate: Gateway→ General→ Part tab→ Save Data for Feature Edit

To use during edit: Show Previous State
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Rollback data to memory to improve Modeling performance

What is it?

Use the Load Rollback Data to Memory customer default to allow NX to rollback its available data to
memory instead of to the hard disk, thus improving the overall performance of Modeling operations.

The memory requirements of NX will rise accordingly while this customer default is enabled, and it is
not recommended for systems with insufficient installed physical memory.

The amount of data that is rolled back is controlled by the current hardware configuration.

Why should I use it?

Most Rollback data will remain in memory while this customer default is enabled, reducing the time it
takes to read and write to disk and increasing the speed of Modeling.

Where do I find it?

Customer Defaults Load Rollback Data to Memory

Menu
File→ Utilities→ Customer Defaults→ Modeling → General→ Update
tab→ Load Rollback Data to Memory

Offset 3D Curve enhancements

What is it?

The former 3D Curve Offset command has been enhanced and renamed to Offset 3D Curve, and
has been moved to the Derived Curve Group within the Modeling application.

The enhancements include:

• An Associative option to create associative Offset 3D Curve features.

• Advanced Curve Fit methods and options:

o Degree and Segments method to specify the output curves using values for the degree and
the number of segments.

o Degree and Tolerance method to specify the output curves using values for the degree
and tolerance.

o Keep Parameterization method to inherit the parameters for degree, number of segments,
and the pole and knot structure from the input curve (or in the case of an Intersection Curve,
the input surface) and apply them to the output curve.

o Auto Fit method to specify the minimum and maximum degree, the maximum number of
segments, and the tolerance of the output curve.

• A Join Curves option to either maintain individual B-splines in the output curve, or join them
in a single B-spline.

• A dynamic Preview mode available during both feature creation and edit.
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These improvements bring Offset 3D Curve to the same level of capability and completeness as
that of the Offset Curve command.

Where do I find it?

Application Modeling

Command Finder Offset 3D Curve

Enhancements to patterns with extracted bodies

What is it?

The Pattern Feature and Pattern Geometry commands now copy both positive and negative
extracted symbolic threads and threads on positive holes for downstream operations.

• When extracting Mirrored Body and Body types, if the Copy Threads check box is selected, the
positive or negative disposition of the extracted symbolic threads is maintained in subsequent
patterning of those threads.

• This includes WAVE linked extracted geometry.

• This enhances Pattern Feature so that you can now copy extracted hole threads using either
the Variational or the Simple pattern method. Previously only Variational was available for
copying extracted threads.

Why should I use it?

To ensure correct patterning and mirroring behavior when extracting geometry and patterning it.

Where do I find it?

Application Modeling

Command Finder Extract Geometry , Pattern Feature ,

Pattern Geometry

Location in dialog box

Extract Geometry dialog box:

Type list→Mirror Body, Body options→Copy
Threads

Pattern Feature dialog box:

Pattern Method group, Method

Pattern Geometry dialog box:

Settings group→Copy Threads
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Detect Primitives

What is it?

Use the Detect Primitives command to identify the shape types of a facet body and add color
attributes to them.

All color information is stored as Face Analysis data.

Each shape type is assigned a unique color
attribute that is added to the vertices of the
selected facet body.

• To display the shape colors select a facet
body.

• To disable the colors change the Rendering
Style.

• To re-enable the colors set the Rendering
Style to Face Analysis.

• To delete the color attributes select the facet
body with the Edit Object Display command
and clear the Face Analysis option.

Shape type color
classifications

Plane

Sphere

Cylinder

Cone

Other

The Curvature Sensitivity option can narrow or broaden the transition range between planar shapes
and other types.
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Curvature Sensitivity low Curvature Sensitivity high

The boundary between shape types appears in the Other shape color to help separate the main
features.

You can configure any of the assigned colors by clicking the respective shape type in the dialog box.

Why should I use it?

You can create specific color attributes for facet bodies and use them for color coded selection using
the Fit Surface command.

Where do I find it?

Application Modeling and Shape Studio

Command Finder Detect Primitives

Paint Facet Body

What is it?

Use the Paint Facet Body command to apply color attributes to facet bodies interactively using
a digital paint brush.

You can paint regions on facet bodies to call out areas of interest.

You can paint facet bodies to clean up color attributes that were automatically assigned by the Detect
Primitives command, so the facet model is better suited for color coded selection by other tools.
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If you only need to correct small irregularities from Detect Primitives output (as shown here), the
Paint Facet Body digital paint brush lets you easily do so.

• You can specify your own paint colors or inherit them from a facet body.

• You can specify the size of the digital paint brush.

All color information is stored as Face Analysis data and can be deleted by selecting the facet body
with the Edit Object Display command and clearing the Face Analysis option.

Why should I use it?

You can clean up the color output from the Detect Primitives and Facet Body Curvature commands
so the facet body can better support color coded selection by the Fit Surface command.

Where do I find it?

Application Modeling

Command Finder Paint Facet Body
Menu Edit→Facet Body→Paint
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Law Extension enhancements

The Law Extension command now contains an option to smooth the surface extension.

Use the Angular Correction to create a smoother surface.

Where do I find it?

Application Modeling and Shape Studio

Command Finder Law Extension
Location in dialog
box Angle Law group→Angular Correction

Fit Surface enhancements

What is it?

The Fit Surface command has been enhanced to improve fitting surfaces to facet bodies and curve
features or groups as part of a reverse engineering workflow.

You can now:

• Use color coded selection to select parts of facet bodies for the target.

• Select multiple targets to create multiple Fit Surface features.

Why should I use it?

These enhancements will be useful when:

• You need to fit a face to only a part of a facet body (you no longer need to cut this piece out
manually).

• You have multiple shapes of the same type in your target that you want to reverse engineer.
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Where do I find it?

Application Modeling
Command Finder Fit Surface

Trim Sheet enhancements

What is it?

The name of the Trimmed Sheet command and feature name have been changed to Trim Sheet.
Legacy Trimmed Sheet features will be renamed to Trim Sheet. Custom programs that use the
feature name Trimmed Sheet will need to be updated to Trim Sheet.

Additional user interface changes include:

• The Cue line for Target selection has changed to Select sheet bodies to trim.

• The Boundary Objects group name has been changed to Boundary.

• The Cue line for Region has been changed to Select regions to keep or discard.

Where do I find it?

Application Modeling and Shape Studio

Command Finder Trim Sheet

Synchronous Modeling Blend option

What is it?

The Delete Face Synchronous Modeling command includes a new Blend type that allows you to
delete blends based on the their unique characteristics, such as tangency.

Use this option to delete these types of faces:
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• Blends with a constant or variable radius

• Notch blends

• Cliff blends

To delete a notch blend of a cliff blend, use the Face-Edge Blend Preference setting. In this
example, the blend face was deleted.

Where do I find it?

Application Modeling

Command Finder Delete Face

Trim and Extend

What is it?

The Trim and Extend command is updated as follows:

• The By Distance option has been removed.

• The Percentage of Measured option has been removed.

• You may choose from new Body Output options: Extend Original Sheet, Extend as New Face
or Extend as New Sheet.
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Where do I find it?

Application Modeling and Shape Studio
Prerequisite A sheet to trim and additional boundary geometry.

Command Finder Trim and Extend

Extend Sheet

What is it?

Use Extend Sheet to extend or trim a sheet body. Use Offset to trim or extend the sheet at a
specified distance from the selected edge. Use Until Selected to trim the sheet to other geometry.

Extend using offset Extend until selected

Additional control includes:

• Surface Extension Shape

• Edge Extension Shape

• Body output type

Where do I find it?

Application Modeling and Shape Studio

Command Finder Extend Sheet
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Expressions enhancements

The Expressions dialog box is enhanced with two new options:

Show Locked Formula Expressions
When selected, expressions with locked formulas display in the expressions list. By default, the
check box is unchecked and expressions with locked formulas are hidden.

Replace Expressions
Enables you to replace all instances of an expression formula string within the current work part
with another string. This saves you from having to individually edit every expression formula
when you have a design change or when you simply want to explore other design scenarios.

Example

You can replace the variable “x” with the variable “y” or with the statement “y+z/2”.

The DesignLogic list is enhanced with two new options:

Expression Expert Mode
Impacts the behavior of NX when you insert a formula in a parameter entry field using the

DesignLogic list button .

Expression Expert Mode Expression Expert Mode

The expression formula displays in the field. The expression value displays in the field.

The formula can be directly edited. The expression value is locked and cannot
be directly edited in the field.

Caution

This optional mode is not intended for general use as it makes it significantly easier for
users to inadvertently edit expressions.

You can enable or disable expert mode by setting a customer default called Expression Expert
Mode.
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Extended Text Entry

The Extended Text Entry option is added to the DesignLogic list. This option opens the
Extended Text Entry dialog box, which provides a text entry area where you can enter and
edit expression formula text.

Where do I find it?

Application Modeling and Assemblies

Command Finder Expressions

Expression Expert Mode

Command Finder Customer Defaults
Menu File→Utilities→Customer Defaults

Location in dialog
box

Simulation→User Interface→Navigator tab→Expression Expert Mode
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Expression groups

You can use expression groups to see an organized hierarchical tree view of expressions in the
Expressions dialog box, as opposed to a flat list.

Name Formula Value

Default Group
D
N
P
T

Measurement
Expressions

Attribute
Expressions

Interpart
Expressions

(N*P)/pi()
50
4
p/2

63.6...
50
4
2

• Only one group is active at a time. Newly created expressions are added to the active group.

• When groups are first enabled, the Default Group is active and any existing or newly created
expressions reside there.

• Expression groups can contain expressions and nested expression groups.

• Group names must be unique to the part.

• Expressions can only belong to one group at a time. Drag expressions from one group to another.

• Expressions displayed outside of the Expressions dialog box do not contain any group
information.

• When merging parts, if the source part contains expression groups other than the Default
Group, those expressions, when transferred from the source part, retain their original group
assignments in a new top level group that uses the source part file name as the folder name.
Source groups are nested inside.
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Why should I use it?

Well-organized expressions are faster to navigate in complex models. Expression groups can
enforce design modularity and provide meaningful and descriptive packaging of expressions within
models intended for reuse.

Where do I find it?

Application Modeling and Assemblies

Command Finder Expressions

Location in dialog
box

Create or delete a group:

With Show Groups selected, right-click any group→New Group or
Delete Groups

Make active group:

With Show Groups selected, right-click any group→Make Group Active

Interpart expression format

For interpart expressions, a level of indirection has now been created between the expression object
and the part name. NX creates a system generated expression for each interpart expression. The
system generated expression can then be referenced on the right-hand-side of other expressions.

Note

Existing interpart expressions will be converted to the new format when the part is fully loaded
into the NX session.

The Show Locked Formula Expressions check box must be selected in order to see the system
generated expression.

Where do I find it?

Application Modeling, Assemblies
Command Finder Expressions

Prerequisite
The Show Locked Formula Expressions check box must be selected
in order to see the system generated expression.
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SNAP

What is it?

Simple NX Application Programming (SNAP) is improved to provide additional capabilities when
writing SNAP programs. The major enhancements are:

• Topology functions – These new functions let you get detailed information about the topology of a
body (the way in which faces and edges are connected together). The topology functions help
you write programs that analyze the shape and structure of solid bodies. For example, you can
write programs to find holes, or fillets, or other types of features.

Also, there are new Shell, Loop, Fin, and Vertex SNAP objects, which extend the existing Body,
Face, and Edge topology objects. There is a suite of approximately 20 new enquiry functions that
let you find out how these various objects are connected together. For example, you can find all
the faces in a shell, all the fins meeting at a vertex, and so on.

• Temporary display functions – These functions let you draw temporary objects in the NX graphics
window. You can draw markers, lines, circles, polylines, and text.

The temporary display functions let you provide graphical prompting or feedback to the users of
your programs, which often makes them easier to understand. The user can easily erase the
temporary objects after they have served their purpose.

• New documentation – The SNAP and NX Open for GRIP Users guide is added that describes
SNAP (and to a lesser extent, NX Open) from the point of view of a GRIP user. If you already
know GRIP, this guide enables you to easily find corresponding functions in SNAP and NX Open.

In addition, there are other enhancements including new functions to:

• Calculate points on a B-surface very quickly

• Create curves that replicate the shapes of edges

• Analyze the convexity across an edge

• Check whether a point lies inside a body or a face

• Convert between degrees and radians

• Access the NX Work View and other standard NX views

Why should I use it?

You can write programs that can provide additional functionality and features.

Where do I find it?

The SNAP and NX Open for GRIP Users guide is in the Programming Tools section of the NX Help.

Detailed descriptions of the new functions with examples are in the SNAP Reference Guide. The new
functions can be found in the following namespaces and classes:

• Topology objects and functions: new Snap.Topology namespace; additions to Snap.NX.Body,
Snap.NX.Face, and Snap.NX.Edge
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• Temporary display functions: Snap.Draw class

• Fast calculation of points on a B-surface: Snap.Geom.Surface.Bsurface.Position

• Create curves from edges: Snap.NX.Edge.ToCurve

• Analyze edge convexity: Snap.NX.Edge.Convexity

• Point containment: Snap.NX.Body.ContainsPoint and Snap.NX.Face.ContainsPoint

• Convert between degrees and radians: Snap.Math class

• Work view: Snap.Globals.WorkView

• NX standard views: Snap.NX.View.Standard class

NX Realize Shape

Import Subdivision Geometry

What is it?

Use the Import Subdivision Geometry command to import subdivision geometry (not large
tessellated data files) which has been exported by other applications using the Wavefront *.obj format.

Why should I use it?

To enable editing subdivision geometry from other applications.

Where do I find it?

Application Modeling
Command Finder File Subdivision
Menu File→Import→Subdivision Geometry

Project Cage enhancements

What is it?

The Project Cage command is enhanced with the new type Align Normal. It aligns selected cage
edges with the normals of a selected or defined plane.
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For the Target Type, new objects are recognized to be projected onto:

Arcs and Circles are now recognized as objects.
Vertices of selected cage edges are projected onto the selected arc or spline

Spline selected to be projected onto

Edges selected to project
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Vertices of selected edges now on spline

Dynamic Coordinate System
Vertices of selected cage edges are projected onto the XY plane of the dynamic coordinate
system. You can manipulate the dynamic coordinate system so its XY plane is the desired
plane to project to, prior to clicking Apply or OK

XY plane of dynamic coordinate system oriented as desired
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Edges selected to be projected

Vertices of selected edges now on XY plane of dynamic coordinate system

Why should I use it?

To make cage edges linear or parallel and/or to prepare for a high quality symmetric model.

Where do I find it?

Application Modeling and Shape Studio
Task Environment NX Realize Shape

Command Finder Project Cage
Location in dialog
box Type group
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Split Face enhancements

What is it?

• The Uniform type now allows you to drag the split lines during creation. Handles are provided for
this at creation time.

• The Along Polyline type now allows you to select Point on Face.

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Split Face
Location in dialog
box Type group, Uniform

Extrude Cage enhancements

What is it?

The Extrude Cage command is enhanced to let you:

• Specify an extrude direction for selected faces, edges, and NX Realize Shape.

Single edge extruded at an angle
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Polyline extruded

• Use internal edges as support.

• Add additional sections in the extrusion direction (polylines and internal edges only).

• Optional conditional thickening of open sheet bodies. It must be an open sheet body, and all
the faces must be selected.

Open edge sheet body

One face extruded—no thickening
All faces selected—thickened
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Why should I use it?

Use it when you have polylines to be extruded, or you need to extrude a polyline, edge or face
in a specific direction.

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Extrude Cage

Revolve Cage

What is it?

Use the Revolve Cage command to revolve a selected set of polylines or cage edges about an axis
to generate a control cage.

Polyline to be revolved

Polyline revolved about the Y axis 360 degrees,
with eight segments specified
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Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Revolve Cage

Loft Cage

What is it?

Use the Loft Cage command to create a loft of control cages using sets of face edges and polylines.

Two three-segment polylines and 3 cage edges
selected to be lofted

Loft cage created, with one segment specified

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Loft Cage
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Sweep Cage

What is it?

Use the Sweep Cage command to create a control cage and a subdivision body when you have
section polylines or control cage edges and no more than two guide polylines or edges.

Four cage edges and two guide polylines, each
with two segments

Swept cage

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Sweep Cage

Tube cage

What is it?

Use the Tube Cage command to create a tube using a polyline as a centerline and by specifying the
number of cage segments.
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Three-segment polyline

Tube with 6 segments specified

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Tube Cage

Transform Cage enhancements

What is it?

The Transform Cage command has been enhanced with a new falloff option. This option gives you a
smooth transition between the transformed objects and the remaining objects.

The user can choose one of three options:

• None–(the default)

• Selected–The user-selected objects which should participate in the falloff.

• All–All remaining objects will participate in the falloff.

The effective falloff transformation depends on the distance to the primarily transformed objects.
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The Falloff Curve can be set to emphasize closer objects, be linear, or can be set to emphasize
distant objects.

Falloff selections:

1. Selected Object

2. Selected Falloff Objects

Falloff selected: None

Falloff selected: Selected

Falloff selected: All

Why should I use it?

When you want a more gradual effect on a transformation.

Where do I find it?

Application Modeling and Shape Studio
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Task environment NX Realize Shape

Command Finder Transform Cage
Location in dialog
box Below Method

Primitive Shape enhancement

What is it?

The Primitive Shape command is enhanced to include the Torus shape type.

Why should I use it?

Use Torus if you want to create surface subdivision geometry that is toroidal in shape.

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Primitive Shape
Location in dialog
box Type group

Cage Polyline

What is it?

Use the Cage Polyline command to create or edit a line or series of lines used to create control cages.
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A three segment polyline selected to be revolved

Polyline revolved 360 degrees, in eight segments

Use Cage Polyline to:

• Create a polyline by specifying its points. Each point specified defines a segment of the polyline.

• Select any point you want, on cage geometry or non-cage geometry.

• During creation, drag the location of any polyline segment end point.

Why should I use it?

Use Cage Polyline as a preparation for extruding, revolving, lofting, or sweeping them into cage
faces,.

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Cage Polyline
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Extract Cage Polyline

The Extract Cage Polyline command lets you extract cage polylines from an existing curve or
face edge from outside a subdivision feature.

• Each linear section is one polyline segment.

• A non-linear section is broken into as many linear segments as you specify.

In the example above, a polyline is extracted from sketch geometry, then revolved to create a bottle.

Why should I use it?

Use the Extract Polyline command to create polylines from non-cage geometry. The extracted
polylines are then used to generate cage geometry using Extrude Cage, Revolve Cage, Loft Cage,
Sweep Cage, or Tube Cage.

Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Extract Polyline

Copy Cage

Use the Copy Cage command to copy and move selected cage faces and polylines.
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• Selected cages that you want to move and copy highlight, and the cage manipulator is positioned
to the averaged center of the selected elements.

• Use the cage manipulator to specify the translation and rotation movement you want.

• Each copy of the selected cages creates new topology, unassociated to the parent cage, within
the subdivision feature.
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Where do I find it?

Application Modeling and Shape Studio
Task environment NX Realize Shape

Command Finder Copy Cage

Sew Cage

What is it?

Use the Sew Cage command to connect open control cage edges of a subdivision feature.

• You select two sets of open edges to be connected. You can select the edges directly or by
selecting cage faces near an open edge.

o Each set needs the same number of edges.

o You can select edges in any order.

• When there are gaps, the selected cage edge pairs are averaged. The continuity setting of the
connecting surface is inherited from the target edge.
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Where do I find it?

Application Modeling
Task environment NX Realize Shape

Command Finder Sew Cage

NX Realize Shape preferences enhancements

What is it?

The preferences for NX Realize Shape now include options to control cage display, enhance cage
selection and display weights.

Cage and Body
There are three different display modes when editing subdivision feature within the task
environment.

Cage and Body

This is the default display and most commonly used display mode.

Cage Only

Use the Cage Only display mode when you want to create the main structures of a shape
without waiting for body display updates. The cage faces are shaded in this mode.
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Body Only

Use the Body Only display mode when you want to do surface analysis of the resulting body
without exiting the task environment. Due to the hidden control cage, editing is not possible in
this mode.

Allow Backside Selection
Use this as a selection filter when selecting cage elements.

• When active, you can select cage elements that lie behind other subdivision geometry.
This option is on by default.

• When inactive, you cannot select any cage elements on the back side of control cage, even
if you can see the element through the transparent cage.

Show Weight
Use the Show Weight display mode when you want to display the current weight factors set on
cage elements.
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NX Realize Shape Preferences
Use the NX Realize Shape Preferences dialog box to set control cage display preferences.
You can set:

• The cage display mode preferences.

Cage and Body Cage Only Body Only

• The cage object display preferences.

Show Weight

Line fonts for display of sharp and smooth edges.

Line Font (Smooth Edge) = Dotted

Line Font (Sharp Edge) = Solid

• The control cage selection preferences.

Allow Backside Selection

Where do I find it?

Application Modeling
Task environment NX Realize Shape

Command Finder

Cage and Body , Allow Backside Selection , Show Weight

, and NX Realize Shape Preferences
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Assemblies

Visual Reporting

Create an HTML report for Visual Reporting

What is it?

Use the new Create HTML Report option to send the results from an activated visual report to an
HTML web page. You can set the Create HTML Report option so that when you run a visual report
you create an HTML web page containing the results.

In the report, you can browse the results tree and its corresponding Info View information.

Where do I find it?

Prerequisite Legend Style must be set to Tree, and you must run a visual report.
Resource Bar HD3D Tools→Visual Reporting
Location in dialog
box Results group→right-click the tree background→Create HTML Report

Creating visual reports for component patterns

What is it?

Use the new Component Pattern Type option to define a visual report that reports on the component
patterns in your assembly.

The following example shows the results of running a visual report using the Component Pattern
Type option. The arrow points to the master component. The circular pattern components are red
and the linear pattern components are yellow. The reference pattern color, blue, does not appear
because its components are the same ones that are used in the circular array
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Where do I find it?

Prerequisite

In the Visual Report Definition dialog box, in the Report Property group,
you must set Source to Component Property.

Note

You can open the Visual Report Definition dialog box by clicking

Define New Report in the HD3D Visual Reporting tool.

Location in dialog
box Report Property group→Property→Component Pattern Type

Preserving broken interpart expressions

What is it?

Interpart expressions are now preserved when they break. An interpart expression will break when
the source part file or the expression in the source part file cannot be found. In previous versions
of NX, the interpart formula would be replaced by the last known value. If the source part file
or the expression in the source part file was found, then the interpart expression would have to
be constructed again.

In NX 10.0.1, if an interpart expression is broken, NX preserves the interpart expression formula and
marks the expression as broken. If the source part file is found or if an expression with the correct
name is created in the source part file, then the interpart expression is relinked automatically. NX
retains the last known value for the expression as long as it remains broken.

The user is informed when the interpart expression’s condition changes to either preserved or relinked.
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Why should I use it?

Preserving the formula describing the interpart expression and marking the expression as broken
retains more of the designer’s original design intent and saves time and effort in finding and repairing
broken interpart expressions. Automatic relinking similarly removes the need to recreate broken
interpart expressions when a valid parent is reintroduced.

Where do I find it?

Application Modeling
Command Finder Expressions

Mirror Assemblies Wizard

What is it?

If you are in a Teamcenter environment, you now use the business logic set up for your site when
you create new mirror parts using the Mirror Assembly Wizard (MAW). The MAW also supports
the new Teamcenter multi field key attributes.

The new items created in Teamcenter for any newly created mirror parts will be of the same type
as the source parts being mirrored. When you mirror a part or assembly, you create a new part or
assembly, not a new revision.

Note

You can no longer change the item type for mirrored parts with the Mirror Assembly Wizard.

Why should I use it?

You can rename all the new objects and their attributes, including Teamcenter multi field attributes, at
one time in a single mirroring process. You can see and validate all the attributes as you mirror them.

Where do I find it?

Prerequisite You must be in a Teamcenter environment.
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Command Finder Mirror Assembly

Extraction Path customizing

What is it?

When creating an extraction path in assembly sequencing, use the new Guide Path Manually option
to influence the direction of the path that is created. This lets you drag a copy of the components to a
location in the extraction path. NX then attempts to calculate and create a valid path in that direction.

Why should I use it?

The Guide Path Manually option is useful when the extraction path may be complicated by the
presence and location of other components. By guiding the components in a recommended direction,
you provide NX with information that helps define a path that would otherwise be time-consuming or
difficult to find.

Where do I find it?

Application Assemblies
Command Finder Extraction Path

Location in dialog
box

Located in the version of the Extraction Path dialog box that appears after

you click Generate Result .

Replacing a part families component

What is it?

The Part Families functionality has been enhanced to ensure that drawing data (such as dimensions,
occurrence notes, callouts) and occurrence properties (such as color and visibility settings) are
preserved in certain situations when creating assembly part family members. Prior to this change,
drawing data would be retained and occurrence properties deleted when the assembly part family
member creation required some component of the template assembly to be substituted with another
component. This data loss would occur even when the substituted parts were versions of each other.

Why should I use it?

This enhancement is relevant to users that require better associativity support when creating
assembly part family members.

Where do I find it?

Application Assemblies
Command Finder Part Families
Menu Menu→Tools→Part Families
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Default location for component drag handles

What is it?

You can now specify a default location for the drag handles of components that do not have a
user-defined drag handle location. To do this, set the Drag Handle Location customer default to
either Center of Bounding Box or to Origin of Component.

For parts modeled at the global origin, the component origin is a preferred default location for a
drag handle. For parts modeled in their location in the assembly, the origin of a component might
be quite a distance from the part geometry. In these cases, a CSYS or datum CSYS on the part is
a preferred location.

You can now use the following drag handle shortcut menu options to quickly snap the drag handle to
the desired location:

• Snap Handle to CSYS

• Snap Handle to Component Center

• Snap Handle to Component Origin

If you select multiple components, the default drag handle location is always at the center of the
combined bounding box of all selected components.

Note

A user-defined drag handle location takes precedence over the location set by the customer
default.

Why should I use it?

When you design a manufacturing line within a plant, you can quickly and precisely place components
based on their origin or a CSYS.

Where do I find it?

Command Finder Customer Defaults
Location in dialog box Assemblies→Positioning→Interface tab

Command Finder Assemblies Preferences

Moving a component along a vector and projected distance

What is it?

You can now move a component along a vector and by a projected distance between two objects or
points that are projected on the motion vector. To do this, set the Motion type option to Projected
Distance, and set the following options:

• Specify Vector: Lets you specify a vector for the projected axis.

• Select Start Point or Object: Lets you select the point from which to measure the distance.
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• Select End Point or Object: Lets you select the end point for measuring the distance.

Where do I find it?

Command Finder Move Component

Location in dialog
box

Transform group→Motion

Transform group→Specify Vector

Transform group→Select Start Point or Object

Transform group→Select End Point or Object

Add a component to the XC-YC plane by drag and drop

What is it?

You can use the Position on XC-YC Plane customer default to enable quickly placing of new
components by drag and drop to the XC-YC plane.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Why should I use it?

To quickly place components at Z=0 to simulate objects being placed on a floor.

Support for monolithic JT files

What is it?

A monolithic JT file is a JT file that contains the entire product structure. When you add a monolithic
JT file as a component to an NX assembly, NX now creates JT faceted bodies. In previous releases,
NX created legacy NX faceted bodies.

WAVE-linking product interface enhancement

What is it?

When you use the graphics window to select an object that has a product interface, the product
interface is now selected for the following WAVE commands:

• WAVE Geometry Linker

• Copy Geometry to Component

• Copy Geometry to Part

• Copy Geometry to New Part
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When you use one of the copy commands, the object you select must correspond exactly with
a product interface in order to link to the product interface. The WAVE mode object types that
correspond with product interface object types are:

• Body

• Datum

• Point

• Sketch

• Composite curve

Note

Edges and faces do not link to a product interface because those WAVE mode object types do
not correspond to product interface object types.

Why should I use it?

The behavior of these commands is now consistent with the behavior of other WAVE commands.
Previously, when you used the graphics window to select geometry that has a product interface, some
WAVE commands selected the product interface while others selected the object geometry. Most
users prefer to link to the product interface instead of the geometry because, if the product interface is
remapped to new geometry, the associated WAVE link also updates to point to the new geometry.

Where do I find it?

WAVE Geometry Linker

Command Finder WAVE Geometry Linker

Copying geometry

Prerequisite Make sure that WAVE Mode is active in the Assembly Navigator.

Assembly Navigator
Right-click on a component→WAVE→Copy Geometry to Component,
Copy Geometry to Part, or Copy Geometry to New Part

Updating assembly structures in the Assembly Navigator

What is it?

The Update Structure on Expand customer default check box is now selected by default. This
ensures the following occurs when you expand nodes for unloaded subassemblies in the Assembly
Navigator:

• The expanded assembly structure is up-to-date.

• The bounding boxes are correct.

• The attributes are up-to-date.
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Update Structure on Expand has no effect on loaded subassemblies, because their structure,
bounding boxes, and attributes are updated as part of the load process.

You can select or clear the Update Structure on Expand preference check box to experiment with
its effects on performance in your NX session.

Why should I use it?

If the Update Structure on Expand check box is not selected, unloaded assemblies could display
out-of-date information when you expanded their Assembly Navigator nodes.

Where do I find it?

Update Structure on Expand customer default

Ribbon bar File tab→Utilities→Customer Defaults
Location in dialog
box

Assemblies→General→Miscellaneous tab→Update Structure on
Expand

Update Structure on Expand preference

Menu Menu→Preferences→Assemblies→Update Structure on Expand

Interpart expression format

For interpart expressions, a level of indirection has now been created between the expression object
and the part name. NX creates a system generated expression for each interpart expression. The
system generated expression can then be referenced on the right-hand-side of other expressions.

Note

Existing interpart expressions will be converted to the new format when the part is fully loaded
into the NX session.

The Show Locked Formula Expressions check box must be selected in order to see the system
generated expression.

Where do I find it?

Application Modeling, Assemblies
Command Finder Expressions
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Prerequisite
The Show Locked Formula Expressions check box must be selected
in order to see the system generated expression.

Drafting

Designing using Layout

Layout process in NX

Layout describes a conceptual 2D design environment where an engineer or designer can explore
concepts in 2D by creating layouts of a part or assembly. The task is not to produce a finished
drawing, but to provide an alternate way of solving design problems whose key characteristics are
represented in 2D. You can use it for rapid prototyping of a design or part.

The layout process lets you do concept design without modeling 3D geometry, but it achieves the
requirements that will drive the 3D design.

In NX, the Layout tab centralizes main commands in the following groups for exploring concepts
in 2D.

• View commands

• Sketch and 2D Component commands

• Dimension and Annotation commands

2D components are rigid reusable objects dedicated for 2D design that you can use to quickly and
easily create a layout. In the context of the 2D design, 2D components are analogous to 3D parts.

Using the layout process, you can:

• Create and organize 2D components into a hierarchical structure in the Part Navigator.

• Edit an active 2D component including nesting other 2D components. Other 2D components
with same definition can be immediately updated or you can delay the update and lock 2D
components to not apply the changes.

• Drag and drop from the Reuse Library to add existing 2D components to your layout.

• Apply different settings to each 2D component to manage the visibility of 2D components,
geometry, dimensions, and annotations or apply them to all 2D components.

• Replace existing 2D components with one other 2D component.

• Break associativity between the 2D component and its definition or smash it into its constituent
objects.

• Document your layout for design review or production.

• Move a 2D component to a new view.

• Copy 2D components to 3D modeling space or create an assembly to continue your design in 3D.
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• Publish 2D component definitions to Teamcenter or a disk drive for sharing with other engineers.

2D components and sketch integration

2D component instances are sketch objects that you can manipulate and position as any other sketch
object. Their geometry is rigid and changes only when edited.

2D component hierarchy is shown in the Part Navigator under the sketch node.

Drawing
Sheet “Sheet 1” (Work-Active)

Sketch “SKETCH_SHEET 1_000” (Active)
2DComp

Out-of-Date

You can apply sketch geometric and dimensional constraints:

• On 2D component geometry.

• Between 2D component instances.

• Between 2D component geometry and sketch geometry.

When you edit a 2D component, NX preserves the constraints as long as, during the edit, you do not
delete the 2D component geometry where the constraint is placed.

Note

A 2D component can snap to the grid and supports Move, Rotate, Offset, Cut, Copy, and
Paste commands.

2D components

A 2D component is a reusable drafting object dedicated for 2D design and layout. It is analogous to
a 3D part in the context of a 2D environment.

Each 2D component has one 2D component definition and one or more 2D component instances.

2D component

2D component definition 2D component instance 1

2D component instance 2

2D component instance 3
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2D component
definition

Defines the 2D component recipe that contains the geometry, the name,
the anchor point, and a preview image of the 2D component. It is stored in
the Reuse Library. You can place multiple instances of the 2D component
definition in your layout. When the 2D component definition changes, all of its
instances are updated.

2D component
instance

Represents the 2D component in your layout and displays it in the graphics
window. A 2D component instance is a sketch object that belongs to a sheet
sketch, view sketch, or another 2D component. It is associatively linked to the
2D component definition. Each 2D component instance has a unique name
derived from the 2D component definition name.

Supported 2D component objects

The supported objects for a 2D component are:

• Sketch objects

• Drafting and sketch dimensions

• Drafting annotations including custom symbols

• Centerlines

• Nested 2D components

A 2D component is another sketch object; as such, it cannot contain basic curves, drafting curves, 3D
solids, 3D faces, 3D edges, groups, drawing views, tables, title blocks, and images. In addition, a 2D
component cannot contain sketch groups and a sketch group cannot contain 2D components.

2D component Reuse Library

All 2D component definitions are stored in the Reuse Library. The definitions can be stored in the
current part file, in a centralized library created on a disk drive, or in Teamcenter.

Reuse Library

2D Component Library
Published 2D Components

Simple 2D Components
Complex 2D Components

Local 2D Components

2D components stored in the current part file are called local 2D components. They appear in the
Local 2D Components folder node under 2D Component Library.

2D components stored in a centralized library on a disk drive or in Teamcenter are called published
2D components. They appear in the Published 2D Components folder node under 2D Component
Library.

The name and location of the centralized 2D component library is defined in Customer Defaults.
You can create subfolders for managing your 2D component definitions.
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2D component settings and preferences

You can modify the appearance of one or more 2D component instances through the Settings dialog
box. To modify the appearance of all newly created or placed 2D components, use the Drafting
Preferences dialog box.

You can show or hide:

• Reference geometry

• Annotations

• Dimensions

New 2D Component

Use the New 2D Component command to create an empty 2D component instance and store
its definition in the Reuse Library. You can continue to create additional empty 2D components
including nested 2D components to build a virtual structure in the Part Navigator before adding
geometry and annotation to the 2D components.

Drawing
Sheet “Sheet 1” (Work-Active)

Drawing View “Top@1”
Sketch “SKETCH_TOP1_000”

2DComp
2DComp1

2DComp4
2DComp2
2DComp3

Sketch “SKETCH_SHEET 1_000”
2DComp5

2DComp6
Out-of-Date

When you use the New 2D Component command, NX adds the newly created 2D component to the
active sketch. The active sketch belongs to one of the following:

• Active sheet

• Active drawing view

• Active 2D component

As you are creating the 2D component, you can rename it or use the uniquely generated name. You
can modify the prefix NX uses with the 2D component Name Prefix customer default.

You must make the newly created 2D component active before adding geometry and annotation to it.
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Where do I find it?

Application Drafting

Command Finder New 2D Component
Graphics window Right-click the 2D component→New 2D Component

Part Navigator
Right-click the sheet node, the drawing view node, the sketch node, or the
2D component node→New 2D Component

Define 2D Component

Use the Define 2D Component command to define a 2D component instance by selecting its content
in the graphics window and storing its definition in the Reuse Library.

You can select any existing sketch geometry including other 2D components, annotations, and
dimensions from the active sketch. The active sketch can be located in the sheet, the drawing view,
or the active 2D component.

In addition to the selection, in the Define 2D Component dialog box, you can specify:

• The anchor point.

• The location in the Reuse Library where you want to store the new definition.

• The descriptive name of the 2D component definition.

• The preview image.

NX creates a 2D component definition in the Reuse Library that contains all copied sketch geometry
including constraints and nested 2D components. If the selection contained a sketch group, the
content of the sketch group is moved to the 2D component. The group stays empty.

In the graphics window, NX replaces the selected objects by the 2D component instance of the
newly created 2D component. All constraints and dimensions between the 2D component and other
geometry are maintained. In the Part Navigator, NX creates a new 2D component node under the
sketch node of the sheet or the drawing view or under the parent 2D component node.

Where do I find it?

Application Drafting

Command Finder Define 2D Component
Graphics window Right-click selection→Define 2D Component
Part Navigator Right-click the 2D component node→Define 2D Component

Reuse Library
Right-click a folder node or a subfolder node under the 2D Component
Library→Define 2D Component
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Replace 2D Component

Use the Replace 2D Component command to replace the selected 2D component instances with
another 2D component definition.

You can replace:

• One 2D component instance.

• All instances of the selected 2D component.

• Instances of different 2D components.

• Nested 2D component instances. This causes the parent 2D component definitions to change
and the 2D component instances that use them to update.

When the association between the 2D component instance and its definition is broken, the Replace
2D Component command can replace the orphan 2D component with an existing 2D component
definition. The association can be broken, if, for example, the 2D component instance of a local 2D
component is copied from one part to another without publishing the 2D component definition or if the
part file of a published 2D component is deleted from the system drive or from Teamcenter.

You can replace locked 2D components as long as their parents are not locked. The replaced
instances are not locked. You cannot replace an active 2D component. You must first exit or finish
editing the 2D component before replacing it.

Where do I find it?

Application Drafting
Prerequisite The 2D component must not be active.

Command Finder Replace 2D Component
Graphics window Right-click the 2D component→Replace
Part Navigator Right-click the 2D component node→Replace

Make 2D Component Unique

Use the Make 2D Component Unique command to create a new 2D component definition for the
selected 2D component instance. In the Make 2D Component Unique dialog box, you specify:

• The location in the Reuse Library where you want to store the new definition.

• The descriptive name of the 2D component definition.

• The optional preview image.

When you create a new 2D component definition, the nested 2D components of the selected instance
keep the same definitions they had prior to the command. Making a nested 2D component instance
unique changes the definition of its parent and updates its instantiated components.
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When the association between the 2D component instance and its definition is broken, the Make 2D
Component Unique command creates a new 2D component definition for the orphan 2D component.
The association can be broken, if, for example, the 2D component instance of a local 2D component
is copied from one part to another without publishing the 2D component definition or if the part file of a
published 2D component is deleted from the system drive or from Teamcenter.

You can make a locked 2D component unique as long as its parent is not locked. You cannot make
an active 2D component unique. You must first exit or finish editing the 2D component before making
it unique.

Where do I find it?

Application Drafting
Prerequisite The 2D component must not be active.

Command Finder Make 2D Component Unique
Graphics window Right-click the 2D component→Make Unique
Part Navigator Right-click the 2D component node→Make Unique

Smash 2D Component

Use the Smash 2D Component command to break an instance of a 2D component into its
constituent pieces. NX inserts the constituent pieces into the parent sketch.

If you smash a 2D component instance that has nested 2D components, the nested 2D components
are not smashed, but they are placed in the top level sketch or the parent 2D component. You can
smash locked 2D components as long as their parents are not locked.

Constraints, dimensions, and annotations applied to the smashed 2D component are maintained.

Instances are smashed the way they are currently being displayed. If the instance is out-of-date the
smashed objects match the out-of-date instance. If the annotations, dimensions, and reference
curves are not visible due to defined style options, they are copied but remain hidden in the smashed
instance.

You cannot smash an active 2D component. You must first exit or finish editing the 2D component
before smashing it.

Where do I find it?

Application Drafting
Prerequisite The 2D component must not be active.

Command Finder Smash 2D Component
Graphics window Right-click the 2D component→Smash
Part Navigator Right-click the 2D component node→Smash
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Publish 2D Component

Use the Publish 2D Component command to create an external part file containing the 2D
component definition. You can publish one 2D component definition or all 2D component definitions
that are stored in the Local 2D Components folder or its subfolders.

In the Publish 2D Component dialog box, you specify one destination location where all 2D
component definitions will be saved. When you publish a 2D component definition that contains
nested 2D components, NX also publishes the nested 2D component definitions in the same
destination location.

In the Customer Defaults dialog box, you or your company can specify:

• The name and location of the published 2D component library.

• If the published 2D components are stored either on a disk drive or in Teamcenter.

In native NX, the external 2D component part files have distinct names that end with .2dc.prt. In
Teamcenter Integration, the published 2D components are items with unique names across the
Teamcenter database.

Where do I find it?

Application Drafting

Reuse Library

Right-click the Local 2D Components folder node or a subfolder
node→Publish 2D Component

Right-click a 2D component in the Local 2D Components folder→Publish

Customer Defaults

Command Finder Customer Defaults
Location in dialog
box Gateway→Reuse Library→2D Component Library tab

Create Assembly from Layout

Use the Create Assembly from Layout command to create an assembly that replicates the 2D
component geometry and hierarchy of your layout. This enables you to continue your design in 3D
in the Modeling application.

You specify:

• The top level sketch that contains the layout. The sketch can be either in the sheet or the drawing
view.

• A part file where NX creates the assembly containing the component parts. The units of the
assembly part must be the same as the units of the layout part.

NX creates:

3-74 What's new in NX

Chapter 3: CAD



CAD

• The assembly structure that replicates the 2D component hierarchy of your layout.

• A new part for each 2D component definition that is used in the selected layout. The units of the
created component parts are the same as the units of the layout part. The name of the created
component part file is the same as the name of the 2D component definition.

Note

If a file or an item with the same name already exists in the destination folder or in the
Teamcenter database, NX does not create the part. Instead, you get a warning message.

The geometry of the 2D definition is used to create all component parts, even if the 2D component
instance is locked or out-of-date. This may cause differences between the layout and the assembly if
the layout contains out-of-date instances.

In the assembly, NX does not create parts from orphan 2D component instances as they do not have
a definition. If you have orphan 2D components use the Make 2D Component Unique command to
create 2D component definitions for them before creating the assembly.

Transferred annotations become assorted parts.

Sketches in Modeling

The layout top level sketch is copied to the assembly part sketch, while each 2D component definition
sketch is copied to the corresponding component part sketch. The sketches include all geometry,
geometric constraints, and dimensional constraints from the original sketches.

All sketches are created in the XY plane of their corresponding new part and their origin is placed
at the origin of the absolute coordinate system. If the original top level sketch is in a drawing view,
the drawing view orientation is used to define the plane. The sketch origin in a component part
corresponds to the position of the 2D component anchor point. The XY orientation of the created
sketch matches the XY orientation of the 2D component sketch. The display settings of the 2D
component geometry is preserved in the component part sketch.

Where do I find it?

Application Drafting

Command Finder Create Assembly from Layout

Restructure of the Drafting customer defaults

What is it?

The Drafting customer default categories and options are reorganized so that they are arranged
similar to the way the same options are arranged in the Drafting Preferences dialog box. This
reorganization introduces a new identifier in the structure of a customer defaults file called
Subcategory. Subcategories group the defaults into smaller and more logical collections of options.
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1 = Application
2 = Category
3 = Subcategory

The Subcategory identifier appears as an additional column in the results table when you search for
a default.
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Most drafting options are now located under the Drafting Standard customer default option. In
the Customer Defaults dialog box, from the Drafting→General/Setup node, you must select an
appropriate Drafting standard, and then click Customize Standard to access and change these
options.

Additionally, you can now use the Find Default tool to search for a default like in the Customize
Standard mode.

Drafting customer default files

Due to this reorganization, most drafting customer default settings are now located in, and
controlled by, the appropriate drafting standards file. For example, if the Drafting Standard
for your part is set to ISO, then most of the drafting custom default settings are located in the
nx_ISO_Drafting_Standard_Shipped.dpv file.

Tip

If you have customized your Drafting default settings, or have created unique drafting standard
default files (e.g. a custom version of the nx_ISO_Drafting_Standard_Shipped.dpv file), you

must use the Import Drafting Standard tool to migrate all of your Drafting customer
default settings into NX 10. To access this tool, you must click the Customize Standard button
on the Drafting→General/Setup node in the Customer Defaults dialog box.

If you have customized your customer defaults file (i.e. nx9_user.dpv) then you must use both

the Import Drafting Standard tool and the Import Defaults tool, located in the
Manage Current Settings dialog box, to import all of your customized user default settings.

Where do I find it?

Access and change existing Drafting customer default settings

Command Finder Customer Defaults
Menu File→Utilities→Customer Defaults
Location in dialog
box

Drafting→General/Setup node→Standard tab→select a standard from the
Drafting Standard list→click Customize Standard

Import your existing drafting customer defaults settings

Command Finder Customer Defaults
Menu File→Utilities→Customer Defaults

Location in dialog
box

Drafting→General/Setup node→Standard tab→select a standard from
the Drafting Standard list→click Customize Standard and then click the

Import Drafting Standard button
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Borders and Zones enhancements

What is it?

To provide improved compliance with drafting standards and improve the usability of the Borders
and Zones command, the following enhancements are available:

• The Borders and Zones dialog box has been redesigned to provide a more intuitive interaction
with the command.

• Format and display options originally on the Borders and Zones dialog box are now accessible
from a new Borders and Zones node in the Drafting Preferences dialog box and Settings
dialog box.

• New preference and setting options that let you do the following:

o Specify the drafting standard that is used to set the default values when creating borders
and zones.

o Control the appearance and position of line center marks and arrow head center marks.
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o Set the style and appearance of the trimming marks. You can choose to display a right-angled
isosceles triangle trimming mark or a corner trimming mark.

o Display the drawing sheet size in place of the zone label in the lower right corner of the
drawing border.

o Specify the letters that cannot be used in a zone label.

o Specify whether or not zone numbers can continue on subsequent drawing sheets.

o Set margin values used to locate the drawing border within trimmed and untrimmed drawing
sheets.
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Why should I use it?

Use the new preference settings to create more standards-compliant drawing formats, or to further
refine your custom drawing format.

Where do I find it?

Borders and zones preferences

Application Drafting

Command Finder Drafting Preferences

Location in dialog
box

Drawing Format→Borders and Zones→Border Display node

Drawing Format→Borders and Zones→Border Margin node

Drawing Format→Borders and Zones→Zone node

Borders and zones settings

Application Drafting

Command Finder Borders and Zones
Location in dialog
box Settings group→Settings

Title Block enhancements

What is it?

The following enhancements are available for title blocks:

• The title block automatically repositions correctly when the drawing border is changed or removed.

• A new Edit Table button in the Define Title Block dialog box places you in a special
task environment with specific table commands for editing and redefining the table. This task
environment also allows you to edit and delete locked title block cells. The cells revert to a locked
state once the edits are complete.

Note

While in the task environment, you can add and remove sections, cells, columns and
rows from any tabular note that makes up the title block table. You must exit the task
environment and use the Select Tables button in the Define Title Block dialog box to add
a new tabular note to, or completely remove an entire tabular note from, the title block table.

To exit the task environment, you must select one of the following commands:

o Finish Edit Table saves the table edits and exits the task environment.
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o Exit Edit Table exits the task environment without saving any edits.

• The ability to cut, copy, and paste title blocks.

• A new Date-Time option for cells that lets you display both a date and time value, and control
the format of those values.

Note

This option works correctly for title blocks and tabular notes created in NX 10 or higher. If
you want to use this option in a title block or tabular note created before NX 10, you must
use one of the version up options on the General/Setup→Workflow node in the Drafting
Preferences dialog box to first update the title block or tabular note.

• Word wrapping is now supported for cells in title blocks.

Note

Applying any fit method to a title block table may cause the table to expand in an
undesirable direction. Use care when applying fit methods to cells in a table.

• You can use the Enter key to cycle through the list of items in both the Populate Title Block
dialog box and the Define Title Block dialog box.

Where do I find it?

Edit Table command

Application Drafting
Prerequisite A title block table must be selected.
Graphics window Right-click a title block table→Edit Definition
Location in dialog
box Tables group→Edit Table

Finish Edit Table command and Exit Edit Table command

Application Drafting
Prerequisite You must be in the Edit Table task environment.

Command Finder

Finish Edit Table

Exit Edit Table

Date-Time option for cells

Application Drafting
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Location in dialog
box

In the Drafting Preferences dialog box:

Table→Common→Cell node→Format group→Category
list→Date-Time

In the Settings dialog box:

Common→Cell node→Format group→Category list→Date-Time

Fit support for angled text in tables

What is it?

The following fit methods are now supported for text at a 90° angle in the cell of a table:

• Wrap

• Auto Size Text

• Truncate

• Overwrite Border

• Abbreviate

• Remove Spaces

• Auto Size Row

• Auto Size Column

Why should I use it?

Use the fit methods when you want to display vertical text in the cell of a table while controlling the
size of the cell.

Where do I find it?

Application Drafting

Prerequisite
The Lettering Angle option in a cell must be set to something other than 0
degrees.

Location in dialog
box

In the Drafting Preferences dialog box:

Table→Common→Cell node→Fit Methods group

In the Settings dialog box:

Common→Cell node→Fit Methods group
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Section View command

What is it?

The following section view commands are consolidated into a single Section View command.

• Simple/Stepped

• Half

• Revolved

• Folded

• Unfolded Point to Point

The section view dialog bar is replaced with a block-based dialog box that lets you select which type
of section view you want to create, and then automatically displays the appropriate groups of options
based on the view type and creation method you selected.

Section line definition

As with the previous commands, the Section View command requires you to define the section line
before you create the section view. You can dynamically create the section line after selecting an
existing drafting view, or you can select an existing stand-alone section line.

Note

Use the Section Line command if you want to create a stand-alone section line using
the sketch tools.

When you choose to dynamically create the section line, interactive on-screen controls are available
to define and edit the location and configuration of the section line.

Example of on-screen control handles for end points and node points of a section line
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Legacy section views

The following section view types are not affected by this change, and continue to use the same dialog
box interface and process for creating the view.

• Unfolded Point and Angle

• Pictorial

• Oriented

• Break-out

The Unfolded Point and Angle and Oriented section view commands are hidden in all roles and
must be added to the user interface by using the Customize command on the Ribbon bar. The
Pictorial and Break-out section view commands are available in the advanced roles, or they can
be added to the user interface using the Customize command.

Where do I find it?

Application Drafting

Command Finder Section View

Graphics window

Right-click a drafting view→Add Section View

Right-click a stand-alone section line→Add Section View

Section Line command

What is it?

Section Line lets you create standalone section lines for the following types of section lines.

Simple Stepped
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Half Point to point (folded and unfolded)

The Section Line command always creates section lines in a sketch that has the following unique
characteristics:

• Any dimensions created in the sketch are for reference only, and are not visible outside of the
sketch environment.

• You can constrain the sketch curves to geometry in the associated view only. If you want to add
constraints to geometry outside of the view, including geometry in other sketches associated to
the view, you must add reference geometry to the sketch.

• Only one continuous section line can exist in the sketch.

• The sketch is not visible in the Part Navigator. You must edit the section line to enter the
sketch environment.

When editing a section line, you cannot change the parent view. You cannot add sketch-based
section lines to views that contain view breaks. If you want to add associative section lines to a
drawing view with an Exact (Pre-NX 8.5) representation, you must turn on extracted edges.

Why should I use it?

Use the Section Line command when you want greater control over the definition of the section
line. You can also use the Section Line command to create a stand-alone section line that is not
associated to a section view.

Note

Use the Section View command if you want to simultaneously create both a section line
and an associated section view.

Where do I find it?

Create a stand-alone section line

Application Drafting

Command Finder Section Line
Graphics window Right-click a drafting view→Add Section Line
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Edit a section line

Application Drafting

Graphics window

Right-click a section line→Edit

Double-click a section line

View enhancements

What is it?

The following enhancements are available for smart lightweight drafting views:

• You can create break-out section views from smart lightweight views.

• Crosshatch patterns are correctly rendered when they are hidden behind bodies in a sectioned
smart lightweight view.

• You can import PMI lightweight section views onto a drawing as smart lightweight section views.

• You can suppress the display of all hidden edges that are not referenced in a smart lightweight
view. Alternately, you can display hidden edges that are referenced by associated annotation or
when view dependent edits are applied to the hidden edge.

Also, the Work in Progress interruption mechanism has been enhanced to provide a quicker
response when stopping a view update process.

Why should I use it?

Smart lightweight drafting views improve performance and memory efficiency when working with large
assembly drawings. These enhancements enable a wider use of smart lightweight views in drawings.

Where do I find it?

Set the view type to display a smart lightweight view

Application Drafting

Location in dialog
box

In the Drafting Preferences dialog box:

View→Common node→Setting group→Representation

In the Settings dialog box:

Common node→Setting group→Representation

View break enhancements

What is it?

When you break a view that has a radial dimension partially outside of the view break, NX displays
the radial dimension with the view break. The radial dimension is partially outside if its leader
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terminate point is outside of the view break. The selected curve for the radial dimension can be an
arc, circle, spline, or conic.

This enhancement applies to any radial dimensions, whether their settings specify Radius to Center
or not, with arrows pointing in or out. It applies both to drafting radial dimensions created on the
drawing and to inherited PMI radial dimensions shown on the drawing.

In previous releases, the radial dimension was hidden when the center of the arc or circle was
inside the view break.

Pre-NX 10 NX 10

If you open a part with views created in older NX releases, you need to version the views up to NX 10
to display the radial dimension that is partially inside the view break.

If any dimension or annotation attachment point is fully consumed by a view break the object
highlights so that you can see and acknowledge the result before it is hidden.

Where do I find it?

Application Drafting

Command Finder View Break
Graphics window Right-click a view border→Add View Break
Part Navigator Right-click a view node→Add View Break

View versioning

Application Drafting

Command Finder Drafting Preferences
Location in dialog
box General/Setup→Workflow node→Version Up group
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Single-sided dimensions

The Display as Single Sided Dimension option lets you create and edit linear and angular
dimensions with only a single leader line. Use single-sided linear or angular dimensions for geometry
that is larger than the size of the drawing view or sheet, or where the measurement origin is
associated to geometry that is not visible. While creating or editing a single-sided dimension, you can

use the Flip Dimension Side button to switch between dimension lines.

Note

Chain dimension sets and narrow dimensions are not supported. Also, you cannot create
single-sided dimensions using the Rapid dimension command.

When you are in edit mode. Access handles are available to indicate which extension line and
arrow to retain. The access handle can also be used to set the length of the remaining, stunted
arrow line. Alternately, you can also set the length of the remaining line using the Length option
in the Settings dialog box.

Example of a linear single–sided
dimension Example of an angular single–sided dimension

Where do I find it?

Set the single sided option

Application Drafting and PMI

Graphics window

Right-click while creating a dimension→Settings

Double-click an existing dimension→Settings
Location in dialog
box Single Sided node→Display as Single Sided Dimension
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Flip Dimension Side button

Application Drafting, PMI

Graphics window

While in edit mode, click the Arrow Line access handle, and then turn the

Flip Dimension Side on-screen button on or off.

Right-click while creating a dimension→Settings

Double-click an existing dimension→Settings
Location in dialog
box Single Sided node→Flip Dimension Side

Set the length of the remaining arrow line

Application Drafting, PMI

Graphics window

While in the edit mode, click and drag the Arrow Line access handle

Right-click while creating a dimension→Settings

Double-click an existing dimension→Settings
Location in dialog
box Single Sided node→Length

Linear dimension measurement types

What is it?

A new Measurement Type option in the Linear Dimension dialog box lets you specify a linear
dimension as a general dimension, a directed dimension, or a feature of size dimension. The
dimension type determines how the feature is measured and how the tolerance is applied to the
measurement. This additional information is saved with the dimension object when it is created.

• A General dimension is a simple dimension with no additional, implied information about the
measurement.

• A Directed dimension specifies the direction in which a feature is measured from an implied
datum. All of the tolerance is applied to the second object.
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• A Feature of Size dimension is a measurement about an implied datum halfway between the two
measured features. The tolerance is equally disposed about the two measured features.
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When the Measurement Type is set to Directed, you can select multiple objects for the origin object
and the measured object. When it is set to Feature of Size, you can select multiple objects for
the first object and the second object

Note

To make the Measurement Type option available in the Linear dimension dialog box, you
must first set the Enable Directed Dimensions option in the Drafting Preferences dialog
box. This option is not available in the Settings dialog box, so you cannot set it while creating
or editing a linear dimension

Hole callouts, cylindrical dimensions, chain dimensions, and baseline dimensions are not supported
as directed or feature of size dimensions.

Why should I use it?

Use the new measurement types to capture additional design information when dimensioning the
features on your model. In particular, the information captured for PMI dimensions can be used in
downstream applications such as tolerance analysis and inspection applications.

Where do I find it?

Measurement Type option

Application Drafting, PMI
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Prerequisite
The Enable Directed Dimensions option in the Drafting Preferences
dialog box must be set.

Command Finder Linear
Location in dialog
box References group→Measurement Type

Enable Directed Dimensions option

Application Drafting, PMI

Command Finder Drafting Preferences
Location in dialog
box Dimensions→Workflow node→Enable Directed Dimensions

Ordinate dimension enhancements

What is it?

The following enhancements are available for ordinate dimensions:

• You can reuse existing ordinate origins in any view on any drawing sheet to create dimensions
in other views.

You can select an existing ordinate origin from a new List box in the References group of the
Ordinate Origin dialog box, or you can select an existing ordinate origin or ordinate dimension
directly from the graphics window.

• You can use the new Clip Ordinate Dimension Line on-screen setting to limit the ordinate
dimension line to the bounding box of the view (not the actual view boundary).
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This setting is only available when the ordinate origin and the ordinate dimensions are in different
views or on different sheets and the Show Dimension Line option in the Settings dialog box
for the ordinate dimension is set.

You can also set the Clip Ordinate Dimension Line option from the Settings dialog box while
creating or editing an ordinate dimension.

• You can locate and display the ordinate origin by right-clicking an existing ordinate dimension
and selecting Navigate to Origin.

Why should I use it?

Use existing ordinate origins to create new ordinate dimensions in any view on any drawing sheet
without the need to redefine the origin point. The Navigate to Origin command helps you locate
the associative ordinate origin. The associative origin can be on the same drawing sheet or a
different sheet.

Where do I find it?

List of existing ordinates

Application Drafting

Command Finder Ordinate
Location in dialog
box References group→List group

Clip Ordinate Dimension Line option

Application Drafting
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Prerequisite
In the Settings dialog box or Drafting Preferences dialog box, in the
Ordinate node→Set group, the Show Dimension Line option must be set

Graphics window

While in the edit mode for an ordinate dimension, click the Arrow Line

access handle, and then turn the Clip Ordinate Dimension Line
on-screen button on or off.

Location in dialog
box

In the Drafting Preferences dialog box:

Common→Line/Arrow→Arrow Line node→Arrow Line group→Clip
Ordinate Dimension Line

In the Settings dialog box:

Line/Arrow→Arrow Line node→Arrow Line group→Clip Ordinate
Dimension Line

Navigate to Origin command

Application Drafting
Graphics window Right-click an ordinate dimension→Navigate to Origin

Automatic line breaks

The Create Break option for dimension lines and annotation lines automatically creates breaks on the
lines when they cross other annotation lines or dimension lines. The breaks appear and are centered
at the intersection points once the annotation or dimension is placed.

A Break Size option lets you control the size of the break gap.

Where do I find it?

Application Drafting
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Location in dialog
box

In the Drafting Preferences dialog box:

Common→Line/Arrow→Break node→Format group→Create Breaks
and Break Size

In the Settings dialog box:

Line/Arrow→Break node→Format group→Create Breaks and Break
Size

Jogs on linear dimensions

You can add or remove jogs on extension line while creating or editing linear dimensions. Interactive
on-screen handles and controls let you add, place, and size the jog for one extension line or for
both extension lines.

Preference and setting options are available to control the initial parameters of the jog.

Where do I find it?

Interactively add or remove jogs

Application Drafting and PMI

Graphics window

Double-click an existing dimension, or while creating a dimension, click the

Edit on-screen button to enter the dimension edit mode, and then click
the Extension Line access handle to display the on-screen controls.

Set the jog parameters

Application Drafting and PMI
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Location in dialog
box

In the Drafting Preferences dialog box:

Dimension→Jog node→Linear Format Side 1 group and Linear
Format Side 2 group

In the Settings dialog box:

Jog node→Linear Format Side 1 group and Linear Format Side
2 group

Foreshortening symbols

The following commands are available for adding and removing foreshortening symbols from leader
lines and dimension lines:

• Add Foreshortening Symbol lets you add a foreshortened symbol to leader lines and dimension
extension lines.

• Remove lets you remove a single foreshortening symbol.

• Remove all Foreshortening Symbols lets you remove all foreshortening symbols associated
with the dimension or annotation.
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The commands for adding and removing foreshortened symbols are on a shortcut menu which is
available while creating or editing annotations and dimensions. You display the shortcut menu by
right-clicking an Arrow Line access handle (1), a Dimension Line access handle (2), or a Leader
Line access handle (3).

Once the foreshortening symbol is created, you can use the drag handle to interactively reposition the
symbol or delete the symbol.

Use options in the Drafting Preferences dialog box and Settings dialog box to control the type,
width, height, and angle of the foreshortening symbol.

Where do I find it?

Add or remove foreshortening symbols

Application Drafting

Graphics window

Double-click an existing dimension, or while creating a dimension, click the

Edit on-screen button to enter the dimension edit mode, and then do
one of the following:

• Right-click the Extension Line, Arrow Line, or Leader Line access
handle→Add Foreshortening Symbol or Remove All Foreshortening
Symbols

• Right-click the drag handle of an existing foreshortening
symbol→Remove
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Foreshortening symbol options

Application Drafting

Location in dialog
box

In the Drafting Preferences dialog box:

Common→Line/Arrow→Foreshortening Symbol node→Format
group

In the Settings dialog box:

Line/Arrow→Foreshortening Symbol node→Format group

Adding segments to a composite Feature Control Frame

What is it?

You can use the new Add New Frame option in the Feature Control Frame dialog box to add
segments to a composite feature control frame.

Why should I use it?

When creating tolerance information for a feature, you may require multiple tolerance segments to
fully specify the location and definition of the feature.

Where do I find it?

Application Drafting and PMI

Command Finder Feature Control Frame

Prerequisite
In the Characteristics group, set the Frame Style option to Composite
Frame.
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Location in dialog
box Characteristics group→Add New Frame

Leader enhancements and feature control frame display enhancements

What is it?

Enhancements to leader lines and feature control frame functionality let you do the following:

• Use a new Lock Perpendicular shortcut menu option to lock a leader line so that it is always
perpendicular to its attachment object. This option is only available for leader lines with a Plain,
All Around, Without Stub, or All Over leader type.

• Hold the Shift key and drag to create a leader with an extension line. This gesture is only
available for annotation that has a single leader line with a Plain, All Around, Without Stub, or
All Over leader type.

Note

When an extension line is added to a leader for a feature control frame, you cannot add
additional leaders to the feature control frame.

• Add multiple leader lines to single and compound feature control frames with a datum leader.
Only Plain, All Around, and All Over leader types can be added.
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• Underline the text around a feature control frame. You can do the following:

o Underline only the first line of text around a feature control frame.

o Underline all of the text around a feature control frame.

• Control the vertical attachment point on a feature control frame for all leader types.

Why should I use it?

These enhancements let you create standards-compliant annotation and feature control frame
callouts.
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Where do I find it?

Lock Perpendicular option

Application Drafting and PMI

Prerequisite
Only one leader can be selected at a time, and the leader type must be set
to Plain, All Around, Without Stub, or All Over

Graphics window
After selecting the leader termination object, right-click→Lock
Perpendicular

Leader extension line

Application Drafting and PMI

Prerequisite
The annotation object must have only one leader and the leader type must
be set to Plain, All Around, Without Stub, or All Over

Graphics window Before placing the annotation, hold the Shift key and drag

Multiple leader lines

Application Drafting and PMI
Prerequisite Only one datum leader can exist for the feature control frame.
Graphics window Before placing a feature control frame, right-click→Add New Leader

Underline additional text

Application Drafting and PMI

Location in dialog
box

In the Drafting Preferences dialog box:

Annotation→GDT node→Feature Control Frame group→Underline
Additional Text

In the Settings dialog box:

GDT node→Feature Control Frame group→Underline Additional
Text

Vertical attachment point

Application Drafting and PMI

Command Finder Feature Control Frame
Location in dialog
box Leader group→Style group→Vertical Attachment
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Adding symbols and text to datum references

What is it?

You can now add text or symbols to a datum reference within a feature control frame.

This enhancement adds a Text group for text and symbols to the Compound Datum Reference
dialog box and an option for a Projected modifier to the Feature Control Frame and Compound
Datum Reference dialog boxes.

When a feature control frame is selected, any extended information for datum references is displayed
in the Details pane of the Part Navigator.

Related to the enhancement, the PMI search Feature Control Frame Search Details dialog box now
shows only one datum reference at a time when setting search criteria. In order to limit a PMI search
to feature control frames with references to two or more datums, you now create more than one
feature control frame detail entry and add it to the list of PMI search criteria. If a saved PMI search
model view in a legacy part contains feature control frame criteria with multiple datum reference fields
enabled, when you edit the view, NX converts the criteria to the new format.

Columns for the new datum reference extended text are added to the output of a PMI Report
command.

This extended qualifying information enhancement relates to the following standards sections:

• ASME Y14.5-2009

Datum Translation Symbol
Clarifying Applicable Maximum Material Boundary
Multiple Least Material Boundaries
Customized Datum Reference Frames

• ISO 5459:2011

Datum modifier symbols

Why should I use it?

You can indicate conditions for how the datum is applied.

Where do I find it?

Application Drafting and PMI

Command Finder Feature Control Frame
Location in dialog
box

Frame group→Primary Datum Reference, Secondary Datum Reference,
or Tertiary Datum Reference→Text group
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Movable datum targets, new terminator types

What is it?

A new Movable option lets you add a movable modifier to a datum target symbol.

Datum target symbol Datum target symbol
with a movable modifier

Additionally, you can now specify the following leader termination types for datum targets.

Arrow Only X Plus

The display of the movable modifier symbol is compliant with either the ASME or ISO drafting
standard. When a standard other than ASME or ISO is in use, the display conforms to the ISO drafting
standard. The orientation of the movable modifier may be adjusted when the ISO display is used.

Why should I use it?

Use this type of datum target when the form of the feature is such that an acceptable datum target
can be anywhere along a location range. For example, round parts such as cast and forged parts that
are fixtured using equalizing datums.

Where do I find it?

Application Drafting and PMI

Command Finder Datum Target
Location in dialog
box Target group→Movable option and Terminator list

Balloon enhancement

What is it?

The new Create Leader Attachment to Vertex option, when set, automatically attaches leader lines
without stubs to the vertex of a balloon symbol.

This option is available for the following balloon symbols:

Balloon Type Available Vertices
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Triangle Down, Triangle Up

Square, Divided Square

Hexagon, Divided Hexagon

The vertex nearest to the terminating point of the leader line, or nearest to the last jog in the leader
line, is used.

Note

By default, this option is set when the Drafting Standard for your current NX session is set
to ESKD.

Where do I find it?

Application Drafting
Prerequisite The leader type for the balloon symbol must be set to Without Stub.

Location in dialog
box

In the Drafting Preferences dialog box:

Annotation→Balloon node→Format group→Create Leader
Attachment to Vertex

In the Settings dialog box:

Balloon node→Format group→Create Leader Attachment to Vertex

Editing property tracking for inherited PMI

What is it?

Use the new Inherit PMI Tracking command to interactively change the status of tracked properties
of inherited PMI in drawings. Tracked properties are updated in the drawing view when changes are
made to the 3D PMI objects.

For example, from the Inherit PMI Tracking dialog box, you can enable the AnnotationLocation
option to keep track of the position changes for all PMI annotation inherited onto the drawing.

If changes to NX result in new PMI properties that are not currently on the property tracking list, you
can use the Update Tracking Properties option to add these new properties to the list.

Why should I use it?

Use this command to add tracked properties that are saved with the part file, or to modify the tracking
status of existing tracked properties of inherited PMI objects on a drawing.
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Where do I find it?

Change tracking status with the Inherit PMI Tracking command

Application Drafting

Menu Format→PMI→Inherit PMI Tracking

Add newly trackable properties with the Update Tracking Properties option

Application Drafting

Prerequisite
Open a part that does not include all tracking properties supported by the
current version of NX in its set of properties available for tracking.

Menu Format→PMI→Inherit PMI Tracking
Dialog box Version Up group→Update Tracking Properties

Inheriting PMI into a Drafting section view

What is it?

You can now use inherit PMI options to add PMI from a 3D model into a drafting section view.

You can add PMI to the following drafting section views:

Simple
Stepped
Half
Pictorial
Half Pictorial
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All other section views are not supported.

The inherit PMI options set for the parent view are applied when you create the section view.

Note

For existing drafting section views in parts created in earlier versions of NX, you must version
up the views before the inherit PMI options are available.

(Drafting Preferences dialog box→General/Setup→Workflow→Version Up group)

Why should I use it?

You can inherit PMI in a drafting section view instead of creating a PMI lightweight section view and
then adding that view to your drawing. This approach lets you take advantage of reusing existing
information and of bi-directionally editing your annotations.

Where do I find it?

Application Drafting

Graphics window

Right-click the border of an existing Drafting section view→Settings

→Common→PMI

API function for Drawing Booklets

What is it?

A new NX Open API, Drafting::DrawingAutomationWizard, lets you create and edit drawing booklets
in a batch mode. Using this routine in conjunction with a User Exit allows you to suspend starting
the booklet functionality until you reach a predefined time and place, or once you terminate the
current NX session.

The User Exit registers a callback via the
JA_DRAWING_AUTOMATION_WIZARD_set_continue_processing routine and, when the Finish
button is selected in the Drawing Booklet wizard, the callback is executed.

Note

This callback mechanism is only supported in managed mode.

An interruption routine (JA_DRAWING_AUTOMATION_WIZARD_set_continue_processing) is also
provided that lets you suspend the process before it is started. This interruption routine lets you
control whether or not booklet drawings will be created after control returns to NX from the callback. If
set to TRUE, the booklet will get created immediately. If set to FALSE, no drawings are created, and you
can use the data returned by the callback to subsequently create the drawings themselves.

Why should I use it?

Processing drawing booklets consumes computer memory. Interactively running the Drawing
Booklet wizard can consume your NX session and prevent you from interacting with and modifying
drawings that have already been processed. You can use this API to create a custom program that
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will run the Drawing Booklet functionality at a predefined time and location, or when you terminate
your NX session. This allows you to better manage your NX resources.

Multiple overlapping template regions

What is it?

Template regions are rectangular regions on a drawing template that allow the placement of only
certain types of drafting objects when the template is used to create a drawing. The following
enhancements to the Template Region command let you create more complex template regions.

• You can now define more than two overlapping regions in a drawing template.

Note

Overlapping regions must have their growth option set in the same or opposite direction if
you want the overflow to extend into the adjacent region.

• When the Continuation option to set to Next Region, any unlinked region of the same type, on
the current sheet or any other drawing sheet, can be specified as the continuation region.

• The Priority setting for a region is now displayed when you choose to display template region
information on the drawing sheet.

Why should I use it?

Use multiple overlapping template regions to create more complex drawing templates. Drawing
templates are used by the Drawing Booklet wizard to automate the generation of a multi-sheet
drawing.

Where do I find it?

Application Drafting

Prerequisite
You must be in a drawing template, which was created using the Mark as
Template command.
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Command Finder Template Region

Drawing booklet enhancement

What is it?

You can now create or edit drawing booklets with no primary content. These booklets contain empty
drawing sheets with no associated models.

• In native NX and in Teamcenter Integration, this will create an empty drawing with no references
to components.

• In 4GD, this will create an empty drawing with no references to subsets.

To create an empty drawing , use the Create Drawing Booklet wizard but do not select any objects
for the Primary Content option.

Why should I use it?

You can create empty drawings and then edit the drawings to customize the contents displayed
on the sheets. For example, some drawing sheets can show components, and other sheets can
contain related notes.

Where do I find it?

Application Any application except Drafting
Prerequisite You must be in an assembly file
Command Finder Create Drawing Booklet

Menu
Tools→Drawing Automation→Create Drawing Booklet or Edit Drawing
Booklet

Location in dialog
box Scope page→Primary Content group→Select Object

Specifying Item Type for custom symbols

What is it?

In a Teamcenter Integration environment, new options in the Define Custom Symbol dialog box and
the Define Symbol from Catalog dialog box let you specify an Item Type in addition to specifying
the name, revision, and number for the symbol. You can select the item type from a list of types that
are available in the database. This list is typically the same as the list you see when the Blank
template is selected in the File New dialog box.

Where do I find it?

Application Drafting and PMI
Prerequisite You must be in a Teamcenter Integration environment
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Command Finder

Define Custom Symbol

Define Symbol from Catalog
Location in dialog
box Symbol Name group→Item Type

Product and Manufacturing Information (PMI)

Adding segments to a composite Feature Control Frame

What is it?

You can use the new Add New Frame option in the Feature Control Frame dialog box to add
segments to a composite feature control frame.

Why should I use it?

When creating tolerance information for a feature, you may require multiple tolerance segments to
fully specify the location and definition of the feature.

Where do I find it?

Application Drafting and PMI

Command Finder Feature Control Frame

Prerequisite
In the Characteristics group, set the Frame Style option to Composite
Frame.
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Location in dialog
box Characteristics group→Add New Frame

Adding symbols and text to datum references

What is it?

You can now add text or symbols to a datum reference within a feature control frame.

This enhancement adds a Text group for text and symbols to the Compound Datum Reference
dialog box and an option for a Projected modifier to the Feature Control Frame and Compound
Datum Reference dialog boxes.

When a feature control frame is selected, any extended information for datum references is displayed
in the Details pane of the Part Navigator.

Related to the enhancement, the PMI search Feature Control Frame Search Details dialog box now
shows only one datum reference at a time when setting search criteria. In order to limit a PMI search
to feature control frames with references to two or more datums, you now create more than one
feature control frame detail entry and add it to the list of PMI search criteria. If a saved PMI search
model view in a legacy part contains feature control frame criteria with multiple datum reference fields
enabled, when you edit the view, NX converts the criteria to the new format.

Columns for the new datum reference extended text are added to the output of a PMI Report
command.

This extended qualifying information enhancement relates to the following standards sections:

• ASME Y14.5-2009

Datum Translation Symbol
Clarifying Applicable Maximum Material Boundary
Multiple Least Material Boundaries
Customized Datum Reference Frames

• ISO 5459:2011

Datum modifier symbols

Why should I use it?

You can indicate conditions for how the datum is applied.

Where do I find it?

Application Drafting and PMI

Command Finder Feature Control Frame
Location in dialog
box

Frame group→Primary Datum Reference, Secondary Datum Reference,
or Tertiary Datum Reference→Text group
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Leader enhancements and feature control frame display enhancements

What is it?

Enhancements to leader lines and feature control frame functionality let you do the following:

• Use a new Lock Perpendicular shortcut menu option to lock a leader line so that it is always
perpendicular to its attachment object. This option is only available for leader lines with a Plain,
All Around, Without Stub, or All Over leader type.

• Hold the Shift key and drag to create a leader with an extension line. This gesture is only
available for annotation that has a single leader line with a Plain, All Around, Without Stub, or
All Over leader type.

Note

When an extension line is added to a leader for a feature control frame, you cannot add
additional leaders to the feature control frame.

• Add multiple leader lines to single and compound feature control frames with a datum leader.
Only Plain, All Around, and All Over leader types can be added.
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• Underline the text around a feature control frame. You can do the following:

o Underline only the first line of text around a feature control frame.

o Underline all of the text around a feature control frame.

• Control the vertical attachment point on a feature control frame for all leader types.

Why should I use it?

These enhancements let you create standards-compliant annotation and feature control frame
callouts.
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Where do I find it?

Lock Perpendicular option

Application Drafting and PMI

Prerequisite
Only one leader can be selected at a time, and the leader type must be set
to Plain, All Around, Without Stub, or All Over

Graphics window
After selecting the leader termination object, right-click→Lock
Perpendicular

Leader extension line

Application Drafting and PMI

Prerequisite
The annotation object must have only one leader and the leader type must
be set to Plain, All Around, Without Stub, or All Over

Graphics window Before placing the annotation, hold the Shift key and drag

Multiple leader lines

Application Drafting and PMI
Prerequisite Only one datum leader can exist for the feature control frame.
Graphics window Before placing a feature control frame, right-click→Add New Leader

Underline additional text

Application Drafting and PMI

Location in dialog
box

In the Drafting Preferences dialog box:

Annotation→GDT node→Feature Control Frame group→Underline
Additional Text

In the Settings dialog box:

GDT node→Feature Control Frame group→Underline Additional
Text

Vertical attachment point

Application Drafting and PMI

Command Finder Feature Control Frame
Location in dialog
box Leader group→Style group→Vertical Attachment
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Enable Resize preference

What is it?

Use the new Enable Resize PMI preference to control whether or not the display size of PMI objects
can change depending on the view scale.

When the Enable Resize preference is turned on, the following are available:

• Resize on Create (PMI preference)

• Resize on View Save (PMI preference)

• Resize PMI command

Why should I use it?

You can control availability of PMI object resizing methods.

Where do I find it?

Application PMI
Command Finder PMI Preferences
Location in dialog
box Display tab→Resize Options group→Enable Resize

Single-sided dimensions

The Display as Single Sided Dimension option lets you create and edit linear and angular
dimensions with only a single leader line. Use single-sided linear or angular dimensions for geometry
that is larger than the size of the drawing view or sheet, or where the measurement origin is
associated to geometry that is not visible. While creating or editing a single-sided dimension, you can

use the Flip Dimension Side button to switch between dimension lines.

Note

Chain dimension sets and narrow dimensions are not supported. Also, you cannot create
single-sided dimensions using the Rapid dimension command.

When you are in edit mode. Access handles are available to indicate which extension line and
arrow to retain. The access handle can also be used to set the length of the remaining, stunted
arrow line. Alternately, you can also set the length of the remaining line using the Length option
in the Settings dialog box.
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Example of a linear single–sided
dimension Example of an angular single–sided dimension

Where do I find it?

Set the single sided option

Application Drafting and PMI

Graphics window

Right-click while creating a dimension→Settings

Double-click an existing dimension→Settings
Location in dialog
box Single Sided node→Display as Single Sided Dimension

Flip Dimension Side button

Application Drafting, PMI

Graphics window

While in edit mode, click the Arrow Line access handle, and then turn the

Flip Dimension Side on-screen button on or off.

Right-click while creating a dimension→Settings

Double-click an existing dimension→Settings
Location in dialog
box Single Sided node→Flip Dimension Side

Set the length of the remaining arrow line

Application Drafting, PMI
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Graphics window

While in the edit mode, click and drag the Arrow Line access handle

Right-click while creating a dimension→Settings

Double-click an existing dimension→Settings
Location in dialog
box Single Sided node→Length

Linear dimension measurement types

What is it?

A new Measurement Type option in the Linear Dimension dialog box lets you specify a linear
dimension as a general dimension, a directed dimension, or a feature of size dimension. The
dimension type determines how the feature is measured and how the tolerance is applied to the
measurement. This additional information is saved with the dimension object when it is created.

• A General dimension is a simple dimension with no additional, implied information about the
measurement.

• A Directed dimension specifies the direction in which a feature is measured from an implied
datum. All of the tolerance is applied to the second object.

• A Feature of Size dimension is a measurement about an implied datum halfway between the two
measured features. The tolerance is equally disposed about the two measured features.
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When the Measurement Type is set to Directed, you can select multiple objects for the origin object
and the measured object. When it is set to Feature of Size, you can select multiple objects for
the first object and the second object

Note

To make the Measurement Type option available in the Linear dimension dialog box, you
must first set the Enable Directed Dimensions option in the Drafting Preferences dialog
box. This option is not available in the Settings dialog box, so you cannot set it while creating
or editing a linear dimension

Hole callouts, cylindrical dimensions, chain dimensions, and baseline dimensions are not supported
as directed or feature of size dimensions.

Why should I use it?

Use the new measurement types to capture additional design information when dimensioning the
features on your model. In particular, the information captured for PMI dimensions can be used in
downstream applications such as tolerance analysis and inspection applications.

Where do I find it?

Measurement Type option

Application Drafting, PMI
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Prerequisite
The Enable Directed Dimensions option in the Drafting Preferences
dialog box must be set.

Command Finder Linear
Location in dialog
box References group→Measurement Type

Enable Directed Dimensions option

Application Drafting, PMI

Command Finder Drafting Preferences
Location in dialog
box Dimensions→Workflow node→Enable Directed Dimensions

Jogs on linear dimensions

You can add or remove jogs on extension line while creating or editing linear dimensions. Interactive
on-screen handles and controls let you add, place, and size the jog for one extension line or for
both extension lines.

Preference and setting options are available to control the initial parameters of the jog.

Where do I find it?

Interactively add or remove jogs

Application Drafting and PMI

Graphics window

Double-click an existing dimension, or while creating a dimension, click the

Edit on-screen button to enter the dimension edit mode, and then click
the Extension Line access handle to display the on-screen controls.

3-118 What's new in NX

Chapter 3: CAD



CAD

Set the jog parameters

Application Drafting and PMI

Location in dialog
box

In the Drafting Preferences dialog box:

Dimension→Jog node→Linear Format Side 1 group and Linear
Format Side 2 group

In the Settings dialog box:

Jog node→Linear Format Side 1 group and Linear Format Side
2 group

Movable datum targets, new terminator types

What is it?

A new Movable option lets you add a movable modifier to a datum target symbol.

Datum target symbol Datum target symbol
with a movable modifier

Additionally, you can now specify the following leader termination types for datum targets.

Arrow Only X Plus

The display of the movable modifier symbol is compliant with either the ASME or ISO drafting
standard. When a standard other than ASME or ISO is in use, the display conforms to the ISO drafting
standard. The orientation of the movable modifier may be adjusted when the ISO display is used.

Why should I use it?

Use this type of datum target when the form of the feature is such that an acceptable datum target
can be anywhere along a location range. For example, round parts such as cast and forged parts that
are fixtured using equalizing datums.

Where do I find it?

Application Drafting and PMI

Command Finder Datum Target
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Location in dialog
box Target group→Movable option and Terminator list

Specifying Item Type for custom symbols

What is it?

In a Teamcenter Integration environment, new options in the Define Custom Symbol dialog box and
the Define Symbol from Catalog dialog box let you specify an Item Type in addition to specifying
the name, revision, and number for the symbol. You can select the item type from a list of types that
are available in the database. This list is typically the same as the list you see when the Blank
template is selected in the File New dialog box.

Where do I find it?

Application Drafting and PMI
Prerequisite You must be in a Teamcenter Integration environment

Command Finder Define Custom Symbol
Location in dialog
box Symbol Name group→Item Type

Inheriting PMI into a Drafting section view

What is it?

You can now use inherit PMI options to add PMI from a 3D model into a drafting section view.

You can add PMI to the following drafting section views:
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Simple
Stepped
Half
Pictorial
Half Pictorial

All other section views are not supported.

The inherit PMI options set for the parent view are applied when you create the section view.

Note

For existing drafting section views in parts created in earlier versions of NX, you must version
up the views before the inherit PMI options are available.

(Drafting Preferences dialog box→General/Setup→Workflow→Version Up group)

Why should I use it?

You can inherit PMI in a drafting section view instead of creating a PMI lightweight section view and
then adding that view to your drawing. This approach lets you take advantage of reusing existing
information and of bi-directionally editing your annotations.

Where do I find it?

Application Drafting

Graphics window

Right-click the border of an existing Drafting section view→Settings

→Common→PMI

Editing property tracking for inherited PMI

What is it?

Use the new Inherit PMI Tracking command to interactively change the status of tracked properties
of inherited PMI in drawings. Tracked properties are updated in the drawing view when changes are
made to the 3D PMI objects.

For example, from the Inherit PMI Tracking dialog box, you can enable the AnnotationLocation
option to keep track of the position changes for all PMI annotation inherited onto the drawing.

If changes to NX result in new PMI properties that are not currently on the property tracking list, you
can use the Update Tracking Properties option to add these new properties to the list.

Why should I use it?

Use this command to add tracked properties that are saved with the part file, or to modify the tracking
status of existing tracked properties of inherited PMI objects on a drawing.

Where do I find it?

Change tracking status with the Inherit PMI Tracking command

Application Drafting
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Menu Format→PMI→Inherit PMI Tracking

Add newly trackable properties with the Update Tracking Properties option

Application Drafting

Prerequisite
Open a part that does not include all tracking properties supported by the
current version of NX in its set of properties available for tracking.

Menu Format→PMI→Inherit PMI Tracking
Dialog box Version Up group→Update Tracking Properties

Information on leader termination points

What is it?

For PMI and Drafting annotation and custom symbols, the XYZ coordinates of leader and extension
line terminators that terminate on geometry are now displayed when object information is requested
for the selected objects. The coordinate information is displayed as Termination Point data. For
example:

Layer 1
Type PMI Linear Dimension

Extension Line 1
Color 186 (Red)
Font Solid
Density Thin
Termination Point XC = 14.900000000 X = 14.900000000

YC = 0.000000000 Y = 0.000000000
ZC = 13.000000000 Z = 13.000000000

Reporting of terminator coordinates is subject to the following constraints:

• If the object does not have any leaders, no information is output.

• Information is output for each leader line or extension line of the object that is used and which
terminates on geometry or supplemental geometry. No leader termination information is output
for leaders that terminate on other PMI or annotation.

• Since the objective is to report the coordinates of the terminator geometry, the point reported
does not take into account any gaps between the end of the extension line and the geometry.

Why should I use it?

You may want to use information regarding where the leaders or extension lines connect to geometry
in downstream processes.

Where do I find it?

Application Gateway and Drafting
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Prerequisite

The model or drawing must contain PMI or Drafting annotation or custom
symbols, or Feature or Sketch dimensions displayed as PMI, that have
leaders or extension lines terminating on geometry.

Report window
Create an information report on the above objects using the Object
Information command and then search for Termination Point.

Creating PMI objects from a JT file

What is it?

When you open a JT file in NX, you can create real PMI objects from data in the file. Types of PMI
that can be created as real NX PMI from a JT file include all the following:

PMI object type PMI object subtype
Annotation Note
Balloon *
PMI Centerline *
PMI Centermark *
Coordinate Note *
Datum Feature Symbol
Datum Target

Dimension

Angular
Arc Length *
Chamfer *
Diametral
Folded Radius *
Limits & Fits *
Linear
Radial

Feature Control Frame
Line Weld *
Model Views

Part – Native
Part – Managed
Assembly – Native
Assembly – Managed

Surface Finish

* Added in NX 10

Note

To create real PMI objects from the JT file, the Create Real PMI Symbols from JT Files
customer default must be set.
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Why should I use it?

Creating real NX PMI objects from a JT file simplifies authoring and allows the data to be used in
downstream applications that consume PMI.

Where do I find it?

Application Gateway

Command Finder Customer Defaults
Location in dialog
box PMI→Create Real PMI Symbols from JT Files

Data Reuse

Favorites and Ribbon Bar in the Reuse Library

What is it?

A new Favorites node is added to the Reuse Library Navigator. It contains two folder nodes where
you can store recent searches and saved searches if the Index search is on. The Saved Search
node is shown only when the Index search is off.

When you perform an Index search in the Reuse Library, the search result is displayed, and the
search criteria is saved in the Recent Search node automatically. The node will remember the
previous 30 entries. If you want to save the search criteria permanently, you can save a recent search
in the Saved Search node, and specify a custom name and image to represent it.

It is not necessary to have the Index Search Server in order to add objects to and use objects
from the Saved Search node

You can add saved searches and objects to either a Ribbon Tab or a Border Bar. The search
result will be shown for the search.

Why should I use it?

You can create reuse library searches based on multiple criteria, and save them for future use.
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Where do I find it?

Resource bar Reuse Library

Teamcenter library integration

What is it?

You can now use the Reuse Library Management command to access the Teamcenter library
hierarchy. You can browse and search for library elements and publish them to the Teamcenter
library. The Teamcenter library lets you create different library content based on design context.

Why should I use it?

The Teamcenter library integration with NX lets you utilize Teamcenter library features within NX.

Where do I find it?

Prerequisite You must be in a Teamcenter environment.

Command Finder Reuse Library Management

What's new in NX 3-125

CAD



Chapter 3: CAD

Menu Tools→Reuse Library→Reuse Library Management

Reuse library configuration enhancements

What is it?

There are several enhancements to configuration methods in the Reuse Library:

• The number of objects in a classification reuse library is automatically updated when objects
are added to a node.

• Classification attributes are displayed in the Member Select panel. You can configure the column
display for each Classification class when using Table View mode.

• You can now set the Teamcenter revision rule in the reuse library navigator. The items in the
library are loaded using the Teamcenter revision rule you select.
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• There are new Customer Default options in Teamcenter Integration for reusable component part
copy methods, part naming methods, and inferred constraints:

• You can filter the reuse library by application with the Reuse Library Management command.

You can use the Exclusive option to assign a library node to be shown only in the specific
application that you choose.

• You can now save your reuse library configuration in a .krx file using the Export configuration
file command.
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• You can choose to replace or append the current configuration list by selecting Overwrite the
current list when loading configuration in the Settings group.

• You can now set the view mode in the reuse library Member Select Panel for classification
nodes. If you set the view mode to View Classification Object, the reuse library browser does
not retrieve the associated Teamcenter objects, and the search performance is improved.

If you set the view mode to View Classified Object, the reuse library determines the classified
object type, and displays the preview image.

• Teamcenter multifield key functionality (MFK) is now supported by NX and the reuse library
functionality also supports MFK.

Where do I find it?

Prerequisite You must be in a Teamcenter environment.

Resource bar Reuse Library

Teamcenter classification reuse library enhancements

What is it?

You can now search the Teamcenter Classification library for objects based on the following types of
attributes:

• Key LOV
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• String

• Integer

• Real

• Date

You can specify attribute values when you search for existing objects or when you assign new values
to objects using the Edit Classified Part command. The following image shows an example of the
types of attribute values that you can save or edit for a classification object.

The input values for the attributes are validated according to the attribute type.

Where do I find it?

Prerequisite You must be in a Teamcenter environment.

Resource bar Reuse Library

Fastener assembly configuration library

What is it?

You can now use the Fastener Assembly Configuration Library reuse library. This new default
library is configured with the FastenerAssemblyConfiguration.krx file.

You manage fastener assemblies in the Fastener Assembly Configuration Library with the
Configure Fastener Assembly command. You can create, delete, and edit fastener assemblies,
and assign unique icons to the assemblies that appear in the reuse library Member Select panel.

Why should I use it?

You can search for fastener assemblies in the Fastener Assembly Configuration Library and
drag them to your part.

Where do I find it?

Command Finder Configure Fastener Assembly
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Resource bar Reuse Library

Index search from Reuse Navigator

What is it?

If a reuse library contains index data, you can use the Build by Index Data command to create
the reuse library tree from index data.

A new SOLR installation tool named Siemens PLM Documentation Server is used to set up the
index search.

Why should I use it?

You can increase the performance of browsing if you create a reuse navigator index for a library.
Values for part attributes or part expressions can be shown in the reuse library Member Select
panel if the values are indexed.

The new installation tool can be used to set up index search server.

Where do I find it?

Command Finder Build by Index Data

Preferred Data

What is it?

You can include a column named Preferred in a spreadsheet for a reusable component. You can
assign values in the Preferred column to specify which reusable components have first preference.

If the Preferred column exists in the spreadsheet, a Preferred Data list is displayed in the Reuse
Paste or Add Reusable Component dialog box.
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When you specify a Preferred reusable component, only the data series that matches the preferred
value will be shown in the dialog for you to choose.

Why should I use it?

You can control the number of reusable objects and reusable components to choose from if you filter
them to show only those with preferred attributes.

Where do I find it?

Location in dialog
box Reuse Paste, Add Reusable Component

Product Template Studio user interface enhancement

What is it?

You can now author and edit Product Template Studio templates in NX using the PTS Author
application. When you launch the application, the following dialog boxes open and the PTS Explorer

displays in the Resource Bar.

In the PTS Explorer you can right-click objects from the folders to add them to the template.
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In the Product Template Studio dialog box, on the Interface tab you can modify the Properties of
the objects that you add to the template.
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Where do I find it?

Application PTS Author
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Ship Structure

Copy Basic Design Objects

What is it?

Use the Copy Basic Design Objects command to copy basic design objects such as plate systems,
pillar systems, stiffener systems, standard part brackets, cutouts, and seams.

You can:

• Copy a plate system or a pillar system to another location.

• Copy the following types of features attached to a plate system to another plate system:

o Stiffener systems
o Edge reinforcement systems
o Standard part brackets
o Cutouts
o Extrude features
o Seams

Why should I use it?

This command saves time by letting you quickly copy repetitive structures to different locations in
a basic design.

Where do I find it?

Application Ship Structure Basic Design

Command Finder Copy Basic Design Objects
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Mirror Ship Structure

What is it?

Use the Mirror Ship Structure command to mirror detailed design elements or components through
a plane. The resulting features in the mirrored design elements or components are not associated to
the source features and you can edit them independently.

You can:

• Mirror the following types of features:

o Plate
o Stiffener
o Edge Reinforcement
o Pillar
o Standard part brackets and collar plates
o Cutout
o Corner Cut
o Edge Cut
o Along Guide Cut
o Plate Chamfer
o Extrude
o End Cut
o Profile Cutout

• Specify a mirror plane or use the default longitudinal vertical center plane of the ship.

• Generate a report in an XML file that lists which parts were successfully mirrored, which parts
failed, the duration of the operation, and other detailed information.
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Why should I use it?

You can save a lot of time by quickly copying repetitive, symmetrical structures in a ship. This
command is more flexible than the existing Mirror Feature and Mirror Assembly commands
because you edit and update the mirrored geometry as if it was created separately.

Where do I find it?

Application Ship Structure Detail Design

Prerequisite

A ship container part must be identified in the displayed part. If a ship
container part is not defined, the Ship Container Part dialog box is
displayed automatically when you use this command.

Command Finder Mirror Ship Structure

Edge reinforcement and stiffener enhancements

What is it?

The Stiffener/Edge Reinforcement and Edge Reinforcement System commands are enhanced so
that you can extend or trim the edge reinforcement (1) or the reinforced plate (2) to produce a neat
trim. This supports the automatic creation of weld joints.

The Stiffener/Edge Reinforcement command also includes additional enhancements so that you
can:

• Create closed loop edge reinforcements. You can then use the Split Ship Structure command
to define the ends of the edge reinforcements so they can be manufactured.
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• Use the same On Edge and On Face placement types that are available with the Edge
Reinforcement System command. This replaces the existing offset value option.

Why should I use it?

The enhancements let you create structures that support downstream operations such as welding
and manufacturing and they provide consistency between commands in Ship Structure Basic Design
and Ship Structure Detail Design applications.

Where do I find it?

Application Ship Structure Basic Design

Command Finder Edge Reinforcement System

Application Ship Structure Detail Design

Command Finder Stiffener/Edge Reinforcement

Paint Parameters enhancements

What is it?

The Paint Parameters command is enhanced so that you can copy parameters from standard
parts and additional types of features.

You can select the following types of features in the Ship Structure Basic Design application:

• Profile Cutout
• Cutout
• Standard Part (brackets and collar plates)

You can select the following type of feature in the Ship Structure Manufacturing application:

• Excess Material

You can select additional types of objects in the Ship Structure Detail Design application:

• Profile Cutout features
• Cutout features
• Plate Chamfer features
• Along Guide Cut features
• Standard Part (bracket and collar plate components or design elements)

Why should I use it?

You can save time by applying the same parameters to multiple features at once.
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Where do I find it?

Application
Ship Structure Basic Design, Ship Structure Detail Design, and Ship
Structure Manufacturing

Command Finder Paint Parameters

Prevent circular dependencies in a basic design

What is it?

The commands in the Ship Structure Basic Design application are enhanced to prevent circular
dependencies. In previous versions, when you defined boundaries and seams to establish
relationships between plate systems, a circular dependency could produce the following error
message:

There is an object which depends on itself.

Why should I use it?

You no longer have to create duplicate plate systems to work around circular dependencies.

Where do I find it?

Application Ship Structure Basic Design

Command Finder

The enhancements do not change any command dialog boxes. They affect
the processing that occurs in the background when you use a command that
creates or updates plate systems.

Ship Structure performance enhancements

What is it?

The following enhancements are implemented to improve performance when you use the Ship
Structure Basic Design and Ship Structure Detail Design applications:

• Unnecessary interpart updates are eliminated. For example, when you add a corner cut to a
plate, the stiffeners that are placed on the plate no longer update.
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• Standard Part enhancements:

o In the Ship Structure Basic Design application, the Standard Part dialog box includes a Type
option to let you adopt an existing curve. This improves performance because the necessary
parameters and attributes are assigned to simple curves and the standard part templates
do not have to be loaded. The detailed standard part is generated when you transition the
basic design to the detailed design.

o The Standard Part reference set is removed from the standard part template. Using the
existing Model reference set improves performance when you design in context, generate a
drawing, and search by volume.

o The standard part templates and parameters are simplified.

o The option to create standard parts across plates with multiple thicknesses is disabled by
default.

• Enhancements specific to the Ship Structure Basic Design application:

o When you create a plate system, a solid body is no longer generated since it is not referenced
by other structures.

o A Mounting Method option is added to the Stiffener System dialog box and the setting is
saved so that it can be used when you transition parts to the detailed design.

o The time it takes to display the Stiffener System dialog box is reduced.

• Transition Parts enhancements:

o The automatic update of the detailed design is eliminated when you edit a feature in the
basic design. The links from the basic design to the detail design are isolated so the update
only occurs when you transition the parts.

o Updates are minimized when you transition parts to the detailed design using the Update
Existing option.

• Stiffener/Edge Reinforcement enhancements:

o Updates that occur when you access the Stiffener/Edge Reinforcement dialog box are
eliminated.

o The time it takes to create hull stiffeners using the Normal to Surface orientation method is
reduced.

• Redundant updates are reduced when you access spreadsheet-driven steel features.

• Unnecessary updates are eliminated when you fully load parts.

• Performance is improved in the Teamcenter Integration for NX interface.

Why should I use it?

The enhancements reduce the time it takes to create and update ship structures.

What's new in NX 3-139

CAD



Chapter 3: CAD

Where do I find it?

Application Ship Structure Basic Design and Ship Structure Detail Design

Command Finder
The enhancements affect various commands that you can use to access,
create, edit, or update ship structure features and parts.

Weight and Center of Gravity

What is it?

Use theWeight and Center of Gravity command to calculate weight and center of gravity information
for each subsystem in selected ship structure systems or volumes in a basic design.

The results are reported in a spreadsheet that you can easily use to perform other calculations. In this
example, a transverse bulkhead part is selected and portions of the resulting spreadsheet are shown.

Weight and Center of Gravity Report
Selection
Type: Frame

Part System SubSystem Weight(Kilograms) Center of Gravity(mm,mm,mm)

TBH00007/A 79521.702 (87989.916,1.014,11561.951)

StiffenerSystem(21) 707.534 (87799.382,19.478,11475.195)

Subsystem_1 411.122 (87776.542,19.164,6825.000)

Subsystem_2 296.412 (87831.061,19.915,17925.000)

StiffenerSystem(33) 703.573 (87799.203,5980.524,11405.981)

Subsystem_1 411.122 (87776.541,5980.836,6825.000)

Subsystem_2 292.451 (87831.060,5980.085,17845.833)

TransverseBulkhead(3) 73178.038 (88006.443,0.906,11573.512)

Subsystem_1 34684.448 (88006.000,0.000,17750.111)

Subsystem_2 4179.618 (88006.000,13742.666,6322.555)

Subsystem_3 1082.421 (88006.000,7884.968,1017.651)
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Why should I use it?

This command lets you quickly determine the weight and center of gravity of individual systems and
subsystems without having to manually modify or extract geometry.

Where do I find it?

Application Ship Structure Basic Design

Command Finder Weight and Center of Gravity

Material Estimation

What is it?

Use the Material Estimation command to estimate the material requirements for selected ship
structure systems or volumes in a basic design.

The results are reported in a spreadsheet and include the surface area of required plate stock and
length of the required profile stock. In this example, a transverse bulkhead frame part is selected.

Material Estimation
Report

System Type: Material Grade Thickness(mm) Surface Area(Square
Meter)

Plate

Steel A H24 12 614.595

Steel A H24 18 60.333

Steel A H24 14 63.195

Section Type Size Material Grade Length(Meter)

Stiffener

AG AG-350X100X11/17 Steel A H24 86.85

AG AG-250X90X8/14 Steel A H24 105.683

Why should I use it?

This command lets you quickly determine the amount of material required for systems and use
the results to perform additional calculations.

Where do I find it?

Application Ship Structure Basic Design

Command Finder Material Estimation
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Unfolded Minimum Rectangle

What is it?

Use the Unfolded Minimum Rectangle command to calculate the minimum dimensions of a
rectangle that will fit each selected plate subsystem or standard part in the basic design.

The results are reported in a spreadsheet. In this example, three subsystems in a transverse
bulkhead and two subsystems in a hull are selected.

Unfolded Minimum Rectangle Report

Part System SubSystem Rectangle(Meter X Meter)

TBH000016/A

TransverseBulkhead(6)

Subsystem_6 5.982X2.006

Subsystem_7 4.988X4.216

Subsystem_8 7.213X4.166

Hull000001/A

Hull(29)

Subsystem_90 14.054X4.41

Subsystem_91 14.044X3.046

Why should I use it?

This command helps you determine if the unfolded plates will fit on available plate stock and evaluate
the locations of straking seams.

Where do I find it?

Application Ship Structure Basic Design

Command Finder Unfolded Minimum Rectangle
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Edit Context Attributes

What is it?

Use the Edit Context Attributes command to modify the attribute assigned to systems, subsystems,
and standard parts in the basic design that defines their purpose in the ship. This attribute is inherited
by the detailed parts when the basic design is transitioned to the detailed design.

For example, if a stiffener system contributes to the longitudinal strength of the ship, you can change
the value of its context attribute to Longitudinal Strength. After the stiffener system is transitioned
to the detailed design, the resulting stiffeners can be identified so that you can apply appropriate
names, welds, and inspection requirements.

The title of the context attribute is SAW_SUB_NAME. You can define the allowed values in an XML
file located at %NXSHIP_DIR%\data\NX_ShipAttribute.xml. When you edit the context attribute, you
can select one of the values from a list in the dialog box.

For example, the default list for a stiffener system includes:

• Default Stiffener System
• Longitudinal
• Transverse
• Vertical
• Foundation
• Header

Why should I use it?

Use context attributes to apply ship characteristics to systems, subsystems, and standard parts early
in the design process so that they can be used in downstream rules to name detailed parts, add end
cuts, add profile cutouts, create collar plates, or create welds.

Where do I find it?

Application Ship Structure Basic Design

Command Finder Edit Context Attributes

Edit Stock enhancements

What is it?

The Edit Stock command is enhanced so that you can change the Tightness parameter for non-split
plate systems and subsystems.

Why should I use it?

You can apply a unique tightness parameter to selected subsystems within a basic design without
having to change the work part and edit features individually.
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Where do I find it?

Application Ship Structure Basic Design

Command Finder Edit Stock

Location in dialog
box

Plate System Stock group→Tightness

Profile System Stock group→Tightness

Pinjig

What is it?

Use the Pinjig command to position plates relative to the shop floor and generate pin jig setup
data for manufacturing.

You can:

• Define a grid of vertical adjustment pins including the number and spacing in the X and Y
directions, minimum and maximum heights, and weld clearance. You can define default pin jigs
and parameters in a spreadsheet.

• Select a set of connected plates to place on the pin jig. You also have the option to select
additional ship structures attached to plates.

• Define the position and orientation of the plates on the pin jig. You have the option to select an
edge from the selected plates to specify the default X direction of the pin jig.

• Display two pin jig reference lines that are shown on the pin grid and are marked on the selected
plates. These lines are used to position the plates on the pins.

• Display a table containing the list of pins that touch the plates and their heights.
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• Create Product and Manufacturing Information (PMI) notes to show the distances from the
corners of the plates to the closest pins.

Why should I use it?

A pin jig is a common work center used in a shipyard to support plates for welding. This command
lets you easily position the plates and define the setup data for the grid of vertical adjustment pins.

Where do I find it?

Application Ship Structure Manufacturing

Prerequisite

A ship container part must be identified in the displayed part. If a ship
container part is not defined, the Ship Container Part dialog box is
displayed automatically when you use this command.

Use the Cutting Side Face command to specify the cutting sides of the
plates.

Command Finder Pinjig

Plate Template enhancements

What is it?

The Template command is renamed to Plate Template and includes several enhancements.

You can:

• Create alignment marks, ship direction marks, base lines, sight lines, and template location
marks on the plate.

• Define the maximum height value for the templates. You can also create a table of height values
for the resulting templates.
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• Create parts, XML output files, drawing views, and offsets for each template.

The dialog box includes the following changes:

• The Type group is removed. A manual type is assumed if you define a base coordinate system.

• The Existing group is renamed to Base. You can define a base coordinate system to align
the X and Y templates in the set.

• The Location group is renamed to Locations and the names of the options are more descriptive.
You can select existing planes or define evenly spaced planes for the X and Y template locations.

• The End Offsets group is renamed to Extensions and the names of the options are more
descriptive. You can extend the start and end of the X and Y templates beyond the edges of
the plate.

Why should I use it?

These enhancements provide new options and simplify existing options to help you identify and mark
sets of templates that match the contour of a formed plate.

Where do I find it?

Application Ship Structure Manufacturing

Prerequisite

A ship container part must be identified in the displayed part. If a ship
container part is not defined, the Ship Container Part dialog box is
displayed automatically when you use this command.

Command Finder Plate Template

Specifying default attributes and parameters for templates and marking lines.

Command Finder Customer Defaults
Location in dialog
box Ship Design→Manufacturing→Plate Template tab
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Section Drawing

What is it?

Use the Section Drawing command to create deck and bulkhead drawings that typically include
the following objects:

• A deck or bulkhead composed of multiple plates.
• Stiffeners that are attached to or pass through the deck or bulkhead.
• Edge reinforcements around openings or other free edges.
• Plates that are bounded by or penetrate the deck or bulkhead.

To reduce the complexity of the drawings, the objects are displayed as symbolic representations that
conform to shipbuilding conventions.

You can:

• Select existing frames or specify new planes to define section views.

• Create a single non-master drawing file for all section views or a separate non-master drawing
file for each section view. If the displayed part is a non-master drawing file and Sections per
Drawing is set to Multiple, a new sheet is added to the existing non-master drawing file.

• Select Use Booklets in the Ship Drafting customer defaults to create non-master drawing
files as booklets containing worksets.

• Specify a distance value for the Included Part Proximity option under Ship Section in the
customer defaults to automatically determine which objects are hidden in the section view. When
you create the drawings, you can also manually select additional objects within the proximity
range to hide or select objects outside of the proximity range to include in the section views.

• Specify a different color, font, and width for each type of ship structure.

o The initial default values are defined in an XML file located at
%NXSHIP_DIR%\data\NX_ShipAttribute.xml. This file is also used to assign the classification
type and subtype to ship structures using the SAW_NAME and SAW_SUB_NAME attributes.
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o You can change the default color, font, and width for each type of ship structure from the Ship
Drafting→View→Ship Structure Lines node in the Drafting Preferences dialog box.

o You can edit the color, font, and width of ship structures in existing section views from the
View→Ship Structure Lines node in the Settings dialog box.

o You can use custom line fonts specified in the font definition file at
%NXSHIP_DIR%\shipdrafting\symbol\ShipLineFontSettings.fdf. By default, this
file includes a new RAILWAY font that is available in the Ship Structure applications.

Why should I use it?

Create drawings for multiple decks and bulkheads that are simplified and easier to annotate.

Where do I find it?

Application Ship Structure Detail Design

Command Finder Section Drawing

Settings to use booklets and define the part proximity

Command Finder Customer Defaults

Location in dialog
box

Ship Drafting→General

Ship Drafting→Ship Section

Color, font, and width preferences

Application Drafting

Command Finder Drafting Preferences
Location in dialog
box Ship Drafting→View→Ship Structure Lines node

Expansion Drawing

What is it?

Use the Expansion Drawing command to create drawings representing non-planar objects, such as
hull plates and stiffener landing curves, which are mapped to a view plane. These drawings can also
include other planar objects that are not parallel to the view plane.
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You can:

• Select multiple connected plates.

• Specify a base plane and optional upper, fore, and aft limit planes.

• Create a new non-master drawing file and drawing sheet for the expansion view. If the displayed
part is a non-master drawing file, a new sheet is added to the existing non-master drawing file.

• Specify a different color, font, and width for each type of ship structure.

o The initial default values are defined in an XML file located at
%NXSHIP_DIR%\data\NX_ShipAttribute.xml. This file is also used to assign the classification
type and subtype to ship structures using the SAW_NAME and SAW_SUB_NAME attributes.

o You can change the default color, font, and width for each type of ship structure from the Ship
Drafting→View→Ship Structure Lines node in the Drafting Preferences dialog box.

o You can edit the color, font, and width of ship structures in existing views from the View→Ship
Structure Lines node in the Settings dialog box.
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o You can use custom line fonts specified in the font definition file at
%NXSHIP_DIR%\shipdrafting\symbol\ShipLineFontSettings.fdf. By default, this
file includes a RAILWAY font that is only available in the Ship Structure applications.

This command is similar to the existing Shell Expansion command but it lets you create a drawing
using a drawing template.

Why should I use it?

Create drawings for non-planar ship structures that are simplified and easy to annotate.

Where do I find it?

Application Ship Structure Detail Design

Prerequisite

A ship container part must be identified in the displayed part. If a ship
container part is not defined, the Ship Container Part dialog box is
displayed automatically when you use this command.

Command Finder Expansion Drawing

Color, font, and width preferences

Application Drafting

Command Finder Drafting Preferences
Location in dialog
box Ship Drafting→View→Ship Structure Lines node

Annotate Ship Drawing

What is it?

Use the Annotate Ship Drawing command to add symbols and annotation to ship drawing views.
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The symbols are defined in the Reuse Library and configured using a spreadsheet specified in
the customer defaults. NX provides a set of example symbols and a configuration file located at
%NXSHIP_DIR%\shipdrafting\symbol\drawing_annotation_symbols.xlsx. The example symbols
include:

• Plate and stiffener identifiers
• Scantling text
• Boundary seam symbols
• Plate continuity symbols
• Stiffener identifiers
• Stiffener section symbols
• Opening fill lines
• Thickness direction symbols
• End cut symbols

Why should I use it?

Automatically create symbols and other annotation that are unique to ship structures.
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Where do I find it?

Application Drafting

Prerequisite
Create drawings of ship structures using the Section Drawing and
Expansion Drawing commands.

Command Finder Annotate Ship Drawing

Specifying the location of the drawing annotation symbol configuration file.

Command Finder Customer Defaults
Location in dialog
box Ship Drafting→Annotation→Symbol tab

Routing

Stock enhancements

Stock representation

Part Navigator representation

The following are now represented in the Part Navigator with distinct icons and labels.

Model History
Stock (31)
Space Reservation (32)
Stock Transition (33)
Fitting Overstock (34)
Overstock Definition (51)
Overstock Definition (52)

Overstock (52)
Overstock (52)
Overstock (52)

• Stock

• Space Reservation

• Stock Transition

• Fitting Overstock

• Overstock

Note

• Fitting Overstock is available only in Routing Electrical.

• Overstock that is defined together is grouped under an expandable node labeled
Overstock Definition. If you are using Stock as Components, Overstock Definition is a
single node in the Part Navigator.
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HVAC stock representation in the graphics window

When you create non-circular HVAC stock, NX represents the bend segments on the stock as lines
on the face of the stock. This creates a more realistic representation of manufacturable stock.

Note

To create this appearance in stock created in pre-NX 10 versions, edit the stock and use the
Split body faces when arc segments are present check box.

Why should I use it?

With the new representations in the Part Navigator you can:
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• Use standard Part Navigator functionality to work with stock. For example, the easiest way to
edit a feature is by double-clicking it in the Part Navigator.

• Easily differentiate between the different types of stock created in the design.

Where do I find it?

Part Navigator representations

Application Routing

Prerequisite
You must create stock, overstock, stock transition, space reservation, or
fitting overstock to see it in the Part Navigator.

Split body faces when arc segments are present check box.

Application Routing

Command Edit Stock
Location in dialog
box

Edit Stock dialog box→Settings group→Split body faces when arc
segments are present check box

Merge Stocks

Use this command to manually merge the stock or space reservation on two or more segments.

NX automatically merges stock only when you use the Assign Corner and Remove Discontinuity
commands.

Note

You cannot merge stock that are not connected, or stock that have different properties or
attributes such as material, NPS, or display color.
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Where do I find it?

Application Routing

Command Finder Merge Stocks

Upgrading pre-NX 10 stock

The data model has changed for the following from NX 10 onwards:

• Stock

• Overstock

• Space Reservation

• Stock Transition

• Fitting Overstock

Note

Fitting Overstock is available only in Routing Electrical.

In NX 10 or later, you must upgrade stock to the new data model in order to use any Routing
command on a part or assembly which has stock saved in pre-NX 10 versions.

Batch upgrade

Use the refile_part utility to upgrade stock in large assemblies to the new data model. The refile_part
utility can be used for upgrading both Legacy Stock and Stock as Components.

Note

If stock components from the assembly are missing, then the refile_part utility fails. To
recreate missing stock components while using the refile_part utility to upgrade stocks to the
new data model, use the –recreate_missing_stock_components option.

Use case refile_part syntax
Upgrading the stocks in assemblies while using
Teamcenter Integration

ugmanager_refile_program -u=<username> -p=<password> -recreate_missing_stock_components -folder=RefiledParts

Upgrading the stocks in assemblies while using
native NX

refile_part.exe –y -recreate_missing_stock_components –d <folder location>

Upgrading the stocks in a single harness
assembly part file while using native NX

refile_part.exe –y –recreate_missing_stock_components <folder location of file>\<file name>

Upgrading assemblies with Legacy Stock

When you open a part or assembly which has Legacy Stock saved in pre-NX 10 versions in NX
10, NX automatically upgrades the Legacy Stock so that it is compatible with the new data model.
This upgrade happens during part loading when you open the part or assembly and save the part
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or assembly after it loads. Subsequent attempts to open and load the part or assembly are faster
as the stock is upgraded only once.

If you want to defer the stock upgrade, use the Defer Legacy Stock Conversion During Part Load
customer default. If you defer the upgrade, you must use the Upgrade Stocks command to upgrade
the stock before you make any changes to the design.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Upgrading assemblies with Stock as Components

For stock saved in pre-NX 10 versions as Stock as Components, use the Upgrade Stocks command
to upgrade the stock to the new data model. When you use this command, you can also recreate
any stock components that are missing and cannot be loaded.

Where do I find it?

Application Routing

Command Finder Upgrade Stocks
Command line input refile_part

Recreate Inaccessible Stock Components

Use this command to recreate the following components if they are missing and cannot be loaded
in the assembly:

• Stock

• Overstock

• Space Reservation

• Stock Transition

• Fitting Overstock

Note

Fitting Overstock is available only in Routing Electrical.

Where do I find it?

Application Routing
Prerequisite All stock in the part or assembly must be converted to the new data model.

Command Finder Recreate Inaccessible Stock Components
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Loading stock components

When you load an assembly that has Stock as Component type of stock, NX does not load the stock
components automatically. You must fully load all stock components to avoid inconsistent results.

If you partially load an assembly, NX loads the stock components but not the sweep features of
individual stock. In such cases, when you change the segment to which a stock is associated,
for example, change its length or add parts to the segment, the sweep features of the stock are
not updated.

Overstock enhancement

What is it?

When overstock fails, NX no longer deletes it. Failed overstock is now displayed in the Part
Navigator. Double-click the overstock node in the Part Navigator to edit and fix the overstock.

Model History
Stock (1)
Overstock Definition (2)

Overstock (2)

Where do I find it?

Application Routing
Part Navigator Double-click a node that represents failed overstock.

Spline Path enhancement

What is it?

You can now accurately preview a spline path that lies on a stock offset point, a stock offset port,
or a stock offset plane. To do this, use the Show Result option.

Example

The example shows a spline path that is created using a stock offset point. When you click

Show Result , NX updates the preview to accommodate the stock offset point.
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Why should I use it?

The Preview check box creates a dynamic preview that changes as you make selections and
set parameters in the Spline Path dialog box. It does not however take into account stock offset
points, stock offset ports, or stock offset planes that lie on the spline path. If you want NX to take

these objects into account, click Show Result .

Tip

To improve performance, clear the Preview check box and use the Show Result option
only when you want to preview the final spline path.

Where do I find it?

Application Routing

Command Finder Spline Path
Location in dialog
box Preview group→Show Result

Pipe Welding commands

The following commands are now available in the Routing application. These commands work in the
same way as they do in Structure Welding. Use them in Routing to work with welding joints on pipes.
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Assign Weld Attributes
Use this command to assign weld attributes to curves or edges and edit them.

Export Welding Joints
Use this command to simultaneously export multiple welding joints in the design.

Fabrication Label
Use this command to simultaneously apply labels and annotations on multiple welding joints.

Fabrication PMI
Use this command to simultaneously apply PMI symbols on multiple welding joints.

Use these commands to reduce user-interaction while working with welding joints in Routing.

Where do I find it?

Application Routing Mechanical→More→Pipe Welding

Command Finder

Assign Weld Attributes

Export Welding Joints

Fabrication Label

Fabrication PMI

Pipe Welding Joint

Use this command to create different types of pipe welding joints.

The illustration shows a run with pipe welding joints shown in red.

You can create each joint individually or create multiple welding joints simultaneously.
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The illustration shows the types of welding joints you can create. The welding joints are shown in blue.

Butt Socket Mechanical

Boss Sleeve

Where do I find it?

Application Routing Mechanical (Pipe Welding)

Command Finder Pipe Welding Joint

Transform Path enhancements

Inheriting attributes

When you move or copy routing objects using the Transform Path command, you can now specify a
separate routing object from which you want the moved or copied object to inherit attributes. To do
this, use the Select Reference Object option.

For example, if you copy a pipe from one run to another run, you can specify a pump on the second
run from which the copied pipe inherits attributes. Examples of attributes that can be inherited include
operating pressure and operating temperature.

If you do not select a reference object:

• A moved object retains its attributes.

• A copied object inherits the attributes of the object of which it is a copy.
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Inheriting the value of an attribute

You can specify the object from which NX inherits an attribute, or specify if you want NX to ignore the
attribute. To do this, use the following options.

Source
Inherits the value of the attribute from the object that you move or copy.

Destination
Inherits the value of the attribute from the reference object that you specify.

Omitted
Ignores the attribute for the object that you move or copy.

Check for Duplicate Segments

The Check for Duplicates option is now called Check for Duplicate Segments. When you select
this check box NX detects duplicate segments, and displays the Resolve Duplicates dialog box.

Where do I find it?

Application Routing

Command Finder Transform Path

Location in dialog
box

• Copy Attributes group→Select Reference Object

• Copy Attributes group→Copied From column→Right-click the cell for
the attribute whose value you want to change→Source or Destination
or Omitted

• Settings group→Check for Duplicate Segments

Placing connecting parts on flanges

Placing connecting parts on flanges

You can now easily connect parts to a pair of flanges when you place the flanges on stock. Use
connecting parts such as a gasket, studs, bolts, and nuts. Setting up the placement of connecting
parts on flanges makes downstream tasks easier. For example, during or after the completion of
the design you can easily keep track of the number of connecting parts used in the design because
these connecting parts are created as User Defined Objects (UDOs). You can keep track of the
connecting parts using the Routing Bill of Materials (BOM). Note that UDOs are not visible in the
design or in the Assembly Navigator.
When you place a flange to connect it to an existing flange, or when you place a pair of connected
flanges using generic post placement, NX displays successive dialog boxes that list the connecting
parts chosen for post placement.

The displayed connecting parts are filtered based on the value of an attribute, such as BOLT_DIA,
which you must specify before you start placing parts. For example, if you choose to place studs,
you must set up the specifications so that the studs made available for placement are filtered using
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the BOLT_DIA attribute. NX matches the value of the bolt diameter of studs with the value of the
same attribute on the flanges.

The list of results for bolts or studs is filtered further based on the value of the BOLT_LEN attribute.
NX calculates the minimum required bolt length using information on the flanges and the gasket, if
selected, including any user-specified length adjustment. The bolts or studs that are listed have the
shortest length that meets this calculation of minimum length. The calculations and the minimum
required bolt length are also displayed in the selection dialog box for bolts or studs.

To enable filtering of the connecting parts for placement on other parts such as a globe valve, you
must add an attribute, such as the BOLT_DIA attribute, to the part table file (PTB file) of the family of
globe valve parts, and create a specification using the Connection Post Placement dialog box to
filter the parts by the specified attribute.

After you place the connected parts in the design, they appear in the Routing BOM.

Note

• Connected parts appear in the Routing BOM, only if you select the options in the
Compatibility Table dialog box→Report in BOM group.

• Generic post placement works only when you place a part on stock.

Example

Workflow for placing bolts and nuts on a valve part that is placed on stock.
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Part placement enhancements

Maintaining pipe length

NX cuts the pipe to accommodate the flange that you place on it and maintains the overall length of
the pipe when you place the flange in the following conditions:

• You place a flange that has two parallel ports facing opposite directions, such as a weld neck
flange or a socket weld flange.

• You place the flange at the end of the pipe.

In earlier versions, NX maintained the overall length of the pipe only if you placed flanges in
the middle of a pipe.

Note

Blind flanges have a single port. When you place a blind flange at the end of a pipe, it adds
to the length of the pipe.

Placement solutions

The sequence in which NX provides placement solutions is improved. The sequence is based
on the following:

• The PREFERRED_PORT attribute.

• The type of port available on the part—Fitting, Fixture, or Multi—changes the order of placement
depending on:

o Whether you place the part in Routing Mechanical, Routing Electrical, or Routing Logical.

o The object on which you place the part.

• The CROSS_SECTION attribute and the CONNECTION_TYPE attribute when the part is placed
on a Fitting port.

• The Value of the FLOW_DIRECTION attribute of the port. The value of this attribute is defined
when you qualify a port using the Qualify Part dialog box. The part may be placed in one of the
following conditions:

o The object on which you place it is a part of a run. The run must have a defined direction of
flow and the part you place must have a defined FLOW DIRECTION property.

o You place the part on a Fitting port with a FLOW DIRECTION property.

Anchor-based placement solutions

When you use an anchor-based solution to place a part, the Status line displays the name of the
anchor that NX uses for the part placement. To set this up, you must specify a name to the anchor
while qualifying the part. For example, assume that you are qualifying a part to use an anchor-based
solution for placement, and you specify the name of the anchor as ANCH_1234. When you place this
part, the Status line displays Anchor: ANCH_1234.
If, while qualifying a part with an anchor-based solution, you retain the default anchor name, then NX
displays :Anchor: in the Status line, when you place that part.
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Where do I find it?

Application Routing

Command Finder Place Part

Moving a measurement holder

You can change the location and angle of the measurement holders in your design.

To do this, use the Edit Measurement Holder dialog box. To open this dialog box, in the Move

Part dialog box, click Placement Object , select the measurement holder that you want to
move, and click OK.

Note

You can move only those measurement holders that are placed in NX 10.
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Where do I find it?

Application Routing

Command Finder Move Part

Location in dialog
box

Placement Object →Select the measurement holder you want to
move→OK→Edit Measurement Holder dialog box

Sheet Metal

Flange enhancement

What is it?

You can now create a flange on the linear edge of the following:

• A contour flange that is created using the chaining method where the connected curves include
a curved edge.

• A hem flange that is created using connected curves that include a curved edge.

For this example, a flange is created on the linear edge of a contour flange, and then both flanges are
flattened.

You can:

• Unbend and rebend these flanges.

• View the flattened flange in the flat solid representation or the Flat Pattern view.

• Modify the bend radius, bend angle, or neutral factor values of these flanges using the Resize
Bend Radius, Resize Bend Angle, or Resize Neutral Factor command.

• Create tapers on these flanges using the Bend Taper command.

Where do I find it?

Application Sheet Metal

Command Finder Flange
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Unbend and Rebend enhancements

What is it?

You can now use the Unbend and Rebend commands to unform and reform advanced flanges and
joggles. You must first convert the advanced flanges and joggles to sheet metal using the Convert
to Sheet Metal command.

Advanced flange

Joggle

Where do I find it?

Application Sheet Metal

Command Finder

Unbend

Rebend

Convert to Sheet Metal enhancements

What is it?

When you convert a non-sheet metal part to sheet metal, you can now select bend faces of advanced
flanges and joggles.

After the conversion, you can use the Unbend command to flatten the part, or use the Flat Pattern
command to create the flat pattern view.

The example shows the workflow for unbending and rebending an advanced flange and a joggle.
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Original sheet metal part

Use the Convert to Sheet Metal command to
convert the bend faces of the advanced flange
and joggle to sheet metal. To select the bend
faces that you want to convert, use the options in
the Additional Geometry group.

After conversion, use the Unbend command to
flatten the advanced flange and joggle.

Where do I find it?

Application Sheet Metal

Command Finder Convert to Sheet Metal
Location in dialog
box Additional Geometry group

Specifying a target body for creating normal cutouts

What is it?

You can now specify the target body on which you want to create the normal cutout feature.

If the part has a single sheet metal body, NX infers it as the target body.

The example shows the workflow for creating a normal cutout on a target body in a part that has
multiple sheet metal bodies.
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Original sheet metal part

Specify the normal cutout section.

For this example, Limits = Through All.

Select the target body.

NX creates the cutout on the specified target
body.

Why should I use it?

Specifying the target body to create a cutout is useful when the part has multiple sheet metal bodies.

Where do I find it?

Application Sheet Metal and Flexible Printed Circuit Design

Command Finder Normal Cutout
Location in dialog
box Target group→Select Body option
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Specifying a target face for creating bends and jogs

What is it?

You can now specify the target face on which you want to create a bend or jog feature.

If the bend line lies on a face of a sheet metal body, NX infers that face as the target face. You can
specify a different face as the target face if required.

The example shows the workflow for creating a bend on a target face in a part that has multiple
sheet metal bodies.

Original sheet metal part

Specify the bend line.

The bend line must lie on a plane that is parallel
to the target face.

Select the target face.

NX creates the bend on the body of the specified
target face.
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Why should I use it?

Specifying a target face to create a bend or a jog is useful when the part has multiple sheet metal
bodies.

Where do I find it?

Application Sheet Metal and Flexible Printed Circuit Design

Command Finder

Bend

Jog
Location in dialog
box Target group→Select Face option

Gusset enhancements

What is it?

The existing Gusset command is enhanced.

Creating gusset features

You can now specify the location of gussets using a datum plane as reference.

To do this, use the Specify Plane options in the Gusset dialog box. The datum plane must be
perpendicular to the axis of the bend.

Previously, the location of gussets was specified using the start edge as reference. If the start edge
was modified upstream, the gusset would fail.

NX 10 onwards since you use datum planes instead of edges to specify the location of gussets, you
ensure that the gusset does not fail when you perform operations upstream that affect the start edge.
If you reorder the gusset feature in the Part Navigator, for example to re-create a gusset after an
unbend-rebend operation, there is a greater chance that gussets are successfully re-created.
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Example

In the example, the flange is unbent to create a normal cutout and then rebent. Notice that
NX removes the gusset feature after the unbend operation.

To retain the gusset after the unbend operation, in the Part Navigator, reorder the gusset
feature after the Rebend feature to re-create the gusset.

Model History
Datum Coordinate System (0)
SB Tab (1)
SB Flange (2)

SB Unbend (3)
Datum Plane (4)
SB Normal Cutout (5)
SB Rebend (6)
SB Gusset (7)

The Gusset Placement group in the Gusset dialog box is removed. To create multiple gussets on
the same bend, use the Pattern Feature command.

The Corner Radius option is removed. For square gussets, you can specify the Die Radius (D) and
Punch Radius (P) values separately. For round gussets, you can specify the Die Radius (D) value.
The resulting gussets will now have uniform thickness.
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Square gusset Round gusset

While creating gussets you can switch between the Automatic Profile and the User Defined
Profile type. In this case, all dialog box inputs are retained, until you click OK or Cancel to close
the Gusset dialog box.

Flattening bends with gusset features

When you use the Unbend command to flatten a bend across which a gusset feature exists, NX now
displays an alert which indicates that the gusset feature will be removed during the unbend operation.

You can now specify if you want to automatically extract the boundary curves of the gusset and
display them on both layers in the flattened sheet metal part. To do this, select the Extract Gusset
Curves check box in the Unbend dialog box.

Customer defaults

The gusset customer defaults are modified. The Rounding tab is renamed to Settings.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Where do I find it?

Application Sheet Metal
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Command Finder

Gusset

Unbend

Location in dialog
box

Gusset dialog box→Location group→Specify Plane options

Unbend dialog box→Additional Curves or Points group→Extract Gusset
Curves check box

Bend Taper enhancements

What is it?

You can now add or remove material from the bend and web to which you apply a taper. You can also
create reverse tapers as NX now supports negative values for the bend taper distance or angle, and
web taper angles. A dynamic preview of the bend taper is now available.

Specifying stationary faces or edges

You can specify a face or an edge that remains stationary during the taper operation. NX uses the
selected face or edge to infer the side that remains fixed during the taper operation.

Example

In the following example, the top face is stationary.

In the following example, the bottom face is stationary.

To select a stationary face or edge, use the Select Face or Edge option.

Specifying a start location for the taper

You can specify if you want to create tapers that start from the bend or the web.

To do this, use the following options:
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Taper from Bend
NX adjusts the width of the web and creates a taper that starts from the bend.

1 Stationary face

2 Start point of the taper

Taper from Web
NX maintains the width of the web and creates a taper that starts from the web.

1 Stationary face

2 Start point of the taper

You can create bend tapers that extend up to the end of the base flange or the tab.

To do this, use the To End option.

1 Stationary face

2 Start point of the taper

Creating reverse tapers

You can create tapers by adding material to the flange.

To do this:

• If you select Taper from Bend you must enter negative values for both the taper distance or
taper angle of the bend, and the taper angle of the web.
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• If you select Taper from Web you must enter a positive value for the taper distance or taper angle
of the bend, and a negative value for the taper angle of the web.

In the example, a symmetric taper that starts at the bend is created with the taper angle for the
bend and the web set to –20.

Where do I find it?

Application Sheet Metal and Flexible Printed Circuit Design

Prerequisite

The To End option in the Input Method list is available only when you select
the Taper from Web option in the Taper Definition/Taper Definition Side
1/Taper Definition Side 2 group.

Command Finder Bend Taper

Location in dialog
box

• Stationary Face or Edge group→Select Face or Edge

• Taper Definition/Taper Definition Side 1/Taper Definition Side 2
group→Bend subgroup→Taper from Bend or Taper from Web

• Taper Definition/Taper Definition Side 1/Taper Definition Side 2
group→Bend subgroup→Input Method list→To End

• Taper Definition/Taper Definition Side 1/ Taper Definition Side 2
group→Bend subgroup→Taper Distance or Taper Angle

• Taper Definition/Taper Definition Side 1/ Taper Definition Side 2
group→Web subgroup→Taper Angle
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Flexible Printed Circuit Design

Flat Solid enhancements

What is it?

You can now represent PCB components and restriction areas on the flat solid of an FPCD part.

Representing components on the flat solid

NX creates a copy of the PCB component, replicates the PCB Exchange attributes, and transforms
the PCB component on the flat solid. The replicated attributes are non-associative.

To indicate the location of a PCB component on the flat solid, you can represent it as a solid body or
a coordinate system.

1
PCB component in the
FPCD assembly

2
PCB component
represented as a body

3
PCB component
represented as a CSYS

Note

To orient the PCB component correctly on the flat solid you must ensure that the Z-axis of the
PCB component is normal to the placement face of the FPCD part.

If you create a PCB component as a body within the native FPCD part, and you want to represent it
on the flat solid, you must group the PCB component with the associated datum CSYS.

Representing restriction areas on the flat solid

You must define the restriction areas in PCB Exchange. NX represents the restriction areas as
sketches on the flat solid.

A restriction area specified as a solid body or a sheet body must have a sketch associated with it.

• If the restriction area has an internal sketch associated with it, NX uses that sketch as a reference
to represent it on the flat solid.

• If the restriction area has an external sketch associated with it, you must group the external
sketch and the body on which you create the external sketch.
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Note

To orient the PCB restriction area correctly on the flat solid, you must ensure that the sketch
that represents the restriction area lies on the placement face of the FPCD part.

Why should I use it?

These enhancements help you to visualize the location of PCB components and restriction areas of
an FPCD part in the flattened state.

Where do I find it?

Application Flexible Printed Circuit Design

Command Finder Flat Solid

Location in dialog
box

Settings group→Transform Components list→None or Body or CSYS

Settings group→Transform Restriction Areas check box

PCB Exchange

Support of a Flat Solid version of a flexible PCB

What is it?

You can now import and export ECAD models that are in their bent state as long as the
NxFlexFlatSolid variable is set to Yes in the pcbx_ug_model.ini file. Previously, the import and export
was restricted to the flattened 2D state of the board.
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Why should I use it?

You can now work using the full 3D representation of a flexible PCB in PCB Exchange.

Where do I find it?

PCB Exchange looks for pcbx_ug_model.ini in the following locations:

1. Network location specified by the MAYA_PCB_ENV_DIR environment variable.

2. Working directory from where you launch PCB Exchange which is typically the same directory
from which you launch NX.

3. Location specified by the MAYA_PCB_DIR environment variable.

4. The NX installation directory (%UGII_BASE_DIR%\UGPCBXCHANGE).

Multi-Height Area Creation

What is it?

Use the new Multi-Height Area Creation command to create restriction areas that are bounded by
polygon faces. You specify:

• The face on which the restriction area will be placed.

• One or more bounding objects.

• Resolutions along the X and Y axes.

• Restriction area attributes, such as type, name, owner, and color.
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PCB Exchange creates extruded rectangular bodies of resolution X and Y sizes and height going
up to the bounding object. It then unites all bodies and assigns the restriction area attributes to the
united body. You can choose not to unite all the bodies. In that case, PCB Exchange assigns the
restriction area attributes to each body.

Why should I use it?

This command lets you create restriction areas with variable height that are bounded by other objects
in the assembly.

Where do I find it?

Application PCB Exchange

Command Finder Multi-Height Area Creation

Markers stored as faceted geometry

What is it?

Markers are now stored as faceted geometry in .stl files that are stored in the
%UGII_BASE_DIR%\UGPCBXCHANGE\data folder. By default, NX uses the faceted geometry
stored in mark.stl to display markers as a pushpin.

You can use other shapes for your markers. You specify the name of the files in the following
variables in the pcbx_ug_model.ini file.
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Variable Value options Specifies the marker file name
for displaying

NxPinMarkSTLName
ECAD primary pins. They are
always displayed in red.

NxMCADPinMarkSTLName
MCAD primary pins. They are
always displayed in black.

NxPadMarkSTLName
ECAD pads. They are always
displayed in green.

NxTestPointMarkSTLName

“[name of STL file without

extension]”

“mark” (default)
Test points. They are always
displayed in blue.

In previous versions, the displayed markers were NX features stored in part files. If you want to use
NX part files as markers instead of faceted geometry, set the following in the pcbx_ug.ini file:

PCBxDisplayOldMarkers = yes

Why should I use it?

Using faceted geometry instead of NX features to store markers speeds up the display time when
you have a large number of markers.

Where do I find it?

PCB Exchange looks for pcbx_ug_model.ini and pcbx_ug.ini in the following locations:

1. Network location specified by the MAYA_PCB_ENV_DIR environment variable.

2. Working directory from where you launch PCB Exchange which is typically the same directory
from which you launch NX.

3. Location specified by the MAYA_PCB_DIR environment variable.

4. The NX installation directory (%UGII_BASE_DIR%\UGPCBXCHANGE).

Visualize Primary Pins

What is it?

Use the new Visualize Primary Pins command to display MCAD and ECAD primary pin markers
for the selected components.

In the Visualize Primary Pins dialog box, you can:

• Select components from the graphics window or the Assembly Navigator.

• Select components that have the same Teamcenter item type defined by the DB_PART_TYPE
attribute.

• Display the information regarding the alignment of MCAD and ECAD primary pins in the
Information window.

• Reset the current selection and display of markers to be able to display markers of other
components without exiting the dialog box.
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Why should I use it?

This command lets you easily see if the MCAD and ECAD primary pin markers for a selected
component are defined, aligned, or mismatched.

Where do I find it?

Application PCB Exchange

Command Finder Visualize Primary Pins

Primary pin information on components

What is it?

The PC Design Navigator command now displays the information regarding MCAD and ECAD
primary pin markers for components in the Primary Pin column. You can find the following values
in the Primary Pin column.

Match Indicates that the MCAD primary pin location matches the ECAD primary pin
location for the given component.

Mismatch Indicates that the MCAD primary pin location does not match with the ECAD
primary pin location for the given component.

No ECAD Pin Indicates the given component does not have an ECAD primary pin defined.

No MCAD Pin Indicates the given component does not have an MCAD primary pin defined.

In the PC Design Navigator dialog box, you can choose to display the MCAD and ECAD primary
pin markers on the model.

Why should I use it?

You now have primary pin information for all your components directly in the PC Design Navigator
dialog box.

Where do I find it?

Application PCB Exchange

Command Finder PC Design Navigator
Location in dialog
box Components tab→right-click a row→Visualize Primary Pin

Refresh Primary Pin Mismatch Info

What is it?

Use the new Refresh Primary Pin Mismatch Info command to display the Primary Pin Comparison
Report in the NX Web Browser. The report for each component lists the following:
• The package name
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• The part number

• The result of the primary pin comparison

Match Indicates that the MCAD primary pin location matches the ECAD primary
pin location for the given component.

Mismatch Indicates that the MCAD primary pin location does not match with the
ECAD primary pin location for the given component.

No ECAD Pin Indicates the given component does not have an ECAD primary pin
defined.

No MCAD Pin Indicates the given component does not have an MCAD primary pin
defined.

Why should I use it?

In the HTML report that you get when you use the Validate PCA command, PCB Exchange lists
the result of the primary pin comparison at the time you import your ECAD model. The Refresh
Primary Pin Mismatch Info command lets you view the changes that were done to the primary pin
markers in your model after the import.

Where do I find it?

Application PCB Exchange

Prerequisite
In the PCB Exchange Settings dialog box, the Compare Primary Pin
Locations on Import check box must be selected.

Command Finder Refresh Primary Pin Mismatch Info

Remove Holes with Size filter

What is it?

You can now filter non-circular holes when importing, exporting, or updating, your model, or when
creating a thermal solution. NX filters the non-circular hole based on the size of the hole’s bounding
box. You specify values in Less than and Greater than boxes to remove holes with sizes that are
less than or greater than the values specified.

Why should I use it?

This filter lets you better control the aspect of your NX model with respect to non-circular drilled holes.

Where do I find it?

Application PCB Exchange
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Command Finder

Import ECAD Model or Export ECAD Model or Compare

and Update PCA or Create ESC Solution or PCB Exchange

Settings

Import ECAD Model or Export ECAD Model commands

Location in dialog
box

Use Entity Filter →Filters List

(Filters List dialog box) Pre-Defined Filters tab→Remove Holes with
Size

Compare and Update PCA command

Location in dialog
box

Use NX Filters on NX Model or Use NX Filters on ECAD Model

→Filters List

(Filters List dialog box) Pre-Defined Filters tab→Remove Holes with
Size

Create ESC Solution command

Location in dialog
box

Create Idealized Part →Use Entity Filter →Filters List

(Filters List dialog box) Pre-Defined Filters tab→Remove Holes with
Size

PCB Exchange Settings command

Location in dialog
box

IDX Collaboration tab→Entity Filters on NX Model or Entity Filters on

ECAD Model →Filters List

(Filters List dialog box) Pre-Defined Filters tab→Remove Holes with
Size

Filtering entities by ownership

What is it?

You can now create custom filters to filter entities by ownership when importing, exporting, or
updating your model, or when creating a thermal solution. In previous versions, you could only filter
components by ownership, now you can also filter drilled holes and restriction areas by ownership.
You add custom filters in the pcbx_ug_filter.ini file.
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Variable Value options Specifies filtering by
ownership for

KeepinOwner Keep-in areas
KeepoutOwner Keep-out areas
OtherOwner Other areas
CopperOwner Copper areas

DrilledHoleOwner

• ALL (default)

• +/-ECAD

• +/-MCAD

• +/-UNOWNED

• NONE

Drilled holes

For each of the variables, you can define multiple values as a comma delimited list. A plus sign (+) in
front of the value indicates that it is to be included. A minus sign (-) indicates that it is to be excluded.
If there is no indication, plus (+) is assumed.

Why should I use it?

Filtering restriction areas, holes, and components by ownership improves the collaboration between
ECAD and MCAD designers.

Where do I find it?

PCB Exchange looks for the pcbx_ug_filter.ini file in the following locations:

1. Network location specified by the MAYA_PCB_ENV_DIR environment variable.

2. Working directory from where you launch PCB Exchange which is typically the same directory
from which you launch NX.

3. Location specified by the MAYA_PCB_DIR environment variable.

4. The NX installation directory (%UGII_BASE_DIR%\UGPCBXCHANGE).

Creation of idealized part

What is it?

You can now do the following when you create a thermal solution in PCB Exchange:

• Create an idealized part file in addition to the FEM and Simulation files.

• Filter out certain holes and components before the creation of the idealized part file.

Why should I use it?

This new feature lets you store the modifications within the idealized part file and keep the original
master model geometry unchanged.

Where do I find it?

Application PCB Exchange
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Command Finder Create ESC Solution

Location in dialog
box

Output Options group→Create Idealized Part

Output Options group→Create Idealized Part →Use Entity Filter

Creating a Space Systems Thermal solution

What is it?

You can now specify the solution type that you want to create for the thermal analysis of your PCB
model in a dialog box. You can create a solution of the following types:

• Thermal

• Electronic Systems Cooling

• Space Systems Thermal

In the previous releases, you could specify the Thermal and Electronic Systems Cooling solution
types only in the pcbx_thermal.xml file.

As in other solutions, PCB Exchange now creates PCB Component simulation objects and a Printed
Circuit Board simulation object when creating a Space Systems Thermal solution.

Where do I find it?

Application PCB Exchange

Command Finder Create ESC Solution
Location in dialog
box Output Options group→Solution Type

Home tab enhancements

What is it?

You can now access all the PCB Exchange commands on the Ribbon bar from the Home tab. In
previous releases, most of the commands were only accessible through the Menu.

The organization of the commands on the tab also changed. NX now organizes the PCB Exchange
commands in the following groups:

• Edit Attributes

• Data Exchange

• Thermal/Flow Simulation
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• IDX

• Tools

PCB Exchange version

What is it?

NX now displays the following information about PCB Exchange:

• The version of PCB Exchange

• The location of the loaded initialization (.ini) files

Why should I use it?

This new feature provides you with general information about PCB Exchange.

Where do I find it?

Application PCB Exchange

Command Finder About PCB Exchange

Importing holes as curves or cutouts

What is it?

You can now import holes of a certain type as curves or cutouts. In previous versions, you could
import all holes only as simple hole features, curves, or cutouts. You must define the following
variables in the pcbx_ug_model.ini file.

Variable Value options Descriptions
NxWriteHoleTypeAsCurves Imports holes as curves.

NxWriteHoleTypeAsCutouts

• Pin

• Via

• Mounting

• Tool

• Other

Imports holes as cutouts.

For each of the variables, you can define multiple values as a comma delimited list. These variables
overwrite the NxWriteHoleAs variable.

Why should I use it?

You can represent certain types of holes in the board as curves or cutouts instead of filtering them out.
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Where do I find it?

PCB Exchange looks for the pcbx_ug_model.ini file in the following locations:

• Network location specified by the MAYA_PCB_ENV_DIR environment variable.

• Working directory from where you launch PCB Exchange which is typically the same directory
from which you launch NX.

• Location specified by the MAYA_PCB_DIR environment variable.

• The NX installation directory (%UGII_BASE_DIR%\UGPCBXCHANGE).

Creation of CAE items

What is it?

PCB Exchange now creates CAE items in Teamcenter so that you can use them to manage the
information.

Vehicle Design

Pedestrian Protection enhancements

What is it?

When you perform the pedestrian protection analysis of a vehicle, you can now do the following.

• Generate more accurate Bonnet Rear Reference Line (BRRL) output by controlling the rear
reference step distance value.

Change the default value using the Rear Reference Step Distance customer default or enter
a value in the Rear Reference Step Distance box in the Sections group in the Standard
Settings dialog box.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click

Find Default .

• Generate second marginal Bonnet Leading Edge (BLE) and second marginal Bumper Corner
(BC) lines. These lines allow you to easily identify the worst case condition by comparing three
sets of data.

Change the default second marginal values using customer defaults or specify the values in the
Head Impact Reference Angles group in the Standard Settings dialog box.
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NX now generates circle templates at the corner of the BRRL and Side Reference Line (SRL),
whether or not the lines touch. This lets you obtain a smooth curve at the corner of the BRRL and
Side Reference Line (SRL) even if the lines touch.
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NX now generates impact sheets using reference curves instead of impact curves. This lets you
obtain a well-defined headform basin in the output.

Where do I find it?

Standard Settings dialog box

Application Modeling
Prerequisite You must define the vehicle coordinate system.

Command Finder Pedestrian Protection

Location in dialog
box

Pedestrian Protection dialog box→Edit Standards Settings

→Standard Settings dialog box

Second marginal values customer defaults

Command Finder Customer Defaults

Location in dialog
box

Vehicle Design – General Packaging→Pedestrian Protection→Global
Technical Regulation Standards tab, European Standards tab, Japanese
Standards tab, Korean Standards tab, or Chinese Standards tab

Vehicle Packaging option renamed

What is it?

The Pedal Plane Angle (A47) option name is changed to Shoe Plane Angle (A47).

Where do I find it?

Standard Settings dialog box

Application Modeling
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Prerequisite You must define the vehicle coordinate system.

Command Finder Vehicle Packaging

Location in dialog
box

Create Vehicle Packaging wizard→Occupant List step→Create

→Create wizard (for selected occupant)→H-Point Design
step→Position Method group

H-point Design Tool enhancements

What is it?

You can now use the H-point Design Tool command to:

• Establish key vehicle reference points such as SgRP (Seating Reference Point) and Heal point in
compliance with the SAE J4002 Feb2010 standards.

• Specify the pedal type as suspended curved, suspended flat, or treadle. To do this, use the
Select Pedal Type drop-down list in the Accelerator Shoe step.

Suspended Curved Pedal Suspended Flat Pivoting
Pedal Treadle Pedal

• Define and display 2–way or 4–way H-Point travel path.
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2–way H-Point travel path 4–way H-Point travel path

• Get two new reference points (divot points) H2L and H2R in the output.

The following option names in the H-Point Design Tool wizard are changed.

Pre-NX 10 name NX 10 name

Pedal Plane Angle (A47) Shoe Plane Angle (A47)
By Pedal Geometry or Pedal Plane Angle By Pedal Geometry or Shoe Plane Angle
PRP Width Coordinate (W1) BOFRP Width Coordinate (W1)

The formula used to calculate the Shoe Plane Angle (A47) value is updated:

SPA = 2.522(10-7)(H303) – 3.961(10–4)(H302) + 4.644(10–2)(H30) + 73.374

Where do I find it?

Standard Settings dialog box
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Application Modeling
Prerequisite You must define the vehicle coordinate system.

Command Finder H-point Design Tool
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General enhancements

Creating the IPW in the background

You can create the in-process workpiece (IPW) for drilling or milling operations in the background,
while you work on other operations. To do this, you use the Parallel Create 3D IPW command. This
command is similar to the Parallel Generate command that you use to generate operations in the
background. Creating the IPW in the background is useful when:

• You do not want to wait for IPWs from earlier operations to be created before you simulate
or generate an operation.

• You are going to use the Show Thickness by Color option to examine the IPWs for a series of
operations.

When an IPW is being created for one or more operations:

• The symbol appears beside the nodes in the Operation Navigator.

• The Stop Parallel Create 3D option is available when you right-click an operation for which
an IPW is being generated.

• The tool tip for the affected operations shows that the IPW is being generated and shows the
operating system process ID of the background process.

After NX creates the IPW, the IPW column of the Operation Navigator shows the status of the
IPW for each operation:

Generated

Not generated

Out of date

Where do I find it?

Initial release NX 9.0.1
Application Manufacturing
Prerequisite Generate the operations before you attempt to create an IPW and then

select them.
Ribbon bar

Home tab→Workpiece group→Parallel Create 3D
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Operation
Navigator

Right-click one or more selected operations→Workpiece→Parallel Create
3D IPW

Verification settings and playback enhancements

Keyboard shortcuts

When a playback button, for example Step, is selected, you can use keyboard keys to control the
animation.

Step Right arrow key

Step Backward Left arrow key

Forward to Next Operation Page Up key

Rewind to Previous Operation Page Down key

For continuous motion, hold the corresponding arrow key.

Note

You can also use the arrow keys to move a selected slider or scroll a selected list.

Tool Path Visualization settings

The Tool Path Visualization dialog box settings are now retained throughout the NX session, with
the following exception:

• The slider value that controls the listing in the path listing window is not retained.

Note

NX does not retain the settings in dialog boxes that you open from within the Tool Path
Visualization dialog box.
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Tool path display during playback

The Tool Path display options include a Start to Current Motion option, to display the path from the
start point of the operation until the current position of the tool.

Start to Current Motion All

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Prerequisite

You must have at least one operation that has been generated.

For arrow key shortcuts, click a playback button to give it the focus.

For settings retention, reopen the Tool Path Verification dialog box.
Location in dialog
box Replay or 3D Dynamic tab→Tool Path list→Start to Current Motion

Displaying cutter paths - starting in NX 9.0.1

For milling and drilling operations, use the commands in the Display group of the Home tab to filter
the display of tool paths for operations that you select in the Operation Navigator:

• Show Cutting Moves

• Show Non Cutting Moves

• Show Tool Center This option affects ball tipped cutters only.

• End Point

What's new in NX 4-3

CAM NX 9.0.1 — NX 10.0.1



Chapter 4: CAM NX 9.0.1 — NX 10.0.1

Note

o You no longer need to set the environment variable UGII_CAM_TP_DISP_ENDPOINTS to
display end points.

o If you turn off both Show Cutting Moves and Show Non Cutting Moves, NX turns off
the path display for operations that you select in the Operation Navigator.

Where do I find it?

Initial release NX 9.0.1
Application Manufacturing
Prerequisite Select an operation in the Operation Navigator
Ribbon bar Home tab→Display group

Displaying cutter paths - starting in NX 9.0.2

Display group

Use the two new options in the Display group of the Home tab to manage the display of tool paths
when you select or edit an operation.

Display Drop-down

Use the Display Tool Path option to show a tool path relatively quickly. The Display option
supports the options in the display group.

Use the Replay Tool Path option to use all of the settings in the Display Options dialog box,
including tool and path display options, replay speed, display of feed rates, arrows, and line numbers,
and the generation options. You open the Display Options dialog box from the Options group
when you are creating or editing an operation.

Coloring Drop-down
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You can set the tool path display colors by motion type, by operation, or by tool.

The comparison images shown here are taken from one of the sim06_mill_5ax_cam... assemblies in
your ...\MACH\samples\nc_simulation_samples folder. The following three operations are selected
in each image:

ROUGHING
FACE_TOP
CAVITY_TOP
CAVITY_MILL

Motion Type
Use the Motion type option to retain the display behavior of versions previous to NX 9.0.2.

Tool path motions are displayed in the colors that you set in the Options→Edit Display→Path
Display Colors dialog box. You can assign colors to different motions, such as engage, retract,
rapid, and cutting moves.

The example shows the default colors by motion type.
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Tool
Use the Tool option to display the non-rapid moves of tool paths in a different color for each tool.

The example shows paths colored by tool. The first two paths are shown in a blue shade, and
then there is a tool change. The third path, which uses a new tool, is shown in a green shade.

Operation
Use the Operation option to display the non-rapid moves of tool paths in a different color for
each operation.

In the example, the path for the FACE_TOP operation is rendered in a blue shade, the path for
the CAVITY_TOP operation is a green shade, and the path for the CAVITY_MILL operation is
a yellow shade.
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Customer defaults for tool and operation colors

The Color by Tool or Operation defaults control the default colors and order for tool path display by
tool and by operation.

The Rapid Motion, Color and Font defaults control the font and color for rapid motions. Rapid
motions are now red and dashed by default.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Prerequisite Select operations in the Operation Navigator or edit an operation.
Ribbon bar Home tab→Display group

Connecting tool path segments after edits

Use options in the Transfer/Rapid group of the Trim Tool Path dialog box to connect disjoint
segments of tool paths that you have trimmed or divided with options in the Tool Path Editor
dialog box.

Transfer at Direct Makes a direct connection between the end of the
retract of a cutting motion to the start of the engage of
the next cutting motion.

Clearance Sets the clearance height for the transfer.

Lowest Safe Z Applies a direct move first. If the move is not gouge
free, NX uses a previous safe Z-level plane.

Smooth Creates a default transfer with no selectable options.

Smooth connections
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Plane Lets you define a plane for transfer moves for each trim
that you perform.

Transfer using None Does not use any specific transfer motions.

Ramp on Shape Creates a ramping engage move that follows the shape
of the first cutting motions.

Lift and Plunge Produces engages and retracts with vertical moves.

Enter a Lift and Plunge Height.

Height Sets the height at which the transfer takes place.
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Where do I find it?

Initial release NX 9.0.1

Application Manufacturing

Command Finder Edit tool path
Operation
Navigator Right-click operation→Tool Path→Edit

Location in dialog
box

[Tool Path Editor] dialog box→Edit Actions group→Trim →[Trim
Tool Paths] dialog box→Transfer/Rapid group

Trimming tool paths in the Tool Path Editor

You can trim a tool path by selecting an area in the current graphics view plane. The selection
tools include:

• Rectangle

• Lasso

• Polygon

Tip

To add the polygon Select by Polygon method, use the Command Finder to find Select by

Polygon . Right-click and choose Add to Top Border Bar. You can further customize the
Top Border bar by dragging the icon into the Selection list.

You can specify smooth connections between the truncated cutting motions. In the tool path shown,
the walls marked (1) and (2) are colliding with the tool holder. You can trim those areas from the
tool path.
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You can remove one area by trimming the
motions that are inside a rectangle, as shown.

To complete the edit, repeat the trim using a
second inside-rectangle trim.

You can achieve the same result in a single trim operation by trimming outside a selected area
using the Lasso (shown) or Polygon selection method.

Smooth connections between trimmed motions

The following figure shows the trimmed path, with the smooth connections option.
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Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Prerequisite You must edit a generated tool path.
Command Finder Edit Tool Path
Operation
Navigator [Select operation]→right-click→Tool Path→Edit

Location in dialog
box

Edit Actions→Trim →Trim Tool Paths dialog box→Trim Geometry
group→Geometry = Selection in View

Choose the trim method on the Top Border bar.

IPW rendering improvements (10.0.1)

What is it?

Needle count defaults for rendering the IPW are higher counts than in earlier releases. This is
now practical due to increased performance in NX and much more capable computers than were
available when the defaults were created.

Needle Count Option Previous versions NX 9.0.3, NX 10.0.1 and later
Coarse 200 350
Medium 350 500
Fine 500 1000

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Menu Menu→Preferences→Manufacturing
Location in dialog
box Geometry tab→In Process Workpiece Tolerances

IPW tolerances moved into the part (10.0.1)

What is it?

When you have a part that requires IPW settings that are different from those set by the IPW
Tolerances group in the customer defaults, Chordal Tolerance, Tolerance Mode, Needle Distance,
and Needle Count, you can now override the defaults in the Manufacturing Preferences dialog
box. These settings are saved with your part.

The customer defaults now serve only to establish default tolerance values for the Manufacturing
Preferences dialog box.
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Why should I use it?

Part-specific preferences are useful when you have parts that require special settings, for example a
few large parts that require a higher needle count than your other parts.

You can change the IPW tolerances and see the effect without having to restart your NX session.

You can create template parts that have specific settings for the various types of parts with which
you deal regularly.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Menu Menu→Preferences→Manufacturing
Location in dialog
box Geometry tab→In Process Workpiece Tolerances

Generating the IPW with the operation (10.0.1)

What is it?

A new customer default, Generate IPW with Path, lets you generate the in-process workpiece (IPW)
as you generate an operation. NX saves the IPW with the operation.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Why should I use it?

Saving the IPW with the operation saves time when you do the following:

• Use the Verify Tool Path→3D Dynamic method.

• Select the Show Thickness by Color option or the Workpiece→Show 3D option.

• Generate operations that use the previous IPW.

You can:

• Visually inspect the operation result as soon as it is generated.

• Immediately verify the tool path to check for collisions with the IPW.

Where do I find it?

Initial release NX 9.0.3 MP2
Application Manufacturing

Customer Defaults Search for Generate IPW with Path
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Toolpath verification and analysis consolidation (10.0.1)

What is it?

In previous releases, new functionality was added beside existing functionality. This resulted in some
duplication and confusion over which command to use for a given task. Some older functions are
now hidden by default in the Tool Path Verification dialog box.

2D Dynamic tab

The 2D Dynamic tab is now hidden. This protects you from issues that might arise if, for example, a
collision occurs but is not visible in the selected 2D view.

To restore the 2D Dynamic tab, select the Show 2D Dynamic Page customer default.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

3D Dynamic tab

To ensure maximum reliability, on the 3D Dynamic tab, the Facetted Solid options are hidden.

We recommend that you click Show Thickness by Color to check the amount of excess material
that remains on the part.

We recommend that you use the following methods for gouge checking:

• Right-click an operation in the Operation Navigator and choose Tool Path→Gouge Check.

• In the Tool Path Verification dialog box, on the Replay tab, click Gouge and Collision Settings.

To restore the Facetted Solid options, select the Enable Facetted Solid for Gouges and Excess
customer default.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Milling

Automatic cut pattern direction

What is it?

You can choose the Automatic pattern direction option in a Follow Periphery cut pattern. The
pattern direction will alternate between Inward and Outward per cut level and cut region condition.
NX does the following.
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• With an open periphery, the cutter approaches from outside the part and engages the material
while working towards the center of the part.

• With a partial or completely closed periphery, the cutter approaches from outside the part and
the first initial entry machines a slot to reach the region start point. From there the toolpath
continues to work its way outward.
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• For an Outward pattern with standing bosses or features, the entry point and path to the region
start point are optimized.

Previous NX results NX 9.0.2 results

1 = Entry point

2 = Region start point

• Pockets, voids, or existing holes are considered for the open engage portion of the tool path.

Previous NX results NX 9.0.2 results

Why should I use it?

By using the Automatic pattern direction option, you allow NX to optimize the created cavity milling
tool paths for maximum efficiency, tool life and performance.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Location in dialog
box

Cutting Parameters dialog box→Strategy tab→Cutting group→Pattern
Direction→Automatic
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Cavity Mill Cutting Parameters (10.0.1)

What is it?

When you create a tool path that uses the Follow Periphery cut pattern, the Legacy options in the
More tab in the Cutting Parameters dialog box are no longer available when you set the Pattern
Direction to Automatic.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Location in dialog
box

Cutting Parameters dialog box→Strategy tab→Pattern Direction list→
Automatic

Improving surface finish on corners and fillets Curve/Point drive method

When you use the Curve/Point drive method, you can do the following:

• Position the tool to follow along edges of the part geometry at a specified offset using the Offset
Left option.

• Shift the tool contact point a distance along the curve tangent of a non-center cutting tool such
as a bull nose end mill. When you cut around an axis, this is equivalent to a rotational shift
around the axis.

• Chamfer.

These enhancements are primarily intended to improve the surface finish for 5-axis machining
of rotary floors. The Curve/Point drive method is not used exclusively for rotary floors, and the
enhancements may be useful for other types of applications. When the tool axis is not perpendicular
to the cut area, you may see differences in the 3-axis tool path for the Offset Left option. See the
Manufacturing product notes section in the Release Notes for details.

Following edges at an offset

NX does the following to create the tool path:

1. Offsets the selected edges or curves along the cut area surface to create the drive curves.

2. Checks for gouges against part or check geometry, and removes any portions of the tool path
that gouge. If the offset value is too small to clear the geometry, NX does not create a tool path.

Note

To specify an offset to the right, enter a negative value.
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In the following example, the drive curves are selected from the feature edges.

Part to machine Cut area and edges to offset

Tool diameter = 3 mm

Offset Left = 1.5 mm

Drive curves Tool path
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Shifting the contact

The following example shows the effect of shifting the tool contact by 1.5 mm on a 3 mm diameter tool.

Tool at default contact point Tool contact shifted

Chamfering with Curve/Point

Use a chamfering tool and specify negative stock to cut a chamfer. When you generate the operation
NX displays a warning message. To continue generating the operation, click No in the message box.

Why should I use it?

These enhancements help improve surface finish quality. Previously, there was no way to shift the
tool contact, and it was necessary to create offset curves. You no longer need to create offset curves
to drive the tool along part features.

4-18 What's new in NX

Chapter 4: CAM NX 9.0.1 — NX 10.0.1



CAM NX 9.0.1 — NX 10.0.1

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Prerequisite Curve/Point drive method
Location in dialog
box

Curve/Point Drive Method dialog box→Drive Settings group→Offset
Left and Tool Contact Shift

Performance enhancements for Floor Wall operations using a 3D IPW

What is it?

The time required to generate tool paths, or to edit an operation with the Preview option selected is
now improved. The performance improvements depend on the complexity of the blank and 3D IPW,
and are most noticeable when the operation uses a complex or nonrectangular blank.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Command Finder Floor and Wall with IPW

Cut regions and cut order in Flowcut Single operations

The Cut Regions dialog box appears when you generate a Flowcut Single operation, like the
Manual Assembly dialog box in NX 9.0 and earlier versions. Segments from earlier versions are
now referenced as regions.

Use the Flowcut Single operation Cut Regions dialog box to reorder, divide, or delete regions of
a flowcut path.
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Regions to Cut
group

Name column Shows the cut regions in the current cut order. To
reorder the list, drag a row to a new position. You can
also rename a region in this column.

Divide Lets you specify a point to divide the selected region.
NX uses the nearest point on the region to the place
where you click as the dividing point. The region points
are highlighted when the dialog box is open. Point
numbers appear when the mouse cursor is over a point.

Reverse Reverses the cut direction of the selected region. NX
displays a direction arrow at the start point of the region.

Delete Removes the selected region from the tool path.

Where do I find it?

Initial release NX 9.0.1
Application Manufacturing
Prerequisite Create or edit a Flowcut Single operation, and generate the operation

Cut region control for Flowcut Reference Tool

What is it?

You can subdivide the cut area for a Flowcut Reference Tool operation. To do this, set the Cut
Order list to User Defined in the Flow Cut Drive Method dialog box. NX initially subdivides the cut
area based on the steepness angle you provide.
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Region sizes

You control the region sizes. Merge or divide the regions as required. NX updates the cut region
display as you make modifications.

Example of merged regions

Region 11 Region 12 Regions merged as one

Region names when created:

<operation_name> _R_1

<operation_name> _R_2

When you divide regions, NX will append the region name with a sequential numerical value. For
example, if you divide Operation_R_1, the resulting region names would be:

Operation_R_1_1

Operation_R_1_2
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Cut regions and cutting sequence

You control the regions to cut and their cutting sequence. Delete regions to completely avoid
cutting certain areas.

Cut Regions list example:

Name Cut Order Containment Type
Operation Regions
FLOWCUT_REF_TOOL_R_1 1 Flow

FLOWCUT_REF_TOOL_R_1 2 Flow

FLOWCUT_REF_TOOL_R_1 3 Flow

FLOWCUT_REF_TOOL_R_1 4 Flow

FLOWCUT_REF_TOOL_R_1 5 Flow

FLOWCUT_REF_TOOL_R_1 6 Flow

FLOWCUT_REF_TOOL_R_1 7 Flow

FLOWCUT_REF_TOOL_R_1 8 Flow

FLOWCUT_REF_TOOL_R_1 9 Flow

Cut order labels in the graphics display correlate to the Cut Regions list.

You can also do the following:

• Control the cut pattern and other tool path parameters within each cut region. Define a region as
steep or non-steep, and NX applies the appropriate Flowcut Drive Method settings.

• Change the containment type for the region.

• Reverse the flowcut region cut direction. NX will not reverse an area region.
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Editing updates

You can now do the following:

• Drag regions to change the cut order.

• Undo changes from the current editing session.

• Save the current cutting sequence. NX saves the edits with the operation each time it generates
the operation, and uses the saved sequence to produce the updated tool paths.

Why should I use it?

Managing regions can improve cutting efficiency, improve the part surface finish, and improve cutter
wear and performance.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Prerequisite A Flowcut Reference Tool operation

Location in dialog
box

Flowcut Ref Tool dialog box→Drive Method group→Method row→Edit

Flow Cut Drive Method dialog box→Output group→Cut Order→User
defined→OK

Flowcut Ref Tool dialog box→Actions group→Generate →Cut
Regions dialog box

Flowcut Region Management (10.0.1)

What is it?

In a Flowcut operation, you can create, visualize, edit, and save cut regions without generating the
tool path. Cut Region options will be available in the Flow Cut geometry group.

You Can:

• Generate the tool path based on the saved cut regions within the operation.

• View the regions graphically.

• Import inactive regions from previous sessions into the current session.

When changes are made to the parameters of a region, NX displays a message and marks the region
with an Invalid icon in the region list until the operation is regenerated.
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Why should I use it?

Because you can edit cut regions before you generate the operation, overall processing time can
be reduced.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Flowcut Operation
Location in dialog
box Flow Cut Operation dialog box

Corner smoothing for Z-level non-steep cut patterns (10.0.1)

What is it?

You can smooth corners in Flow Cut operations with Zig, ZigZag, or ZigZag with Lifts patterns for
non-steep regions. To do this, you:

1. Set steep regions to Zlevel.

2. Set the Smoothing cutting parameter to All Passes.

3. Specify a radius size to be applied to the corners.

4. Generate the operation.
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Corner Smoothing Corner Smoothing

Why should I use it?

When you machine hard material, or machine at high speeds, consider adding fillets to all corners.
Corner fillets can do the following:

• Prevent a sudden change in direction and cutter deflection which can cause excessive stress on
the machine tool and cutter.

• Aid in tool path generation for Nurbs output because smooth transitions are easier to blend into
Nurbs than sharp corners.

The Smoothing option gives you better control of tool path output for finishing operations and
improves machining efficiency.

Where do I find it?

Initial release NX 9.0.3 MP2
Application Manufacturing
Location in dialog
box

Flowcut Reference Tool operation→Cutting Parameters→Corners
tab→Path Shape in Corners group→Smoothing→All Passes

Adding center passes in Flowcut operations (10.0.1)

What is it?

When you machine corners in Flow Cut operations, you can reduce or remove scallops. To do this,
use the Add Center Passes option. This option creates a center pass in the region when space
between offset passes produces a larger than desired gap that results in a scallop.
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Add Center Passes Add Center Passes Added paths highlighted.

Why should I use it?

This option helps you to improve surface finish when you machine corners.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Flowcut Operation
Location in dialog
box

Flow Cut Drive Method dialog box→Non-steep Cutting and Steep
Cutting groups

Using Steep Overlap and Follow Periphery in Flowcut operations (10.0.1)

What is it?

You can overlap the cutting motions between steep and non-steep regions in Flow Cut operations.
Use the Steep Overlap option to specify the distance or a percentage of the tool diameter overlap.
Additionally, you can use a Follow Periphery pattern for both steep and nonsteep regions.

No Steep Overlap Steep Overlap set at 0.100”

Why should I use it?

When you overlap the cut motions, you can sometimes achieve a smoother finish.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Prerequisite
Flowcut operation using a Zlevel steep pattern with a Follow Periphery
non-steep pattern.

Location in dialog
box Flow Cut Drive Method dialog box→Steep Cutting group
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Corner smoothing

What is it?

You can smooth corners in Zlevel cut patterns in Flowcut Reference Tool operations. To do this, you:

• Set steep and non steep regions to Zlevel.

• Select the Corner Smoothing cutting parameter.

• Specify a Radius size to be applied to the corners.

Previous versions of NX NX 9.0.2

Why should I use it?

When you machine hard material, or machine at high speeds, consider adding fillets to all corners.
Corner fillets can do the following:

• Prevent a sudden change in direction and cutter deflection which can cause excessive stress on
the machine tool and cutter.

• Aid in tool path generation for Nurbs output because smooth transitions are easier to blend into
Nurbs than sharp corners.

The Corner Smoothing option gives you better control of tool path output for finishing operations
and improves machining efficiency.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Location in dialog
box

[Flowcut Reference Tool operation]→Cutting Parameters→Corners
tab→Path Shape in Corners group→Smoothing row→All Passes
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Using a boundary with the Area Milling drive method

Specify Trim Boundaries

Use the Specify Trim Boundaries command to control cut areas in contouring operations that
use the Area Milling drive method.

Contain the cut area by one or more loops of bounding objects. Boundaries can be edges, any
type of curves including sketch curves, or points. Boundaries are projected onto the part surfaces
along the normal vector of the boundary plane.

Edge as boundary

Cut Region Boundary edge, trim inside Tool Path

Sketch as boundary

Boundary sketch, trim outside Tool Path

Closing gaps
You can leave gaps between curves or edges. The gaps are automatically closed by straight lines.
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Closing gaps

The arrows indicate closed gaps, boundary trim
outside

Tool Path

Nested boundaries, no overlap
You can define nested containment boundaries provided they indicate a clear trimming area and
do not overlap.

Outer boundary trim outside

Inner boundary, trim inside

Tool Path
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Linear open boundary
You can define open boundaries provided that the open ends project off the part.

Mouse clicks at (1) and (2) define two points, off
part, as an open boundary Tool Path

Trim boundary options

The trim boundary options are always available in the Contour Area operation subtype. They appear
in the following operation subtypes after you select the Area Milling drive method :

• Fixed Contour

• Contour Surface Area

Contact tool position

When you specify the Contact tool position, NX moves the tool to contact the projected boundary in
such a way that the entire area is cut.
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Area milling geometry with boundaries

In the Geometry view of the Operation Navigator, you can create a MILL_AREA geometry group
and include trim boundaries in the definition. You can then reuse the geometry area in multiple
operations.

NX displays this type of geometry group in the initial Geometry list only when you choose the
Contour Area operation subtype. If you create Fixed Contour or Contour Surface Area operation
subtypes, you must edit the drive method to Area Milling before the area mill geometry appears
in the Geometry list.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Prerequisite
You must have a contouring operation that uses the Area Milling drive
method.

Location in dialog
box Geometry group→Specify Trim Boundaries

Contact tool position on Area Milling boundaries

When you specify the Contact tool position, NX moves the tool to contact the projected boundary in
such a way that the entire area is cut.

The part for this example has a surface that has
both concave and convex regions. A sketched
rounded rectangle is the boundary.
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When projected along the tool axis, the Z-axis in
this example, the boundary encompasses both
concave and convex surface areas.
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As seen along the tool axis, a tool path with the
On tool position moves the tool tip strictly within
the boundary.

When you use the On tool position, in steep
areas, small concave areas are not completely
cut, and small convex areas are cut outside of the
boundary. This happens because when the tool
tip is positioned over the boundary, the point of
contact of the tool with the face is some distance
from the boundary.
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As seen along the tool axis, a path with the
Contact tool position moves the tool tip beyond
the boundary, or stops short of the boundary,
depending on the nature of the surface slope.

The Contact option positions the tool tip such that
the point of contact of the tool with the face lies on
the boundary. This ensures that the tool contacts
all points that lie inside the boundary, and does
not contact points that lie outside of the boundary.

4-34 What's new in NX

Chapter 4: CAM NX 9.0.1 — NX 10.0.1



CAM NX 9.0.1 — NX 10.0.1

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Prerequisite
Create or edit an operation that uses the Area Milling drive method, and
create or edit boundaries to contain the tool motion.

Operation dialog box Specify Trim Boundaries
Location in dialog
box

Trim Boundaries dialog box→Boundaries group→Tool Position
list→Contact

Boundary projection for Area Milling (10.0.1)

As you define or edit a boundary with the Tool Position option set to Contact, the outer boundary of
the contact position is dynamically calculated and shown on all surfaces through the part.

The following images show arbitrary curves used to define a boundary that contains the cutter within
a small area of the part.

The boundary curves contain the toolpath in the
area shown.

When the Trim Boundaries dialog box is open,
and the Tool Position option is set to contact,
NX displays the tool contact boundary on all part
surfaces. The boundary that is displayed on the
surface that is being cut shows you the actual cut
area.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
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Prerequisites

Operations must use the Area Milling drive method.

In geometry groups, the Geometry Subtype option must be set to
MILL_AREA.

In the Trim Boundaries dialog box, in the Boundaries group, the Tool
Position option must be set to Contact.

Minimum cut length for Area Milling (10.0.1)

What is it?

In Area Milling operations, you can now specify a minimum cut length for the steep Zlevel pattern.

Minimum cut length: 0.000” Minimum cut length: 2.300”

Use the Minimum Cut Length option to determine which toolpaths to keep in the current operation.
NX removes tool path cutting motions that are smaller than your specified minimum cut length, and
cuts the Zlevel pattern with no holes or gaps.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Area Milling operation
Location in dialog
box

Area Milling Drive Method dialog box→Drive Settings group→Steep
Cutting

Cut region overlap in Area Milling (10.0.1)

What is it?

You can overlap the cutting motions between steep and non-steep regions in Area Milling operations.
Use the Overlap Steep and Non-Steep Regions option to specify the distance by which the
regions overlap.
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Zero overlap applied A .050” overlap applied

In the example shown, a .050” overlap has been applied. The .050” distance is divided by 2 and the
regions are extended towards each other by .025” while following the part geometry.

Why should I use it?

When you overlap the cut regions, you can sometimes achieve a smoother finish.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Area Milling operation
Location in dialog
box

Area Milling Drive Method dialog box →Steep Containment group
→Overlap Steep and Non-steep Regions

Divide a cut region using a line (10.0.1)

What is it?

In Area Milling operations, you can divide a cut region using a line with additional options. Use the
Divide by Line option to create and control the placement of the line. You can:

• Create points that NX uses to create the line.

• Project the line on to the part.

• Preview the division. If the regions are not what you expect, you can change the line.

After you create the line, NX can create a plane that slices through the line and divides the cut region.

To specify how you want the plane to be oriented, use one of the following Divide Plane options:
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Tool Axis

Use this option to project
the plane is projected
through the current tool
axis.

Normal to Tool Axis

Use this option to project
the plane perpendicular
to the tool axis.

Dynamic

Use this option if you
want to project the plane
using an angle that you
specify. You can either
enter a value or drag the
angel handle. The angle
is referenced from the
tool axis.

The cut region before any divisions. The cut region after using the
Tool Axis Divide Plane option.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Area Milling operation
Location in dialog
box [Area Milling operation] Cut Regions dialog box

Creating gouge free traverse moves in Zlevel operations (10.0.1)

What is it?

In Zlevel operations, for traverse moves, you can now avoid potential collisions between the cutter
and the part or IPW. To do this, you set a safe clearance value and then apply it.

• To set the value, use the Safe Clearance Distance option.
• To apply the value, use the Apply Safety Clearance to Direct option.

If you do not set a Safe Clearance Distance value, NX notifies you that a potential collision could
occur.
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Apply Safety Clearance to Direct Apply Safety Clearance to Direct

A 0.300” distance is used.

Option name change

In the Non Cutting Moves dialog box, on the Transfer/Rapid tab, on the Transfer Type list, the
Lowest Safe Z option is now named Direct / Previous Plane Backup.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Zlevel operation
Location in dialog
box

[Zlevel operation]→Path Settings→Non Cutting Moves→Transfer/Rapid
tab→Between Regions and Within Regions groups

Create smooth noncutting motions in Zlevel operations (10.0.1)

What is it?

You can override the engage, retract, and stepover motions within a region for Zlevel operations. To
do this, use the Override with Smooth Connections option on the Smoothing tab. NX outputs a
smooth continuous motion along a spline that is generated between cutting motions. You can specify
the following parameters on the Smoothing tab:

• The length and height of the smooth engage and retract motions

• Maximum stepover and part safe clearance

• The distance of the smoothing region

• The tolerance
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Override with
Smooth Connections

Override with
Smooth Connections

When machining electrodes for example, NX will apply safe clearances to Negative Part Stock values
for traverse moves. NX also creates consistent, smooth stepover lifts off the part for each pass. If a
smooth engage is not possible, NX notifies you and uses a plunge motion instead.

If you are not satisfied with the automatic start point of the tool path, you can specify the start point for
the region on the Start/Drill Points tab.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Zlevel operation
Location in dialog
box Non Cutting Moves dialog box→Smoothing and Start/Drill Points tabs

Tilt Tool Axis enhancements (10.0.1)

What is it?

There are new usability enhancements that keep the latest tool axis settings stored in the following
cases:

• If you generate a tool path using the OK command, and then stop it.

• If you generate a tool path and then use the UNDO command.

The Tilt Tool Axis dialog box now groups the options logically on the Tilting, Clearance, and
Machine Tool Characteristic tabs.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Command Finder Tilt Tool Axis
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Swarf Blade tool axis enhancement

What is it?

For blade finish operations, the Swarf Blade tool axis option better aligns with blades that are
appropriate for swarfing.

Previous versions Current version

If the flute of your tool is not long enough to swarf cut the entire blade in a single pass, NX uses the
same orientation for all of the cut levels.

Use the Tilt Clearance Angle option to specify a lead angle as the tool begins and ends the cutting
pass. Only positive values are allowed.

Tilt Clearance Angle = 20 Tilt Clearance Angle = 0

Note

We recommend the Swarf Blade tool axis option for blades with ruled surfaces. It is not
appropriate for blades with complex curvatures.
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Ruled surface with
perfect match Complex curvature risks overcuts or gouges

Where do I find it?

Initial release NX 9.0.1
Application Manufacturing
Command Finder

Create Operation
Location in dialog
box

Create Operation dialog box→Type list→mill_multi_blade→Operation

Subtype group→Blade Finish

Completely machine both sides of a blade without edge rolling (10.0.1)

In multi blade operations, the Blade Edge option controls where the path stops following the blade
geometry, and begins extensions that are not driven by the blade shape. You can now use the new
No Curling edge trimming option to prevent the cutter from curling over the blade edges. This is
helpful in the following cases:

• For blades with sharp corners at the trailing edge, the path follows the pressure and compression
sides, and extends tangentially without any curling around the sharp corners.

• For blades that are highly curved around the part axis, NX prevents fast changes in the path
direction as the path moves from the pressure side to the leading edge.

• For operations with the cut levels depth mode set to Offsets from Hub, when a cut level reaches
the shroud height, NX extends the path beyond the top edge of the blade without curling around
the blade.

For roughing and hub finish operations, NX automatically adds a small tangential extension so that all
passes of a cut level extend the same distance from the rotary axis.

For all operations, you can also enter an Extension value to extend the path tangentially. NX adds
any user specified extension after the automatic extension.
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The following examples show how the No Curling option automatically controls the tool path at the
leading and trailing blade edges. The stepovers are exaggerated to show detail.

Blade Edge = Along Blade
Direction

Blade Edge = Along Part
Axis

Blade Edge = No Curling
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Multi Blade operation

Location in dialog
box

[Multi blade operation] dialog box→Drive Method group→edit drive method

Blade rough, hub finish operations:

Multi Blade Rough Drive Method or Hub Finish Drive Method dialog
box→Leading Edge group

Blade finish operations:

Blade Finish Drive Method dialog box→Cut Periphery
group→Leading Edge subgroup

Blend finish operations:

Blend Finish Drive Method dialog box→Cut Periphery
group→Trailing Edge subgroup

Allowed violations of part geometry (10.0.1)

In the path settings for an operation, when you check for gouges, NX normally reports a gouge and
does not generate a gouging tool path.

For some situations, you implicitly authorize a gouge to the modeled body by defining a machining
feature that is not explicitly modeled. In these situations, NX generates a tool path and does not
report gouges within a defined feature volume. For authorized gouges, NX gouge checking reports No

gouged motions found.

The following are examples of implicitly authorized gouges.

Tapping and thread milling

Typically, you model only the tap diameter of a hole or the maximum thread diameter of a boss. NX
creates the feature volume during the machining feature recognition process.

Tapped hole volumes Thread mill boss volume Thread mill hole volume

4-44 What's new in NX

Chapter 4: CAM NX 9.0.1 — NX 10.0.1



CAM NX 9.0.1 — NX 10.0.1

Chamfering holes

You need not model the chamfer.

Chamfer volumes

Drilling holes at points

You can specify a hole feature at a point, without modeling the hole.

Modeled points Hole feature volumes
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Engraving

When you engrave text using Planar Text and Contour Text operations, the text to be cut exists
only as a 2D note. There is no corresponding feature volume, and the operation dialog box does not
contain a gouge checking option. No gouge is reported when you run a gouge check.

2D drafting note Tool path

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Feature volumes must be defined for the operation.

Operation
Navigator

Right-click operation→Gouge Check

Right-click operation→Tool Path→Verify→Replay→Gouge and Collision
Settings

Operation dialog box

Generate

Verify→Replay→Gouge and Collision Settings
Tool Path Editor
dialog box Analyze Tool Path group→Gouge and Collision Check

Simulation Control
Panel dialog box

For tapping and thread milling only:

Simulation Settings group→Simulation Settings →Simulation
Settings dialog box→Collision Detection group→Specify Collision Pairs

→Specify Collision Pairs dialog box→specify the part and the tool

Turning

Part Boundary dialog box enhancements

The look of the dialog boxes where you select boundary options in NX turning has changed.
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Pre-NX 9.0.2 NX 9.0.2

Turning workpiece

The names of boundary selection dialog boxes that you access from the Turn Bnd dialog box have
changed. To display the Turn Bnd dialog box:

• In the Geometry view of the Operation Navigator, right-click Turning Workpiece and choose
Edit.

Path to boundary selection
dialog box Pre-NX 9.0.2 name NX 9.0.2 name

Click Specify Part Boundaries
Part Boundary Part Boundaries

Click Specify Blank

Boundaries
Select Blank Blank Boundaries
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Turning operation

The name of boundary selection dialog boxes that you access from a turning operation have changed.

• Right-click any turning operation and choose Edit.

Path to boundary selection
dialog box Pre-NX 9.0.2 name NX 9.0.2 name

Geometry group→Custom
Part Boundary Data Part Boundary Part Boundaries

Teach Mode operation

The names of boundary selection dialog boxes that you access from a Profile Move type of Teach
Mode operation have changed.

1. Create a Teach Mode operation.

2. In the Teach Mode dialog box, in the Sub-Operations group, click Add New Sub-Operation

.

3. In the Create Teachmode Subop dialog box, from the Move Type list, select Profile Move.

Path to boundary selection
dialog box Pre-NX 9.0.2 name NX 9.0.2 name

Path Settings group→Drive
Geometry list→New Drive
Curve

Select Drive Geometry Part Boundaries

Start and Stop group→Start
Position list→Check
Curve→Start Check Geometry

Select Start Check Geometry Start Check Boundary

Start and Stop group→Start
Position list→Check
Curve→Stop Check Geometry

Select Stop Check Geometry End Check Boundary

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Hole machining

Boss milling and threading operations

What is it?

There are new operations to mill and thread boss geometry. You can select only boss geometry from
within these new operations.
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Boss Milling Boss Thread Milling

The following operations now machine only hole geometry.

Hole Milling

Thread Milling

The Specify Hole or Boss button is now called Specify Feature Geometry. Within each
operation you can select or edit only the appropriate feature geometry.

Why should I use it?

The new operation types make it easier to identify which operations mill holes and which operations
mill bosses.

Where do I find it?

Initial release NX 9.0.1
Application Manufacturing
Command Finder

Create Operation
Location in dialog
box

Create Operation dialog box→Type list→hole_making→Operation

Subtype group→Boss Milling or Boss Thread Milling
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Milling chamfers on holes

Mill hole chamfers using the Hole Chamfer Milling operation to cut a single chamfer on multiple
features.

• Select hole features to chamfer, or select geometry from the graphics window. You do not need
a modeled chamfer.

• For modeled chamfers, select chamfer machining areas to chamfer, or select geometry from the
graphics window. For unmodeled chamfers, select the cylindrical face to chamfer and specify
the counter sink diameter.

• When the angle of the cutter tip does not match the angle of the modeled chamfer:

o The operation leaves material if the cutter angle is less than the chamfer angle.

o The tool gouges if the cutter angle is greater than the chamfer angle. NX reports the gouges.
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The operation determines the in-process feature volume for the chamfer and creates a single circular
cut around the hole diameter.

Chamfer in-process feature volume Chamfer tool path

Tracking points

NX drives the tracking point you select as the drive point along the top edge of the chamfer. Usually
the tracking point is located on the cutting edge, but NX can use any tracking point that you select.

1 Tracking point on spot drilling tool used as the drive point in the operation

Note

Because the operation cuts chamfers on holes with or without a modeled chamfer, NX uses
the selected tracking point even if the tool gouges the part or cuts air.
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Contact and tracking data output

NX optionally outputs contact/tracking data at the tracking point defined on the tool diameter.
Otherwise, NX outputs the tool path at the tool tip centerline.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Prerequisite

A supported chamfering tool such as a chamfer mill, spot drill, or countersink
tool. The tool must have the following attribute:

• Defined tracking point.
Command Finder Create Operation

Location in dialog
box

Hole Chamfer milling operation

Create Operation dialog box→Type list→hole_making→Hole

Chamfer Milling

Selecting the tracking point

Hole Chamfer Milling dialog box→Path Settings group→Drive Point
list

Radial Groove Milling (10.0.1)

The Radial Groove Milling operation combines groove milling and hole milling to machine a
sequence of circular grooves with a T-cutter. The operation cuts in a circular pattern with multiple
radial and axial passes.

Your workflow can include multiple operations. Create a roughing operation that leaves stock on the
floor, ceiling, and side, and then remove the remaining material in a subsequent finishing operation.

You can manually select the groove geometry from within the operation, or use previously recognized
groove features within a feature group. NX updates the tool path when you regenerate if there are:

• Dimensional changes
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• Sequence changes

You can add grooves to the sequence or remove grooves from the sequence.

The Radial Groove Milling operation uses the same level sequencing options that are available
in Groove Milling. For Radial Groove Milling operations, the ceiling is the face closest to the
direction that the tool approaches from.

Ceiling to Floor Floor to Ceiling

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite T-cutter tool, enclosed groove

Command Finder Create Operation

Location in dialog
box

Create Operation dialog box→Type list→hole_making→Operation

Subtype group→Radial Groove Milling
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Drilling interrupted holes (10.0.1)

Use the Sequential Drilling operation to drill a sequence of coaxial holes.

You can:

• Create a feature group geometry parent first, or specify the geometry from within the operation.

• Set the cycle tracking point.

• Drill with or without chip break.

For the chip break cycle, you can also specify a clearance and retract for each hole segment.

• Slow the feed rate when the tool enters material, and again when the tool breaks through
material. Use the First Cut and Last Cut options to specify the distance and feed rates for
entering (1) and leaving (2) material.
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Interrupted hole features

For a Sequential Drilling operation, the Motion Output option is set to Interrupted Moves. This
tells NX to ignore empty spaces when it creates the feature geometry.

Hole feature

Motion Output = Machine Cycle

Hole feature

Motion Output = Interrupted Moves

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Command Finder Create Operation

Location in dialog
box

Create Operation dialog box→Type list→hole_making→Operation

Subtype group→Sequential Drilling

Machining through holes and blind holes together

You can group through holes and blind holes to machine them together. You save on programming
time because you do not have to program the through holes and blind holes separately. Use the
Predefined option of the Group Features command to group features that have identical diameters,
thread pitch, and number of steps. When it groups the features, NX ignores the values of all depth
attributes, including tolerances, chamfers and thread lengths.

How it works

In NX, through holes are STEPxHOLE features and blind holes are STEPxPOCKET features, where
x indicates the number of steps in the feature. When you group features using the Predefined
option, NX:

• Includes all STEP1HOLE and STEP1POCKET features with identical diameters in an
FG_STEP1HOLE_STEP1POCKET feature group.

• Includes all STEP1HOLE_THREAD and STEP1POCKET_THREAD features with identical
diameters and thread pitch in an FG_STEP1HOLE_THREAD_STEP1POCKET_THREAD
feature group.
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• Repeats the process for features with multiple steps.

If additional feature groups are required for holes with different diameters, NX
creates the feature groups and names them FG_STEP1HOLE_STEP1POCKET_1,
FG_STEP1HOLE_STEP1POCKET_2 and so on.
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The following example shows different hole feature profiles, and how NX groups the hole features
together.

Features to group
STEP1HOLE_1 STEP2HOLE_5

STEP1HOLE_2 STEP2HOLE_6

STEP1POCKET_3 STEP2POCKET_7

STEP1POCKET_4 STEP2POCKET_8

Features in the Machining Feature Navigator after grouping
WORKPIECE

FG_STEP1HOLE_STEP1POCKET
STEP1HOLE_1
STEP1HOLE_2
STEP1POCKET_3
STEP1POCKET_4
FG_STEP2HOLE_STEP2POCKET
STEP2HOLE_5
STEP2HOLE_6
STEP2POCKET_7
STEP2POCKET_8
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Sample part

Features selected for FG_STEP1HOLE_STEP1POCKET

Drilling operation for FG_STEP1HOLE_STEP1POCKET

The Group Features command also has the following options:

• None groups features whether or not the attributes are identical.

• All groups features only if all of the attributes are identical.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Machining Feature
Navigator

Right-click in the background→Group Features

Grouping selected features

Right-click selected features→Group Features
Location in dialog
box Group by group→Identical Attributes list →Predefined
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Enhancements to control drilling depth

You can control drilling depth for drills and step drills in the following ways.

• Apply a positive (1) or negative (2) bottom stock to blind holes.

• Apply a bottom offset (1) to through holes.

• Use the MODEL_DEPTH option to drill to the depth where the tool contacts the part.

Use this method to control cutting depth for hole features where depth attributes are not relevant
or not desired.

• Use the Position Tool Shoulder option to control whether the tool contact point is at the tool tip
or the tool shoulder.

Note

The Position Tool Shoulder option is separate from the MODEL_DEPTH option.

What's new in NX 4-59

CAM NX 9.0.1 — NX 10.0.1



Chapter 4: CAM NX 9.0.1 — NX 10.0.1

Drilling to tool contact depth

Use the MODEL_DEPTH option to drill to where the tool contacts the part. You control the drilling
depth by choosing whether the tool contact point is at the tool tip or the tool shoulder. In the following
example, (1) is a hole modeled with a flat bottom and (2) is a hole modeled with a tip angle.

Position Tool Shoulder = Position Tool Shoulder =

If you drill the hole with a tool that does not match the tip angle of the modeled hole, the operation will
either leave material or gouge the part.

• If you use the tool shoulder to position the tool, and the drill tip angle is less than the modeled tip
angle, the operation gouges the part.

• If you use the tool tip to position the tool, and the drill tip angle is greater than the modeled tip
angle, the operation drills as deeply as it can without gouging the part.
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The following example shows a hole feature modeled with a 122° tip.

Hole 102° drill tip 122° drill tip 130° drill tip

Position to tool shoulder

Gouges Exact match Leaves material
Position to tool tip

Leaves material Exact match Leaves material
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Conical holes

Use the Model Depth and Bottom Stock options to help you drill conical holes. The following
example shows the in-process features for the operations used to rough a tapered hole.

Volume to drill: 5 mm through hole with conical taper from 8 mm to 13 mm

4 mm drill

Bottom Stock = 0

Bottom Offset = 1.0

5.5 mm drill

Bottom Stock = 0.1

8 mm drill

Bottom Stock = 0.1

10 mm drill

Bottom Stock = 1.0
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Protecting part geometry below a through hole

Use the Model Depth and Bottom Stock options also for through holes when you need to extend the
depth of the in-process feature to the part geometry.

Note

When you select the Model Depth feature geometry setting, and the in-process feature of a
through hole extends to the part geometry, NX ignores the Bottom Offset cutting parameter
setting. NX uses the Bottom Stock setting instead.

The following example shows the in-process features and resulting tool path for different Machining
Area and Bottom Stock option settings.

Machining Area =
FACES_CYLINDER_1

Machining Area =
MODEL_DEPTH

1 Bottom Stock = 0

(contact point)

Machining Area =
MODEL_DEPTH

2 Bottom Stock = 5

Bottom Offset = 2 Bottom Offset = 2 Bottom Offset = 2
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Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Location in dialog
box

Drilling to model depth

Feature Geometry dialog box→Common Parameters
group→Machining Area list →MODEL_DEPTH

Positioning to the tool shoulder or tool tip

Feature Geometry dialog box→Common Parameters group→Cutting
Parameters subgroup→Position Tool Shoulder

Adding bottom stock to blind holes

Feature Geometry dialog box→Common Parameters group→Cutting
Parameters subgroup→Bottom Stock

Adding bottom offset to through holes

[Drilling operation] dialog box→Cutting Parameters→Cutting
Parameters dialog box→Strategy tab→Extend Path group→Bottom
Offset

Enhancements to optimize drill sequencing

You can optimize the drilling sequence in the following ways:

• Machine parts with holes arranged in a grid using a zig or zig-zag pattern to minimize tool
travel. Whenever possible, NX keeps the transition motions parallel to the axis or vector that
you specify as the primary pattern direction.

• Reverse the order of the listed hole or boss locations.

• Select a hole feature and make it the start or end location of the cutting sequence.

To see the machining order without generating the operation, preview the hole sequence.
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Defining the hole sequence

You can use the hole sequence defined in the HOLE_BOSS_GEOM geometry parent, or modify the
sequence for an individual operation.

Operation Navigator — Geometry

WORKPIECE
HOLE_BOSS_GEOM Defines the default hole sequence (1).

SPOT_DRILLING Uses the default sequence.
DRILLING Modified to use a reversed hole sequence (2).
COUNTERSINKING Uses the default sequence.

Use the Reload List From Parent sequencing option in the operation after changes in the
parent sequence.

Note

The options in the Sequence group in the Hole or Boss Geometry and Feature Geometry
dialog boxes always display the default settings. The sequencing options are actions that
NX execute when you click Reorder List. NX saves the resulting sequence without saving
the settings.
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Machining holes using a zig or zig-zag pattern

To minimize tool travel, machine parts with holes arranged in a grid using a zig or zig-zag pattern.
Whenever possible, NX keeps the transition motions parallel to the axis or vector that you specify as
the primary pattern direction.

The following example compares a zig pattern and a zig-zag pattern with the same start (1) point.
The primary pattern direction (2) is along the X-axis.

Zig pattern Zig-zag pattern

The following example compares two zig-zag patterns with the same start (1) point, but different
primary pattern directions (2).

Primary direction along X-axis Primary direction along specified vector
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Changing the start or end points

To make a feature the start or end location, select it and clickMove to top orMove to Bottom .

Caution

Specifying an end location when using a Zig or Zig-zag pattern is not recommended. NX
determines the appropriate end location for you.

The following example compares the Hole or Boss Geometry dialog box list and preview for a hole
sequence before and after changing the start location.

Hole sequence with STEP1HOLE_1 as the start location.

Item Name
1
2
3
4
5
.
.
.
25

STEP1HOLE_1
STEP1HOLE_2
STEP1HOLE_3
STEP1HOLE_4
STEP1HOLE_5
.
.
.
STEP1HOLE_25

Hole sequence with the start location changed to STEP1HOLE_5. Note that NX retains the original
names of the holes.

Item Name
1
2
3
4
5
.
.
.
25

STEP1HOLE_5
STEP1HOLE_4
STEP1HOLE_3
STEP1HOLE_2
STEP1HOLE_1
.
.
.
STEP1HOLE_21
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Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Location in dialog
box

Defining the sequence for multiple operations

Hole or Boss Geometry dialog box

Defining the sequence for a single operation

[Drilling operation] dialog box→Geometry group→Specify Feature
Geometry→Feature Geometry dialog box

Changing the sequence start or end location

Hole or Boss Geometry or Feature Geometry dialog box→Feature
group→List subgroup→Move to top or Move to Bottom

Zig or zig-zag pattern sequence

Hole or Boss Geometry or Feature Geometry dialog box→Sequence
group→Optimization→Primary Direction

Controlling the width for zig and zig zag hole patterns (10.0.1)

When you optimize a machining sequence, the default tolerance that NX uses for zig and zig zag hole
patterns can create additional passes when the holes are not aligned. Use the Band Width option
to specify a width that is large enough to include nearby holes in each pass. NX applies half of the
specified value to both sides of the pass center line.

Band Width = 1 mm (default value)
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Band Width = 40 mm

The first hole in each pass determines the center line for the pass. NX calculates the band width from
this center line, and the band width determines which holes to include in the pass. If you reverse the
machining order, a hole that was previously included in the pass could be excluded. NX machines
only those holes whose center lines fall within the band width.

In this example, the center lines of holes 2 and 3 are within the band width for the pass. NX includes
holes 1, 2, and 3 in the pass.

When the order is reversed, the center line of hole 2 is not within the band width for the pass. NX
includes only holes 1 and 3 in the pass.
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Note

You must enter the Band Width value each time you optimize the sequence.

The options in the Sequence group in the Hole or Boss Geometry and Feature Geometry
dialog boxes always display the default settings. The sequencing options are actions that NX
executes when you click Reorder List. NX saves the resulting sequence without saving
the settings.
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Where do I find it?

Initial release NX 9.0.3 MP2
Application Manufacturing

Prerequisite
Hole machining sequence with the Optimization option set to Primary
Direction.

Location in dialog
box

Hole or Boss Geometry or Feature Geometry dialog box→Sequence
group→Band Width

Reduce transition motions and machining time for drilling programs (10.0.1)

You can now optimize drilling operations across multiple features and workpieces to minimize
transition motions and machining time within a program.

• Reorder operations to minimize tool changes.

• Create optimization groups for further optimization and verification.

• Apply operation level sequencing at the optimized group level.

• Generate and verify tool paths at the optimized group level. The Optimize NC dialog box
includes the standard operation tool path actions.

Before optimizing

Operation Navigator, Geometry view

WORKPIECE
FG_STEP1HOLE

SPOT_DRILLING
DRILLING_UP
DRILLING_FINISH

FG_STEP1HOLE_STEP1POCKET
SPOT_DRILLING_2
DRILLING_UP_2

Operation Navigator, Program Order view

PROGRAM
SPOT_DRILL Contains two

operations
SPOT_DRILLING
SPOT_DRILLING_2

DRILL
DRILLING_UP
DRILLING_FINISH
DRILLING_UP_2
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After optimizing

Operation Navigator, Geometry view

WORKPIECE
FG_STEP1HOLE

SPOT_DRILLING
DRILLING_UP
DRILLING_FINISH

FG_STEP1HOLE_STEP1POCKET
SPOT_DRILLING_2
DRILLING_UP_2

Operation Navigator, Program Order view

PROGRAM
SPOT_DRILL

OPTIMIZED_NC
SPOT_DRILLING
SPOT_DRILLING_2

DRILL
DRILLING_UP
DRILLING_FINISH
DRILLING_UP_2
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Operation Navigator Right-click the program→Object→Optimize

Controlling non cutting moves for an optimized program group (10.0.1)

When you optimize multiple drilling operations at the program level, NX creates an optimized program
group, OPTIMIZED_NC. You can now specify non cutting moves for this program group, and these
moves override the non cutting moves defined in the individual operations.

By default, NX uses the non cutting moves defined in the first operation for the optimized program
group. You can use the default settings, or change the non cutting move settings for this program
group.

Operation Navigator, Program Order view

PROGRAM
SPOT_DRILL

OPTIMIZED_NC
SPOT_DRILLING
SPOT_DRILLING_2

DRILL
DRILLING_UP
DRILLING_FINISH
DRILLING_UP_2

Where do I find it?

Initial release NX 10.0.1
Application Manufacturing
Operation Navigator Right-click the program→Object→Optimize
Location in dialog
box Optimize NC dialog box→Non Cutting Moves

Tracking points for drilling tools

A tracking point is the internal reference point on the tool that NX uses to calculate tool paths.
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Drilling tools have two system-defined tracking
points at the center line, SYS_CL_SHOULDER
and SYS_CL_Tip.

Step drills have an additional system-defined
tracking point at the center line of each step.

For example, SYS_CL_STEP1_TOP is located
at the top of the first step.

You can also define additional tracking points anywhere on the tool to use in your operation.

Using the tracking points in the drilling operation

You can specify separate tracking points for the non cutting and the cutting moves of a drilling
operation.

• To ensure that the tool tip clears the part, select the tracking point at the tool tip for non cutting
moves.

• To ensure that a position on the tool reaches a certain depth, select the tracking point that
corresponds to that position. For example, select the shoulder of a drill, or a specific shoulder of
a step drill.

NX automatically changes to the correct tracking point for each type of move. For example, the
drilling operation could use the following system-defined tracking points:

• SYS_CL_Tip at the tool tip for all positioning and traversal moves.

• SYS_CL_SHOULDER at the tool shoulder for the cutting moves within the drilling cycle.

If the cycle output contains rapid moves, such as those for Break Chip or for interrupted holes,
the drilling operation would then use:

• SYS_CL_Tip for traversal, approach, and departure moves.
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• SYS_CL_SHOULDER for engage, cutting, and retract moves within the drilling cycle.

Example outputs for different drilling cycle tracking points

1 SYS_CL_TIP output:
GOTO/-25.352,89.572,-24.403

2 SYS_CL_SHOULDER output:
GOTO/-25.352,89.572,-22.000
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Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Prerequisite Drilling tool

Location in dialog
box

Define the tracking point:

Drilling tool dialog box→More tab→Tracking group→Tracking
Points→Tracking Points dialog box

Set the tracking point for non cutting positioning moves:

[Drilling operation dialog box]→Tool group→Cutter Compensation
subgroup→Tracking Data list

Note

To select a specific tracking point, you must customize the drilling
operation dialog box to include the cutter compensation Tracking
Data list. By default, NX uses the None option, which outputs the
tool path at the tool tip centerline.

Set the tracking point for the drilling cycle:

[Drilling operation dialog box]→Path Settings group→Cycle Tracking
Data list

Tracking points for chamfering tools (10.0.1)

A tracking point is the internal reference point on the tool that NX uses to calculate tool paths.

Chamfer milling tools have two system-defined tracking points at the center line and three
system-defined tracking points at the shoulder.

Spot drills and countersinking tools have an added tracking point in the middle of the chamfer.
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You can also define additional tracking points anywhere on the tool to use in your operation.
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Chamfer milling tool
Location in dialog
box

Chamfer milling tool dialog box→More tab→Tracking group→Tracking
Points→Tracking Points dialog box

Specifying tracking points for chamfered tools

You can specify the tracking point on a chamfered tool without specifying the distance from the tip. To
do this, use the By Diameter option. NX automatically calculates the correct distance from the tool tip.

If you enter a value that is greater than the maximum tool diameter, NX displays an alert and sets the
value to the maximum tool diameter.

To manually specify both the diameter and the distance from the tool tip, use the Full option.

Where do I find it?

Initial release NX 10.0
Application Manufacturing
Prerequisite Chamfered tool: chamfer mill, spot drill, or countersink tool

Location in dialog
box

Chamfered tool dialog box→More tab→Tracking group→Tracking

Points →Tracking Points dialog box→Definition list→By
Diameter or Full

Controlling retract moves for canned drilling cycles (10.0.1)

You can choose how NX outputs the retract moves for the canned cycles in a drilling operation.
To do this, use the Retract Output Mode option. Select the setting that matches the output to
your controller requirements.

• Clearance Only outputs the retract level as part of the canned cycle only when the retract
level is equal to the clearance level. In all other cases, NX turns off the cycle and generates an
explicit move to the calculated retract point.

• Clearance Initial outputs the retract level as part of the canned cycle when the retract level is
equal to the clearance level or equal to the initial level.
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• Always outputs the retract level as part of the canned cycle for postprocessors that can handle
this input. The cycle includes the final retract.

When the tool reaches the bottom of a hole, NX returns the tool to one of the following positions:

1. The initial level, which is the G98 position.

The initial level is defined as the last Z position before NX begins the cycle.

2. The defined R-plane, which is the G99 position.

The R-plane is the plane at which the drilling operation begins. NX defines the R-plane and the
clearance plane relative to the cycle level. For a constant clearance, if the cycle level changes,
so does the R-plane.

Note

The initial level does not change when drilling in G99 mode.

3. A Z value on or above the R-plane that is based on the noncutting moves settings.

The following examples show how the Retract Output Mode option affects the tool paths when using
the Lowest Safe Z, Clearance – Tool Axis, and Direct options for transferring between holes. The
holes are machined from left to right, omitting holes 7, 8, 15, and 16.

• Yellow = Departure

• Blue = Approach

• Green = Explicit traverse outside of the cycle

• Red = Implicit traverse within the cycle
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Lowest Safe Z

For the Lowest Safe Z examples, at the 6th hole, the retract level is below the clearance level, and
also below the initial level. At the 14th hole, the retract level is below the clearance level, but at
the initial level.

For the Clearance Only option, NX outputs a CYCLE/OFF statement at the 6th, 14th, and final holes.

Clearance Only, 3 cycles

For the Clearance Initial option, NX outputs a CYCLE/OFF statement at the 6th and final holes.

Clearance Initial, 2 cycles

For the Always option, NX outputs a CYCLE/OFF statement at the final hole.

Always, 1 cycle

Clearance – Tool Axis

For these examples, the clearance is to the bounding box.
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Clearance Only, 14 cycles

Clearance Initial, 2 cycles

Always, 1cycle

Direct

Clearance Only, 7 cycles
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Clearance Initial, 2 cycles

Always, 1 cycle
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Operation Type = hole_making
Location in dialog
box

[Drilling operation] dialog box→Machine Control group→Retract Output
Mode list

Feature group enhancements (10.0.1)

You now have the same control when using an automatic feature group that you have in a manually
defined HOLE_BOSS_GEOM geometry group. Operations within the feature group geometry
parent hierarchy also use the sequence defined in the feature group. In the Feature Group dialog
box, you can:

• Optimize the sequence of features within the group automatically, using one of the Optimization
options.

• Reorder the sequence of features within the group manually.

In the list, select one or more features and use the arrows to move the features as required.

• Reverse the machining direction of selected features.

When this dialog box is open, you can change the orientation of a single feature using the dynamic
manipulator.

You can control the preview color of the feature sequence using the Feature Sequence customer
default.

Tip

To find a customer default, choose File→Utilities→Customer Defaults, and click Find

Default .

If needed, you can still access the legacy classification dialog box.
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Optimize the feature sequence

Closest Primary Direction = X

Reverse machining direction

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Operation Navigator Double-click the feature group

Feature recognition enhancements (10.0.1)

NX now recognizes coaxial interrupted holes. The feature type is
HOLE_ROUND_INTERRUPTED_STRAIGHT.
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NX now recognizes radial grooves. The feature type is GROOVE_INS_RAD_RECT.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Machining Feature
Navigator Right-click in the background→Find Features

Machining unmodeled threads with gouge checking

When a modeled hole is the tap drill size, you now can obtain a tool path for tapping operations
without turning off gouge checking.

When you generate a tapping operation with the Gouge Checking option turned on, NX does not
detect a gouge in the threaded volume. Other gouges are still detected and reported.

The Gouge Check command and the gouge checking options in verification and simulation no
longer report a problem as long as:

• The hole in the part is larger than the minor diameter of the specified thread feature.

• The tool diameter is less than the major diameter of the thread feature.

The threaded volume that is used for gouge checking is the in-process feature for the hole, as shown.
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After a gouge check of the tapping operation in the part shown, the Information window contains
the following output:

Operation TAPPING: No gouged motions found.

Hybrid Gouge Checker used.
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Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Prerequisite Feature volumes must be defined for the operation.

Operation
Navigator

Right-click operation→Gouge Check

Right-click operation→Tool Path→Verify→Replay→Gouge and Collision
Settings

Operation dialog box

Generate

Verify→Replay→Gouge and Collision Settings
Tool Path Editor
dialog box Analyze Tool Path group→Gouge and Collision Check

Simulation Control
Panel dialog box

Simulation Settings group→Simulation Settings →Simulation
Settings dialog box→Collision Detection group→Specify Collision Pairs

→Specify Collision Pairs dialog box→specify the part and the tool

Allowed violations of part geometry (10.0.1)

In the path settings for an operation, when you check for gouges, NX normally reports a gouge and
does not generate a gouging tool path.

For some situations, you implicitly authorize a gouge to the modeled body by defining a machining
feature that is not explicitly modeled. In these situations, NX generates a tool path and does not
report gouges within a defined feature volume. For authorized gouges, NX gouge checking reports No

gouged motions found.

The following are examples of implicitly authorized gouges.

Tapping and thread milling

Typically, you model only the tap diameter of a hole or the maximum thread diameter of a boss. NX
creates the feature volume during the machining feature recognition process.

Tapped hole volumes Thread mill boss volume Thread mill hole volume
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Chamfering holes

You need not model the chamfer.

Chamfer volumes

Drilling holes at points

You can specify a hole feature at a point, without modeling the hole.

Modeled points Hole feature volumes
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Engraving

When you engrave text using Planar Text and Contour Text operations, the text to be cut exists
only as a 2D note. There is no corresponding feature volume, and the operation dialog box does not
contain a gouge checking option. No gouge is reported when you run a gouge check.

2D drafting note Tool path

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Feature volumes must be defined for the operation.

Operation
Navigator

Right-click operation→Gouge Check

Right-click operation→Tool Path→Verify→Replay→Gouge and Collision
Settings

Operation dialog box

Generate

Verify→Replay→Gouge and Collision Settings
Tool Path Editor
dialog box Analyze Tool Path group→Gouge and Collision Check

Simulation Control
Panel dialog box

For tapping and thread milling only:

Simulation Settings group→Simulation Settings →Simulation
Settings dialog box→Collision Detection group→Specify Collision Pairs

→Specify Collision Pairs dialog box→specify the part and the tool

Integrated Simulation and Verification - ISV

Finding machine, tool, and device components in a CAM or CMM setup

What is it?

In native NX, when you open a part that contains a CAM setup, NX Manufacturing has to find the
component parts for machine tools that you added for simulation. In previous releases, when the
assembly load options Load list was set to the default From Folder, NX searched for component
parts in the folder specified by the following environment variable:

UGII_CAM_LIBRARY_INSTALLED_MACHINES_DIR
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Beginning in NX 10, NX extends the search to the library tools and devices folders specified by
the following variables:

• UGII_CAM_LIBRARY_TOOL_DIR

• UGII_CAM_LIBRARY_DEVICE_DIR

In CMM inspection, the search is extended to the folders specified by the following variables:

• UGII_INSPECTION_LIBRARY_INSTALLED_MACHINES_DIR

• UGII_INSPECTION_LIBRARY_TOOL_DIR

• UGII_INSPECTION_LIBRARY_DEVICE_DIR

Why should I use it?

You can accept the default assembly load option Load list setting, From Folder, even when your
CAM setup includes machine tools, solid cutting tools, and devices.

Note

If you modify the standard locations, you must correctly set the variables shown.

In previous releases, if you did not set search
folders, NX did not display devices such as chucks
and the tailstock, and the cutting tools, in the
sim15_millturn_setup_sinumerik_mm_dual_sync.prt
sample setup assembly.
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In NX 10, although you initially get a warning
that several components are not found, NX
Manufacturing locates the tools and devices and
displays them.

Where do I find it?

Initial release NX 10.0
Application Manufacturing
Prerequisite Open a part that has a CAM setup

Saving and retrieving simulation settings

Use the Save Simulation Settings and Load Simulation Settings commands to save and load a
settings file that sets the default simulation parameters in the following dialog boxes:

• Simulation Settings and Animation groups in the Simulation Control Panel dialog box

• Simulation Settings dialog box

• Collision Pairs dialog box

You may have different simulation tasks, such as fast and rough checks, or long detailed checks. You
can save time by saving common simulation parameters in different settings files and loading the one
that you want when you need it. The files are saved to and retrieved from the folder specified by the
Saved Simulation Settings Directory simulation customer default.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

The file name of the current settings file is shown in the Current Settings row of the Manage
Settings group. If you do not specify a settings file, NX displays the label None.
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Where do I find it?

Initial release NX 9.0.1
Application Manufacturing
Location in dialog
box

Simulation Control Panel dialog box→Simulation Settings

group→Manage Settings subgroup→Load Simulation Settings and

Save Simulation Settings

Axis dynamic capabilities in the Machine Tool Navigator (10.0.1)

What is it?

Dynamic properties of axes are now stored in a common location, the NX machine tool assembly.
You enter the properties from the Machine Tool Navigator, using the Edit→Axis command. The
Machine Tool Navigator is available in the Manufacturing and Machine Tool Builder applications.

The following properties are new in NX.

For rotary axes and spindles For linear axes
Max Acceleration [deg/s^2]

Max Deceleration [deg/s^2]

Jerk Limit [deg/s^3]

Jump Velocity [deg/s]

Kv

Fine Precision [deg]

Coarse Precision [deg]

Max Acceleration [mm/s^2]

Max Deceleration [mm/s^2]

Jerk Limit [mm/s^3]

Jump Velocity [mm/s]

Kv

Fine Precision [mm]

Coarse Precision [mm]

Units of mm for linear axes are shown. For English units, in replaces mm.

When you retrieve a machine tool model, NX checks whether machine tool axis and channel data has
ever been modified or imported, and notifies you if the data has not been updated.

You can import axis dynamic and channel data from an MCF file or enter it manually. You will receive
a one-time message that the link between the kinematic model and the MCF is broken, and that
simulation will use the axis dynamic data in the part file.

Why should I use it?

• You do not have to enter the same information in multiple applications.

• You can enjoy the relative ease of using the Machine Tool Builder application, without having
to learn the more advanced Machine Configurator dialog box in the common simulation
environment (CSE).
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Where do I find it?

Initial release NX 9.0.3 MP1

Application

Manufacturing

Machine Tool Builder
Prerequisite An open NX assembly that contains a machine tool kinematic structure

Machine Tool Navigator

Right-click the root node→Import Axis and Channel Data

Right-click an axis node→Edit→Axis→Dynamic Properties group

Channels settings moved (10.0.1)

What is it?

You can now assign axes to channels in the Machine Tool Navigator in NX.

You can still assign a device or a tool holder to a channel to a in the Edit Machine Component dialog
box; however, the options to rename, add, or delete a channel are consolidated in the Channel
Configuration dialog box.

Why should I use it?

• You no longer have to use the Machine Configurator dialog box of the common simulation
environment (CSE) to assign axes to channels.

Where do I find it?

Initial release NX 9.0.3 MP1

Application

Manufacturing

Machine Tool Builder

Prerequisite An open NX assembly that contains a machine tool kinematic structure
Machine Tool
Navigator Right-click the root node → Channel Configuration

Toolpath verification and analysis consolidation (10.0.1)

What is it?

In previous releases, new functionality was added beside existing functionality. This resulted in some
duplication and confusion over which command to use for a given task. Some older functions are
now hidden by default in the Tool Path Verification dialog box.

2D Dynamic tab

The 2D Dynamic tab is now hidden. This protects you from issues that might arise if, for example, a
collision occurs but is not visible in the selected 2D view.

To restore the 2D Dynamic tab, select the Show 2D Dynamic Page customer default.
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Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

3D Dynamic tab

To ensure maximum reliability, on the 3D Dynamic tab, the Facetted Solid options are hidden.

We recommend that you click Show Thickness by Color to check the amount of excess material
that remains on the part.

We recommend that you use the following methods for gouge checking:

• Right-click an operation in the Operation Navigator and choose Tool Path→Gouge Check.

• In the Tool Path Verification dialog box, on the Replay tab, click Gouge and Collision Settings.

To restore the Facetted Solid options, select the Enable Facetted Solid for Gouges and Excess
customer default.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Postprocessing

MoriAPT CLSF

NX can now output the CLSF for single channel Mori Seiki machine tools in the MoriAPT format
developed by Mori Seiki. DMG/Mori Seiki provides a controller-based postprocessor and simulation
package for their CNC machines.

When you output your machining data in the MoriAPT format, you can cut parts on Mori Seiki
machines without having to create a postprocessor or postprocess the data in NX.

The MoriAPT format is an extension to the ISO4343 APT language format.

What's new in NX 4-95

CAM NX 9.0.1 — NX 10.0.1



Chapter 4: CAM NX 9.0.1 — NX 10.0.1

You must use the CLSF Output command, choose the MORIAPT format, choose a name and
location for the file, and create the output by clicking OK or Apply.

Note

Because there is no NC code file or postprocessor, you can simulate only the tool path in NX.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing
Menu Menu→Tools→Operation Navigator→Output→CLSF

Ribbon bar
[Select Operation or program group]→Home tab→Operation
group→More→Output CLSF

Location in dialog
box CLSF Format list→MORIAPT

Post Configurator (10.0.1)

Use the Post Configurator to create postprocessors for the following controllers in an efficient way:

• Sinumerik 840D

• Fanuc 18i

• Heidenhain iTNC 530

• Generic
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You can create a new post processor that is based on a loaded kinematic machine model. If the CAM
setup does not contain a kinematic model, you must set it up manually.

Why should I use it?

The Post Configurator offers a new way of creating postprocessors based on the established
manufacturing output manager (MOM) architecture. If you create post processors, you can use and
configure the included post libraries. There are three stages of licenses available for NX CAM users.

Basic
This license is available for all NX CAM users. It allows you to:

• Run a postprocessor that was created with Post Configurator.

• Edit parameters to which access is granted by the post processor developer.

Advanced
The license is intended for machine tool manufacturers and field service technicians.

It is available for all NX CAM users who currently own a Post Builder license. In addition to do the
tasks that you can do with the basic license you can:

• Create a new post processor.
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• Edit your post processor using the Post Configurator dialog box.

Full
The post developer license.

The license must be purchased. It is designed for Siemens Professional Services staff, Siemens
partners, and NX CAM users who are heavily involved in creating post processors. In addition to
the tasks that you can do with the advanced license, you can also:

• Edit the Tcl code.

• Encrypt your post processors.

• Limit the running of a post processor to a specific Sold-To ID.

• Define an expiration date for your post processors.

Note

When you create post processors using the Post Configurator, you can edit them only in the
Post Configurator. If you created post processors using the Post Builder, you will not be
able to edit them in the Post Configurator.

Where do I find it?

Application Manufacturing

Ribbon Home tab→Tools drop-down→Post Configurator
Menu Menu→Tools→Post Configurator

Feature-based Machining

Machining through holes and blind holes together

You can group through holes and blind holes to machine them together. You save on programming
time because you do not have to program the through holes and blind holes separately. Use the
Predefined option of the Group Features command to group features that have identical diameters,
thread pitch, and number of steps. When it groups the features, NX ignores the values of all depth
attributes, including tolerances, chamfers and thread lengths.

How it works

In NX, through holes are STEPxHOLE features and blind holes are STEPxPOCKET features, where
x indicates the number of steps in the feature. When you group features using the Predefined
option, NX:

• Includes all STEP1HOLE and STEP1POCKET features with identical diameters in an
FG_STEP1HOLE_STEP1POCKET feature group.
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• Includes all STEP1HOLE_THREAD and STEP1POCKET_THREAD features with identical
diameters and thread pitch in an FG_STEP1HOLE_THREAD_STEP1POCKET_THREAD
feature group.

• Repeats the process for features with multiple steps.

If additional feature groups are required for holes with different diameters, NX
creates the feature groups and names them FG_STEP1HOLE_STEP1POCKET_1,
FG_STEP1HOLE_STEP1POCKET_2 and so on.
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The following example shows different hole feature profiles, and how NX groups the hole features
together.

Features to group
STEP1HOLE_1 STEP2HOLE_5

STEP1HOLE_2 STEP2HOLE_6

STEP1POCKET_3 STEP2POCKET_7

STEP1POCKET_4 STEP2POCKET_8

Features in the Machining Feature Navigator after grouping
WORKPIECE

FG_STEP1HOLE_STEP1POCKET
STEP1HOLE_1
STEP1HOLE_2
STEP1POCKET_3
STEP1POCKET_4
FG_STEP2HOLE_STEP2POCKET
STEP2HOLE_5
STEP2HOLE_6
STEP2POCKET_7
STEP2POCKET_8
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Sample part

Features selected for FG_STEP1HOLE_STEP1POCKET

Drilling operation for FG_STEP1HOLE_STEP1POCKET

The Group Features command also has the following options:

• None groups features whether or not the attributes are identical.

• All groups features only if all of the attributes are identical.

Where do I find it?

Initial release NX 9.0.2
Application Manufacturing

Machining Feature
Navigator

Right-click in the background→Group Features

Grouping selected features

Right-click selected features→Group Features
Location in dialog
box Group by group→Identical Attributes list →Predefined
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Feature recognition for coaxial interrupted holes (10.0.1)

NX first tries to recognize a sequence of coaxial interrupted holes as the appropriate STEPx feature
so that the machining process is the same for holes with and without interruptions. If NX does not
recognize a sequence of coaxial interrupted holes as a regular stepped feature, it classifies the feature
as HOLE_ROUND_INTERRUPTED_STRAIGHT. The machining process is different for these holes.

In the following examples, both features consist of coaxial cylinders that extend through multiple
flanges.

STEP2HOLE

The lowest flange contains a STEP2HOLE
feature. The additional cylinders that extend
through the remaining flanges have the same
diameter as the largest STEP2HOLE diameter.

HOLE_ROUND_INTERRUPTED_STRAIGHT

The lowest flange contains a STEP1HOLE
feature. In this case, the diameters of the
additional cylinders in the remaining flanges
do not match the diameter of the STEP1HOLE
feature. This hole requires a different machining
process than a STEP1HOLE feature.

You can use both STEPx and HOLE_ROUND_INTERRUPTED_STRAIGHT features as input for
the Sequential Drilling operation.

Where do I find it?

Initial release NX 10.0.1
Application Manufacturing
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Machining Feature
Navigator Right-click in the background→Find Features

Feature recognition enhancements (10.0.1)

NX now recognizes coaxial interrupted holes. The feature type is
HOLE_ROUND_INTERRUPTED_STRAIGHT.

NX now recognizes radial grooves. The feature type is GROOVE_INS_RAD_RECT.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Machining Feature
Navigator Right-click in the background→Find Features
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Advanced Simulation

Solver version support (10.0.1)

For each released version of NX, the following tables list the supported solver versions for import,
export, and the post-processing of results. Note:

• The version listed in the Import ASCII and Import Binary rows is the solver version that was
generally available when the NX version was released. In general, the import of the solver ASCII
and binary files should be upwards compatible. Therefore, you should be able to import them into
the most recent version of NX. However, in general:

o ASCII files are backwards compatible for import into NX. If you import an ASCII file from a
newer version of the solver than is officially supported, the software simply ignores any new
fields/options that aren't supported in the current NX release.

o Binary files are not backwards compatible. For example, you can import a binary file created
by NX Nastran 5.0 into NX 6.0.2, but you might not be able to import a binary file created by
NX Nastran 6.1 into NX 5.

• The version listed in the Export ASCII rows is the solver version that was available when the
NX version was tested. In general, the exported solver input file is upwards compatible for that
solver. Backwards compatibility is not guaranteed. For NX Nastran, the Model Setup Check
function in Advanced Simulation tries to flag potential version incompatibility issues.

• The version listed in the Post-processing Results rows is the version of the solver results
that was tested in the listed NX version. In general, results from earlier solver versions are
also supported.

NX 10 releases

Solver File Type NX 10 NX 10.0.1
Import ASCII (.dat) 10 10
Import Binary (.op2) 10 10
Export ASCII (.dat) 10 10NX Nastran
Post-processing of Results (.op2,
.xdb)

10 10.1

Import ASCII (.dat) 2013.1 2014
Import Binary (.op2) 2013.1 2014
Export ASCII (.dat) 2013.1 2014MSC Nastran
Post-processing of Results (.op2,
.xdb)

2013.1 2014
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Solver File Type NX 10 NX 10.0.1
Import ASCII (.inp) 6.13 6.13
Import Binary N/A N/A
Export ASCII (.inp) 6.13 6.13
Post-processing of Results (.fil) 6.14 6.14-1

Abaqus

Post-processing of Results (.odb) 6.13-5 6.13-5
Import ASCII (PREP7, CDB) 15.0 15.0
Import Binary (.rst, .rth) 15.0 15.0
Export ASCII (.inp) 15.0 15.0ANSYS

Post-processing of Results 15.0 15.0
Import ASCII 971R6.0 971R6.0
Import Binary N/A N/A
Export ASCII (.k) 971R6.0 971R6.0LS-DYNA

Post-processing of Results 971R7.1 971R7.1

Permas Post-processing of Results (.res,
.post)

13 13

Import ASCII (.dat) 16.1 (build 16.1-02) 16.1 (build 16.1-02)
Import Binary (.sdb) 16.1 (build 16.1-02) 16.1 (build 16.1-02)
Export ASCII (.dat) 16.1 (build 16.1-02) 16.1 (build 16.1-02)SAMCEF
Post-processing of Results (.des,
.fac)

16.1 (build 16.1-02) 16.1 (build 16.1-02)

NX 9 releases

Solver File Type NX 9 NX 9.0.1 NX 9.0.2 NX 9.03
Import ASCII (.dat) 9 9 10 10
Import Binary (.op2) 9 9 10 10
Export ASCII (.dat) 9 9 10 10NX Nastran
Post-processing of
Results (.op2)

9 9 10 10

Import ASCII (.dat) 2013 2013 2013.1 2013.1
Import Binary (.op2) 2013 2013 2013.1 2013.1
Export ASCII (.dat) 2013 2013 2013.1 2013.1MSC Nastran
Post-processing of
Results (.op2)

2013 2013 2013.1 2013.1

Import ASCII (.inp) 6.12 6.12 6.12 6.12
Import Binary N/A N/A N/A N/A
Export ASCII (.inp) 6.12 6.12 6.12 6.12
Post-processing of
Results (.fil)

6.12-1 6.12-1 6.13-4 6.13-4Abaqus

Post-processing of
Results (.odb)

6.12 6.12 6.12 6.13-2
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Solver File Type NX 9 NX 9.0.1 NX 9.0.2 NX 9.03
Import ASCII (PREP7,
CDB)

14.5 14.5 15.0 15.0

Import Binary (.rst, .rth) 14.5 14.5 15.0 15.0
Export ASCII (.inp) 14.5 14.5 15.0 15.0ANSYS

Post-processing of
Results

14.5 14.5 15.0 15.0

Import ASCII 971R6.0 971R6.0 971R6.0 971R6.0
Import Binary N/A N/A N/A N/A
Export ASCII (.k) 971R6.0 971R6.0 971R6.0 971R6.0LS-DYNA
Post-processing of
Results

971R6.0 971R6.0 971R7.1 971R7.1

Permas Post-processing of
Results (.res)

13 13 13 13

NX 8 releases

Solver File Type NX 8 NX 8.0.1 NX 8.0.2 NX 8.0.3 NX 8.5 NX 8.5.1 NX 8.5.2
Import ASCII
(.dat)

8 8 8.5 8.5 8.5 8.5 8.5

Import Binary
(.op2)

8 8 8.5 8.5 8.5 8.5 8.5

Export ASCII
(.dat)

8 8 8.5 8.5 8.5 8.5 8.5NX
Nastran

Post-processing
of Results
(.op2)

8 8.1 8.5 8.5 8.5 8.5 9

Import ASCII
(.dat)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2012.1

Import Binary
(.op2)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2012.1

Export ASCII
(.dat)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2012.1MSC
Nastran

Post-processing
of Results
(.op2)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2013

Import ASCII
(.inp)

6.10 6.10 6.10 6.10 6.12 6.12 6.12

Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.10 6.10 6.10 6.10 6.12 6.12 6.12

Post-processing
of Results (.fil)

6.11 6.11 6.11 6.12-1 6.12-1 6.12-1 6.12-1Abaqus

Post-processing
of Results
(.odb)

6.10-EF1 6.11 6.11 6.11 6.12 6.12 6.12
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Solver File Type NX 8 NX 8.0.1 NX 8.0.2 NX 8.0.3 NX 8.5 NX 8.5.1 NX 8.5.2
Import ASCII
(PREP7, CDB)

13 13 14 14 14 14 14.5

Import Binary
(.rst, .rth)

13 13 14 14 14 14 14.5

Export ASCII
(.inp)

13 13 14 14 14 14 14ANSYS

Post-processing
of Results

13 13 14 14 14 14 14

Import ASCII 971R5.0 971R5.0 971R5.0 971R5.0 971R6.0 971R6.0 971R6.0
Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.k)

971R5.0 971R5.0 971R5.0 971R5.0 971R6.0 971R6.0 971R6.0LS-DYNA

Post-processing
of Results

971R5.0 971R5.0 971R5.0 971R5.0 971R6.0 971R6.0 971R6.0

NX7 releases

Solver File Type NX 7 NX 7.5 NX 7.5.1 NX 7.5.2 NX 7.5.3 NX 7.5.4 NX 7.5.5.
Import ASCII
(.dat)

6.1 7.0 7.0 7.1 7.1 7.1 8

Import Binary
(.op2)

6.1 7.0 7.0 7.1 7.1 7.1 8

Export ASCII
(.dat)

6.1 7.0 7.0 7.1 7.1 7.1 8
NX
Nastran

Post-processing
of Results

6.1 7.0 7.1 7.1 7.1 7.1 8

Import ASCII
(.dat)

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1

Import Binary
(.op2)

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1

Export ASCII
(.dat)

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1
MSC
Nastran

Post-processing
of Results

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1

Import ASCII
(.inp)

6.8-1 6.9–1 6.9–1 6.9-1 6.10 6.10 6.10

Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.8-1 6.9 6.9 6.9 6.10 6.10 6.10

Post-processing
of Results (.fil)

6.8-EF2 6.9.2 6.9.2 6.10-1 6.10-1 6.10-1 6.11-1Abaqus

Post-processing
of Results
(.odb)

6.8-EF2 6.9-EF1 6.9-EF2 6.9-EF2 6.10-EF1 6.10-EF1 6.10-EF1
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Solver File Type NX 7 NX 7.5 NX 7.5.1 NX 7.5.2 NX 7.5.3 NX 7.5.4 NX 7.5.5.
Import ASCII
(PREP7, CDB)

12 12.1 12.1 12.1 13 13 13

Import Binary
(.rst, .rth)

12 12.1 12.1 12.1 13 13 13

Export ASCII
(.inp)

12 12.1 12.1 12.1 13 13 13ANSYS

Post-processing
of Results

12 12.1 12.1 12.1 12.1 12.1 12.1

Import ASCII N/A N/A N/A N/A N/A N/A N/A
Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.k)

971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1LS-DYNA

Post-processing
of Results

N/A N/A 971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1

NX 6 releases

Solver File Type NX 6 NX 6.0.1 NX 6.0.2 NX 6.0.3 NX 6.0.4 NX 6.0.5
Import ASCII
(.dat)

6.0 6.1 6.1 6.1 6.1 7.0

Import Binary
(.op2)

6.0 6.1 6.1 6.1 6.1 7.0

Export ASCII
(.dat)

6.0 6.1 6.1 6.1 6.1 7.0
NX
Nastran

Post-processing
of Results

6.0 6.0 6.1 6.1 7.0 7.0

Import ASCII
(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import Binary
(.op2)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Export ASCII
(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1
MSC
Nastran

Post-processing
of Results

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import ASCII
(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Import Binary N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Post-processing
of Results (.fil)

6.7-5 6.8-1 6.8-3 6.8-EF2 6.8-EF2 6.8-EF2
Abaqus

Post-processing
of Results (.odb)

N/A N/A N/A 6.8-EF 6.8-EF2 6.9-EF2
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Solver File Type NX 6 NX 6.0.1 NX 6.0.2 NX 6.0.3 NX 6.0.4 NX 6.0.5
Import ASCII
(PREP7, CDB)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Import Binary
(.rst, .rth)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Export ASCII
(.inp)

11 11 SP1 11 SP1 11 SP1 12.0 12.0ANSYS

Post-processing
of Results

11 SP1 11 SP1 11 SP1 11 SP1 12.0 12.1

Import ASCII N/A N/A N/A N/A N/A N/A
Import Binary N/A N/A N/A N/A N/A N/A
Export ASCII (.k) 971R2 971R2 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA
Post-processing
of Results

N/A N/A N/A N/A N/A N/A

NX 5 releases

Solver File Type NX 5 NX
5.0.1

NX
5.0.2

NX
5.0.3

NX
5.0.4

NX
5.0.5

NX
5.0.6

Import ASCII
(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Import Binary
(.op2)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Export ASCII
(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1
NX
Nastran

Post-processing
of Results

5.0 5.0 5.1 5.1 5.1 5.1 6.0

Import ASCII
(.dat)

2005 2005 2007 2007 2007 2007 2007r1

Import Binary
(.op2)

2005 2005 2007 2007 2007 2007 2007r1

Export ASCII
(.dat)

2005 2005 2007 2007 2007 2007 2007r1
MSC
Nastran

Post-processing
of Results

2005 2005 2007 2007 2007 2007 2008r1

Import ASCII
(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1

Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1Abaqus

Post-processing
of Results

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.8-1

Import ASCII
(PREP7,
CDB)

10 10 11 11 11 11 11

Import Binary
(.rst, .rth)

10 10 11 11 11 11 11

Export ASCII
(.inp)

10 10 11 11 11 11 11
ANSYS

Post-processing
of Results

10 11 11 11 11 11 11 SP1
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NX 4 releases

Solver File Type NX 4 NX 4.0.1 NX 4.0.2 NX 4.0.3 NX 4.0.4
Import ASCII (.dat) 4.0 4.1 4.1 5.0 5.0
Import Binary (.op2) 4.0 4.1 4.1 4.1 4.1
Export ASCII (.dat) 4.0 4.1 4.1 5.0 5.0NX Nastran
Post-processing of
Results

4.0 4.1 4.1 5.0 5.0

Import ASCII (.dat) 2005 2005 2005 2005 2005
Import Binary (.op2) 2005 2005 2005 2005 2005
Export ASCII (.dat) 2005 2005 2005 2005 2005

MSC
Nastran

Post-processing of
Results

2005 2005 2005 2005 2005

Import ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6
Import Binary N/A N/A N/A N/A N/A
Export ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6Abaqus
Post-processing of
Results

6.5-1 6.5-1 6.5-1 6.6 6.6-3

Import ASCII
(PREP7, CDB)

8 9 9 10 10

Import Binary (.rst,
.rth)

8 9 9 10 10

Export ASCII (.inp) 8 9 9 10 10
ANSYS

Post-processing of
Results

9 9 9 10 10

General capabilities

Measuring the area and perimeter of polygon faces

What is it?

You can now use the Measure Face command to calculate the area and perimeter values of polygon
body faces. You can also perform the calculation in different analysis units. If you select the
Associative check box, NX creates:

• A Face Measure feature in the history for the FEM file.

• An expression for the area and the perimeter of each polygon face.

Note

If you clear the Associative check box, NX does not create the Face Measure feature
or the expressions.

Additionally, you can now use the Measure Area option in the Expressions dialog box to calculate
the area and perimeter of polygon body faces. With this option, NX always creates the Face Measure
feature and the expressions for area and perimeter for each polygon face.

In previous releases, you could use Measure Face or Measure Area to calculate the area and
perimeter of body faces only in the CAD part.
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Where do I find it?

Measure Face

Application Advanced Simulation
Prerequisite An active FEM file
Command Finder

Measure Face
Menu Analysis→Measure Face

Measure Area

Application Advanced Simulation
Prerequisite An active FEM file
Menu Tools→Expressions

Location in dialog box Measurements list

Enhancements to dialog boxes with tabs

What is it?

Dialog boxes that had multiple horizontal tabs in previous releases of NX have been enhanced to a
vertical layout. In previous releases, NX may have run slowly when you used these dialog boxes.
The new vertical layout is also easier to use.

The following are examples of dialog boxes that have been updated to this layout:

• Solution dialog box

• Solution Step dialog box (NX Multiphysics environment only)

• Materials dialog boxes

• Output Requests dialog box
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Where do I find it?

Application Advanced Simulation

Alternative workflow for editing 3D mesh and element properties

What is it?

You can now edit mesh and element properties for a 3D mesh using the Mesh Properties command.
In previous releases, the command supported only 2D meshes.

TheMesh Properties command lets you specify all mesh and element properties for a selected mesh.
This command is an alternative to the standard workflow of defining these properties using individual
commands such as Physical Properties, Edit Mesh Collector, and Mesh Associated Data.

Note

This command affects the properties only for the selected mesh, and not any other meshes
or elements. This is different from the standard workflow, in which you can share and inherit
properties across many meshes.

The Mesh Properties dialog box has three tabs:

• Element Properties— Lets you define element properties such as material orientation. This tab
corresponds to the Mesh Associated Data dialog box.

• Collector Properties— Lets you change the type of mesh collector in which this mesh is stored.
This tab corresponds to the Mesh Collector properties dialog box.
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• Physical Properties — Lets you define physical properties such as default thickness,
nonstructural mass, and material properties. This tab corresponds to the Physical Property
Table dialog box.

You can define the same properties for several selected meshes at the same time. To do this, select
the meshes and then open the Mesh Properties dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisites A FEM file as the work part and displayed part

The Simulation Navigator set to Mesh View
Command Finder

Mesh Properties
Graphics window Right-click one or more 2D or 3D meshes → Mesh Properties
Simulation Navigator Right-click one or more 2D or 3D meshes → Edit Mesh Properties

Additional grouping in Mesh View of Simulation Navigator

What is it?

When you view your meshes in the Mesh View of the Simulation Navigator, meshes are now
grouped according to their mesh type in addition to their element family.
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In previous versions, the Mesh View grouped the meshes only by element family.

Where do I find it?

Application Advanced Simulation
Simulation Navigator Right-click the Simulation Navigator column heading and choose Mesh

View.

Identifying objects by color

In the Simulation Navigator, the Color column lets you view and modify colors of various entities in
the graphics window.
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You can view and modify colors for the following entities:

• Polygon bodies

• Meshes

• Coordinate systems

• Boundary conditions

These include loads, constraints, and Simulation objects.

• Physical properties

The Color column for physical properties is visible only in the Physical Properties view. To
make the colors visible in the Physical Properties view, in the Model Display dialog box, on the
Element tab, set Color Basis to Physical Property Table.

• Materials

The Color column for materials is visible only in the Material view. To make the colors visible
in the Material view, in the Model Display dialog box, on the Element tab, set Color Basis to
Material Property Table.

To modify the color of an object, double-click the color in the Color column.

To assign a series of different colors to multiple boundary conditions, select the boundary conditions
or a folder containing multiple boundary conditions. Right-click and select Sequence Display Colors.
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Original colors Colors after using Sequence Display Colors

To modify the colors in the sequence, in the Customer Defaults dialog box, choose
Simulation→Boundary Conditions, and click the Sequence Display Colors tab.

Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite Boundary conditions applied to the model
Simulation Navigator Right-click multiple boundary conditions→Sequence Display Colors

Edge selection enhancements

What is it?

This release includes the following new methods to select connected edges.

• The Connected Edges method helps you select connected polygon edges.

First edge selected Connected edges highlighted

• The Connected Element Edges method helps you select connected element edges.
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First element edge selected Connected element edges highlighted

To start, select one or more polygon or element edges. When you move your mouse, NX highlights
additional connected polygon or element edges that you can select. Use the Smart Selector
Options dialog box to enter additional selection criteria for connected edges. You can specify free
edges, gaps, and gap tolerance.

This release also includes enhancements to path selection for the Thermal Stream command.
You can now select a single path of polygon edges that span multiple polygon bodies that are not
topologically connected. In previous releases, you could select only paths on edges that were
topologically connected. Use the new Path Selector Options dialog box to specify free edges, gaps,
and a maximum gap tolerance between edges.

Where do I find it?

Edge selection

Application Advanced Simulation
Selection bar Method list

Path selection

Application Advanced Simulation
Command Finder

Thermal Stream
Simulation Navigator Right-click the Load Container node→New Load→Thermal Stream

Representative graphics for local coordinate systems

What is it?

In this release, the graphical icons that appear in the NX graphics window for local coordinate
systems now visually indicate whether the coordinate system is Cartesian, spherical, or cylindrical.
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(1) Cartesian; (2) Spherical; (3) Cylindrical

Also, in the Visualization Preferences dialog box, you can now control the size of the coordinate
system display and control its visibility through the model. For example, to improve dynamic viewing
performance in models that have thousands of coordinate systems, you can turn off the coordinate
system display. For more information about new options related to coordinate systems and the View
Triad, see CSYS and View Triad enhancements.

Where do I find it?

Application Gateway, Advanced Simulation
Command Finder Visualization Preferences
Location in dialog box Visualization Preferences dialog box→View/Screen tab→Part Settings

group
Simulation Navigator Right-click CSYS→Display Settings

Solution Monitor enhancements

What is it?

• The Solution Monitor is now used by the NX Multiphysics and NX Nastran solvers.

• The Solution Monitor now displays text output for each solver on a separate tab when you run a
coupled NX Multiphysics analysis.

o The NX Multiphysics tab displays the text output for the coupled solver.

o The NX Thermal tab displays the text output for the thermal solver.

o The NX Nastran tab displays the text output for the NX Nastran solver.

• You can copy and paste the displayed text output. In previous versions, the displayed text output
was not selectable.

• The user interface of the Solution Monitor is refreshed and the command names are more
intuitive. The commands now have tooltips describing their functionality.
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Where do I find it?

Application Advanced Simulation, Design Simulation

Prerequisite

NX Nastran, NX Multiphysics, NX Thermal and Flow, NX Space Systems
Thermal, or NX Electronic Systems Cooling as the selected solver
environment

Command Finder Solve
Simulation Navigator Right-click a solution node→Solve

Viewing modeling objects in the Simulation Navigator

What is it?

You can view modeling objects in the Simulation Navigator. You can sort and filter the modeling
objects that will be visible. By default, the filter is set to All Off.

Support for non-ASCII characters

What is it?

You can now use multi-byte characters to name files and enter data in the Advanced Simulation,
Design Simulation, and Motion applications. For example, you can use multi-byte characters in the
names of:

• All Motion objects, such as joints and drivers.

• Solutions, solution steps, or subcases.

• CAE related files, such as FEM and Simulation files.

In NX, your specified locale controls the language used in the user interface as well as the code
set for storing character data. For example, if your locale is set to China, you can enter Chinese
character data in the NX user interface.

The graphic shows Chinese characters in the Simulation Navigator.
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NX follows the Unicode international standard to store multi-byte character data, using UTF–8
encoding. Although NX supports the use of multi-byte characters, many third party software packages
that interface with NX, such as finite element solvers, support only ASCII character data.

Caution

NX does not provide an error message if the solver receives unsupported characters. You
must verify that your solvers will support your desired locale before implementing localization.

Solver support for multi-byte characters

Solver Unicode support Solve with
non-ASCII
entities

Solve with
non-ASCII file

names

Export with
non-ASCII file
names and
entities

Import
with

non-ASCII
file names

and
entities

NX
Nastran

No Yes Yes Yes Yes

MSC
Nastran

No No No Yes Yes

Abaqus No No Yes Yes Yes
ANSYS No No No Yes Yes
NX
Nastran
Design

No Yes Yes Yes Yes

NX
Multiphysics
(Structural)

No Yes Yes N/A Yes

NX
Multiphysics
(Thermal/Mapping/Coupled)

No No No N/A Yes
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Solver Unicode support Solve with
non-ASCII
entities

Solve with
non-ASCII file

names

Export with
non-ASCII file
names and
entities

Import
with

non-ASCII
file names

and
entities

NX
Thermal/Flow
(Thermal/Advanced
Thermal,Flow/Advanced
Flow,
Coupled
Thermal-Flow,
Axisymmetric
Thermal)

No No No No Yes

NX
Thermal/Flow
(Mapping/Axisymmetric
Mapping)

No Yes Yes No Yes

LS-DYNA No Yes Yes Yes Yes
UNV No N/A N/A Yes Yes
Shape
Optimization

No No No N/A N/A

Topology
Optimization

No No No N/A N/A

Durability No No Yes N/A N/A
Geometry
Optimization

No Yes Yes N/A N/A

Adaptivity No Yes Yes N/A N/A
NX
Motion
Co-Simulation

No No No N/A N/A

NXMotion
Recurdyn

No Yes Yes N/A N/A

NXMotion
ADAMS

No Yes Yes N/A N/A

Fields

Complex data support

What is it?

When you create a table field, you can now define tabular data that has a complex dependent
domain. You can:

• Import the tabular data from a text file.

• Edit or create the tabular data in an external spreadsheet application.
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• Enter the tabular data directly.

Just like table fields with real domains, table fields with complex dependent domains are defined from
the Table Field dialog box. To specify a complex dependent domain, you must first access the
unfiltered listing of dependent domains.

The software accepts complex data in the real/imaginary format which is the default, or the
magnitude/phase format. To switch to the magnitude/phase format, in the Table Field dialog box, in
the Data Points table, right-click the (Real) or (Imaginary) column heading and choose Display
Magnitude/Phase.

Where do I find it?

Application Advanced Simulation
Simulation Navigator Right-click Fields→New Field→Table
Location in dialog box

Table Field dialog box→ClickRemove complex domains filter →1–D
list→Other→Independent domains list→select ComplexNumber

Extrapolation options

What is it?

You can now specify the extrapolation method when any Delaunay method is selected as the
interpolation method in the Table Field dialog box. In earlier versions of NX, you could specify the
extrapolation method only when Linear was selected as the interpolation method.

When you select a Delaunay method as the interpolation method in the Table Field dialog box, you
have the following extrapolation options: Undefined and Constant.

• Select Undefined if you do not want the software to assign a value to the dependent domain of
points whose independent domain lies outside the cloud of points defined by the tabular data.

• Select Constant if you want the software to do the following:

1. Identify the location on the surface of the cloud of points that is closest to the point whose
independent domain lies outside the cloud of points.

2. Interpolate the tabular data to calculate the value for the dependent domain at that location
on the surface of the cloud of points.

3. Use the interpolated value as the table lookup value for the point whose independent domain
lies outside the cloud of points.

The Constant option in NX 10 is equivalent to the default behavior when a Delaunay method is
selected as the interpolation method in earlier versions of NX.

Where do I find it?

Application Advanced Simulation
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Simulation Navigator Right-click Fields→New Field→Table
Location in dialog box Table Field dialog box→Interpolation list→Delaunay – Fast or

Delaunay – Medium or Delaunay – Accurate→Values Outside Table
list→Constant or Undefined

Graphical table editing

What is it?

When you create a spatial field, you can now obtain the coordinates for the tabular data directly from
the graphics window. In previous versions of NX, you had to explicitly enter the coordinates for the
tabular data. After you select a point in the graphics window, you must enter the corresponding
value of the dependent domain.

To support the new functionality, the new Points in Table dialog box is available. You type the value
of the dependent domain for the selected point in the Value field in this dialog box.

Where do I find it?

Application Advanced Simulation
Simulation Navigator Right-click Fields→New Field→Table
Location in dialog box Table Field dialog box→Data Points group→Graphical table editing

→Points in Table dialog box
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Creating an axisymmetric spatial field

What is it?

You can now create spatial fields with axisymmetric independent domains. The utility of an
axisymmetric spatial field is that NX can apply the axisymmetric spatial field, which is two-dimensional,
across a three-dimensional model. To facilitate this capability, Axisymmetric Plane is added to the
list of independent domains options in the Formula Field and Table Field dialog boxes.

Typical applications for this capability include:

• Using axisymmetric thermal results in a 3D structural model

• Mapping axisymmetric pressure data to a 3D surface

In both of these applications, you can use either a table field or a formula field.

• If you can describe how the dependent domain varies in the axisymmetric plane with a
closed-form mathematical expression, use a formula field.

• If you can describe how the dependent domain varies in the axisymmetric plane only with tabular
data, use a table field.

Where do I find it?

Application Advanced Simulation
Prerequisite In the New FEM or New FEM and Simulation dialog box, in the Solver

Environment group, from the 2D Solid Option list, select ZX Plane, Z
Axis or XY Plane, X Axis.

Simulation Navigator Right-click Fields→New Field→Expression or Table
Location in dialog box Formula Field or Table Field dialog box→Domain group→Independent

list→Axisymmetric Plane

4D field support

What is it?

Beginning with NX 10, you can create 4D fields. 4D fields are formula fields or table fields whose
independent domain includes both spatial coordinates and a single non-spatial variable like time,
temperature, or frequency. Mathematically, 4D fields allow you to model functional relationships
of the form:

f = f(x1,x2,x3,α)

where x1, x2, and x3 represent a set of Cartesian, cylindrical, spherical, or parametric spatial
coordinates, and α represents a non-spatial variable like time, temperature, or frequency.

You can use 4D fields to define the following boundary conditions:

• Acceleration

• Heat flux
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• Heat generation

• Nodal pressure

• Pressure

• Radiation

• Temperature load

• Convection

• Enforced displacement

• Thermal constraints

In earlier releases, you could define the magnitude of these boundary conditions only as a function of
a single non-spatial variable and define the distribution of these boundary conditions as a function of
spatial coordinates. The value of the boundary condition that NX applies at a node is the product
of the two functions.

For example, suppose the magnitude is defined as a function of time and the distribution is defined
as a function of Cartesian coordinates. The value of the boundary condition applied to node i at
time to is as follows:

bci = f(to) g(xi,yi,zi)

where:

• bci is the boundary condition value for node i at time to

• f(to) is the time-dependent function for the magnitude at time to

• g(xi,yi,zi) is the spatial function for the distribution

• (xi,yi,zi) are the Cartesian coordinates for node i

You can define the functional relationships using either formula fields or table fields, or both a formula
field and a table field.

The 4D field capability allows you to define both magnitude and distribution with a single function.
Thus, for the previous example, the value of the boundary condition applied to node i at time to is:

bci = h(xi,yi,zi,to)

You can define the functional relationship using either a formula field or a table field.

If the 4D functional relationship can be expressed as a closed-form mathematical relationship, you
can create the 4D field as a formula field. When NX evaluates the formula field for a given set of
spatial and non-spatial values, it simply evaluates the expression that relates the independent and
dependent domains at the given values. Because the evaluation is direct, formula fields are not
subject to interpolation errors.

If the 4D functional relationship can only be approximated by a set of tabular data that relates
the independent and dependent domains, you can create the 4D field as a table field. When NX
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evaluates the table field for a given set of spatial and non-spatial values at which a tabular data point
does not exist, it interpolates the tabular data to obtain the corresponding dependent domain value.

You can select the interpolation method that NX uses to look up values. The interpolation methods
applicable to 4D table fields are:

• Nearest neighbor and approximate nearest neighbor methods

• Renka’s modified Shepard method

• Inverse distance weighting method

These interpolation methods treat the non-spatial variable as a spatial variable in the interpolation
calculations. This is true even though the dimensions of the non-spatial variable typically differ
from the dimensions of the spatial variables.

If the table look up is only at locations where a data point is defined, the 4D interpolation effectively
becomes an interpolation over only the non-spatial variable. For such a case, errors arising from
treating the non-spatial variable as a spatial variable do not occur. However, for all other cases, you
should first consider the following alternatives:

• If you can relate the independent and dependent domains with a closed-form mathematical
relationship, create a 4D formula field instead of a 4D table field.

• If you can group the tabular data into a reasonable number of sets of spatial data points with
each set corresponding to a specific value of the non-spatial variable, create a table of fields
instead of a 4D table field. With a table of fields, two distinct interpolations occur during a table
look up. The first interpolation is over the spatial domain. The second interpolation is over the
non-spatial domain.

If a 4D formula field or a table of fields are not a viable alternative, and the table look up is not only at
locations where a tabular data point is defined, you can still minimize 4D interpolation errors as follows:

• Define enough tabular data points to ensure that a tabular data point is in close spatial and
non-spatial proximity to any look-up point.

• Use interpolation sub-options like Approximate Nearest Neighbor Tolerance and Interpolate
On to limit the distance from the look-up point that a tabular data point can be located and still
be included in the interpolation calculation.

Where do I find it?

Application Advanced Simulation
Command Finder Temperature Load
Location in dialog box Magnitude group→Temperature list→New Field→Formula Constructor

or Table of Fields Constructor→Domain group→Independent
list→Time, Cartesian
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Scaling fields that define boundary conditions

What is it?

In earlier versions of NX, when you defined a boundary condition, the Scale Factor box appeared in
the Magnitude group after you selected Field from the drop-down list.

In NX 10, the Scale Factor box does not appear when you define the boundary condition with a field.

Now, the edit button appears. To enter a scale factor, click , choose Scale Factor from the
list, and enter your value in the Scale Factor box in the Field Scale Factor dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisite Define the magnitude and distribution of a boundary condition with a field
Location in dialog box

Boundary condition dialog box→Magnitude group→Edit →list→Scale
Factor→Field Scale Factor dialog box→Scale Factor box

Scaling fields that define material properties

What is it?

You can scale fields that define material properties. In earlier versions of NX, when you used a
field to define a material property, you were not given an option to scale the field. Now, after you

assign a field to a material property, the edit button appears. To enter a scale factor, click ,
choose Scale Factor from the list, and enter your value in the Scale Factor box in the Field Scale
Factor dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisite Define a material property with a field
Location in dialog box Material property dialog box→Material property group→Edit

→list→Scale Factor→Field Scale Factor dialog box→Scale Factor
box

Expressions

Auto-generated expressions

What is it?

Now NX automatically generates expressions for a set of commonly used variables such as Cartesian
coordinates, frequency, time, temperature, and so on. For many of these variables, the names of the
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auto-generated expressions and the variable names are identical. Because you can enter expressions
directly in the formulas for other expressions, the need to use the UG variable function is eliminated.

For example, NX auto-generates an expression for the temperature variable. The name of the
auto-generated expression is temperature.

In earlier versions of NX, to enter the temperature variable in the formula for an expression, you
would type:

ug_var(“temperature”)

Now, to enter the temperature variable in the formula for an expression, you can type:
temperature

In this example, temperature is an expression name. Because expression names are not string
constants, you do not surround them in quotes.

NX also auto-generates expressions for any variables that you use to define the independent and
dependent domains of a field that otherwise would not be auto-generated.

For example, suppose you select strain as the independent variable of a field. When you create the
field, NX auto-generates an expression named strain. To include the strain variable in the formula for
an expression, you can type:

strain

where strain is an expression name.

When NX auto-generates expressions, it disallows blank spaces and some characters, and replaces
them as follows.

Disallowed character Disallowed character
description Replacement Replacement

character description
Blank space _ Underscore

. Period _ Underscore
( Parenthesis _ Underscore

) Parenthesis None. The character
is dropped.

{ Brace None. The character
produces an error.

} Brace None. The character
produces an error.

& Ampersand None. The character
produces an error.

– Dash None. The character
produces an error.

All expressions must have unique names. Because NX auto-generates expressions for certain
variables, duplicate expression names would occur if you opened a part that contains an expression
whose name is identical to one of the auto-generated expression names. To prevent this from
occurring, use the Variable Prefix, Rename Existing Expressions, and Rename Prefix customer
defaults.

• If the Rename Existing Expressions customer default is enabled, NX pre-pends the text string
defined by the Rename Prefix customer default to any existing expression names that are the
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same as an auto-generated expression name. NX does not use the Variable Prefix customer
default when Rename Existing Expressions is enabled.

• If the Rename Existing Expressions customer default is disabled, NX pre-pends the text string
defined by the Variable Prefix customer default to any auto-generated expression names that
are the same as an existing expression name. NX does not use the Rename Prefix customer
default when Rename Existing Expressions is disabled.

Where do I find it?

Application Advanced Simulation
Command Finder

Customer Defaults
Location in dialog box Simulation→Fields→Rename Existing Expressions or Rename Prefix

or Variable Prefix

Referencing fields in expressions

What is it?

Beginning with NX 10, you can reference a field in the formula for an expression with the new field
function. The field function is notated as fd( ). The argument for the field function is the name of the
field that is being referenced and optional entries that control how NX evaluates the field.

For example, you can apply the field function to a field that represents a function of a single
independent variable. Mathematically, such a function is expressed as f = f(x), where the independent
variable might be a spatial coordinate or a non-spatial variable like time or temperature.

Suppose the Simulation Navigator lists a table field named Table Field(1) that relates how pressure
varies as a function of time. To enter this field in the formula for an expression such that pressure is
returned at any time for which the expression is evaluated, in the formula, type:

fd(“Table Field(1)”)

Note

You must place quotes around string constants. Names of fields are string constants.

To enter this field in the formula for an expression such that the field is evaluated at a specific time,
in the formula, type:

fd(“Table Field(1)”,t0)

where t0 is the numerical value for the specified time.

You can also apply the field function to a field that represents a multi-variable functional relationship
like a function of two independent variables. Mathematically, such a function is expressed as f = f(x,y),
where the independent variables might be two spatial coordinates, or a single spatial coordinate and
a non-spatial variable like time or temperature, or a pair of non-spatial variables.

Suppose the Simulation Navigator lists a formula field named Formula Field(1) that relates how
pressure varies as a function of X- and Y-coordinates. To enter this field in the formula for an
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expression such that pressure is returned for any combination of X- and Y-coordinates for which the
expression is evaluated, in the formula, type:

fd(“Formula Field(1)”)

To enter this field in the formula for an expression such that the field is evaluated at a specific
X-coordinate, but over all Y-coordinates, in the formula, type:

fd(“Formula Field(1)”,X0,y)

where X0 is the numerical value for the specified X-coordinate.

Note

The order of independent variables is given in the Domain group of the dialog box for the field
that represents the multi-variable function.

To enter this field in the formula for an expression such that the field is evaluated at a specific
Y-coordinate, but over all X-coordinates, in the formula, type:

fd(“Formula Field(1)”,x,Y0)

where Y0 is the numerical value for the specified Y-coordinate.

To enter this field in the formula for an expression such that the field is evaluated at a specific
X-coordinate and a specific Y-coordinate, in the formula, type:

fd(“Formula Field(1)”,X0,Y0)

where X0 and Y0 are the numerical values for the specified X- and Y-coordinates, respectively.

With the field function, you can also do the following:

• Include mathematical operations within the argument of the field function

• Define composite functions

• Reference components of vector-valued functions

New functions for expressions

What is it?

New functions are introduced in NX 10 for defining expressions. The SIGN(v) function is implemented
across all NX applications. The other functions are supported only in the NX CAE application.

New general-purpose functions

Function Description
DR(“point name”) Returns the radial displacement of the input

point. The DR(“point name”) function is results
dependent.

DX(“point name”) Returns the X-displacement in the global
Cartesian coordinate system at the input
point. The DX(“point name”) function is results
dependent.
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Function Description
DY(“point name”) Returns the Y-displacement in the global

Cartesian coordinate system at the input
point. The DY(“point name”) function is results
dependent.

DZ(“point name”) Returns the Z-displacement in the global
Cartesian coordinate system at the input
point. The DZ(“point name”) function is results
dependent.

FD(“field name”) Returns the value for a field.
GAPD(“point name”) Returns the local gap distance at the input point.

The GAPD(“point name”) function is results
dependent.

KU(v) Converts temperature to Kelvin and removes the
units.

R(“point name”) Returns the radial distance from the axis of
rotation to the input point.

RS(“point name”) Returns the rotational speed at the input point.
SIGN(v) Returns -1 if the input value is negative, 0 if the

input value is 0, +1 if the input value is positive.
TEMP(“point name”) Returns the temperature of the solid at the input

point.
THICK(“point name”) Returns the thickness at the input point.
X(“point name”) Returns the X-coordinate in the global Cartesian

coordinate system at the input point.
Y(“point name”) Returns the Y-coordinate in the global Cartesian

coordinate system at the input point.
Z(“point name”) Returns the Z-coordinate in the global Cartesian

coordinate system at the input point.

New fluid-thermal functions

Function Description

ABS2REL
Returns the relative temperature of a fluid at a
given absolute temperature, radius, rotational
speed, and fluid swirl velocity.

ABS2REL_SR
Returns the relative temperature of a fluid at a
given absolute temperature, radius, rotational
speed, and fluid swirl ratio.

CONDFL(v) Returns the thermal conductivity of a fluid at a
given temperature.

DENSFL(v) Returns the density of a fluid at a given
temperature.

ENTHFL(v) Returns the specific enthalpy of a fluid at a given
temperature.

GAMMAFL(v) Returns the specific heat ratio of a fluid at a given
temperature.
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Function Description
MF(“point name”) Returns the local mass flow at the input point.
MIX(i1,i2,i3,.....,i10) Returns the temperature from mixing two or more

streams.
MMIX(i1,i2,i3,.....,i10) Returns the mass flow rate from mixing two or

more streams.
RE() Returns Reynold’s number for a flow over a

rotating body.
REL2ABS Returns the absolute temperature of a fluid at

a given relative temperature, radius, rotational
speed, and fluid swirl velocity.

REL2ABS_SR Returns the absolute temperature of a fluid at
a given relative temperature, radius, rotational
speed, and fluid swirl ratio.

REL2REL Returns the relative temperature of a fluid at a
given relative temperature, radius, rotational
speed, and fluid swirl velocity for another
rotational speed and fluid swirl velocity.

REL2REL_SR Returns the relative temperature of a fluid at a
given relative temperature, radius, rotational
speed, and fluid swirl ratio for another rotational
speed and fluid swirl ratio.

SA(i) Returns the convecting area of a stream.
SMO(i) Returns the outlet mass flow of the stream.
SP(i) Returns the maximum pressure of the stream.
SPECFL(v) Returns the constant pressure specific heat of a

fluid at a given temperature.
SSV(i) Returns the swirl velocity of the stream.
STI(i) Returns the stream inlet temperature.
STMO(i) Returns the outlet metal temperature of the

stream.
STO(i) Returns the stream outlet temperature.
TEMPF(“point name”) Returns the local metal temperature of the fluid

at the input point.
VA(i) Returns the convecting area of a void.
VISCFL(v) Returns the viscosity of a fluid at a given

temperature.
VP(i) Returns the maximum pressure of the void.
VSV(i) Returns the maximum swirl velocity of the void.
VT(i) Returns the maximum temperature of the void.
ZA(i) Returns the convecting zone area.
ZP(i) Returns the maximum pressure of the convecting

zone.
ZSV(i) Returns the maximum swirl velocity of the

convecting zone.
ZT(i) Returns the maximum temperature of the

convecting zone.

What's new in NX 5-29

CAE



Chapter 5: CAE

User-defined functions for expressions

What is it?

NX can now dynamically evaluate user-defined functions for expressions. Dynamically evaluated
functions update throughout an analysis.

User-defined functions are also known as plug-in functions. In earlier versions, NX could not
dynamically evaluate plug-in functions. Because of this, their output was fixed throughout an analysis.

Materials

Multiple Fluid material

What is it?

The new Multiple Fluid material type lets you define a primary fluid material and up to five additional
fluid materials.

The thermal solver uses the specified primary fluid material properties during computation. The
additional fluid material number can be passed as an argument to some CAE functions, such as fluid
plug-ins, and also to user-defined functions. See User-defined functions for expressions for more
information on plug-in functions.

You define the Multiple Fluid material type in the following loads and modeling object:

• Thermal Convecting Zone load

• Thermal Stream load

• Void Non-Geometric Element modeling object

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics or NX Thermal and Flow as the specified solver.

Defining the multiple fluid material

Command Finder Manage Materials
Location in dialog
box Type list→Multiple Fluid→ Create
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Specifying the multiple fluid material in loads

Command Finder Thermal Convecting Zone or Thermal Stream

Simulation Navigator
Right-click the Load container node→New Load→Thermal Convecting
Zone or Thermal Stream

Location in dialog
box Fluid Materials list

Specifying the multiple fluid material in the modeling object

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
Location in dialog
box

Type list→Void Non-Geometric Element→Create→Environment
group→Fluid Materials list

Norton-Bailey Power Law creep support in NX Multiphysics

What is it?

You can now use the Norton-Bailey Power Law creep model in Multi-step Nonlinear solutions when
NX Multiphysics is the specified solver.

You select this model in the Materials dialog box, on the Creep page, using the
Temperature-Dependent Time Hardening (Norton-Bailey) Power Law (Type 301) option. This
option corresponds to the new MATCRP bulk data entry, which is an alternate method for selecting the
Norton-Bailey creep model. It lets you define the coefficients of the power law equation as either
constant or temperature dependent.

In the Materials dialog box, you define the A, B, and D coefficients of this creep model in the
Constant Multiplier (a), SIGMA Exponent (b), and Hardening Exponent (d) boxes.

• To define creep at a single temperature, enter real values for the coefficients.

• To define creep as temperature dependent, define a table field for the coefficients. The table
corresponds to the TABLEM1 bulk data entry.

Checking system units

A Check Unit System option is added to the new Type 301 power law as well as to the existing Time
Hardening (Norton-Bailey) Power Law Type 300. This option checks for inconsistent units in the
solution and the creep coefficients. NX checks when the solver input file is exported and alerts you if
the solution units are not consistent with the creep coefficient units. NX cannot convert the creep
coefficient units when it exports the solver input file.
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Controlling creep effects

For NX Multiphysics, you can now turn off creep effects at the solution level and subcase level. For
more information, see Controlling plasticity and creep effects.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver and an active Multi-step Nonlinear

solution

or

NX Nastran as the specified solver and an active SOL 601,106 Advanced
Nonlinear Statics solution

Command Finder
Manage Materials

Location in dialog box
Create Material →Creep page

Samcef damage properties

What is it?

The Samcef damage material models predict the fibers breaking, the matrix cracking, and the
de-cohesion between fibers and the matrix. Delamination between two plies is also taken into account.

When you create orthotropic materials, you can use options on the new Damage page in the
Orthotropic Material dialog box to model Intra-laminar failure. You can define a progressive
damage model for a general orthotropic ply, for an enhanced ply (NCF), as well as for woven fabrics.

For these material models, you can specify properties such as:

• Nonlinear behavior in fiber direction.

• Damage evolution in the matrix, including coupling effects in shear and transverse directions.

• Plasticity behavior in the matrix.

You can also use the Manage Materials dialog box to create Damage Interface materials for
cohesive elements.

Where do I find it?

Damage Interface material

Application Advanced Simulation
Prerequisite Samcef as the specified solver.
Command Finder

Manage Materials
Location in dialog box

Type list→Damage Interface→Create Material
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Damage material model for orthotropic materials

Application Advanced Simulation
Prerequisite Samcef as the specified solver.
Command Finder

Manage Materials
Location in dialog box

Type list→Orthotropic→Create Material →Damage page

Adding material properties to existing library definitions

What is it?

You can now add material properties to existing material library definitions using a correctly structured
XML file. You can define these custom properties so that they appear in the materials dialog boxes on
existing material property tabs or on new tabs. The custom properties always appear in new groups
on the dialog box. If you define a property on a new tab and do not specify a name for the tab,
the new tab is displayed as DefaultTabName.

You add material properties using an XML file with a .udmpx extension.

The DTD for this customization capability resides in the NX installation structure as
\..\ugii\materials\usermaterialsdefinitions.dtd. The DTD defines the structure and legal elements of
the XML file that you must provide.

Your users will be able to populate and edit these custom properties using the NX material dialog
boxes, provided the NX session has the customization. To make the custom properties available
to your users, you can place this XML file in any UGOPEN_STARTUP_DIR folder, such as
UGII_USER_DIR\\startup, UGII_SITE_DIR\\ startup, and UGII_VENDER_DIR\\startup.

If a material defined and saved in NX contains a user-defined property, the property remains in the
material object even when another NX session that does not have the customization opens the part.
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User-defined properties added to a new tab

Support for plastic strain material nonlinearity in NX Multiphysics

What is it?

In the NX Multiphysics environment, you can now define a stress-dependent material with plastic
strain properties. In the Materials dialog boxes, on the Mechanical page, a new Type of
Nonlinearity option PLSTRN has been added.
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This option corresponds to the MATS1 bulk data entry with TYPE=PLSTRN. For more information, see
MATS1 in the NX Nastran Quick Reference Guide.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver

An active Multistep Nonlinear solution
Command Finder

Manage Materials
Location in dialog box

Create Material →Mechanical page→Stress-Strain Related
Properties group→Type of Nonlinearity=PLSTRN

Support for stress-strain related properties in orthotropic and anisotropic materials

What is it?

You can now specify stress-strain properties for orthotropic and anisotropic materials. The Materials
dialog boxes include the Stress-Strain Related Properties group of options when you create a
new orthotropic or anisotropic material.

For the corresponding syntax for each solver, see Stress-strain input as engineering or true
stress-strain.

Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran, MSC Nastran, ANSYS, Abaqus, or LS-DYNA as the specified

solver.
Command Finder

Manage Materials
Location in dialog box

Create Material →Mechanical page→Stress-Strain Related
Properties group

Stress-strain input as engineering or true stress-strain

What is it?

You can now specify stress-strain data for nonlinear materials as either engineering stress-strain
or true stress-strain.

When writing out the solver input file, NX converts the stress-strain data depending on the specified
solver. When NX Nastran is the solver, NX additionally takes into account the type of solution and
the setting of the Type of Nonlinearity option. The output stress-strain data is in the same units
as the input stress-strain data. The units of Young’s Modulus should be consistent with the input
stress-strain data.
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In the Materials dialog boxes, on the Mechanical page, the Stress-Strain Related Properties group
includes a new option, Stress-Strain Input Data Type, with these available types:

• Engineering Stress-Strain (default)

• Engineering-Plastic Strain

• True Stress-Log Strain

• True Stress-Plastic Strain

• Undefined

When they are migrated from earlier versions of NX, materials that contain stress-strain property data
are set to the Undefined type automatically.

Conversion details

Solver Solution type

Type of
Nonlinearity
option
(corresponds to
the TYPE field on
MATS1)

NX converts to Corresponding
solver syntax

NLELAST

PLASTIC

There is no
conversion.

Stress-strain
data is written
out directly as
specified in the
material data.

MATS1,
TYPE=NLELAST

MATS1,
TYPE=PLASTICSOL 601,106

PLSTRN
Not supported.

A fatal error is
reported.

N/A

NLELAST

PLASTIC
Engineering
Stress-Strain

MATS1,
TYPE=NLELAST

MATS1,
TYPE=PLASTIC

Nastran

SOL 106

PLSTRN

Engineering
Stress-Strain

TYPE is changed
to PLASTIC.

MATS1,
TYPE=PLSTRN
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Solver Solution type

Type of
Nonlinearity
option
(corresponds to
the TYPE field on
MATS1)

NX converts to Corresponding
solver syntax

NLELAST
Not supported.

A fatal error is
reported.

N/A

PLASTIC Engineering
Stress-Strain

MATS1,
TYPE=PLASTIC

NX Multiphysics Multi-Step
Nonlinear

PLSTRN
Engineering
Stress-Plastic
Strain

MATS1,
TYPE=PLASTIC

Abaqus All N/A True Stress-Plastic
Strain *PLASTIC keyword

ANSYS All N/A True Stress-Log
Strain

Depends on
the Material
plasticity model
(stress-strain
option) that is
selected in the
Solution dialog
box.

• TB, MELAS

(default)

• TB, MISO

• TB, KINH

LS-DYNA All N/A True Stress-Plastic
Strain

*MAT_PIECEWISE_LINEAR_PLASTICITY

keyword (constant
temperature only)

Samcef Nonlinear PLASTIC
Samcef

Biot , Cauchy, or
Kirchoff laws

.MAT

BIOT/CAUCHY/KIRCHOFF

Note

When Stress-Strain Input Data Type is set to Undefined, NX writes out the stress-strain data
directly as specified in the material data and does not perform a conversion.

For example, if you enter engineering strain into NX for an ANSYS solution, NX performs the
conversion from engineering strain to true strain as follows.

Type Conversion
Engineering Strain → Log (True) Strain
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Type Conversion

Engineering Stress → True Stress

Where:

εT = Engineering Total Strain

εe = Engineering Elastic Strain

εp = Engineering Plastic Strain

S = Engineering Stress

v = Poisson’s Ratio

σ = True Stress

εl = Log (True) Strain

E = Young’s Modulus

Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran, MSC Nastran, NX Multiphysics, Samcef, Abaqus, ANSYS, or

LS-DYNA as the specified solver
Command Finder

Manage Materials
Location in dialog box

Create Material →Mechanical page→Stress-Strain Related
Properties group

Geometry idealization and abstraction

Midsurface thickness source enhancements

What is it?

In the Mesh Associated Data dialog box, when you select Midsurface as the source of the thickness
for a 2D mesh, you can use options on the new Thickness Evaluation Type list to control the
location and manner in which the software evaluates the thickness:

• Select At Every Node to have the software perform ray casting operations to compute the
thickness at each node in the mesh associated with the midsurface. For example, at a triangular
element, the software casts rays from each of the element’s nodes to determine the thickness
values.
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• Select At Element Centroid to have the software perform a single ray casting operation at the
centroid of each element to determine the thickness value. With this option, the software then
assigns the same thickness value to all of the element’s nodes. The At Element Centroid
option offers slightly improved performance over the At Every Node option as the software
performs fewer calculations.

• Select Average Feature Thickness to have the software extract the average thickness value for
midsurface face pairs defined with the Midsurface by Face Pairs, Offset Midsurface, or the
User Defined Midsurface commands. This option is the fastest way to evaluate the thickness
as the software does not have to perform any ray casting calculations. It is the recommended
option for constant thickness parts.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part
Command Finder

Mesh Associated Data
Location in dialog box Element Properties group

Excluding geometry from abstraction

What is it?

Use the new Freeze Geometry command to designate faces that should be excluded from most
automatic or manual geometry abstraction processes. When you use the Freeze Geometry
command on a set of faces:

• The software does not perform any automatic abstraction or geometry cleanup operations on
those faces during 2D or 3D meshing.

• You cannot select those faces for use with most polygon geometry commands. For example,
you cannot use the Stitch Edge command to modify a face on which you have previously used
the Freeze Geometry command.

You can continue to use the Split Edge and Merge Edge commands on faces that you select with
the Freeze Geometry command.

New Freeze_Geometry node in the Simulation Navigator

NX stores the faces that you select as a Freeze_Geometry recipe in the CAE Geometry Recipes
folder in the Simulation Navigator.
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You can use the Freeze_Geometry nodes in the Simulation Navigator to:

• Rename the frozen geometry recipes.

• Display the locations of the frozen geometry.

• Delete selected frozen geometry recipes.

• Edit the faces in the frozen geometry recipes. You can add or remove faces from the recipe.

If you decide you want to later re-include frozen geometry in abstraction operations, delete the
appropriate Freeze_Geometry node. Deleting the node will not change the polygon geometry
or trigger an update of the FEM file; the faces are available for selection with manual abstraction
commands and are included in any automatic abstraction operations.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the work part and displayed part
Command Finder

Freeze Geometry
Menu Insert→Model Cleanup→Freeze Geometry

Surface Wrap commands support

What is it?

All commands on the Surface Wrap tab are now accessible from all solver environments supported
in NX. These are:

• NX Thermal/Flow

• NX Electronic Systems Cooling

• NX Space Systems Thermal

• NX Multiphysics

• NX Nastran

• NX Nastran Design
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• MSC Nastran

• Samcef

• Abaqus

• ANSYS

• LS-DYNA

Why should I use it?

You can generate surface wrap bodies that you can use to create your simulation model in all
solver environments.

Surface wrapping enhancement

What is it?

When you use the Create Surface Wrap Body command, you can now generate a surface wrap
body by selecting imported meshes that are not associated to a polygon body. You can select 2D
shell elements or 3D element free faces.

You can select both polygon bodies and elements in the same surface wrap recipe.

Note

Because imported meshes have no polygon edges, the Snap to Source Edges check box
does nothing.

In previous releases, you could select only polygon bodies and the command name was called
Create Surface Wrap Fluid Domain. NX now creates surface wrap bodies instead of fluid bodies.

Why should I use it?

You can generate surface wrap bodies from models for which you only have meshes.

Where do I find it?

Application Advanced Simulation
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Prerequisite Import a meshed model into a FEM.

Command Finder Create Surface Wrap Body

Simulation Navigator
Right-click the Surface Wrap Recipes node→New Surface Wrap Fluid
Domain

Location in dialog
box Surface Wrap Boundaries group

Synchronizing polygon body names to the CAD part

What is it?

Use the new Synchronize to CAD Name command in the Simulation Navigator to synchronize
the names of bodies in a part file and the names of the corresponding polygon bodies. This allows
you to rename selected polygon bodies to be consistent with the names of the corresponding bodies
in the associated CAD part.

Note

You can only use the Synchronize to CAD Name command if the associated CAD part
is loaded.

You cannot use the Synchronize to CAD Name command to rename:

• A polygon fluid body.

• A polygon body that is created from 2D elements or from 3D element free faces using the Face
from Mesh command.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part

The CAD part associated with the FEM file loaded
Simulation Navigator In the Polygon Geometry folder, right-click one or more Polygon Body

nodes→Synchronize to CAD Name

Meshing

Adaptive meshing enhancements

What is it?

This release introduces a new adaptive meshing capability into NX. This capability builds upon the
adaptive analysis solution process that was available in previous releases. These enhancements
include:

• An expanded range of supported analysis types, including both thermal and multi-physics
analyses.
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• Global and local refinement options for the mesh.

• The ability to exclude certain regions of the mesh from the adaptivity process.

In Advanced Simulation, you can use the Adaptivity solution process to set up and run adaptive
meshing.

Benefits of the adaptive meshing process

Adaptive analysis automates the lengthy and repetitive process of running multiple finite element
analyses with different mesh densities. The mesh refinement is determined by stress, strain energy,
and temperature error estimates associated with element stress and strain discontinuities. Based on
these error estimates, the software identifies critical regions on the model which become the target
for further refinement of the mesh in subsequent iterations.

Supported solvers and analysis types

Solution type Solvers Notes
Linear statics analysis NX Nastran, MSC Nastran, Abaqus,

ANSYS
The mesh error is calculated by NX
during the adaptivity process.

Thermal analysis
(steady-state and
transient)

NX Thermal The mesh error is calculated by
the NX Thermal solver during the
adaptivity process.
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Solution type Solvers Notes
Coupled thermal and
structural (linear and
non-linear) analyses

NX Multiphysics The thermal and structural mesh
errors are calculated independently.

• NX Thermal calculates the
thermal error.

• NX Nastran calculates the
structural error.

The thermal and structural solvers
output independent mesh error
values.

Mapping solution NX Multiphysics • You can include one mapping
solution in the adaptive process.

• NX solves the mapping solution
prior to solving the main solution
in each iteration. The software
then provides the results from
the mapping solution to the
primary solution.

Supported element types

You can use adaptive meshing to refine meshes of the following general types of elements:

• Triangular elements

• Quadrilateral elements

• Tetrahedral elements

You can include other types of elements in a model in which you use an Adaptivity solution process.
However, the software ignores those element types during the refinement process. Other elements
must be geometry-based if they are connected directly to adaptive meshes. You can also create
contact or glue definitions to connect other types of elements to adaptive meshes.

Control over adaptive mesh parameters

You can use the options in the Adaptivity Meta Solution dialog box to control how NX remeshes the
model during the adaptivity analysis. For example, the Adaptivity solution process now supports
both local and global mesh refinement. You can use the Meshing Method list to control the scope of
the error calculation and error analysis. For example:

• Select Local to have the software remesh only the regions where the specified error norms are
high. With Local refinement, NX refines only the mesh on the faces where the error norms
are high and the neighboring faces.

• Select Global to have the software remesh the entire part. With Global refinement, NX refines
the mesh on all faces.
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You can also control the number of iterations that NX performs during the analysis, as well as the
maximum level of element refinement.

Excluding regions from adaptive refinement

You can use options in the new Adaptivity Exclusion Zone dialog box to define regions of the mesh
that you want to exclude from adaptive refinement. The software treats these zones as converged
regions that require no refinement. Exclusion Zone items are stored in the Simulation Navigator
under the Adaptivity solution process node. For example, you may want to define an Exclusion
Zone in a region to exclude regions of a part that are not critical to your current analysis.

Note

These regions may still remesh due to changes in the meshes on neighboring regions.
However, changes to the mesh in an exclusion zone are not influenced by the error estimates
in that region.

Accuracy parameters

In the Adaptivity Setup dialog box, you must define the accuracy parameters for the adaptivity
process. These parameters, which are also known as error estimates, are the criteria that the
software uses to determine whether the solution has converged. The accuracy parameters that the
software uses depend upon the analysis type of your solution. For example:

• For structural analyses, NX Nastran generates strain energy norm errors, stress energy norm
errors, or both error values.

• For thermal analyses, NX Thermal generates temperature error norm results.

For example, for NX Thermal analyses, the solver supports an output estimate of the local error in the
temperature on nodes and elements at each output time. The software uses the maximum error at
each node over all integration time steps, along with the time at which the maximum occurs, as the
input for refining the mesh.

Adaptive meshing output

When the software completes the final iteration, it saves several different types of output. This
output includes:

• The solution results, including the error listing for the final iteration only.

• The final mesh.

• A summary of the adaptive analysis that provides detailed information, including:

o The maximum actual value for each accuracy parameter at each iteration.

o The total number of iterations.

o The total number of elements and nodes in the mesh at each iteration.

o Whether or not the solution converged.
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Viewing adaptivity results in NX Post Processing

After the Adaptivity iterations complete, you can review the results of the adaptive solution in the
Post-Processing Navigator. For example, you can create contour plots of the strain energy error as
well as the stress or temperature errors. You can also create contour plots of the mesh refinement
level results.

When you create a contour plot of the mesh refinement level results, the software generates a
banded display that indicates the level of refinement necessary at each node based on the computed
error results from the adaptive analysis.

Where do I find it?

Adaptivity solution process

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

NX Nastran, MSC Nastran, NX Multiphysics, NX Thermal, Abaqus, or
ANSYS as the specified solver

Simulation Navigator Right-click the Simulation file→New Solution Process→Adaptivity
Menu Insert→Adaptivity Setup
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Solve an adaptivity solution

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

NX Nastran, MSC Nastran, NX Multiphysics, NX Thermal, Abaqus, or
ANSYS as the specified solver

An existing adaptivity solution
Simulation Navigator Right-click the adaptivity solution→Solve

Adaptivity Exclusion Zone

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

NX Nastran, MSC Nastran, NX Multiphysics, NX Thermal, Abaqus, or
ANSYS as the specified solver

Simulation Navigator In the appropriate Adaptivity solution process node, right-click the
Exclusion Zones folder→New

Boundary layer meshing in the FEM

What is it?

You can now create boundary layer meshes directly in the FEM.

Workflow

Step 1: Define a boundary layer mesh control on the polygon face from which you want to start
the boundary layers. You need to specify:

• The number of element layers in the boundary layer mesh.

• The thickness of the first layer of elements in the boundary layer mesh.

• The method used to define the height of the boundary layer. You can either specify
the total thickness of the boundary layer or the growth rate of the element thickness
in the boundary layer. For example, a growth rate of 1.1 results in every successive
layer being 10% thicker than the previous one.

What's new in NX 5-47

CAE



Chapter 5: CAE

Mesh Controls
Boundary Layer
Boundary Layer(1)

Step 2: (Optional) Create a 2D mesh on the polygon face that has the boundary layer mesh
control.

If you create a triangular surface mesh, the boundary layer mesh will contain wedge
elements. If you create a quadrilateral surface mesh, the boundary layer mesh will
contain hexahedral elements. If you do not create a 2D mesh, NX automatically
generates a triangular mesh on the surface.

Note

You need to specify an element type that is linear.

Step 3: Create a 3D tetrahedral mesh on your polygon body.

Note

You need to specify an element type that is linear.

3D Collectors
Solid(1)

3d_mesh(1)
3d_Pyramid_transition(1)
3d_BL_HexWedges(1)

Results

NX creates up to five solid meshes:

• A boundary layer mesh composed of hexahedral elements and wedge elements. This mesh is
always created. In the Simulation Navigator, this mesh is stored in the 3d_BL_HexWedges
nodes.

• A boundary layer mesh composed of tetrahedral elements. NX creates these elements as
transition elements. In the Simulation Navigator, this mesh is stored in the 3d_BL_Tets nodes.

• A boundary layer mesh composed of pyramid elements. NX creates these elements as transition
elements. In the Simulation Navigator, this mesh is stored in the 3d_BL_Pyramids nodes.

• A transitional mesh composed of pyramidal elements, to transition from hexahedral boundary
layer elements or quadrilateral shell elements to the tetrahedral elements. In the Simulation
Navigator, this mesh is stored in the 3d_Pyramid_transition nodes.

• A 3D tetrahedral mesh that meshes the rest of the polygon body volume. This mesh is always
created.

The number of solid meshes created depends on the complexity of your model and other mesh
controls and meshes defined prior to creating the boundary layer mesh.
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In previous releases, to create a boundary layer mesh, you needed to define a Fluid Domain
simulation object in the Simulation file and solve the solution to display the boundary layer mesh in
the Post Processing Navigator. You could not view the boundary layer mesh before you solved
your solution.

Why should I use it?

Use the boundary layer meshing for CFD analysis and acoustics modeling.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder Mesh Control

Simulation Navigator
Right-click the Mesh Controls node→New Mesh Control or New Mesh
Control Definition

Graphics window Right-click a polygon face→Mesh Control
Location in dialog
box Density Type→Boundary Layer

Multi-block decomposition technique for 2D meshing

What is it?

Use the new Attempt Multi-Block Decomposition option in the 2D Mesh dialog box to improve
quadrilateral meshes on largely orthogonal surfaces (surfaces with a number of 90° corners). When
you select this option, NX breaks up faces into a cluster of convex regions and then generates
meshes on each convex region. In general, the resulting meshes are more orthogonal in nature. If
you select both the Attempt Multi-Block Decomposition and the Attempt Free Mapped Meshing
options, NX creates a structured mesh on more regions of your model.

The graphics show the difference between a surface meshed with quadrilateral elements (1) and the
same set of surfaces meshed using the new Attempt Multi-Block Decomposition option (2).
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Additionally, when you select Attempt Multi-Block Decomposition, Attempt Free Mapped
Meshing, and the new CAD Curvature Abstraction options, the software uses a methodology to
analyze surfaces and identify certain types of features, such as narrow bead and annular surfaces.
NX is then able to produce a better, more structured mesh in those regions.

With these improvements, the software is now able to, for example, capture details, such as the
crests of beads, while creating a mapped mesh along the body of the bead, as shown in the following
graphic.
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NX can now also produce an all quadrilateral mesh along annular faces, as shown in the following
graphic.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part
Command Finder

2D Mesh
Menu Insert→Mesh→2D Mesh
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Improved feature preservation and abstraction in 2D meshing

What is it?

Use the new CAD Curvature Abstraction option in the 2D Mesh dialog box to improve quadrilateral
meshes on relatively thin-walled parts with curvature, such as automotive body panels. When you
select this option, the software uses a new methodology to abstract the geometry in your model. This
methodology uses a curvature analysis to improve the quality of the quadrilateral elements in your
model by preserving the representation of part features during the geometry abstraction process.

In previous releases, the geometry abstraction process treated an entire polygon body as a single
entity during the abstraction process. In NX 10, the abstraction process analyzes groups of adjacent
faces that have similar curvature. Where possible, it merges those individual faces together. For
smaller, sliver faces within the model, such as tiny faces along fillets, the software more aggressively
merges those faces with adjacent faces. This new process aims to preserve the boundaries of
features while eliminating very small faces that are interior to features. This results in fewer small
elements in the mesh that violate the specified Minimum Element Length value.

Note

The CAD Curvature Abstraction option is valid only for free meshes with quadrilateral
elements.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part

The associated CAE part loaded
Command Finder

2D Mesh
Menu Insert→Mesh→2D Mesh
Location in dialog box Model Cleanup group

Support for 2D seed mesh creation in NX Multiphysics

What is it?

In the NX Multiphysics environment, when you create a mesh for a structural analysis, you can now
create 2D seed meshes to control the placement of nodes on subsequent 3D meshes. In the 2D
Mesh or the 2D Mapped Mesh dialog box, you can select either the Linear Quadrilateral Seed or
Linear Triangle Seed options from the Type list to create the seed mesh. These seed meshes have
the following characteristics:

• They can only be used to create solid meshes.

• They do not have any associated physical properties or mesh associated data.

• They are not written out to the solver input file when you export or solve your model.

In previous releases, you could create only 3D meshes for models in which NX Multiphysics was
the specified solver.
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Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part

NX Multiphysics as the specified solver

Structural as the specified analysis type
Command Finder

2D Mesh or 2D Mapped Mesh
Menu Insert→Mesh→2D Mesh

Updated support for 3D manual swept meshes

What is it?

You can now use the 3D Swept Mesh command to automatically or manually create hexahedral
meshes between selected faces. Use the new Automatic Between and Manual Between options in
the Type list to sweep a structured 3D mesh between two solid meshes. For example, you can use
these options to create a mesh of brick or wedge elements even if you do not have any geometry
to define a body.

Swept meshes that you create with the Automatic Between and Manual Between options can
update either as the geometry updates, or as the parameters of the neighboring meshes change. NX
now creates a mesh recipe for manual hexahedral meshes in the Simulation Navigator. You can
use this recipe to modify the swept mesh. NX also uses this mesh recipe to update the manual swept
mesh when changes occur to adjacent meshes or in the underlying geometry.

In previous releases, you used the 3D Sweep Between command to manually create hexahedral
meshes. However, those meshes were entirely FE-based and did not update.

In the example, (1) shows an assembly of blocks that are all meshed separately. (2) shows swept
meshes created using the Manual Between option. (3) shows how the swept meshes update when
the size of the meshes on the blocks update.
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Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part
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Command Finder
3D Swept Mesh

Menu Insert→Mesh→3D Swept Mesh

Contact mesh usability improvements

What is it?

The Contact Mesh dialog box has been redesigned to improve its usability and workflow. You use
the Contact Mesh command to create point-to-point contact between two edges or a portion of
two edges that you define. The type of elements that you can create between the selected edges
depends on your specified solver. For example, in the NX Nastran environment, you can create
CGAP elements, while in the Abaqus environment you can create GAPUNI elements.

Additionally, the Contact Mesh command now supports journaling.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

NX Nastran, MSC Nastran, Abaqus, or ANSYS as the specified solver.
Command Finder

Contact Mesh
Menu Insert→Mesh→Contact Mesh

Manually associating nodes to geometry

What is it?

You can now use the Manual Node Association command to manually associate nodes in an
orphaned mesh to selected geometry. This command gives you more granular control over which
nodes are associated to specific geometry. For example, you can use Manual Node Association
to associate a selected set of orphan nodes to a selected edge.

As a best practice, you should first use Node Association to have the software automatically
associate as many orphan nodes as possible to nearby polygon geometry. You can then use the
Manual Node Association command to associate any remaining orphan nodes.

Note

Manual Node Association controls only the geometry association between a node and
geometry. It does not change the location of a node.
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Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part
Command Finder

Manual Node Association
Menu Edit→Mesh→Manual Node Association

Saving full morphing data

What is it?

When you create a FEM file, you can use the new Save Full Morphing Data option in the New FEM
dialog box to control whether the software stores comprehensive data about modifications to the
underlying CAD geometry. If you plan to use morphing and not the FEM Update command to update
the meshes in your model in subsequent NX sessions, select this option because it stores additional
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data about changes to the CAD geometry. If you use the morphing commands in a subsequent NX
session, this additional data allows NX to produce higher quality morphing results.

Note

The Save Full Morphing Data option does not have any impact on the quality of morphing
results when you modify the CAE geometry and morph an associated mesh in the same
NX session.

Where do I find it?

Application Advanced Simulation
Prerequisite A part displayed
Simulation Navigator Right-click the part file→New FEM

Location in dialog box Mesh Morphing group

Geometry filtering for non-circular holes with Mapped Hole mesh controls

What is it?

When you use the Filter option in the Mesh Control dialog box to create a Mapped Hole mesh
control, you can select the Allow Non Circular Holes check box to have the software search for both
circular and non-circular holes that meet the criteria you specify. In previous releases, the automatic
geometry selection filtering for Mapped Hole mesh controls searched only for circular holes.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part
Command Finder

Mesh Control
Menu Insert→Mesh→Mesh Control

Export Mesh to Solver option more widely available

What is it?

You can now use the Export Mesh to Solver option to control whether manually created meshes are
written out to the solver input file when you export or solve your model. This option is now available
for the following manual element creation commands when you create 2D elements:

• Element Create

• Element Extrude

• Element Revolve

• Element Copy and Translate

• Element Copy and Project
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• Element Copy and Reflect

In previous releases, meshes that you created using these commands were always written out
to the solver input file.

Additionally, the Export Mesh to Solver option is now available in the Mesh Associated Data
dialog box for 2D meshes.

Where do I find it?

Manual element creation commands

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part
Command Finder

Element Create , Element Extrude , Element Revolve ,

Element Copy and Translate , Element Copy and Project ,

Element Copy and Reflect
Menu Insert→Element

Location in dialog box Destination Mesh group

Mesh Associated Data

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part
Simulation Navigator Right-click a 2D mesh→Mesh Associated Data

Improvements for editing multiple meshes

What is it?

You can now edit multiple meshes and have the software retain the existing element type of
each mesh. This allows you to make selected changes to meshes that have the same topology
without affecting the specified element type settings. Now, when you select multiple meshes in the
Simulation Navigator and use the right-click Edit Mesh option, you can use the new Retain Type
option in the Edit Mesh dialog box to indicate that you do not want to change the type of elements
used in the selected meshes.

• The Retain Type option is available when you select multiple meshes with different element
types or multiple meshes which use different mesh collectors.

• When you select the Retain Type option, the Destination Collector options in the Edit Mesh
dialog box become insensitive. NX uses the existing collector for each selected mesh.

Where do I find it?

Application Advanced Simulation
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Prerequisite A FEM file as the displayed part and the work part
Simulation Navigator Right-click one or more meshes→Edit

Midnode placement changes for tetrahedral elements

What is it?

This release includes improvements to the process that NX uses to place midnodes on the edges of
parabolic tetrahedral elements. In previous releases, if the software detected that an element violated
the specified Max Jacobian value specified in the 3D Mesh dialog box at the element’s Gauss
points, NX straightened the element’s edges.

In NX 10, some small enhancements have been made to the element edge straightening algorithm.
The software now iteratively moves the midnodes off the geometry to try to preserve the curvature of
the underlying geometry. Instead of immediately reverting to a straight element edge, the software
incrementally straightens the edge by moving the midnode along a line between the original location
and a final straight location. The software first moves the node 25% of the distance along that line,
then 50%, then 75%, then 100%. If the element passes the Jacobian criteria with the node at the
25%, 50%, or 75% location, then no further straightening occurs. As a result of this process, the
nodes remain closer to the underlying geometry while still satisfying the quality criteria.

The following graphic shows the subtle differences between a 3D mesh generated in NX 9 (1) and
a 3D mesh generated in NX 10 (2).

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part
Command Finder

3D Tetrahedral
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Menu Insert→Mesh→3D

Jacobian calculation changes for Nastran tetrahedral elements

What is it?

The Jacobian element quality check in the NX Nastran and MSC Nastran environments now
calculates the Jacobian values for tetrahedral elements only at their Gauss points. In previous
releases, NX calculated an element’s Jacobian values at its Gauss points and at its corner nodes.

Neither NX Nastran nor MSC Nastran fails to solve due to Jacobian errors at an element’s
corner nodes; Nastran only fails to solve if Jacobian errors occur at an element’s Gauss points.
Consequently, in the Nastran environments, the Element Quality Checks command no longer
evaluates Jacobian values at an element’s corner nodes.

Note

NX Nastran and MSC Nastran still list warnings for high Jacobian values at an element’s corner
nodes to the .f06 file. To view these warnings, you can review the .f06 file after the solve.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

NX Nastran or MSC Nastran as the specified solver
Command Finder

Element Quality Checks
Menu Analysis→Finite Element Model Check→Element Quality

Creating plane strain and plane stress elements parallel to axisymmetric plane

What is it?

You can now create plane strain and plane stress elements on a plane that is parallel to the
axisymmetric plane, we well as on the axisymmetric plane itself. To create these elements on a
parallel plane, use a mesh creation command, such as 2D Mesh, or manual element creation
commands, such as Element Create and Element Translate. This change gives you greater
flexibility when you create models. In previous releases, you could create plane strain and plane
stress elements directly on the axisymmetric plane only.

Where do I find it?

Application Advanced Simulation

5-60 What's new in NX

Chapter 5: CAE



CAE

Prerequisite A FEM file as the displayed part and the work part

NX Nastran, NX Multiphysics, Abaqus, ANSYS, NX Electronic Systems
Cooling, NX Thermal and Flow, or NX Space Systems Thermal as the
specified solver

Axisymmetric Structural or Axisymmetric Thermal as the analysis
type, or Structural or Thermal as the analysis type with the 2D Solid
Option set to any option other than None

Changes to 0D element creation

What is it?

Beginning in this release, point-based meshes that you create on a face or an edge with the 0D Mesh
command now follow the underlying mesh on the edge or face. For example, if you use the 0D Mesh
command to define a series of elements along an edge, NX generates those 0D elements only after
you generate a beam mesh along that edge. Similarly, if you use 0D Mesh to define an element at a
location on a face, NX generates the 0D element after you create the mesh on that face.

Additionally, NX no longer creates a mesh point when you create a 0D element. In previous releases,
NX created a mesh point for every node that was associated with a 0D element. This caused
performance issues during the mesh update process when changes occurred to the underlying
CAD geometry.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part
Command Finder

0D Mesh
Menu Insert→Mesh→0D Mesh

Batch Meshing enhancements

What is it?

The NX Batch Meshing utility has been updated to include many of the enhancements to the 2D
meshing capabilities from this release. The following table details the new batch meshing parameters
and their use.
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Parameter name Parameter file entry Description
CAD curvature
abstraction

CAD_curvature_abstraction Improves quadrilateral meshes on
relatively thin-walled parts with
curvature, such as automotive body
panels. With this parameter, the
software uses a new methodology to
abstract the geometry in your model.

When you turn this parameter on,
the software more aggressively
merges smaller, sliver faces with
larger, adjacent faces. This results
in fewer small elements in the mesh
that violate the specified Minimum
Element Length value.

Note

The CAD Curvature
Abstraction option is valid
only for free meshes with
quadrilateral elements.

For more information, see Improved
feature preservation and abstraction
in 2D meshing.

Minimum element
length

minimum_feature_length If you use the
CAD_curvature_abstraction

parameter, you must also use the
minimum_feature_length parameter
to specify a target minimum element
length value. The software uses
this value to determine which small
faces it should merge during the
abstraction process.

Multi Block
decomposition

multi_block_decomposition Improves quadrilateral meshes
on largely orthogonal surfaces
(surfaces with a number of 90°
corners).

When you turn this parameter on,
NX breaks up faces into a cluster of
convex regions. The software then
generates meshes on each convex
region. In general, the resulting
meshes are more orthogonal in
nature.
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Parameter name Parameter file entry Description

For more information, see
Multi-block decomposition technique
for 2D meshing.

Boundary Conditions

Load sets

What is it?

You can define and organize the loads in NX Nastran, MSC Nastran, and NX Multiphysics simulation
files using load sets. The load sets are stored in the Solver Sets folder in the Simulation Navigator.
You can also create the load set in the active solution or subcase.

You can create loads using a right mouse button command in the appropriate type of load set, or you
can use the drag and drop method to add existing loads.

The following types of load sets are available:

• Static Load Set

• Frequency Excitation Load Set

• Transient Excitation Load Set

• Acoustic Source Load Set

• Temperature Set

Using Folders

You can add folders of loads to load sets. If the folder contains loads other than those accepted by
the particular load set type, NX adds the folder, but disables the unaccepted loads.

Supported solution sequences

The following table shows the types of solutions that are available for each Nastran solution type.

Load set type Solutions
Static Load Set All Nastran and NX Multiphysics solution types
Frequency Excitation Load Set SOL 108, 111, 200
Transient Excitation Load Set SOL 109, 112, 129, 159, 200, 401, 601, 701
Acoustic Source Load Set SOL 108, 111
Temperature Set All Nastran and NX Multiphysics solution types
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Static Load Set

What is it?

You can use a Static Load Set to specify the structural loads for use in an NX Nastran, MSC
Nastran, or NX Multiphysics analysis.

There are two types of static load sets:

• Applied load

• Enforced Motion

The type of static load set you select limits the type of loads that you can add. For example:

• If you select Enforced Motion, you can only add enforced motion loads.

• You cannot add bolt pre-loads to a static load set.

• If you select Applied Load, you can add all other structural load types.

You can add gravity to an Applied Load static load set; however, you cannot combine gravity with
other types of loads in the same load set. NX Nastran requires the load set identification number
(SID) assigned to gravity loads to be unique and different from the SID assigned to all other loads.

Corresponding Nastran Syntax

A Static Load Set corresponds to the NX Nastran LOAD case control command.

The Label field in the Static Load Set dialog box assigns the SID for NX Nastran.

Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver
Simulation Navigator Right-click Solver Sets → New → Static Load Set

Transient Excitation Load Set

What is it?

You use a Transient Excitation Load Set to define a time-dependent dynamic load or enforced
motion load for use in a transient response analysis.

The transient excitation load set defines a load as a function of time, using either an expression or
a field. You can also define a dynamic load time delay directly in the Transient Excitation Load
Set dialog box.

Adding loads to a Transient Excitation Load Set

You cannot add individual loads to a dynamic load set, but you can add a static load set, and add
loads to that.

• You can add an Applied Load static load set only to a transient excitation load set of type
Applied Load.

5-64 What's new in NX

Chapter 5: CAE



CAE

• You can add an Enforced Motion type of static load set only to a transient excitation load set of
type Enforced Displacement, Enforced Velocity, or Enforced Acceleration.

• The type of motion created by an Enforced Motion Load is specified by the type of transient
excitation load set into which you place the static load.

Corresponding Nastran Syntax

The Transient Excitation Load Set corresponds to the NX Nastran TLOAD1 case control command.

The Label field in the Transient Excitation Load Set dialog box assigns the SID or load set
identification number for NX Nastran.

Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver
Simulation Navigator Right-click Solver Sets→ New→ Transient Excitation Load Set

Frequency Excitation Load Set

What is it?

You use a Frequency Excitation Load Set to define a frequency-dependent dynamic load for
use in a frequency response analysis.

The excitation you create is applied over all frequencies for all degrees of freedom. You can define
the value of the excitation as a function of frequency, using any of the following:

• A complex expression

• A field

• Magnitude and phase

You can also define dynamic load phase leads and time delay in the Frequency Excitation Load
Set dialog box.

Adding loads to a Frequency Excitation Load Set

You cannot add individual loads to a dynamic load set, but you can add a static load set, and add
individual loads to that.

• You can add an Applied load type of static load set only to a frequency excitation load set of
type Applied load.

• You can add an Enforced Motion type of static load set only to a frequency excitation load set of
type Enforced Displacement, Enforced Velocity, or Enforced Acceleration.

• The type of motion created by an Enforced Motion Load is specified by the type of frequency
excitation load set into which you place the static load.
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Corresponding Nastran Syntax

The Frequency Excitation Load Set corresponds to the NX Nastran RLOAD1 case control command.

The Label field in the Frequency Excitation Load Set dialog box assigns the SID or load set
identification number for NX Nastran.

Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver
Simulation Navigator Right-click Solver Sets→ New→ Frequency Excitation Load Set

Acoustic Source Load Set

What is it?

You use an Acoustic Source Load Set to define the acoustic source loads for use in an acoustic
or vibro-acoustic analysis.

The acoustic source load set defines the fluid properties and the power of the acoustic excitation as a
constant value or as a function of the frequency. You can also define dynamic load phase leads and
time delay in the Acoustic Source Load Set dialog box.

The only type of load that you can add is a Darea Acoustic Source load.

Corresponding Nastran Syntax

The Acoustic Source Load Set corresponds to the ACSRCE bulk data entry.

Where do I find it?

Application Advanced Simulation

Prerequisite

NX Nastran or MSC Nastran as the specified solver

SOL 108 or SOL 111 as the specified solution type

Acoustic or Vibro-Acoustic as the specified analysis type

Mesh of Acoustic Fluid elements
Simulation Navigator Right-click Solver Sets→ New→ Acoustic Source Load Set

Temperature Set

What is it?

You use a Temperature Set to specify the temperatures for use in an NX Nastran, MSC Nastran,
or NX Multiphysics analysis.

Temperature sets have 3 types:

• Initial/Stress Free Temperature defines the initial temperature distribution.

This type corresponds to the TEMPERATURE(INITIAL) case control command.
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• Material Temperature is used to determine temperature-dependent material properties.

This type corresponds to the TEMPERATURE(MATERIAL) case control command.

• Temperature Load updates the temperature-dependent material properties, and defines the
temperatures used for thermal loading.

This type corresponds to the TEMPERATURE(LOAD) case control command.

For NX Multiphysics, this type will correspond to the DTEMP case control command if time assigned
temperatures are added to the temperature set.

The only type of load that you can add to a temperature set is a temperature. You cannot add a
temperature directly to the load container of an NX Nastran, MSC Nastran, or NX Multiphysics
solution or subcase; instead, you must use a temperature set.

Note

You cannot add multiple temperature sets of the same type to a solution. For Nastran, you
cannot include both an Initial Temperature type temperature set and a Material Temperature
type temperature set in the same solution. For NX Multiphysics, the Material Temperature
type temperature set is not available.

Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver
Simulation Navigator Right-click Solver Sets → New → Temperature Set

Boundary Condition ID

What is it?

You can now insert the boundary condition ID into a boundary condition name by including the
symbol %%ID. For example, if you create a thermal void with an ID of 6 and set the name to Void —

%%ID, the name appears as Void — 6.

You can also pass the boundary condition ID as an argument of some built-in functions when you
define boundary conditions using the expressions.

You can do this for any type of boundary condition that includes the boundary condition ID in its dialog
box. Currently, these boundary conditions are:

• Thermal Convecting Zone

• Thermal Stream

• Thermal Void

Built-in functions with the boundary condition ID as an argument

In the following functions, “i” represents the boundary condition ID value.
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Built-in function Description

STI(i) Returns the total absolute or relative inlet
temperature of the stream i.

STO(i) Returns the total absolute or relative outlet
temperature of the stream i.

VT(i) Returns the total absolute or relative temperature
of the void i.

ZT(i) Returns the total absolute or relative temperature
of the convecting zone i.

SMO(i) Returns the outlet mass flow of the stream i.

STMO(i) Returns the outlet metal temperature of the
stream i.

SP(i) Returns the pressure of the stream i.
VP(i) Returns the pressure of the void i.
ZP(i) Returns the pressure of the convecting zone i.
SSV(i) Returns the swirl velocity of the stream i.
VSV(i) Returns the swirl velocity of the void i.
ZSV(i) Returns the swirl velocity of the convecting zone i.
SA(i) Returns the surface area of the stream i selection.
VA(i) Returns the surface area of the void i selection.

ZA(i) Returns the surface area of the convecting zone
I selection.

MIX(i1,i2,...,i10) Returns the temperature from mixing the flows of
two or more streams, i1, i2, up to i10.

MMIX(i1,i2,...,i10) Returns the mass flow from mixing the flows of
two or more streams, i1, i2, up to i10.

Why should I use it?

You can use the boundary condition ID to define interdependencies between boundary conditions; for
example, to model flow recirculation of thermal streams, you define the outlet temperature of one
thermal stream as a function of the input temperature of another stream.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Structural Multi-Step Nonlinear
Thermal Thermal

NX Multiphysics

Coupled Thermal-Structural (Multi-Step
Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics or NX Thermal and Flow as the specified solver.
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Command Finder

Thermal Convecting Zone or Thermal Stream or Thermal Void

Simulation Navigator
Right-click the Load container node→New Load→Thermal Convecting
Zone or Thermal Stream or Thermal Void

Location in dialog
box Name group→Boundary Condition ID

Temperature load enhancements

What is it?

You can now define a temperature load by importing temperature results into the Nastran and NX
Multiphysics environments. You do this using a Temperature — External Time Unassigned type of
Temperature load. You can import constant temperatures from Nastran, Abaqus, ANSYS, and NX
Thermal results files.

In an NX Multiphysics environment, you can now do the following:

• Create temperature loads that are dependent on time. You create a Temperature — Time
Assigned type of Temperature load to define temperatures that vary with time or with time and
space. The temperature loads in any NX Multiphysics step must be either all time assigned or
all not time assigned.

• Import time dependent temperature fields from an NX Thermal results file. You do this using a
Temperature — External Time Assigned type of Temperature load.

Corresponding Nastran syntax

The new types of Temperature load correspond to different NX Nastran bulk data entries.

• If you select the Temperature — Time Assigned type, NX creates the DTEMP bulk data entry.

• If you select the Temperature — External Time Assigned type, NX creates the DTEMPEX bulk
data entry.

• For all other types, NX creates the TEMP bulk data entry.

Defining initial temperatures and material temperatures

For NX Nastran, MSC Nastran, or NX Multiphysics, the Temperature Load command has been
renamed to Temperature, as you can now use it to also define initial temperatures and material
temperatures. You cannot add a Temperature load directly to the load container of an NX Nastran,
MSC Nastran, or NX Multiphysics solution or subcase; instead, you must use a temperature set. The
type that you select in the Temperature Set dialog box defines how the temperature will be used:

• An Initial Temperature type of temperature set defines the initial temperature distribution.

• A Material Temperature type of temperature set defines temperature-dependent material
properties.
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• A Temperature Load type of temperature set updates the temperature-dependent material
properties, and defines the temperatures used for thermal loading.

For more information on the new usage of the Temperature load in Nastran, see Updated processes
for defining temperatures in a Nastran analysis.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver

Structural or Coupled as the specified analysis type
Command Finder

Temperature

Updated processes for defining temperatures in a Nastran analysis

What is it?

The processes for defining temperatures in a Nastran analysis have been simplified for NX 10.
You can now define all of the temperatures needed for studying thermal strains and stresses in a
structural solution using the Temperature load and Temperature Sets.

Defining default temperatures

In previous releases, you used the following options in the Solution or Solution Step dialog boxes to
define default temperatures:

• Initial Temperatures Default

• Material Temperatures Default

• Temperature Load Default

• Default Initialization Temperature

You now use the Default field in the Temperature Set dialog box to define your default temperatures.
The Type option you select in the Temperature Set dialog box defines if the default will be an initial
temperature, material temperature, or a temperature load.

Assigning temperatures to geometry

In previous releases, you used the following simulation objects and loads to assign temperatures
to selected geometry:

• Initial Temperatures simulation object

• Material Temperatures simulation object

• Temperature Load
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You now use a Temperature load each time you assign temperatures to selected geometry. The type
of Temperature Set into which you add the Temperature load defines if the temperature will be an
initial temperature, a material temperature, or a temperature load.

Applying results from a previous analysis

In previous releases, you used the Temperature Pre-Load option in the Solution or Solution Step
dialog boxes to apply temperature results from a previous analysis.

You now use a Temperature — External Time Unassigned type of Temperature load to apply
temperature results from a previous analysis.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver

Structural or Coupled as the specified analysis type
Command Finder

Temperature

Enforced motion load

What is it?

You can use the Enforced Motion Load command to create a known displacement to geometry
or FE entities in a static or dynamic analysis.

• The Components type lets you define the displacement by the 6 degrees of freedom relative to a
selected coordinate system.

• The Magnitude and Direction type lets you define the magnitude of the displacement in a
single direction.

• The Normal type lets you define the constraint by specifying a displacement magnitude and a +/–
direction that is normal to the selected geometry or element faces.

Using enforced motions in dynamic analysis

In a dynamic analysis, you can use the Enforced Motion Load command to also define a known
velocity or acceleration.

In Nastran, you use the SPCD bulk data entry to define the enforced motion. You use the TLOAD1 or
TLOAD2 bulk data entries to define a transient response excitation with a reference to the SPCD entries.
You define the motion as a displacement, velocity, or acceleration with the TYPE field in the TLOAD1

or TLOAD2 bulk data entries.

In NX, you create an Enforced Displacement, Enforced Velocity, or Enforced Acceleration type
of Transient Excitation Load Set. You add the Enforced Motion Load to the load set to define the
type of motion used.
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In Nastran, you use the RLOAD1 or RLOAD2 bulk data entries to define a frequency response excitation
with a reference to the SPCD entries. You define the motion as a displacement, velocity, or acceleration
with the TYPE field in the RLOAD1 or RLOAD2 bulk data entries.

In NX, you create an Enforced Displacement, Enforced Velocity, or Enforced Acceleration type
of Frequency Excitation Load Set. You add the Enforced Motion Load to the load set to define the
type of motion used.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver
Command finder

Enforced Motion Load

Pressure load enhancements

What is it?

For Pressure loads of the type On Axisymmetric Elements (Normal to Edge) XY and On
Axisymmetric Elements (Normal to Edge) ZX, you can now define the pressure by specifying
the total load to apply.

NX converts the total load to a pressure when it writes the input file:

Pressure = Total Force / Area of the 360° revolved edge

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver

Axisymmetric Structural as the specified analysis type
Command Finder

Pressure

Edge load enhancements

What is it?

For edge loads of the type Edge Load on Plane Strain and Stress Elements (Normal to Edge) XY
and Edge Load on Plane Strain and Stress Elements (Normal to Edge) ZX, you can now specify
the total load to apply. With the Constant and Spatial distribution types, you define the load using
pressure units, whereas with the new Total distribution type, the load is defined using force units.

NX converts the total load to a pressure when it writes the input file:

Pressure = Total Force / Element Edge Length x Element Thickness

Where do I find it?

Application Advanced Simulation
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Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver

Axisymmetric Structural as the specified analysis type
Command Finder

Edge Load

Dynamic load time delay

What is it?

You can now create time delays for dynamic loads, using the Dynamic Load Time Delay modeling
object. The same time delay can be applied to every excitation selected, or you can specify unique
values for individual DOF components. The nodes affected can be individually selected, or chosen
as a group.

You can define load time delay while creating a Frequency Excitation, Transient Excitation, or
Acoustic Source Load Set. When defined with the load set, the delay can be created as a Dynamic
Load Time Delay modeling object, or as a simple expression. If you use an expression, the delay is
applied to all excitations in the load set.

Corresponding Nastran Syntax

The Dynamic Load Time Delay command corresponds to the NX Nastran DELAY bulk data entry.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver
Command Finder

Modeling Objects
Location in dialog box Type list → Dynamic Load Time Delay

Dynamic load phase lead

What is it?

You can now create phase leads for dynamic loads, using the Dynamic Load Phase Lead modeling
object. Apply the same angle of lead to every excitation selected, or specify unique values for
individual DOF components. You can select the affected nodes individually or as a group.

You can define load phase lead while creating a Frequency Excitation, or an Acoustic Source
Load Set. When defined with the load set, the delay can be created as a Dynamic Load Phase
Lead modeling object, or as a simple expression. If you use an expression, the delay is applied to all
excitations in the load set.

Corresponding Nastran Syntax

The Dynamic Load Phase Lead command corresponds to the NX Nastran DPHASE bulk data entry.
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Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver
Command Finder

Modeling Objects
Location in dialog box Type list → Dynamic Load Phase Lead

Darea Nodal Force and Moment load

What is it?

You can use the Darea Nodal Force and Moment load to create both forces and moments in which
the values can vary at each node. You define the forces and moments by the six DOF components
relative to the nodal displacement coordinate system.

By selecting the Unique DOF Values option, you can access the Edit By Node dialog box and
enter unique values for each node.

Corresponding Nastran Syntax

The Darea Nodal Force and Moment command corresponds to the NX Nastran DAREA bulk data entry.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran or MSC Nastran as the specified solver
Command Finder

Darea Nodal Force and Moment

Acoustic source load

What is it?

Acoustic waves are longitudinal waves generated by the volumetric expansion or contraction of the
medium (for example, air or water), caused by excitation of the system. You can use the new Darea
Acoustic Source command and Acoustic Source Load Set to simulate a stationary acoustic
source in the space that emits pulsating pressure waves. You can use this source for acoustic
or vibro-acoustic analysis.

Examples of acoustic sources include:

• A small speaker in a small rigid box emitting sound at low frequency.

• An engine inside an anechoic chamber.

• An engine exhaust pipe outlet.

The sound waves emitted from an acoustic source form a uniform spherical envelope.
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Using the Darea Acoustic Source command, you define the spatial distribution of the acoustic
source by selecting nodes in a fluid mesh. To enable the acoustic source, enter 1 in the DOF1
box. To disable the acoustic source, enter 0.

You can use the Unique DOF Values option to enable or disable the acoustic source for each node
independently. This way, you can study the contribution of each acoustic source independently, for an
acoustic or vibro-acoustic system that has multiple acoustic sources.

You must create the acoustic source in an Acoustic Source Load Set. This load set has an
excitation value (real value only) that defines the TP field on the ACSRCE bulk data entry. For more
information, see Acoustic Source Load Set.

Corresponding Nastran Syntax

The Darea Acoustic Source command corresponds to the DAREA bulk data entry.

The Acoustic Source Load Set command corresponds to the ACSRCE bulk data entry.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran or MSC Nastran as the specified solver.

SOL 108 or SOL 111 as the specified solution type.

Acoustic or Vibro-Acoustic as the specified analysis type.

Mesh of Acoustic Fluid elements.
Command Finder

Darea Acoustic Source

Bolt Pre-Load enhancements

What is it?

When defining Bolt Pre-Load for NX Nastran solutions 106, 129, and 601, as well as NX Multiphysics,
you now define the bolt geometry from polygon bodies or 3D elements. You define the bolt plane from
a point, a node, or a mesh point, and the bolt axis.

Force on 2D elements

In NX Multiphysics, you can also now create bolt pre-loads on 2D elements. You define the bolt
geometry from polygon faces or 2D elements. You define the bolt plane from a point, a node, or a
mesh point, and the bolt axis.

Corresponding Nastran Syntax

The changes in how the Bolt Pre-Load is defined correspond to a change in the option used on the
Nastran BOLT bulk data entry. The Bolt Pre-Load for these solutions now uses the ETYPE=3 option. In
previous releases, the ETYPE=2 option was used.
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Where do I find it?

Application Advanced Simulation
Command finder

Bolt Pre-Load

Abaqus axisymmetric contact analysis (10.0.1)

What is it?

This release includes expanded support for contact analyses in the Abaqus environment. You
can now perform a number of different types of contact analyses in axisymmetric structural and
thermal models. In previous releases, contact analyses in the Abaqus environment were limited to
non-axisymmetric models.

The following table summarizes the commands that are now available for axisymmetric structural
and thermal solutions:

Abaqus
element

Description Analysis types
supported

Corresponding Abaqus
keywords

Edge-to-Edge

Contact

Defines contact
conditions between
selected polygon edges
or element edges.

Axisymmetric structural *CONTACT PAIR

*SURFACE

Contact
Interference

Defines time-dependent
allowable interferences
for contact pairs and
elements.

You can use Contact
Interference to model
interference fits (press
fits) when there are large
overclosures between the
contacting surfaces in
the initial configuration of
the model. The defined
contact interferences
can result in stresses
and strains as the solver
resolves the overclosure
between the contacting
surfaces.

Axisymmetric structural *CONTACT PAIR

*CONTACT INTERFERENCE
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Abaqus
element

Description Analysis types
supported

Corresponding Abaqus
keywords

Contact with

Clearance

Defines precise clearance
or overclosure values
for the nodes on the
slave (target) surface
in a contact pair. An
overclosure value allows
you to specify any
initial penetration for
the contacting surfaces.

Axisymmetric structural *CONTACT PAIR

*CLEARANCE

Surface-to-Surface
Thermal
Conductance

Models conductive
heat transfer between
proximate or contacting
surfaces. You can model
the conductive heat
transfer as a function of:

• The clearance
between the
contacting surfaces.

• The contact pressure
at the interface
between the
contacting surfaces.

• Both the clearance
and the contact
pressure.

Axisymmetric thermal *GAP CONDUCTANCE

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver

Axisymmetric Structural or Axisymmetric Thermal as the analysis type

General Analysis or Heat Transfer as the solution type

ANSYS axisymmetric contact analysis (10.0.1)

What is it?

This release includes support for contact analyses in ANSYS axisymmetric structural and thermal
solutions. In previous releases, contact was supported only in non-axisymmetric solutions.
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Axisymmetric structural solutions

You can now use the Structural Contact command to analyze contact between the edges of planar
elements in axisymmetric models. You use the Structural Contact and the Region dialog boxes to
define contact and sliding between a 2D target edge and a deformable surface. When you export or
solve the solution, the software creates the appropriate CONTA172 elements to define the deformable
surface and TARGE169 elements to define the target surface.

Axisymmetric thermal solutions

You can now use the Thermal Contact command to define thermal contact conduction between
contacting surfaces in axisymmetric models using the edges of planar elements. You use the
Thermal Contact and the Region dialog boxes to define the contact between the edges, as well as
select the edges, points, or nodes that define the contacting edges.

After you define the contacting surfaces, use the CONTA174/172 Real Constants dialog box to
define the required thermal contact properties. You can define the following properties:

• Thermal contact conductance (TCC), which allows you to take into account the conductive heat
transfer between the contact and target surfaces.

Note

Currently, NX supports only a constant Thermal contact conductance value. You cannot
vary the Thermal contact conductance with temperature, pressure, or time.

• The Stefan-Boltzmann constant (SBCT), which you can use to model radiative heat transfer. If
you do not specify a value for the Stefan-Boltzmann constant, the radiation effect is excluded
from the thermal contact calculations.

• The Radiation view factor (RDVF), which you can use to define the radiation view factor for
near-field radiation.

Where do I find it?

Structural Contact

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Axisymmetric Structural as the analysis type

Linear Statics or Nonlinear Statics as the solution type
Command Finder

Structural Contact

Thermal Contact

Application Advanced Simulation
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Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Axisymmetric Thermal as the analysis type

Steady State Thermal as the solution type
Command Finder

Thermal Contact

Constraint equation support in Abaqus and ANSYS thermal solutions (10.0.1)

What is it?

You can now create constraint equations between the temperature degrees-of-freedom of thermal
elements in both the Abaqus and ANSYS thermal environments. In previous releases, you could only
create constraint equations in the Abaqus and ANSYS structural environments.

Constraint equations for Abaqus thermal solutions

In the Abaqus thermal environment, use the new Manual Coupling command to define the
independent and dependent coupling parameters between selected nodes. When you export or solve
your model, NX creates the appropriate *EQUATION commands in your Abaqus input file.

Constraint equations for ANSYS thermal solutions

In the ANSYS thermal environment, the Manual Thermal Coupling command has been enhanced to
allow you to create constraint equations as well as define sets of coupled degrees-of-freedom. Use
the new CE option in the Type list of the Manual Thermal Coupling dialog box to define coupling
between the temperature degrees-of-freedom within the model. When you export or solve your
model, the software creates the appropriate CE keywords in your ANSYS input file.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus or ANSYS as the specified solver

Thermal as the analysis type
Command Finder

Manual Coupling (Abaqus)

Manual Thermal Coupling (ANSYS)

Displaying boundary conditions and associated geometry

What is it?

This release includes new commands and options that let you control the display of boundary
conditions and geometry associated with the boundary conditions.
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• Use the BC Selection Display command to highlight geometry that is associated with selected
boundary conditions. The geometry is displayed with the same color as the boundary condition
symbols and labels. This display mode is an alternative to the display that is specified by the
Color Basis option and in the Model Display Options dialog box.

The following image shows the view of pinned and user-defined constraints on a face when the
BC Selection Display command is not selected, and when it is.

Standard view BC Selection Display selected

• Use the BC Selection Display Options command to select which boundary conditions are
displayed. You can also control the display colors for excluded and overlapping boundary
conditions.

When you right-click a boundary condition name, two new options provide additional refinements to
the display.

• Show Only displays only the selected boundary conditions and their associated geometry.

The following image shows the views of a user-defined constraint on a face when the Show
Only option is not selected, and when it is.

Standard view Show Only selected

• Show Reverse displays everything except the selected boundary conditions and their associated
geometry. This option lets you determine whether or not you have applied a boundary condition
to a particular geometry item.
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The following image shows the views of a user-defined constraint on a face when the Show
Reverse option is not selected, and when it is.

Standard view Show Reverse selected

Where do I find it?

BC Selection Display and BC Selection Display Options

Application Advanced Simulation
Prerequisite Boundary conditions applied to the model
Command Finder BC Selection Display or BC Selection Display Options

Show Only and Show Reverse

Application Advanced Simulation
Prerequisite Boundary conditions applied to the model
Simulation Navigator Right-click the boundary condition→Show Only or Show Reverse

User interface changes for defining boundary conditions

What is it?

The dialog boxes that you use to specify a boundary condition have changed in NX 10.

• In earlier versions of NX, to specify the magnitude of a boundary condition, you first select either
Expression or Field from the drop-down list in the Magnitude group. If you select Field, you are
then presented with a second drop-down list. From this list, you select how you want to define the
field. For many boundary conditions in NX 10, you specify the boundary condition from a single
entry box regardless of whether you want to define it with an expression or a field.

• In earlier versions of NX, the magnitude and distribution of a boundary condition are defined
separately. The magnitude is defined in the Magnitude group, and the distribution is defined
in the Distribution group. For many boundary conditions in NX 10, both the magnitude and
distribution of the boundary condition are defined by a single expression or field entry in the
Magnitude group.

• In earlier versions of NX, the Scale Factor box appears in the Magnitude group once you select
Field from the drop-down list. In NX 10, the Scale Factor box does not appear when you define
the boundary condition with a field. Instead, an edit button appears in the entry box. If you click
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the edit button, an option list appears. If you select Scale Factor from the list, the new Field
Scale Factor dialog box opens from which you can enter the scale factor.

Where do I find it?

Entering a scale factor

Application Advanced Simulation
Prerequisite Define the magnitude and distribution of a boundary condition with a field
Location in dialog box

[Boundary condition] dialog box → Magnitude group → edit → list →
Scale Factor→ Field Scale Factor dialog box → Table Field box

Solutions

Updating a solution from a condition sequence

What is it?

You can now modify a condition sequence (such as add, modify, and remove time points), and then
use the new Update from Condition Sequence command to update the solution that was created by
that condition sequence. In the previous release, you could not edit a condition sequence and update
the steps in the solution that was created from the condition sequence.

The Update from Condition Sequence command makes corresponding changes to the time steps
in the solution.

• If you add new time points to the condition sequence, the update command adds new condition
sequence-associated time steps to the solution.

• If you change the time values in the condition sequence, the update command updates the
solution step with the new time values.

• If you remove time points from the condition sequence, the update command deletes the solution
steps associated with those time points.

Updating a solution with a different condition sequence

For a solution that was created from a condition sequence, you can also use a different condition
sequence to update the solution. For example, suppose you use condition sequence CS-A to create
Solution 123. Later, you create condition sequence CS-B. You can use the Update from Condition
Sequence command to update Solution 123 with condition sequence CS-B.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the work part and displayed part

A solution created from a condition sequence, using the New Solution
from Condition Sequence command

Simulation Navigator Right-click the solution→Update from Condition Sequence
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Scaling loads using the Subcase/Step Association Manager

What is it?

You can now scale static loads directly in the Subcase/Step Association Manager in the following
environments:

• NX Multiphysics Structural and Coupled environments

• NX Nastran Structural (solution 101 only)

A new Switch to Scaling View button allows you to add a real number as a scale factor for individual
loads and for defined load sets. A scale factor defined for a load set applies to all static loads in that
set. The following graphic shows the scaling view; the highlighted value shows a scale factor of 10
applied to a force load in a subcase.

After you specify a scale factor for a load-step association, you can right-click that scale factor and
choose an option that applies that scale factor to other loads.

• To apply it to that same load in all steps, choose Set Scale on Column.

• To apply it to all loads in one step, choose Set Scale on Row.

• To apply it to all loads in all steps, choose Set Scale on All.
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The scale factors appear in the Nastran LOAD bulk data entries.

Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran (SOL 101 only) or NX Multiphysics as the specified solver

A Simulation file as the work and displayed part

At least one active solution that contains multiple steps or subcases
Simulation Navigator Right-click a selected solution→Step Manager or Subcase Manager

(Nastran)
Location in dialog box Switch to Scaling View button

Making copies of subcases and steps

What is it?

You can now make copies of subcases or steps using the Clone Multiple command.

When you use this command:

• The cloned copies include the loads and constraints from the original subcase or step.

• The name of each cloned copy includes the original entity plus a numerical suffix.

• The last copy created becomes the new active subcase or step.

Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite A Simulation file as the work part and displayed part
Simulation Navigator Right-click a subcase or step → Clone Multiple

Reordering steps

What is it?

You can reorder the steps or subcases in a solution by using drag and drop in the Reorder dialog
box. You can reorder multiple steps by dragging them at the same time.

Note

Reordering your steps will not change their end time. You can change the end time of steps
using the End Time field in the Solution Step dialog box.

When NX can infer the boundary condition evaluation time or the end time, it displays it in the
Time/End Time column. When NX can determine a boundary condition evaluation frequency or a
forcing frequency, it displays it in the Frequency column.
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When you create additional steps in your solution, you can control the order in which the new steps
are placed. By default, NX creates the new step in the last position. To place your new step before an
existing step, select the existing step from the Relative Position field in the Solution Step dialog box.

Where do I find it?

Application Advanced Simulation
Simulation Navigator Right-click a solution → Reorder Steps or Reorder Subcases

Editing boundary condition-step association using a spreadsheet

What is it?

You can now export boundary condition-step associations to a spreadsheet, make changes in the
spreadsheet, and then import the associations back into NX. In previous versions, you could export
the associations, but you could not import them back into NX.

With this release, use these steps:

1. To edit your data in a spreadsheet, in the Step/Subcase Manager dialog box, right-click in an
empty area of the Step/Subcase List table and choose Edit in Spreadsheet.

2. Make your changes and save the spreadsheet as a comma-separated values (CSV) file.

3. To import your edited file, in the Step/Subcase Manager dialog box, right-click in an empty area
of the Step/Subcase List table and choose Import from CSV.

This release also adds the Export to CSV command, which lets you export the association data from
NX to a file in the comma-separated values format.

Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite A Simulation file as the work and displayed part

At least one active solution that contains multiple steps or subcases
Simulation Navigator Right-click a selected solution→Step Manager or Subcase Manager

(Nastran)
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Generating loads and subcases from a recipe

What is it?

You can now import load data from an external source and use it to generate solutions, subcases,
and loads. Use the Load Recipes Manager command to define a load recipe that specifies the type
of load data and how it should be mapped to nodes and faces in a FEM. You can then use the New
Solution from Load Recipe command to create a new solution.

The typical use of a load recipe is to apply loads to an acoustics simulation model. Using a load
recipe, you can apply function data to the entities of the model.

Load Recipe dialog box

The load recipe defines how the boundary condition and subcases are created with the data from
data sources. In the Load Recipe dialog box, you can define the following:

Data Sources
You can add multiple data sources in the load recipe using the Add button. For the selected data
source, a format handler is available, where you can specify how the data from the data sources
is interpreted. Only the universal (.unv) file type is supported.

Load Conditions
You can specify the load conditions that are used for the creation of subcases by enabling or
disabling a load condition.

Waterfall
You can get an overview of the available tracking values.

Mapping
You can map a function from the data sources to a node or face of the model. You can select a
load from the available load types.

You can map the loads to the target using these methods:

• Automatic Entity (AE)— Maps a function from the data sources to the defined entity label
and the component.

• Manual Function (MF) — Maps a function with the specified function name from the data
sources to the one on the model, even though it may not have the correct entity and DOF
annotations.

• Manual Entity (ME)— Maps a function from the data sources to the specified entity and the
component, but ignores the entity label of the target.

Load Recipes Manager

The Load Recipes Manager is a collector of load recipes that you can use to create, delete, or
edit the load recipes.

• You can attach the function from the data sources to the node or to the face by using various
tabs on the Load Recipe dialog box.

• You can define the recipe with the data from an external source and apply it to the model.
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• You can create subcases and loads based on the available data in the external source and
assign loads to the subcases.

Creating solutions from a load recipe

You can create a solution from a load recipe using the New Solution from Load Recipe command.
The Solution dialog box lists only those analysis types and solution types that the load recipe
supports. NX generates the loads and places them in the boundary condition containers, depending
on the load type defined in the load recipes. For multiple subcases, you can create the folders
in the boundary condition container. Each of these folders contains all the loads necessary for
creating one subcase.

Update solution from a load recipe

You can update a solution from a load recipe using the New Solution from Load Recipe command.
It updates the subcases with the related boundary conditions and table fields, depending on options
that you select in the Solution dialog box.

Where do I find it?

Importing, editing, or creating load recipes

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part
Command Finder

Load Recipes
Menu Insert→Load Recipes

Creating a new solution from a load recipe

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part
Menu Insert→New Solution from Load Recipes
Simulation Navigator Right-click the Simulation node→New Solution from Load Recipes

Nastran support enhancements

NX Nastran acoustics analysis support in NX

What is it?

This release includes significant enhancements to support NX Nastran acoustic and vibro-acoustic
analysis.
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Acoustic and Vibro-Acoustic solutions

When you create a new NX Nastran solution, two new analysis types are available:

• Acoustic — only acoustic elements (3D) are available in this environment.

• Vibro-Acoustic — both acoustic elements (3D) and structural elements are available in this
environment.

Supported NX Nastran solutions

The following solution types are supported with both acoustic and vibro-acoustic solutions:

• SOL 103 – Real Eigenvalues

• SOL 107 – Direct Complex Eigenvalues

• SOL 108 – Direct Frequency Response

• SOL 110 – Modal Complex Eigenvalues

• SOL 111 – Modal Frequency Response

Supported acoustics capabilities

Acoustic Absorber
You can create an Acoustic Absorber simulation object in acoustic or vibro-acoustic solutions.
An acoustic absorber is applied on free faces of the fluid elements. It allows you to define an
acoustic surface impedance (or its reciprocal admittance). The Acoustic Absorber corresponds
to the Nastran CAABSF and PAABSF bulk data entries.

Panel
You can create a Panel simulation object in vibro-acoustic solutions. A panel contains 2D
structural elements. It corresponds to the PANEL bulk data entry. It can be used to compute
contributions of structural panels to acoustic pressure results.

Fluid-Structure Interface Modeling Parameters
For a vibro-acoustic solution, to specify the acoustic and structural elements that need to be
coupled, create a Fluid-Structure Interface Modeling Parameters modeling object, which
corresponds to the ACMODL bulk data entry. You can define the wetted surface by selecting the
acoustic and structural elements to be coupled. You can create multiple modeling objects, but can
select only one modeling object per solution (on the Bulk Data tab of the Solution dialog box).

Fluid-Structure Interaction Control Parameters
For a vibro-acoustic solution, to define parameters for the fluid-structure interaction, create
a Fluid-Structure Interaction Control Parameters modeling object, which corresponds to
the FLSTCNT case control command.

Modal Damping
For a vibro-acoustic SOL 111 solution, you can define modal damping separately for the structural
and the acoustic model. You can define modal damping groups on the:

• Case Control tab of the Solution dialog box
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• Solution Step dialog box for each subcase

You can define uniform structural damping and uniform fluid damping in the damping parameter
groups on the Parameters tab of the Solution dialog box. These options correspond to the
KDAMP,KDAMPFL and G,GFL parameters.

Modal Contributions for Structural, Acoustic and Vibro-Acoustic analysis types
You can define the modal contribution parameters in structural, acoustic, or vibro-acoustic
solutions, in their Output Requests. The Modal Contribution output request corresponds to
the MODCON case control command.

In a vibro-acoustic solution, you can request modal contributions separately for the structural
modes and the fluid modes.

You can request SORT1 and SORT2 output formats. However, only contributions in SORT2
format are supported for display in the NX XY Function Navigator. The SORT1 output can be
in the form of PRINT and/or PUNCH. NX Nastran will then write the results to the f06 or to
the PCH file, respectively.

Panel Contributions for Acoustic and Vibro-Acoustic analysis types
You can request the panel contributions in acoustic or vibro-acoustic solutions in their Output
Requests. These are the contributions from structural panels to pressure results on acoustic
fluid nodes for the solution. The Panel Contribution output request corresponds to the PANCON

case control command.

Where do I find it?

Creating an acoustic or vibro-acoustic analysis

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part
Menu Insert →Solution
Location in dialog box Solution dialog box→ Analysis Type list→select Acoustic or

Vibro-Acoustic

Creating an acoustic absorber

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part

An active Acoustic or Vibro-Acoustic solution
Simulation Navigator Right-click the Simulation Object node→New Simulation

Object→Acoustic Absorber
Command Finder

Acoustic Absorber

Creating a panel
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Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and the displayed part

An active Acoustic or Vibro-Acoustic solution
Simulation Navigator Right-click the Simulation Object node→New Simulation Object→Panel
Command Finder

Panel

Creating a fluid-structure interface

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part

An active or Vibro-Acoustic solution
Menu Insert→Modeling Objects→Fluid-Structure Interaction Modeling

Parameters or Fluid-Structure Interface Modeling Parameters
Location in dialog box Modeling Objects Manager dialog box→Type list→Fluid-Structure

Interface Modeling Parameters or Fluid-Structure Interaction Control
Parameters

Analyzing vibro-acoustic contribution data

What is it?

After you solve a vibro-acoustic model, you can analyze the panel contribution data and modal
contribution data using the XY Function Navigator.

You can plot the result curves for a particular subcase, type, or degree of freedom for all contribution
data.

Analyzing contribution data

You can request the following types of contribution results in the Nastran solution.

Panel Contributions
Panel contribution curves express the contribution of a given vibrating structural panel (the sum
of all its nodes) to the pressure response at a given acoustic node. Panels must be part of the
wetted surface. You can request this contribution using the Panel Contribution output request
for the solution by selecting the Panels for Contributions option.

Structural Mode Contributions
Structural mode contributions express the contribution of a given structural mode to the
response at a given node and degree of freedom. You can request this contribution using the
Modal Contribution output request for the solution by selecting the Structural Modes for
Contributions option.
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Acoustic Mode Contributions
Acoustic mode contributions express the contribution of a given acoustic mode to the response
at a given node and degree of freedom. You can request this contribution using the Modal
Contribution output request for the solution by selecting the Fluid Modes for Contributions
option.

The OP2 result file from the NX Nastran solution will contain the requested contribution data.

XY plotting from OP2 SORT2 results

In NX, you can analyze the NX Nastran SORT2 results using the XY Function Navigator. The
results are grouped by response node, response type, degree of freedom, and subcase.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A loaded Nastran OP2 SORT2 results file in the XY Function Navigator
XY Function Navigator Right-click the Nastran OP2 Files- Sort2 Results→Open or Open

Directory
Graphics window Right-click the desired contribution curve and click XY Plot

Generating loads and subcases from a recipe

What is it?

You can now import load data from an external source and use it to generate solutions, subcases,
and loads. Use the Load Recipes Manager command to define a load recipe that specifies the type
of load data and how it should be mapped to nodes and faces in a FEM. You can then use the New
Solution from Load Recipe command to create a new solution.

The typical use of a load recipe is to apply loads to an acoustics simulation model. Using a load
recipe, you can apply function data to the entities of the model.

Load Recipe dialog box

The load recipe defines how the boundary condition and subcases are created with the data from
data sources. In the Load Recipe dialog box, you can define the following:

Data Sources
You can add multiple data sources in the load recipe using the Add button. For the selected data
source, a format handler is available, where you can specify how the data from the data sources
is interpreted. Only the universal (.unv) file type is supported.

Load Conditions
You can specify the load conditions that are used for the creation of subcases by enabling or
disabling a load condition.

Waterfall
You can get an overview of the available tracking values.
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Mapping
You can map a function from the data sources to a node or face of the model. You can select a
load from the available load types.

You can map the loads to the target using these methods:

• Automatic Entity (AE)— Maps a function from the data sources to the defined entity label
and the component.

• Manual Function (MF) — Maps a function with the specified function name from the data
sources to the one on the model, even though it may not have the correct entity and DOF
annotations.

• Manual Entity (ME)— Maps a function from the data sources to the specified entity and the
component, but ignores the entity label of the target.

Load Recipes Manager

The Load Recipes Manager is a collector of load recipes that you can use to create, delete, or
edit the load recipes.

• You can attach the function from the data sources to the node or to the face by using various
tabs on the Load Recipe dialog box.

• You can define the recipe with the data from an external source and apply it to the model.

• You can create subcases and loads based on the available data in the external source and
assign loads to the subcases.

Creating solutions from a load recipe

You can create a solution from a load recipe using the New Solution from Load Recipe command.
The Solution dialog box lists only those analysis types and solution types that the load recipe
supports. NX generates the loads and places them in the boundary condition containers, depending
on the load type defined in the load recipes. For multiple subcases, you can create the folders
in the boundary condition container. Each of these folders contains all the loads necessary for
creating one subcase.

Update solution from a load recipe

You can update a solution from a load recipe using the New Solution from Load Recipe command.
It updates the subcases with the related boundary conditions and table fields, depending on options
that you select in the Solution dialog box.

Where do I find it?

Importing, editing, or creating load recipes

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part
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Command Finder
Load Recipes

Menu Insert→Load Recipes

Creating a new solution from a load recipe

Application Advanced Simulation
Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part
Menu Insert→New Solution from Load Recipes
Simulation Navigator Right-click the Simulation node→New Solution from Load Recipes

PBEAR physical property table enhancements

What is it?

This release includes a number of enhancements for the PBEAR physical property table. In NX
Nastran, you use the PBEAR bulk data entry to define the stiffness and damping matrices for bearing
connections that you define with the CBEAR bulk data entry for rotor dynamics analyses.

You can use new options in the PBEAR dialog box to do the following:

• Define axial stiffness and viscous damping terms in the translation direction, and radial stiffness
and viscous damping terms in the direction of rotation.

• Specify whether the components of the stiffness and viscous damping matrices are constant or
vary as a function of speed, speed and relative displacement, or speed and relative force.

• Specify composite relative displacements and forces.

• Set nominal values for stiffness and viscous damping.

Support for new stiffness and damping terms

You now have more flexibility in terms of how you define the stiffness and damping terms for CBEAR
elements. In previous releases, you could define the translational stiffness and viscous damping for
CBEAR elements in the plane normal to the rotor’s axis. Now, you can define the following:

• Axial stiffness and viscous damping terms in the translation direction.

• Radial stiffness and damping terms in the direction of rotation.

• The stiffness and damping of the cross coupling axial translational direction with other
translational directions.

These enhancements allow you to create bearings that have combined radial and axial dependence.

Defining stiffness and damping components as constant or varying values

You can use the new Field Independent Domain option in the PBEAR dialog box to define stiffness
and viscous damping matrices as a constant value or as a function of the following:
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• Rotor speed.

• Rotor speed and relative displacement.

• Rotor speed and relative force.

Defining composite relative displacements and forces

Composite relative displacements are linear combinations of radial and axial relative displacements.
You can now use the options on the new Composite Coefficient tab to define linear combinations of
axial and radial relative displacements or axial and radial relative forces when the stiffness or viscous
damping matrices vary with respect to rotor speed and relative displacement or relative force.

• For bearing properties that are speed and displacement-dependent, the software uses the
composite relative displacements to look up values for bearing stiffness and bearing viscous
damping.

• For bearing properties that are speed and force-dependent, the software uses the composite
relative forces to look up values for bearing stiffness and bearing viscous damping.

Defining nominal values for stiffness or viscous damping

On the Stiffness Matrix and Viscous Damping Matrix tabs in the PBEAR dialog box, you can use
the new Nominal Relative Displacement options to define the relative displacement or force that NX
Nastran uses to compute the bearing stiffness or viscous damping.

Note

NX Nastran uses the specified nominal values only if the stiffness or damping matrices are
not defined as a constant value.

Where do I find it?

CBEAR elements

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

NX Nastran version 10.0 as the specified solver
Command Finder

1D Mesh
Location in dialog box Type→CBEAR

PBEAR dialog box

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

NX Nastran version 10.0 as the specified solver
Command Finder

Physical Properties
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Location in dialog box Type→PBEAR

Updated processes for defining temperatures in a Nastran analysis

What is it?

The processes for defining temperatures in a Nastran analysis have been simplified for NX 10.
You can now define all of the temperatures needed for studying thermal strains and stresses in a
structural solution using the Temperature load and Temperature Sets.

Defining default temperatures

In previous releases, you used the following options in the Solution or Solution Step dialog boxes to
define default temperatures:

• Initial Temperatures Default

• Material Temperatures Default

• Temperature Load Default

• Default Initialization Temperature

You now use the Default field in the Temperature Set dialog box to define your default temperatures.
The Type option you select in the Temperature Set dialog box defines if the default will be an initial
temperature, material temperature, or a temperature load.

Assigning temperatures to geometry

In previous releases, you used the following simulation objects and loads to assign temperatures
to selected geometry:

• Initial Temperatures simulation object

• Material Temperatures simulation object

• Temperature Load

You now use a Temperature load each time you assign temperatures to selected geometry. The type
of Temperature Set into which you add the Temperature load defines if the temperature will be an
initial temperature, a material temperature, or a temperature load.

Applying results from a previous analysis

In previous releases, you used the Temperature Pre-Load option in the Solution or Solution Step
dialog boxes to apply temperature results from a previous analysis.

You now use a Temperature — External Time Unassigned type of Temperature load to apply
temperature results from a previous analysis.

Where do I find it?

Application Advanced Simulation
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Prerequisites NX Nastran, MSC Nastran, or NX Multiphysics as the specified solver

Structural or Coupled as the specified analysis type
Command Finder

Temperature

Improved support for residual vector results

What is it?

This release includes improved support for the calculation of residual vectors.

• NX now supports the import of the RESVEC case control command from both NX Nastran and MSC
Nastran input files. NX can import the RESVEC command from both .dat and .op2 files.

• NX now supports the NODAMP describer for the RESVEC case control command. If you do not want
to compute residual vectors for the degree-of-freedom in which viscous damping is defined on
CBUSHI, CDAMPI, and CVISC elements, select the new NODAMP option in the Viscous Damping list
on the Residual Vector tab. In previous releases, NX only supported the DAMPLOD describer.

For more information on residual vectors, see the NX Nastran Basic Dynamics User’s Guide.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

NX Nastran or MSC Nastran as the specified solver
Command Finder

Modeling Objects
Location in Dialog Box Type list→ Structural Output Requests→Residual Vector tab

Response Simulation support for composite elements

What is it?

You can now include composite elements in a Response Simulation analysis. For Random type of
events, you can now generate RMS and LCR stress contour results when the dynamic solution
results file contains ply stress and/or homogeneous stress modes. In previous releases, Response
Simulation did not support composite elements.

In the Evaluate RMS Results and Evaluate LCR Results dialog boxes, you can select Stress as
the Result Type. The composite elements in the model are evaluated with respect to the ply result
coordinate system.

Where do I find it?

Application Advanced Simulation
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Prerequisites NX Nastran as the specified solver

A Simulation file as the work part and displayed part

An active Response Simulation solution process
Command Finder

Evaluate RMS Results

Evaluate LCR Results

Import improvements for models with material orientation vectors

What is it?

Larger finite element models can contain thousands of 3D elements, each with their own material
orientation vector. When you create a Nastran input file from that model, the thousands of 3D
elements become thousands of PSOLID bulk data entries, each possibly referencing a separate
CORDM coordinate system bulk data entry. When you import an input file like this into NX, NX tries to
create separate mesh collectors in the Simulation Navigator for each of these coordinate systems
and PSOLID entries. This process of creating thousands of separate mesh collectors can seriously
degrade the import performance.

You can use the Import 3D MOVs as field data option in the Import Simulation dialog box to
automatically create spatial fields to represent the individual material orientation vectors. Importing
3D material orientation vectors as spatial fields can significantly improve import performance.
However, importing the material orientation vectors as spatial fields can result in a loss of detail.

This release includes a new Number of PSOLID properties for spatial field creation customer
default. Use this default to specify the threshold number of PSOLID properties that a solver input file
must contain for NX to automatically create spatial fields to represent the material orientation vectors
for 3D elements. NX creates the spatial fields when the number of PSOLID properties in the Nastran
input file exceed this threshold value.

Where do I find it?

Import 3D MOVs as field data option

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

NX Nastran as the specified solver

Structural as the specified analysis type
Menu File→Import→Simulation
Location in dialog box Data Compaction Options group

Number of PSOLID properties for spatial field creation customer default

Menu File→Utilities→Customer Defaults
Location in dialog box Nastran→General tab
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Updates to Geometry Check options

What is it?

You can now use the Geometry Check Options modeling object to run optional quality checks on
Nastran plane strain, plane stress, and axisymmetric elements. You can now have Nastran perform
the following optional checks when you solve your model:

• Minimum and maximum interior angle (TRX_IAMN, TRX_IAMX, QDX_IAMN, QDX_IAMX)

• Aspect ratio (TRX_AR, QDX_AR)

• Skew (QDX_SKEW)

• Taper (QDX_TAPR)

• Edge point length ratio (TRX_EPLR, QDX_EPLR)

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

NX Nastran or MSC Nastran as the specified solver
Command Finder

Modeling Objects
Location in Dialog Box Type list→Geometry Check Options

Import now available for NX Nastran SOL 401 solutions

What is it?

You can now import NX Nastran SOL 401 input files into Advanced Simulation. For SOL 401 input
files, select NX MULTIPHYSICS as the solver in the Import dialog box. You can import SOL 401
solutions from both .dat and .op2 files. If you select the Create new solution option in the Import
Simulation dialog box, NX imports the data into a new solution with NX Multiphysics as the specified
solver and the Analysis Type set to Structural.

Additionally, you can also use the Append Merge option in the Solver Deck Append dialog box
to import, append, and merge data from a SOL 401 input file, which is the source file, into an NX
Multiphysics FEM or Simulation file, which is the destination file.

Importing NX Multiphysics solutions that were previously exported from NX

Currently, you cannot use a Round Trip Parameters modeling object to preserve the order and
format of bulk data that you import from a SOL 401 solution for later export. However, if you export
an NX Multiphysics solution from NX and later import that same solution back into NX, the two
solutions should be equivalent. A solve on the imported solution should generate the same results
as a solve on the original solution.
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Note

Some minor differences may exist between the two solutions. For example, how a solution
appears in the Simulation Navigator may be slightly different. For example, loads and
boundary conditions could be listed within a specific Step instead of with the global solution.

The following are not supported for re-import into NX following a previous export:

• The setting for the Ignore Material Temperature Dependence option on Solution Control tab
in the Solution dialog box.

• The Augmented Time Step modeling object dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the displayed part and the work part

NX Multiphysics as the specified solver
Menu File→Import→Simulation

Import improvements for Nastran

What is it?

This release includes several new options on the Import Simulation dialog box. These new options
provide you with additional control over how NX imports data from your Nastran input file.

New data checking options

Use the new Data Checking option in the Import Simulation dialog box to control the degree to
which NX evaluates the validity of the file you are importing.

• Select Minimal to perform the lowest level of mesh validity checking. With this option, NX
assumes that the input file is ready to solve, and NX only performs minor checks during the
import. The Minimal option offers the fastest import performance.

• Select Nominal to have NX check for basic issues with the input file. For example, NX checks
to ensure that nodes and elements that are referenced by loads are included in the file. The
Nominal option offers a balance between file validity checking and import performance.

• Select Extended to perform the highest level of mesh validity checking. NX checks for the
existence of each node on every element that is included in the input file. The Extended option
can increase the processing time for importing an input file, particularly in larger models. In
addition, NX checks each element for duplicate nodes.

Note

If you select any of the Selective Import options, NX performs Extended data checking.
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New option for importing multi-point constraints

Use the new Import MPCs as Multi-MPCs option to improve the import performance for models that
contain a large number (greater than 10,000) of multi-point constraints. When you select this option,
NX imports the individual MPCs as a single Multi-MPC type of Manual Coupling constraint instead
of numerous individual MPC type constraints. This option offers faster import times for a large model
at the expense of a more detailed representation of your input file in NX.

This release also includes a new Number of MPCs for Multi-MPC Creation customer default. You
can use this default to specify the threshold number of multi-point constraints that a solver input file
must contain before NX imports them as Multi-MPC couplings instead of individual MPC couplings.

Where do I find it?

Import Simulation dialog box

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the displayed part and the work part

NX Nastran or MSC Nastran as the specified solver
Menu File→Import→Simulation

Number of MPCs for Multi-MPC Creation customer default

Menu File→Utilities→Customer Defaults
Location in dialog box Nastran→General tab

Export improvements for Nastran

What is it?

This release includes several new options on the Export Simulation dialog box. These new options
provide you with additional control over how NX exports data from your NX to your Nastran input file.

Control over exported temperature unit system

In this release, you can now control the units used for temperatures in your model during export. This
gives you the flexibility to define temperatures in a different unit system, such as Kelvin, than the rest
of your model, which may be in metric or British units. In previous releases, you could only specify a
different unit system for temperatures during import.

In the Export Simulation dialog box, use the new Specify temperature units list to select the unit
system to use for temperatures in the Nastran input file that you export. If you select a different unit
system for temperatures, the software converts units for temperature values in your model during
the export. These values include, for example:

• Temperature and Radiation loads

• Initial Temperature and Material Temperature simulation objects

• Thermal Constraints and Convection constraints
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• Material properties that have temperature units, such as values for the Thermal Expansion
Coefficient and Phase Change Temperature

Special export processing for input files that contain large ID values

NX now automatically detects large ID values within your Nastran input file and performs special
processing during export. In previous releases, NX could export input files that contained large IDs,
however, if the bulk data entry associated with the large ID was written using the small field format,
then the export operation aborted.

• In Nastran, an ID value is defined as large when it requires more than eight digits, namely an
ID greater than 99999999.

• In NX, node and element ID values cannot exceed 2^31-1 or 2147483647. However, you can use
options in the Formatting Options group of the Export Simulation dialog box to offset these
ID values by up to this same maximum limit.

Therefore, the largest ID value that NX can export for a Nastran input file is 2*(2^31-1), or
4294967294.

In NX 10, when you export an NX Nastran input file that contains large IDs, NX now does the following:

• Automatically exports the bulk data entry using the large field format.

Note

If you use Solver Syntax Preview to preview the format of a bulk data entry with a large
ID, NX also uses the large field format to preview the entry.

• Writes out the NASTRAN SYSTEM(525)=1 system cell in the Nastran section of the input file.

• Issues a warning or error message, as appropriate, during the export of the following types of
solutions:

o Warning message: SOL 101 Superelement, SOL 103 Superelement

o Error message: SOL 103 Response Simulation, SOL 200 Model Update, SOL 103 with the
Solution Process menu set to either Correlation or Laminate Dynamics

To obtain a 64-bit binary file for NX Nastran, you should solve the input file with the ILP64 version of
NX Nastran. In NX 10, this is the version that the UGII_NX_NASTRAN environment variable references
by default.

For MSC Nastran input files that contain large ID values, NX automatically exports the associated
bulk data entries using the large field format. NX does not do any other special processing when it
exports MSC Nastran input files. This is because MSC Nastran does not require any specific bulk
data entries or system cells to handle large integer ID values.

Control over the use of THRU formatting

In previous releases, when you exported a Nastran input file, the software always took advantage of
the Nastran THRU format for applicable bulk data entries. In general, using the THRU format reduces the
size of the exported input file.
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Now, you can use the new Use THRU Format option on the Formatting options tab to control
whether you want to use the THRU format. If you clear this check box, NX will not use the THRU format
when it exports the following bulk data entries:

• ACCEL1

• ASET1

• BLSEG

• BNDFIX1

• BNDFREE1

• BOLT

• BSET1

• BSURF

• CSET1

• GROUP

• EBDSET

• MATCID

• NSM1

• NSML1

• OMIT1

• PLOAD2

• PLOAD4

• QBDY3

• QSET1

• QVOL

• RADBC

• ROTORB

• ROTORG

• RVDOF1

• SPC1
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• SPOINT

• SUPORT1

• TEMPP1

• TEMPRB

• USET1

Note

The Use THRU Format option applies only to bulk data entries and does not affect how
the SET case control command is exported.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the displayed part and the work part

NX Nastran or MSC Nastran as the specified solver
Menu File→Export→Simulation

Controlling the organization of an exported input file

What is it?

When you use export a Nastran input file from NX, you can now control how the data in that exported
file is organized. Beginning in this release, you can specify a pattern file for the software to use as a
guide for organizing data during the export operation. A pattern file is a file that you have previously
exported from NX and might have rearranged to your preference.

For example, you can use a pattern file to establish the following:

• The order in which you want NX to export entities, such as parameters. For example, you can
create a pattern file in which the Nastran PARAM cards always appear at the end of the bulk data
section of the input file.

• How included files are used during the export. For example, if you always want to export the
GRID bulk data entries that define nodes in a separate file, you can create a pattern file in which
the nodal data is stored in a separate grid.dat file and simply referenced in the pattern file with
an INCLUDE statement.

• The format to use for bulk data entry fields.

After you create a pattern file, you can use options in the Round Trip Parameters modeling object
dialog box to specify the following:

• The pattern file that you want to scan for information and organizational structure.

• Whether you want to export data using the same included files as the pattern file.
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When you later export a solution that references this Round Trip Parameters modeling object that
you specify on the General tab in the Solution dialog box, NX uses the pattern file to configure
the data in the exported file.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

An NX Nastran or MSC Nastran solution active
Command Finder

Modeling Objects

Creating node and element groups from an appended file

What is it?

When you append a Nastran input file to an existing FEM or Simulation file, you can use the new
Create group from appended file option to create a group of the nodes and elements that NX
imports from the input file. This option is available when you select Append or Append Merge from
the Import Behavior list in the Solver Deck Append dialog box.

During the import and append process, NX checks the ID of each imported nodes and element with
the IDs of the nodes and elements in the existing FEM and Simulation file.

• If NX does not find a conflict between the imported ID and the existing ID values, NX adds
the node or element to the group.

• If NX finds a conflict, NX uses the options you select in the Merge Conflict Resolution Options
in the Solver Deck Append dialog box to determine whether to include the node or element in
the NX group.

o If you select Ignore File Data, NX does not add the node or element to the group.

o If you select Modify With File Data, NX adds the node or element to the group.

o If you select Add File Data, NX adds the node or element to the group and uses the specified
Label Offset value to increment the ID value from the solver input file.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the displayed part and the work part

NX Nastran or MSC Nastran as the specified solver
Menu File→Append
Location in dialog box General Options group in the File Append or File Merge dialog box
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Import and export support improvements for Nastran

What is it?

This release includes support enhancements for Nastran:

• Bulk data entries and case control commands

• Parameters

• System cells

Bulk data and case control command support updates

The following table details the changes in bulk data and case control command support for this
release.

Name NX Nastran
import/export

support

MSC Nastran
import/export

support

Notes

ACMODL Yes No Defines modeling
parameters for the
interface between
the fluid and the
structure.

ACSRCE Yes No Defines source
strength as
a function of
frequency for a
simple acoustic
source.

ADAPTERR

case control
command

Yes No In the NX
Multiphysics
environment,
controls the
computation and
output of error
estimates for
adaptive meshing.

See Adaptive
meshing
enhancements for
more information.

BGPARAM Yes No SLIDE is now
supported

BGSET case
control
command

Yes No The STATUS option
is now supported.
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BOLT Yes No ETYPE=3 is now
supported. See
Bolt Pre-Load
enhancements for
more information.

CRSTRN Yes No
DAREA Yes Yes See Darea Nodal

Force and Moment
load and Acoustic
source load for
more information.

DELAY Yes Yes See Dynamic load
time delay for more
information.

DPHASE Yes Yes See Dynamic load
phase lead.

DTEMP Yes No
DTEMP case
control
command

Yes No

DTEMPEX Yes No
ELSTRN case
control
command

Yes No Requests elastic
strain at grid points
on elements.

FLSTCNT

case control
command

Yes No

GCRSTRN

case control
command

Yes No

GELSTRN

case control
command

Yes No Requests elastic
strain at gauss
points.

GPLSTRN

case control
command

Yes No Requests grid point
strains for printing
only.

GSTRAIN

case control
command

Yes No Requests strain at
gauss points.

GSTRESS

case control
command

Yes No Requests stress at
gauss points.
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GTHSTRN

case control
command

Yes* (For the
NX Multiphysics
environment only)

No Requests thermal
strain at gauss
points.

Gauss point output
is only available in
the NX Multiphysics
environment.
See Additional
structural outputs.

MAT10 Yes Yes NX now supports
the GAMMA, TIDBULK,
TIDRHO, TIDGE, and
TIDGAMMA fields.

MATCRP Yes No For more
information, see
Norton-Bailey
Power Law creep
support in NX
Multiphysics.

MATOVR Yes No
MATS1 Yes Yes Accompanies the

MAT1, MATG,
MATHP cards.
In NX900 upgrade
from FAM Type 1
to FAM type 3. In
NX10 on import, set
to Undetermined

MODCON case
control
command

Yes No The n to use a set
to define modal
contributions is not
supported by NX.
Additionally, the
PANELMC field can
reference only a
single PANEL.

MPC Yes Yes For more
information,
see Import
improvements for
Nastran.

NLCNTL Yes No
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OPRESS case
control
command

Yes No Supported in the
NX Multiphysics
environment for
Coupled analyses
only.

For more
information,
see Additional
structural outputs.

OTEMP case
control
command

Yes No Supported in the
NX Multiphysics
environment only.

Supported for
import since
NX 9 but only
documented in
NX 10.

For more
information,
see Additional
structural outputs.

PANCON case
control
command

Yes No The n to use a set
to define modal
contributions is
not supported by
NX. Additionally,
the PANEL field can
reference only a
single PANEL bulk
data entry.

PANEL Yes No You can import
panels that are
defined with
nodes, elements
or physical property
tables.

PBEAR Yes No See PBEAR
physical
property table
enhancements for
more information.
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PGPLSN Yes No Supported in the
NX Multiphysics
environment only.

For performance
reasons, the GRID

IDs that you specify
on this bulk data
entry are imported
into NX as Mesh
Associated Data.

PLSTRN case
control
command

Yes No Supported in the
NX Multiphysics
environment only.

For performance
reasons, the GRID

IDs that you specify
on this bulk data
entry are imported
into NX as Mesh
Associated Data.

RESVEC Yes Yes For NX Nastran,
the NORVEL field is
not supported for
import.

For MSC Nastran,
the NOADJLOD field
is not supported for
import.

RIGID case
control
command

Yes Yes Adds support
for the AUTO and
STIFF fields in the
NX Multiphysics
environment.

SEQDEP case
control
command

Yes No Supported for
import since
NX 9 but only
documented in
NX 10.

SET1 Yes No Processed in
the context of a
reference by the
ACMODL card

SET3 Yes No Processed in
the context of a
reference by the
ACMODL card

TABLED3 Yes Yes EXTRAP is not
supported?
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TABLEST Yes Yes Prior to NX 10,
an imported
TABLEST entry could
only reference a
TABLES1table. Now,
the TABLEST entry
can also reference
TABLED1, TABLED2,
or TABLED3 entries.
This works if the
TABLEST entry from
a PBEAR entry.

TEMPEX Yes No Supported in the
NX Multiphysics
environment only.

THSTRN case
control
command

Yes No For more
information,
see Additional
structural outputs.

TSTEP1 Yes No Supported in the
NX Multiphysics
environment only.

Only the last Tendi,
Ninci, and Nend

in the entry are
imported into NX.

Parameters

The following table details the changes in parameter support for this release.

Parameter Description Notes

PARAM,ROTCSV Specifies CSV output
for Rotordynamics
solutions.

You can now import an
NX Nastran input file that
contains PARAM,ROTCSV

for either a SOL 107 or a
SOL 110 analysis.

PARAM,UNITSYS Identifies the units
system to use.

Support has been
updated to include
temperature units. NX
writes out PARAM,UNITSYS
only when the specified
temperature unit is
different from the default
(°C is default for metric
and °F is default for
British).
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System cell support updates

The following table details the changes in system cell support for this release.

System Cell
Name

Description Notes

119 MSC Nastran system
cell

281 SPLINE_METRICSPrint additional quality
information for splines.

MSC Nastran system
cell

414 Controls whether the
lumped mass matrix
contains translational
components only for
CBAR and CBEAM
elements

MSC Nastran system
cell

443 ESNLRO Controls Nonlinear
Response Optimization
with the concept of
Equivalent Static Loads.

MSC Nastran system
cell

444 Controls whether MSC
Nastran uses the
pre-Nastran 2010 or
the 2010 release of IFP
for bulk data processing.

MSC Nastran system
cell

445 MSC Nastran system
cell

IFPSTAR Controls whether MSC
Nastran uses the
pre-Nastran 2010 or
the 2010 release of
Common Data Model for
data processing.

445 MNLQ4C Allows or disallows
corner stress
calculations for material
nonlinear CQUAD4

elements.

MSC Nastran system
cell

449 PARSLAVE Controls the DMP
execution of slave
processes in nonlinear
analysis

MSC Nastran system
cell
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451 If set non zero, requests
the method to calculate
transverse shear
correction for elements
using MID4, or “Z0”
on the PCOMP to
offset a shell element.
The default 0 uses a
method that avoids
excessive transverse
shear stiffness. This is
expected to have small
effect on most models,
unless the shell is thick
and the offset is large.

MSC Nastran system
cell

579 FREQVM Determines whether the
von Mises stress and
strain are computed for a
deterministic frequency
response analysis in
SOL 108 or SOL 111.

NX Nastran system cell

580 Suppresses warning
messages from the
DMAP compiler that
arise because of
undefined input or output
to DMAP commands.

NX Nastran system cell

581 Turns off the error trap
which occurs when an
SPCD entry is defined
with a bolt pre-load.

NX Nastran system cell

583 Controls the maxminum
number of flutter
iterations in SOL 145.

NX Nastran system cell

587 Determines whether
axisymmetric input and
output is on a per radian
or per 2π radian basis.

NX Nastran system cell

589 Controls the R6 stiffness
for CQUADR and CTRIAR

elements.

NX Nastran system cell

624 IFPBUFF Specifies the size of
IFPSTAR data base I/O
transfers

MSC Nastran system
cell

653 NONUPIV MSC Nastran system
cell

655 GPU_MIN_FRONT MSC Nastran system
cell

656 GPU_MIN_RANK MSC Nastran system
cell
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662 MSC Nastran system
cell

664 SEGLOG MSC Nastran system
cell

666 CNTBKCMP MSC Nastran system
cell

676 LMFBKCMP MSC Nastran system
cell

677 FFOBKCMP MSC Nastran system
cell

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the displayed part and the work part

NX Nastran or MSC Nastran as the specified solver
Menu File→Import→Simulation

File→Export→Simulation

NX Multiphysics enhancements

Coupled thermal-structural analysis

What is it?

You can now perform a coupled thermal-structural analysis in the NX Multiphysics environment. This
is in addition to the Structural, Thermal, and Mapping analysis types that were available in the
previous release of the NX Multiphysics environment.

The Coupled analysis type links a structural solution from the NX Nastran SOL 401 Multi-Step
Nonlinear solver and a thermal solution from the NX Thermal solver. The results from the thermal
solution, for example, temperatures, affect the structural solution, and the results from the structural
solution, for example, displacements, affect the thermal solution.

Data is passed between the solvers through the NX Multiphysics application

The thermal solver can pass the following data to the structural solver:

• Temperatures on nodes and elements
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• Thermal boundary condition pressures. NX maps pressures on 1D or 2D thermal elements
to pressures on structural faces and edges.

The structural solver can pass the following data to the thermal solver:

• Nodal displacements

• Contact pressures and contact separation (gap) distance on nodes. The contact pressures can
be used to determine conductive properties at the contact surfaces.

You use the same mesh for both the structural and thermal solution.

As you do with the other NX Multiphysics analysis types, you can use a condition sequence to
create the solution and solution steps.

Solution steps

The sequence of solution steps is based on the End Time that you define for each solution step. By
default, a solution step is sequentially dependent on the results of the previous solution step, and its
start time is the End Time of the previous solution step. When you create a new solution step in a
coupled analysis solution, you can define the step as one of these types.

Thermal Nonlinear
Statics

Coupled thermal-structural step in which the structural solver and the thermal
solver exchange data through the NX Multiphysics application.

In each solution step, you can specify that the thermal solution type is transient
or steady state, and you can specify nonlinear control parameters for the
structural solver.

The structural solver runs a static solution in which loads can be constant
or time assigned.

This type of solution step can include geometry and plasticity or creep material
nonlinearity.

Normal Modes Specialized structural step that runs a modal analysis. This step can include
stress stiffening, follower stiffness, and the spin softening from the previous
thermal nonlinear static solution step.

Preload Specialized structural step for a Bolt Pre-Load, including contact and glue, or
Temperature load. Preload steps must have an End Time of 0. Any solution
step that precedes a Preload step must also have an End Time of 0. You can
have only one Preload step in a solution.

Time step control

Within a Thermal Nonlinear Statics or Preload solution step, the thermal solver and the structural
solver perform their respective solves at each time step. The thermal solver is always the starting
solver. You can control the time steps taken by each solver separately. You control the time steps in a
solution step by specifying the End Time and Number of Increments for that step.

The time steps for a solution step correspond to the TSTEP1 NX Nastran bulk data entry.

Alternatively, with Thermal Nonlinear Statics steps, you can specify a constant Step Size in terms
of time. By default, the thermal solver uses Automatic adaptive time stepping.

5-114 What's new in NX

Chapter 5: CAE



CAE

Coupling times

The structural solver and the thermal solver exchange data at coupling times. You can control the
time step increment at which NX Multiphysics exchanges data between the solvers, up to the solution
step End Time. The End Time is always a coupling time. By default, the coupling times are at each
of the thermal solver time steps. To change the coupling time basis, you can use the Coupling
Time Option in the Coupled Solution Parameters for the solution. Coupling times are added
automatically as common integration time points for both solvers.

At each coupling time, temperatures on nodes and elements (from the thermal solution) are passed
to the structural solver. You can specify that additional types of data are passed at each coupling time
using the options in the Coupled Solution Parameters for the solution.

Sequential or iterative coupling

In the Coupled Solution Parameters for the solution, you can specify the coupling Mode:

Sequential The structural solver and the thermal solver pass information to each other
once per coupling time and do not attempt to converge together. NX solves the
first solution until convergence is obtained, and then solves the other solution
using the values from the first solution.

Iterative The structural solver and the thermal solver pass information to each other for
several iterations, until the variables that are being passed converge. This
method requires you to specify the Iteration Limit, Convergence Criterion,
Convergence Norm, and Relaxation values. Coupled convergence occurs
when both temperatures and displacements have converged.

Output of solution data

During the course of a coupled analysis, the structural solver and the thermal solver perform many
solves. You may want to output data for post processing at each of these solution points or only at
certain points, such as at the End Time of the solution step. You can control this output in the
Solution Step dialog box on the Time Step Definition page, under the Output Control group.

Post-processing structural and thermal results

In NX Multiphysics solutions, the structural and thermal results are listed together under the same
solution in the Post Processing Navigator.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Multiphysics Coupled Multi-Step Nonlinear

Where do I find it?

Application Advanced Simulation
Location in dialog box Solution dialog box→Analysis Type=Coupled

Adding time points to a structural solution to match a reference solution

What is it?

The Augmented Time Step List modeling object is added to let you import additional time points into
an NX Multiphysics structural solution.

With NX Multiphysics, you can create structural solutions in which the temperatures are mapped from
a thermal solution. If the thermal solution used automatic time stepping, the time stepping is uneven.
If you want to solve the structural solution at the same time points as those specified in the thermal
solution, you must add those time points to the structural solution. To do this, you can import the
uneven list of time points from the thermal results into the structural solution. NX Nastran then solves
the structural solution at the same time points as the thermal solution, along with any time points
you specify in the structural solution.

You can import these additional time points from an NX Nastran, NX Thermal, Abaqus, or ANSYS
results file that contains transient results. If you want to subdivide the additional time points, you can
specify a number of increments. You can also specify at what point the solver should output data, for
example, at the solution step end time or at each time step increment.

You can also import time points from a CSV file.

You associate the Augmented Time Step List with the solution in the Solution dialog box on the
Solution Control page.

When you solve, NX writes the additional time points to the TSTEP1 bulk data entry in the NX Nastran
input file.
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Example

The following NX Nastran input file shows the time points in the structural solution, before adding
the augmented time step list.

This example shows additional time points imported from an NX Thermal .bun file with the augmented
time step list.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Multiphysics Structural Multi-Step Nonlinear

Where do I find it?

Application Advanced Simulation
Location in dialog box Solution dialog box→Solution Control page
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Step Association Manager

What is it?

The Step Association Manager command is now available in the NX Multiphysics environment.
Use this command to:

• Manage which boundary conditions are associated with a given solution step.

• Change multiple boundary condition assignments across solution steps.

• Add a scale factor to a load in a particular solution step.

• Export information about the boundary condition assignments to an HTML page or a spreadsheet,
make changes in the spreadsheet, and import the changes back into NX.

For small models, and during the initial creation of the model, the standard methods of assigning
individual boundary conditions to the active solution or step may be adequate. These methods,
however, may become unwieldy when you want to edit or refine a model that contains a large
number of defined boundary conditions, boundary conditions that are organized into multiple folders,
simulations that contain multiple solutions, and solutions that contain multiple solution steps or
subcases. Use the Step Association Manager to manage and document the distribution of multiple
boundary conditions across steps within a solution.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Structural Multi-Step Nonlinear
Thermal Thermal

NX Multiphysics

Coupled Thermal-Structural (Multi-Step
Nonlinear)

Where do I find it?

Application Advanced Simulation
Command Finder

Step Association Manager

New boundary conditions supported in NX Multiphysics

What is it?

NX Multiphysics has added support for the following loads and boundary conditions:

• Moment

• Enforced Motion Load

• Enforced Displacement

• Surface-to-Surface Contact
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• Edge-to-Edge Contact

• Edge-to-Edge Gluing

• Material Override

• Override Set — Thermal Properties

• Solid Motion Effects

Some loads and constraints that were previously available only in structural or only in thermal
solutions are now available in both. You can create Surface-to-Surface Gluing in thermal solutions.
Thermal Convecting Zone, Thermal Stream, and Thermal Void loads that you create in thermal
and coupled solutions, can be added to structural solutions to define pressure only. You can use all of
the loads and constraints for structural and thermal solutions in the new Coupled type of analysis.

Initial Temperatures are no longer available as simulation object types. You now define them with
temperature loads and a temperature set. For more information on defining initial temperatures, see
Updated processes for defining temperatures in a Nastran analysis.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver

Controlling plasticity and creep effects

What is it?

You can control plasticity and creep effects at both the solution and the step level.

Solution level

In the Solution dialog box, the Material Nonlinearity option must be turned on for any plasticity
or creep effects to exist in the solution. You can control creep and plasticity using a Nonlinear
Control Parameters modeling object.

You can also disable the creep and plasticity effects for individual elements or for physical property
tables by including a Material Override simulation object in the solution.

Step level

In the Solution Step dialog box, you can separately control creep and plasticity using a Nonlinear
Control Parameters modeling object.

Corresponding Nastran syntax

The Material Nonlinearity option for the solution corresponds to the NX Nastran MATNL parameter.

The Nonlinear Control Parameters for creep and plasticity correspond to the NX Nastran CREEP and
PLASTIC parameters on the NLCNTL bulk entry.

The Material Override simulation object corresponds to the NX Nastran MATOVR bulk entry.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
Structural Multi-Step NonlinearNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver

Structural or Coupled as the specified analysis type
Command finder Material Override
Location in dialog box Solution dialog box → Solution Control page → Material Nonlinearity

check box

Solution dialog box → Solution Control page → Nonlinear Control
Parameters list → Plasticity Effects or Creep Effects

Solution Step dialog box → Step Control page → Nonlinear Control
Parameters list → Plasticity Effects or Creep Effects

Norton-Bailey Power Law creep support in NX Multiphysics

What is it?

You can now use the Norton-Bailey Power Law creep model in Multi-step Nonlinear solutions when
NX Multiphysics is the specified solver.

You select this model in the Materials dialog box, on the Creep page, using the
Temperature-Dependent Time Hardening (Norton-Bailey) Power Law (Type 301) option. This
option corresponds to the new MATCRP bulk data entry, which is an alternate method for selecting the
Norton-Bailey creep model. It lets you define the coefficients of the power law equation as either
constant or temperature dependent.

In the Materials dialog box, you define the A, B, and D coefficients of this creep model in the
Constant Multiplier (a), SIGMA Exponent (b), and Hardening Exponent (d) boxes.

• To define creep at a single temperature, enter real values for the coefficients.

• To define creep as temperature dependent, define a table field for the coefficients. The table
corresponds to the TABLEM1 bulk data entry.

Checking system units

A Check Unit System option is added to the new Type 301 power law as well as to the existing Time
Hardening (Norton-Bailey) Power Law Type 300. This option checks for inconsistent units in the
solution and the creep coefficients. NX checks when the solver input file is exported and alerts you if
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the solution units are not consistent with the creep coefficient units. NX cannot convert the creep
coefficient units when it exports the solver input file.

Controlling creep effects

For NX Multiphysics, you can now turn off creep effects at the solution level and subcase level. For
more information, see Controlling plasticity and creep effects.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver and an active Multi-step Nonlinear

solution

or

NX Nastran as the specified solver and an active SOL 601,106 Advanced
Nonlinear Statics solution

Command Finder
Manage Materials

Location in dialog box
Create Material →Creep page

Support for plastic strain material nonlinearity in NX Multiphysics

What is it?

In the NX Multiphysics environment, you can now define a stress-dependent material with plastic
strain properties. In the Materials dialog boxes, on the Mechanical page, a new Type of
Nonlinearity option PLSTRN has been added.

This option corresponds to the MATS1 bulk data entry with TYPE=PLSTRN. For more information, see
MATS1 in the NX Nastran Quick Reference Guide.

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver

An active Multistep Nonlinear solution
Command Finder

Manage Materials
Location in dialog box

Create Material →Mechanical page→Stress-Strain Related
Properties group→Type of Nonlinearity=PLSTRN
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Support for 2D seed mesh creation in NX Multiphysics

What is it?

In the NX Multiphysics environment, when you create a mesh for a structural analysis, you can now
create 2D seed meshes to control the placement of nodes on subsequent 3D meshes. In the 2D
Mesh or the 2D Mapped Mesh dialog box, you can select either the Linear Quadrilateral Seed or
Linear Triangle Seed options from the Type list to create the seed mesh. These seed meshes have
the following characteristics:

• They can only be used to create solid meshes.

• They do not have any associated physical properties or mesh associated data.

• They are not written out to the solver input file when you export or solve your model.

In previous releases, you could create only 3D meshes for models in which NX Multiphysics was
the specified solver.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part

NX Multiphysics as the specified solver

Structural as the specified analysis type
Command Finder

2D Mesh or 2D Mapped Mesh
Menu Insert→Mesh→2D Mesh

Support for the generalized plane strain formulation

What is it?

NX Multiphysics now supports the new generalized plane strain element formulation, which was
introduced in the NX Nastran 10 release. You can use this new formulation with the following plane
strain element types:

• Plane Strain Linear Triangle (CPLSTN3)

• Plane Strain Linear Quadrilateral (CPLSTN4)

• Plane Strain Parabolic Triangle (CPLSTN6)

• Plane Strain Parabolic Quadrilateral (CPLSTN8)

In NX, you use the Generalized Plane Strain physical property table to specify this new element
formulation and associate it with the elements. The options in this dialog box correspond to the NX
Nastran PGPLSN bulk data entry. For example, you can specify:

• The isotopic (MAT1) or orthotropic (MAT3) material to use.
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• The element’s thickness in its undeformed state.

• Optional additive normal stiffness and rotational stiffness values.

Defining a controlling node to add additional degrees-of-freedom

With the PGPLSN entry in NX Nastran, you can define a control grid point (node) that adds three
additional degrees-of-freedom to the element:

• One translational degree-of-freedom along the element’s thickness direction.

• Two rotational degrees-of-freedom around the element’s two in-plane axes.

The control grid point is the location where NX Nastran applies any out-of-plane loads or enforced
displacements to the associated elements.

In NX, you can use the Generalized Plane Strain Control Node option in the Mesh Associated
Data dialog box to select the appropriate node to use as the control grid point.

Generalized plane strain formulation is for specialized applications

The generalized plane strain formulation is applicable only to small strain, small deflection structural
analyses. These structural analyses include linear static, creep, and plasticity analyses, and
combination creep and plasticity analysis. Analysis with the generalized plane strain formulation is
highly specialized and is typically used to evaluate the behavior of gas turbine compressor and
turbine blades. For such an analysis, you mesh the cross section of the blade with the appropriate
plane strain elements and then create a Generalized Plane Strain physical property table to define
the properties for those elements.

Where do I find it?

Generalized Plane Strain physical property table

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

NX Multiphysics as the specified solver

2D Solid Option set to ZX Plane, Z Axis or XY Plane, X Axis
Command Finder

Physical Properties

Mesh Associated Data

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

NX Multiphysics as the specified solver

2D Solid Option set to ZX Plane, Z Axis or XY Plane, X Axis
Command Finder

Mesh Associated Data

What's new in NX 5-123

CAE



Chapter 5: CAE

Checking the completeness of NX Multiphysics solutions

What is it?

You can now use the Model Setup command to check the completeness of structural and coupled
thermal-structural solutions in the NX Multiphysics environment before you solve. In the NX
Multiphysics environment, the Model Setup commands checks to ensure that:

• A material is specified.

• The material orientation is defined.

• A physical property table for the elements is specified.

• The model has loads or constraints applied.

For coupled thermal and structural solutions, Model Setup performs some checks specific to thermal
analyses, such as the following:

• Whether the appropriate element data is specified.

• Whether the appropriate modeling objects are specified when required.

• Whether all geometry is meshed.

Additionally, if the model contains laminate composites, the Model Setup check issues warnings or
error messages related to the laminates, if necessary.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the displayed part and the work part

NX Multiphysics as the specified solver
Command Finder Model Setup

Additional structural outputs

What is it?

You can now request contact results and additional strain results for an NX Multiphysics structural
and coupled analysis.

For contact results, you may choose to include the contact pressure, contact force, contact status,
and the minimum value of separation distance between source and target elements.

The following stress and strain results are now available:

• Creep Strain

• Plastic Strain

• Elastic Strain
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• Thermal Strain

• Gauss Point Creep Strain

• Gauss Point Plastic Strain

• Gauss Point Elastic Strain

• Gauss Point Strain

• Gauss Point Thermal Strain

• Gauss Point Stress

To control whether these options are selected by default, use the Results Options tab for NX
Multiphysics in the Customer Defaults dialog box.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Structural Multi-Step NonlinearNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Structural Output Requests

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver
Command Finder

Modeling Objects
Location in dialog box Type list →Structural Output Requests

Results Options customer defaults

Menu File → Utilities →Customer Defaults
Location in dialog box Simulation →NX MULTIPHYSICS → Results Options

Defining thermal coupling with contact and gluing

What is it?

You can now define heat transfer through contact and gluing simulation objects for Coupled and
Thermal types of NX Multiphysics analysis. You do this using the Activate Thermal Coupling
option in the Edge-to-Edge Contact, Edge-to-Edge Gluing, Surface-to-Surface Contact, and
Surface-to-Surface Gluing dialog boxes.

By specifying the thermal coupling type, you determine what thermal properties must be specified:

• Select Perfect Contact to transfer heat with no thermal resistance.
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• Select Heat Transfer Coefficient to define the heat transfer coefficient for the contact pair.

• Select Edge Contact to define the conductance per length of the edge.

• Select Thermo-Mechanical Contact to use one heat transfer coefficient when there is a gap
between the contact pair, and a separate heat transfer coefficient when the contact pair has
no gap.

The following table shows which thermal coupling types are available for each simulation object.

Simulation object type Thermal coupling types available
Edge-to-Edge Contact Perfect Contact

Heat Transfer Coefficient

Edge Contact

Thermo-Mechanical Contact
Edge-to-Edge Gluing Perfect Contact

Heat Transfer Coefficient

Edge Contact
Surface-to-Surface Contact Perfect Contact

Heat Transfer Coefficient

Thermo-Mechanical Contact
Surface-to-Surface Gluing Perfect Contact

Heat Transfer Coefficient

Supported solvers and analysis types

Solver Analysis Type Solution Type
Structural Multi-Step Nonlinear
Thermal Thermal

NX Multiphysics

Coupled Thermal-Structural (Multi-Step
Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver
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Command Finder
Edge-to-Edge Contact

Edge-to-Edge Gluing

Surface-to-Surface Contact

Surface-to-Surface Gluing

Preload solution step

What is it?

You can now create a Preload type of solution step for structural and coupled NX Multiphysics
solutions.

Bolt Pre-Load and a Temperature Load type of temperature set are the only loads that you can
include in the preload solution step. You can add an optional constraints container to the solution
step, and add any structural constraints to that.

The Preload solution step is the only step in an NX Multiphysics solution where you can add a
Bolt Pre-Load Load. You cannot add it to other types of solution steps or directly to the solution
load container.

In the Time Step Definition of the preload step, the End Time is always 0. You can use multiple
increments if the solution does not converge correctly with the Number of Increments set to 1.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Structural Multi-Step NonlinearNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisites NX Multiphysics as the specified solver
Location in dialog box Solution Step dialog box → Step list → Step — Preload

Adaptive time stepping enhancement

What is it?

The new adaptive time stepping scheme handles the sharp changes in temperature at boundary
conditions better than the previous scheme. When there are no abrupt changes in boundary
conditions, it accelerates the simulation without losing accuracy. The time step size calculation is
now based on the estimated error between the analytical solution and the simulation. The error is
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the difference between a fit quadratic function and a linear variation through three consecutively
computed temperature values for two consecutive time steps.

When there are abrupt temperature changes in the model, as seen in the example, the adaptive time
stepping scheme adapts by performing smaller time steps around the times when the abrupt changes
occur. The blue curve represents the time-varying heat load that is applied to the boundary condition
and each red + represents the temperature value at one point of the boundary condition for the
transient run. The +’s that are close to each other indicate that the time steps are smaller at those
times to better capture the changes in the heat load.

You specify the temperature error tolerance, the minimum time step size, and the maximum time
step size.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation

Command Finder Step-Subcase
Simulation Navigator Right-click a thermal step node→Edit
Location in dialog
box

Time Step Definition node→Time Step Control group→Time Step Option
list→Automatic

Solution Monitor enhancements

What is it?

• The Solution Monitor is now used by the NX Multiphysics and NX Nastran solvers.

• The Solution Monitor now displays text output for each solver on a separate tab when you run a
coupled NX Multiphysics analysis.
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o The NX Multiphysics tab displays the text output for the coupled solver.

o The NX Thermal tab displays the text output for the thermal solver.

o The NX Nastran tab displays the text output for the NX Nastran solver.

• You can copy and paste the displayed text output. In previous versions, the displayed text output
was not selectable.

• The user interface of the Solution Monitor is refreshed and the command names are more
intuitive. The commands now have tooltips describing their functionality.

Where do I find it?

Application Advanced Simulation, Design Simulation

Prerequisite

NX Nastran, NX Multiphysics, NX Thermal and Flow, NX Space Systems
Thermal, or NX Electronic Systems Cooling as the selected solver
environment

Command Finder Solve
Simulation Navigator Right-click a solution node→Solve

Multi-layer shell support

What is it?

You can now use multi-layer shell elements to model thin geometries, such as panels and layers, in
the NX Multiphysics solver environment.

In the Thin Shell physical property table, you can now specify a thin shell to be treated as a
multi-layer shell by selecting the Divide Thickness into Uniform Layers option. NX divides the shell
thickness that you specify equally into a specified number of layers.

When you define multi-layer shells, you can now select one or more layers to which you apply the
boundary condition in the Temperature and Thermal Loads dialog boxes.

Why should I use it?

Using multi-layer shell elements, you can obtain a detailed picture of the conduction through the
geometry without using thin solid (3D) elements. Multi-layer shell elements present a smaller
conductance matrix than solid elements.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Multiphysics Thermal Thermal

Where do I find it?

Thin Shell physical property
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Application Advanced Simulation

Prerequisite

NX Multiphysics as the specified solver.

A FEM file as the displayed part and work part.

Command Finder Physical Properties
Menu Insert→Physical Properties

Location in dialog
box

Type list→Thin Shell→Create→Thickness group→ Divide Thickness
into Uniform Layers

Load and constraint

Application Advanced Simulation
Prerequisite NX Multiphysics as the specified solver.

Command Finder Thermal Loads or Temperature

Simulation Navigator

Right-click the Loads node→New Load→Thermal Loads

Right-click the Constraint Set node→New Constraint→Temperature
Location in dialog box Multi-Layer Shells group

Enhancements to thin shell

What is it?

The following enhancements are now available for thin shell elements in the NX Multiphysics thermal
environment:

• Material Orientation is now added to both element associated data and mesh associated data.

• The Thin Shell physical property now supports orthotropic materials. In the previous release,
you could choose only isotropic materials.

• You can now divide a specified thickness into equal layers in order to model uniform multi-layer
shell elements in the Thin Shell dialog box.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Multiphysics Thermal Thermal

Where do I find it?

Application Advanced Simulation

Prerequisite

NX Multiphysics as the specified solver.

A FEM file as the displayed part and work part.
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Element and mesh associated data

Command Finder Element Modify Associated Data or Mesh Associated Data
Location in dialog
box Material Orientation group

Thin Shell physical property

Command Finder Physical Properties
Location in dialog
box Type list→Thin Shell→Create

Plane strain element support

What is it?

The NX Multiphysics thermal and coupled solutions now support the following 2D element types in
both the XY and the ZX planes:

• Plane Strain Linear Quadrilateral

• Plane Strain Parabolic Quadrilateral

• Plane Strain Linear Triangle

• Plane Strain Parabolic Triangle

Although there is no element associated data related to the plain strain elements, the material
orientation angle is supported as mesh associated data.

The plain strain elements are either tied to a Plane Property or to a Generalized Plane Strain
Property physical property defined at the mesh collector level. In the physical property, you can
specify either isotropic or orthotropic materials.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation

Prerequisite

NX Multiphysics as the specified solver.

A FEM file as the displayed part and work part.
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Command Finder 2D Mesh
Location in dialog
box Element Properties group→Type list

Defining a thermal stream with a radial coordinate system

What is it?

You can define convection caused by radial thermal streams over surfaces. The stream flows radially
over the surface starting from the origin of the specified cylindrical coordinate system.

The thermal solver creates a 1D duct with mass flow elements on the selected regions and, using
convection thermal coupling, connects the 1D elements to the nearest thermal solid elements that lie
in the same radial band. The 1D duct is shown in blue in the following figure.

You can set the radial Thermal Stream load type based on whether you want the thermal stream to
convect to a single surface or to two surfaces.

In addition to specifying the region, the fluid material, the stream conditions, and the heat transfer,
you also specify the cylindrical coordinate system. In the structural multiphysics solution, you only
specify the pressure.

Why should I use it?

The load provides an automated way to include the effects of convection and advection in a thermal
model. It improves your efficiency by regrouping many thermal simulation boundary conditions
in a single command.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
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Structural Multi-Step Nonlinear
Thermal Thermal

NX Multiphysics

Coupled Thermal-Structural (Multi-Step
Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite The specified solver must be NX Multiphysics or NX Thermal and Flow.

Command Finder Thermal Stream
Simulation Navigator Right-click the Load container node→New Load→Thermal Stream
Location in dialog
box

Type list→One-Sided Stream on Faces (Cylindrical Components) or
Two-Sided Stream on Faces (Cylindrical Components)

Solid Motion Effects simulation object enhancement

What is it?

Use the Spinning - All Elements type of Solid Motion Effects simulation object to model the
thermal effects of a spinning model. All elements in the model spin together.

You select the spinning axis, and specify the number of calculations per spin, N. The thermal solver
calculates the view factors and thermal couplings that result from NX spinning the model N times,
each time rotating the spinning model by 360/N degrees. The thermal solver then averages the view
factors and thermal couplings of these N positions.

The view factors include the following:

• Solar, earth, and albedo view factors from orbital heating.

• Heat flux view factors from radiative heating.

• Black body and ray-traced view factors from the deterministic and hemicube methods.

• Ray-traced view factors, radiative couplings, and heat loads from the Monte Carlo method.

Note

Best accuracy is obtained when N is greater than the number of elements around the
circumference of the spinning part. This is especially true for thermal coupling calculations.

The Spinning type of Solid Motion Effects simulation object from the previous releases is now
called Spinning - Selected Elements.

Why should I use it?

The Spinning - All Elements type of Solid Motion Effects simulation object can be used, for
example, to model a spinning spacecraft that spins rapidly around a specified axis.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow NX Advanced Thermal/Flow with

ESC
NX Space Systems Thermal Thermal Space Systems Thermal

Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation

Command Finder Solid Motion Effects

Simulation Navigator
Right-click the Simulation Object container node→New Simulation
Object→Solid Motion Effects

Location in dialog
box Type list→Spinning - All Elements or Spinning - Selected Elements

Varying capacitance for Void Non Geometric Element modeling object

What is it?

You can now define a time-varying or temperature-varying capacitance when you create a Void
Non-Geometric Element modeling object. To define the capacitance, you can specify the
capacitance value or the volume value. Both quantities can vary with time or temperature.

In previous releases, you could specify only a constant capacitance value.

Why should I use it?

You can use time-varying capacitance, for example, to model the capacitance of fuel in aircraft wings.
The fuel mass and thus the capacitance varies with time over a flight profile.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
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Prerequisite NX Multiphysics or NX Thermal and Flow as the specified solver.

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
Location in dialog
box

Type list→Void Non-Geometric Element→Create→Calculation Method
group

Multiple Fluid material

What is it?

The new Multiple Fluid material type lets you define a primary fluid material and up to five additional
fluid materials.

The thermal solver uses the specified primary fluid material properties during computation. The
additional fluid material number can be passed as an argument to some CAE functions, such as fluid
plug-ins, and also to user-defined functions. See User-defined functions for expressions for more
information on plug-in functions.

You define the Multiple Fluid material type in the following loads and modeling object:

• Thermal Convecting Zone load

• Thermal Stream load

• Void Non-Geometric Element modeling object

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics or NX Thermal and Flow as the specified solver.

Defining the multiple fluid material

Command Finder Manage Materials
Location in dialog
box Type list→Multiple Fluid→ Create

Specifying the multiple fluid material in loads
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Command Finder Thermal Convecting Zone or Thermal Stream

Simulation Navigator
Right-click the Load container node→New Load→Thermal Convecting
Zone or Thermal Stream

Location in dialog
box Fluid Materials list

Specifying the multiple fluid material in the modeling object

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
Location in dialog
box

Type list→Void Non-Geometric Element→Create→Environment
group→Fluid Materials list

Local temperature error estimate result sets

What is it?

You can now recover local temperature error estimate results. The thermal solver generates
temperature error estimate results which estimate the local spatial discretization errors due to the
mesh used for the simulation of conduction.

After you solve the model, the following result types appear under the solution node in the Post
Processing Navigator:

• Temperature Error Estimates - Nodal

• Temperature Error Estimates - Elemental

• Time of Maximum Error Estimates - Nodal

• Time of Maximum Error Estimates - Elemental

• Maximum Temp Error Estimates - Nodal

• Maximum Temp Error Estimates - Elemental

The last four result types are written only for transient runs. They are displayed under the Time
Invariant node in the Post Processing Navigator.
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The error estimate is measured in units of temperature difference.

The elemental error estimate, εT, is the maximum temperature difference of all boundary elements
computed as follows:

εT = max |TBE – fBE(T1, T2, ..., TN)|

where:

• TBE are the calculated boundary element
temperatures

• Ti are the N smoothed nodal temperatures

• N is the number of nodes

• The fBE function uses element shape
functions to interpolate the nodal
temperatures to the boundary element

Why should I use it?

The adaptive meshing solution process uses the maximum local temperature error estimates to
refine the mesh for conduction thermal analysis.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics as the specified solver.

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
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Location in dialog
box

Type list→Thermal Output Requests→Create→Thermal tab→ Local
Temperature Error Estimate

Envelope results for thermal post processing

What is it?

Time invariant results from transient thermal solutions are now located under the Time Invariant
node in the Post Processing Navigator.

iron
Solution 1

Thermal
Increment 1, 0.0 sec
...
Increment 61, 600.000 sec
Time Invariant

Max Temperature - Elemental
Min Temperature - Elemental
Time at Max Temperature - Elemental
Time at Min Temperature - Elemental

The time invariant thermal results include the following:

• Maximum and minimum elemental temperature over the complete transient run and the times
at which they occur.

• Maximum thermal error estimates at each element over the complete transient run and the
times at which they occur.

• Absorbed, incident, reflected, or transmitted radiative fluxes at each element when these values
are constant over the complete transient run.

In previous releases, these results were displayed in the first or last time step.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal

5-138 What's new in NX

Chapter 5: CAE



CAE

Thermal Thermal

Advanced Thermal
Axisymmetric Thermal Axisymmetric Thermal

Advanced Axisymmetric Thermal
Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite Loaded results file that contains transient thermal results.

Convective heat flux results

What is it?

You can now recover convective heat flux results on 2D shell elements. You request nodal, elemental,
or nodal and elemental types of results from the Convective Heat Flux Results Location list.

After you solve the model, depending on your request, either or both of the following result types
appear under the solution node in the Post Processing Navigator:

• Convective Heat Flux - Nodal

• Convective Heat Flux - Elemental
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Why should I use it?

Convective heat flux results help you analyze the results of your thermal simulation.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics as the specified solver.

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects

Location in dialog
box

Type list→Thermal Output Requests→Create→Thermal tab→
Convective Heat Fluxes

Swirl velocity results

What is it?

You can now recover swirl velocity results on 2D shell elements or on 1D axisymmetric elements.
You request nodal, elemental, or nodal and elemental types of results from the Swirl Velocity
Results Location list.

After you solve the model, depending on your request, either or both of the following result types
appear under the solution node in the Post Processing Navigator:

• Swirl Velocity on Walls - Nodal

• Swirl Velocity on Walls - Elemental
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The thermal solver computes swirl velocities when you define Thermal Stream, Thermal Convective
Zone, or Thermal Void loads, or Duct Flow Boundary Conditions simulation objects of type
One-Sided Total Temperature Effects or Two-Sided Total Temperature Effects.

Why should I use it?

These result sets help you analyze the behavior of your thermal model.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics as the specified solver.

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects

Location in dialog
box

Type list→Thermal Output Requests→Create→1D Flow tab→ Swirl
Velocities

Selective thermal results

What is it?

You can request specific thermal results on selected geometry, nodes, elements, or groups. In the
same thermal output request, you can specify different selections for results requests that are on the
Thermal tab, the Radiation tab, or the 1D Flow tab.

In the previous release, you could request thermal results only on all elements, all nodes, or on
all elements and nodes in the model.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics as the specified solver.
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Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
Location in dialog
box

Type list→Thermal Output Requests→Create→Thermal tab or Radiation
tab or 1D Flow tab→Entity Selection group→Entity list→Selected

Results location options

What is it?

The thermal solver can output the results at elements, at nodes, or at elements and nodes for
additional results sets. In the previous release, the thermal solver output only elemental results
for these results sets.

When you request one of the following results sets, you can now specify the location of the results.

On the Thermal tab:

• Total temperature

• Free and forced convection coefficient

On the 1D Flow tab:

• Velocity

• Swirl velocity

• Pressure

• Density

• Mass flow

• Reynolds number

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics as the specified solver.

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
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Location in dialog
box

Type list→Thermal Output Requests→Create→Thermal tab or 1D Flow
tab

Heat transfer coefficient magnitude for edge interface resistance

What is it?

You can now specify the heat transfer coefficient for an Interface Resistance simulation object of
type Edge Interface.

The resistance is calculated as:

1/(heat transfer coefficient x area)

At an edge interface, the area is calculated as follows:

area = (the length of the edge) x (the minimum shell thickness)

Why should I use it?

This improvement lets you define the resistance magnitude at an edge interface by specifying the
heat transfer coefficient, which is a value that is often available in handbooks.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal
Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation

Command Finder Interface Resistance

Simulation Navigator
Right-click the Simulation Objects node→New Simulation
Object→Interface Resistance

Location in dialog
box

Type list→Edge Interface→Magnitude group→Type list→Heat Transfer
Coefficient
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Modeling ablation and charring

What is it?

You can now model ablation and charring in the NX Multiphysics solver environment and apply the
created modeling object to the NX Multiphysics solution.

The ablation or charring of a material occurs at the phase change temperature when an object is
exposed to an intense transient heat source.

In addition to the thermal properties, you must define the phase change temperature and the latent
heat for the material that undergoes the ablation or charring.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow NX Advanced Thermal/Flow with

ESC
NX Space Systems Thermal Thermal Space Systems Thermal

Thermal Advanced Thermal
Axisymmetric Thermal Advanced Axisymmetric Thermal

NX Thermal and Flow

Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Creating the Ablation-Charring modeling object

Application Advanced Simulation

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
Location in dialog
box Type list→Ablation-Charring→Create

Applying the created modeling object to the NX Multiphysics solution

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit

Location in dialog
box

Solution Control node→Thermal Control group→Create

Ablation-Charring Material

5-144 What's new in NX

Chapter 5: CAE



CAE

Appending new mapped results to a results file

What is it?

You can now append new mapped results to a BUN results file. The specified destination BUN file
must have results at the same time points that you specify in the current mapping solution. To avoid
overwriting results in the destination BUN file, in your mapping solution, exclude elements that
already have results.

Why should I use it?

Use this option to include mapped results on a region of your model that you excluded from a
previous mapping.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Multiphysics Mapping Thermal

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box

Mapping Details node→Data Source and Destination group→Mapped
Data Destination list→Append to Selected Results File

Aligning source and target models for mapping

What is it?

The mapping solver now can automatically align source and target models if both models have
the following three named points defined: MAP1, MAP2, and MAP3. The three points in each
model must correspond to each other. Before it maps quantities, the mapping solver automatically
transforms the source model to line up the mapping points with those in the target model.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Mapping Thermal-Flow
NX Space Systems Thermal Mapping Thermal

Mapping Thermal-FlowNX Thermal and Flow
Axisymmetric Mapping Thermal

NX Multiphysics Mapping Thermal

Where do I find it?

Application Advanced Simulation
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Prerequisite
Corresponding MAP1, MAP2, and MAP3 named points defined in source
and target models

Command Finder Solve
Simulation Navigator Right-click a mapping solution node→Solve

Abaqus support enhancements

Abaqus keyword support enhancements

What is it?

This release includes support for a number of new Abaqus keywords.

Keyword Import support Export support Supported
parameters

For more
information, see

*BASE MOTION Yes Yes All required
and optional
parameters for
*MODAL DYNAMIC

analysis are
supported.

Expanded support
for Abaqus solution
types

*COHESIVE

BEHAVIOR

Yes Yes ELIGIBILITY,
REPEATED CONTACT,
TYPE

Cohesive behavior
now supported

*CONNECTOR

BEHAVIOR

Yes Yes All required
parameters
supported.

Element support
enhancements

*CONNECTOR

DAMPING

Yes Yes COMPONENT Element support
enhancements

*CONNECTOR

ELASTICITY

Yes Yes COMPONENT Element support
enhancements

*CONNECTOR

SECTION

Yes Yes ELSET, BEHAVIOR Element support
enhancements

*DAMAGE

EVOLOTION

Yes Yes TYPE, MIXED MODE

BEHAVIOR, MODE
MIX RATIO, POWER,
SOFTENING

Cohesive behavior
now supported

*DAMAGE

INITIATION

Yes Yes CRITERION=MAXS,
CRITERION=MAXU,
CRITERION=QUADS,
CRITERION=QUADU,
defining damage
initiation as part of
a contact property
model.

Cohesive behavior
now supported

*DAMAGE

STABILIZATION

Yes Yes N/A Cohesive behavior
now supported
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*DAMPING

CONTROLS

Yes Yes All parameters
supported.

Expanded support
for Abaqus solution
types

*DASHPOT Yes Yes ELSET,ORIENTATION Element support
enhancements

*DIRECT CYCLIC Yes Yes All optional
parameters
supported.

Expanded support
for Abaqus solution
types

*DISTRIBUTING

COUPLING

Yes Yes All parameters
supported.

Element support
enhancements

*DISTRIBUTION Yes Yes All required
parameters
supported.

Defining the
material orientation
of 3D elements with
a field

*DISTRIBUTION

TABLE

Yes Yes All parameters
supported.

Defining the
material orientation
of 3D elements with
a field

*DYNAMIC Yes Yes All optional
parameters for
the general implicit
integration method
are supported.

Expanded support
for Abaqus solution
types

*FREQUENCY Yes Yes SIM, DAMPING

PROJECTION

Expanded support
for Abaqus solution
types

*GLOBAL DAMPING Yes Yes All optional
parameters
supported.

Expanded support
for Abaqus solution
types

*INITIAL

CONDITIONS

Yes Yes TYPE(CONTACT),
TYPE(TEMPERATURE)

Cohesive behavior
now supported

Expanded support
for Abaqus solution
types

*JOINT Yes Yes All required
and optional
parameters
supported.

Element support
enhancements

*LOAD CASE Yes N/A NAME Initial import
support for Abaqus
load cases

*MEMBRANE

SECTION

Yes Yes All parameters
supported.

Element support
enhancements

*MODAL DAMPING Yes Yes All parameters
supported.

Expanded support
for Abaqus solution
types

*MODAL DYNAMIC Yes Yes All optional
parameters
supported.

Expanded support
for Abaqus solution
types
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*MONITOR Yes Yes All required
and optional
parameters
supported.

Monitoring nodes to
determine solution
progress

*PLASTIC Yes Yes HARDENING=KINEMATIC

and
HARDENING=COMBINED

*PLASTIC is used
in direct cyclic
analysis.

Expanded support
for Abaqus solution
types

*RESTART Yes Yes All parameters
supported except
CYCLE and
ITERATION.

Restarting Abaqus
analyses in NX

*SECTION

CONTROLS

Yes Yes HOURGLASS Non-default
hourglass control

*SELECT

EIGENMODES

Yes Yes All parameters
supported.

Expanded support
for Abaqus solution
types

*SOLID SECTION Yes Yes REF NODE is now
supported for
generalized plane
strain elements.

Element support
enhancements

*SOLUTION

TECHNIQUE

Yes Yes All parameters
supported.

Expanded support
for Abaqus solution
types

*SURFACE SECTION Yes Yes ELSET Element support
enhancements

*TIME POINTS Yes Yes NAME, GENERATE The *TIME POINTS

keyword is used
in direct cyclic
analysis.

Expanded support
for Abaqus solution
types

*VISCO Yes Yes All parameters
supported.

Expanded support
for Abaqus solution
types

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Menu File→Import→Simulation

File→Export→Simulation
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Element support enhancements

What is it?

This release includes support for a number of additional Abaqus element types, which include:

• Distributing coupling elements

• Connector elements

• 2D diffusive heat transfer elements

• Surface elements

• Dashpot elements

• Axisymmetric shell and membrane elements

• Generalized plane strain elements

• Rigid elements

Distributing coupling elements

You can now create Abaqus DCOUP2D distributing coupling elements in NX. You can use a
distributing coupling element to distribute forces and moments on a reference node to a collection
of nodes. DCOUP2D elements have a number of different applications. For example, you can
use a DCOUP2D element to do the following:

• Distribute mass to a collection of nodes.

• Distribute forces and moments on a reference node to a collection of nodes.

Abaqus
element

Description NX command for
element creation

NX Physical property
table

DCOUP2D Two-dimensional
distributing coupling
element

1D Connection with the
Node to Node, Point to
Point, Point to Edge, or
Point to Face types

N/A

Use the Mesh Associated Data dialog box to specify the mass to distribute to the coupling nodes.

Connector elements

You can now create Abaqus CONN3D2 connector elements in NX. You can use connector elements
when you need to connect two rigid bodies. Multi-point constraints cannot be used to connect the
bodies at nodes other than the reference nodes, since multi-point constraints use degree-of-freedom
elimination, and the other nodes on a rigid body do not have independent degrees of freedom.

Abaqus
element

Description NX command for
element creation

NX Physical property
table

CONN3D2 3-node linear element 1D Mesh or 1D
Connection

Connector Section

What's new in NX 5-149

CAE



Chapter 5: CAE

You can use the new Connector Section physical property table dialog box to define properties for
the elements, such as the connection type and orientation of the connector elements. The options in
the Connector Section dialog box correspond to the Abaqus *CONNECTOR SECTION keyword.

Diffusive heat transfer elements

The following table details the Abaqus diffusive heat transfer elements that are now supported in NX.
You can use these elements in heat transfer analysis. Diffusive heat transfer elements allow for heat
storage (specific heat and latent heat effects) and heat conduction. They also provide temperature
output that you can use as input to the equivalent stress elements.

Abaqus
element

Description NX command for
element creation

NX Physical property
table

DC2D3 3-node linear element 2D Mesh Solid 2D Plane
DC2D4 4-node linear element 2D Mesh Solid 2D Plane
DC2D6 6-node quadratic element 2D Mesh Solid 2D Plane
DC2D8 8-node bi-quadratic

element
2D Mesh Solid 2D Plane

You can use the Solid 2D Plane physical property table dialog box to define properties for the
elements, such as material orientation and planar thermal thickness. The options in the dialog box
correspond to the Abaqus *SOLID SECTION keyword.

Surface elements

You can now create certain types of Abaqus surface elements in NX. Surface elements are similar
to Abaqus membrane elements. They are surfaces in space with no inherent stiffness. Surface
elements are useful in a number of specific modeling cases. For example, you can use surface
elements to bring additional mass into the model in the form of a mass per unit area. You can also
use surface elements to distribute the mass of fuel in a tank over the tank surface, particularly when
the tank is modeled with solid elements.

Abaqus
element

Description NX command for
element creation

NX Physical property
table

SFM3D3 3-node triangle element 2D Mesh Surface Section
SFM3D4 4-node quadrilateral

element
2D Mesh Surface Section

SFM3D4R 4-node quadrilateral
element, reduced
integration

2D Mesh

Use the Element
Formulation option in
the Mesh Associated
Data dialog box to select
the reduced formulation.

Surface Section

SFM3D6 6-node triangle element 2D Mesh Surface Section
SFM3D8 8-node quadrilateral

element
2D Mesh Surface Section

5-150 What's new in NX

Chapter 5: CAE



CAE

Abaqus
element

Description NX command for
element creation

NX Physical property
table

SFM3D8R 8-node quadrilateral
element, reduced
integration

2D Mesh

Use the Element
Formulation option in
the Mesh Associated
Data dialog box to select
the reduced formulation.

Surface Section

The options in the Surface Section physical property table dialog box correspond to the options for
the *SURFACE SECTION keyword.

Dashpot elements

You can now create Abaqus dashpot elements in NX. Dashpot elements can be linear or nonlinear
and can couple a force with relative velocity or a moment with angular velocity. You can use dashpots
to model a relative velocity-dependent force or torsional resistance. You can also use dashpot
elements as a mechanism for dissipating on viscous energy dissipation.

Abaqus
element

Description NX command for
element creation

NX Physical property
table

DASHPOT1 Dashpot element between
a node and the ground
that acts in a fixed
direction.

0D Mesh Grounded Dashpot

DASHPOTA Axial dashpot element
between two nodes,
whose line of action is
the line that joins the two
nodes.

1D Mesh or 1D
Connection

DashpotA

DASHPOT2 Dashpot element between
two nodes that acts in a
fixed direction.

1D Mesh or 1D
Connection

Dashpot

The options in the Grounded Dashpot, DashpotA, and Dashpot physical property table dialog
boxes correspond to the Abaqus *DASHPOT keyword.

Axisymmetric shell and membrane elements

You can now create Abaqus axisymmetric shell (SAX1, and DSAX1) and membrane (MAX1) elements
in NX. You can use these elements to model axisymmetric geometry with axisymmetric deformation.

• Use SAX1 elements in stress and displacement analyses.

• Use DSAX1 elements in heat transfer analyses.

• Use MAX1 elements to model thin surfaces about a symmetry axis. MAX1 elements do not
allow for any twist about that axis.
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Abaqus
element

Description NX command for
element creation

NX Physical property
table

SAX1 2-node thin or thick linear
shell, stress/displacement
element

1D Mesh or 1D
Connection

Axisymmetric Shell
Section

DSAX1 2-node shell heat transfer
element

1D Mesh or 1D
Connection

Axisymmetric Shell
Section

MAX1 2-node linear membrane
element, with no twist

1D Mesh or 1D
Connection

Axisymmetric
Membrane Section

The options in the Axisymmetric Shell Section physical property table dialog box correspond to the
options and data lines for the Abaqus *SHELL SECTION keyword.

The options in the Axisymmetric Membrane Section physical property table dialog box correspond
to the options and data lines for the Abaqus *MEMBRANE SECTION keyword.

Generalized plane strain elements

You can now create a number of different types of Abaqus generalized plane strain elements in NX.
You can use generalized plane strain elements to model cases in which the structure has constant
curvature with respect to the axial direction of the model. Generalized plane strain elements are
typically used to model a section of a long structure that is free to expand axially or is subjected
to axial loading.

The options in the Generalized Plane Strain physical property table dialog boxes correspond to the
options and data lines for the Abaqus *SOLID SECTION keyword.

Abaqus
element

Description NX command for
element creation

NX Physical property
table

CPEG3 3-node linear triangle
element

2D Mesh Generalized Plane
Strain

CPEG3H 3-node linear triangle,
hybrid element with
constant pressure

2D Mesh Generalized Plane
Strain

CPEG4 4-node bilinear
quadrilateral element

2D Mesh Generalized Plane
Strain

CPEG4H 4-node bilinear
quadrilateral, hybrid
element with constant
pressure

2D Mesh Generalized Plane
Strain

CPEG4I 4-node bilinear
quadrilateral element,
incompatible modes

2D Mesh Generalized Plane
Strain

CPEG4IH 4-node bilinear
quadrilateral element,
incompatible modes,
hybrid with linear pressure

2D Mesh Generalized Plane
Strain
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Abaqus
element

Description NX command for
element creation

NX Physical property
table

CPEG4R 4-node bilinear
quadrilateral element,
reduced integration with
hourglass control

2D Mesh Generalized Plane
Strain

CPEG4RH 4-node bilinear
quadrilateral element,
reduced integration with
hourglass control, hybrid
with constant pressure

2D Mesh Generalized Plane
Strain

CPEG6 6-node quadratic triangle
element

2D Mesh Generalized Plane
Strain

CPEG6H 6-node quadratic triangle
element, hybrid with linear
pressure

2D Mesh Generalized Plane
Strain

CPEG6M 6-node modified element,
with hourglass control

2D Mesh Generalized Plane
Strain

CPEG6MH 6-node modified element,
with hourglass control,
hybrid with linear pressure

2D Mesh Generalized Plane
Strain

CPEG8 8-node biquadratic
quadrilateral element

2D Mesh Generalized Plane
Strain

CPEG8H 8-node biquadratic
quadrilateral element,
hybrid with linear pressure

2D Mesh Generalized Plane
Strain

CPEG8R 8-node biquadratic
quadrilateral element,
reduced integration

2D Mesh Generalized Plane
Strain

CPEG8RH 8-node biquadratic
quadrilateral element,
reduced integration,
hybrid with linear pressure

2D Mesh Generalized Plane
Strain

Rigid elements

You can now create a number of different types of Abaqus rigid elements in NX. You can use rigid
elements to define the surfaces of rigid bodies for contact or for multi-body dynamic simulations. You
can also attach rigid elements to deformable elements. For example, you can:

• Use R2D2 elements in plane stress or plane strain analyses.

• Use RAX2 elements to model axisymmetric planar geometry.

• Use RB2D2 and RB3D2 elements as rigid links between nodes on deformable bodies.
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Rigid elements are also associated with a given rigid body and share a common node, known as
the rigid bod reference node. In NX, use the Rigid Body Reference Node option in the Mesh
Associated Data dialog box to select the appropriate reference node.

Abaqus
element

Description NX command for
element creation

NX Physical property
table

R2D2 2-node linear link element 1D Mesh or 1D
Connection

Rigid Body Section

R3D3 3-node, triangular facet
element

2D Mesh Rigid Planar Section

R3D4 4-node, bilinear
quadrilateral element

2D Mesh Rigid Planar Section

RAX2 2-node shell heat transfer
element

1D Mesh or 1D
Connection

Rigid Body Section

RB2D2 2-node thin or thick linear
shell, stress/displacement
element

1D Mesh or 1D
Connection

Rigid Body Section

RB3D2 2-node rigid beam
element

1D Mesh or 1D
Connection

Rigid Beam Section

The options in the new rigid body physical properties dialog boxes as well as the Reference Node
option in the Mesh Associated Data dialog box correspond to the options and data lines for the
Abaqus *RIGID BODY keyword.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

Abaqus as the specified solver

Expanded support for Abaqus solution types

What is it?

This release includes significantly enhanced support for the types of Abaqus solutions that you can
create within NX Advanced Simulation. You can now perform the following types of analyses:

• Visco analyses

• Transient modal dynamic analyses

• Implicit dynamic stress and displacement analyses

• Direct cyclic analyses

• Transient heat analysis in axisymmetric thermal analyses
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Visco analyses

You can now create Visco type steps in an Abaqus General Analysis solution to calculate a transient
static response in a solution that includes time-dependent material behavior. Time-dependent
material behavior includes:

• Creep

• Swelling

• Viscoelasticity

For example, you can create a Visco step to analyze quasi-static creep and swelling problems, which
occur over fairly long periods of time. You can also use a Visco step to analyze both viscoelastic
and two-layer viscoplastic materials.

Note

You can use all material models that are valid in a static analysis procedure in a Visco
analysis step.

Use the options on the new Visco Step Setup tab in the Solution Step dialog box to specify
options to control the quasi-static step as well as optional creep and damping parameters.
For example, you can specify the following:

• Options to control time incrementation.

• The method to control explicit creep integration.

• Whether to have Abaqus automatically stabilize minor, local instabilities.

The options on the Visco Step Setup tab correspond to the parameters for the Abaqus *VISCO

keyword.

Transient modal dynamic analyses

Use the new Transient Modal Dynamic Step type to analyze a transient linear dynamic problem
using modal superposition. In a transient modal dynamic analysis, Abaqus calculates the response
of the model as a function of time based upon time-dependent loading. The structure’s response
is based on a subset of the modes of the system. You must first extract these modes using an
eigenfrequency extraction procedure.

You can either use the modes that Abaqus extracted in a prior eigenfrequency step or you can
specify different modes.

The options on the Transient Modal Dynamic Step Setup tab correspond to the parameters for
the Abaqus *MODAL DYNAMIC keyword.

Implicit dynamic stress and displacement analyses

Use the new Implicit Dynamic type of Solution Step to perform Abaqus implicit, direct integration
analyses in NX. You can use an Implicit Dynamic step to perform:

• Dynamic stress and displacement analysis using explicit integration.
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• Adiabatic stress analysis.

In these analyses, Abaqus uses implicit time integration to calculate the transient dynamic response
of a system. You can use implicit direct integration dynamic analysis to study nonlinear transient
dynamic response.

Use the options on the new Implicit Dynamic Step Setup tab in the Solution Step dialog box to
specify the options for the analysis. For example, you can specify the following:

• The time incrementation for the dynamic stress and/or displacement analysis.

• The time integration method to use.

• The time incrementation scheme to use when contact impacts or releases occur during the
analysis.

The options on the Implicit Dynamic Step Setup tab correspond to the parameters for the Abaqus
*DYNAMIC keyword.

Direct cyclic analyses

Use the new Direct Cyclic type of step in the Solution Step dialog box to perform a direct cyclic
procedure for nonlinear, non-isothermal, quasi-static analyses. You can use a Direct Cyclic analysis
to predict the following:

• Progressive damage and failure for ductile bulk materials.

• Delamination or debonding growth at the interfaces in laminate composites in low-cycle fatigue
analyses.

Use the options on the Cyclic Step Setup tab in the Solution Step dialog box to control, for example:

• Time incrementation.

• The number and increment of the Fourier terms.

• The time integration accuracy of the creep integration.

Additionally, you can use the new Time Points modeling object to specify the time points at which
Abaqus evaluates the structural response.

The options on the Cyclic Step Setup tab correspond to the parameters for the Abaqus *DIRECT

CYCLIC keyword. The options in the Time Points dialog box correspond to the parameters for the
Abaqus *TIME POINTS keyword.

Transient heat analysis in axisymmetric thermal analyses

When you create a Heat Transfer solution in Abaqus Axisymmetric Thermal analyses, you can now
create both steady-state and transient heat transfer steps. In previous releases, only steady-state
heat transfer analysis was supported in the axisymmetric environment.

• Create a Steady State Analysis step to omit the specific heat term in the governing heat transfer
equation.
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• Create a Transient Analysis step to perform a transient heat transfer analysis. In transient
steps, Abaqus performs time integration with the backward Euler method in the pure conduction
elements. You can use a Transient Analysis step to control uncoupled heat transfer with a
transient response analysis.

You can use this transient capability to model solid body heat conduction with general,
temperature-dependent conductivity, internal energy (including latent heat effects), and both general
convection and radiation boundary conditions.

Note that:

• If you do not include specific heat data in your material (*SPECIFIC HEAT keyword), Abaqus issues
an error message when you solve the solution.

• If the Iterative solver method is used, you might not be able to generate numerical results if your
hardware does not support multiprocessing or your Abaqus solver license does not allow you to
run parallel execution. If that is the case, you will get an error message.

Additionally, in the Solution dialog box, you can use the new Initial Conditions option to specify
an Initial Temperature value for the model. In previous releases, this value was hardcoded by the
software, and you could not modify it.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Simulation Navigator Right-click a Simulation→New Solution

Initial import support for Abaqus load cases

What is it?

NX now provides initial import support for the Abaqus *LOAD CASE and *END LOAD CASE keywords. In
Abaqus, a load case refers to a set of loads, boundary conditions, and base motions that define a
particular loading condition. For example, in a simplified model, the operational environment of
an airplane might be broken into five load cases: (1) take-off, (2) climb, (3) cruise, (4) descent,
and (5) landing.

You can use this initial support to import load cases that are associated with static perturbation
steps into NX.

• If the input file contains a single load case in one solution step, NX imports all loads and
constraints in the load case and associates them with the solution step in the Simulation
Navigator.

• If the input file contains multiple load cases in one solution step, NX imports all loads and
constraints in the load cases. Each imported load or constraint is named after the associated
load case and step number, such as Boundary3_in_LoadCase2_Step5.

o Only loads and constraints in the first load case of the step are associated with the solution
step in the Simulation Navigator.
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o NX places the loads and constraints from all subsequent load cases in either the Load
Container or the Constraint Container in the Simulation Navigator. You can then add
these loads and constraints to the appropriate solutions or solution steps.

For example, you import an Abaqus input file that contains two static perturbation steps, and each
step has two load cases:

• Solution Step 1: LoadCaseA and LoadCaseB

• Solution Step 2: LoadCaseC and LoadCaseD

During the import process, NX creates two steps in the Simulation Navigator. The loads and
constraints associated with load cases A, B, C, and D are imported as follows:

• All loads and constraints from load case A and C are imported and associated with steps 1 and
2, respectively. This occurs because load case A and load case C are the first load case in
each step.

• All loads and constraints from load cases B and D are imported and placed in the Load
Container or the Constraint Container in the Simulation Navigator.

In previous releases, NX ignored any *LOAD CASE and *END LOAD CASE keywords in an imported
input file.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Menu File→Import→Simulation

Improved support for importing Abaqus assemblies

What is it?

In Abaqus, you can define a finite element model as an assembly of individual part instances.
Assemblies allow you to reuse part instance definitions, which is particularly helpful when creating
large, complex models.

In NX 9, NX offered initial support for a number of the Abaqus assembly keywords, such as
*PART/*END PART, *ASSEMBLY/*END ASSEMBLY, and *INSTANCE/*END INSTANCE. NX now imports load,
constraint, and solution step data associated with part instances in an Abaqus assembly model.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Menu File→Import→Simulation
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Monitoring nodes to determine solution progress

What is it?

In Abaqus, you can monitor the progress of an overall solution through a selected node or
degree-of-freedom. Use the new Monitor modeling object dialog box to:
• Select a specific node and degree-of-freedom to monitor.

Note

The degree-of-freedom you select must be valid for the selected node. For example, if the
node you select belongs to a membrane element, the only active degrees-of-freedom are
1, 2, 3. If the degree-of-freedom you select is not valid, Abaqus issues an error message
and the solve does not run.

• Control the frequency with which the software outputs the status of the node or degree-of-freedom.

After you create a Monitor modeling object, you can use the new Monitor Request options in the
Step dialog box to associate the appropriate modeling object with the step.

You can change the node or degree-of-freedom that you are monitoring in individual steps by creating
multiple Monitor modeling objects.
When you solve the solution, Abaqus prints information about the node you are monitoring in the
Abaqus status file (job-name.sta). The status file is a text file that contains information about the
progress of an analysis. You can examine the status file as Abaqus solves the solution.

The options in the Monitor dialog box correspond to the options for the Abaqus *MONITOR keyword.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Command Finder

Modeling Objects

Non-default hourglass control

What is it?

You can use the new Hourglass Control options in the Mesh Associated Data dialog box to select
a non-default hourglass control approach for:

• Shell elements.

• Membrane elements (S4R and M3D4R elements).

Use the Hourglass Control options to select the appropriate method for hourglass control.
• Select the Stiffness method to base the hourglass control on the assumed enhanced strain

method. You can then enter separate scaling factors for the hourglass stiffness to use with the
element’s displacement and rotational degrees-of-freedom.
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• Select the Enhanced method to define hourglass control that is based on the assumed enhanced
strain method. This formulation provides improved coarse mesh accuracy with slightly higher
computational cost and performs better for nonlinear material response at high strain levels when
compared with the default total stiffness formulation.

The new Hourglass Control options correspond to parameters for the Abaqus *SECTION CONTROLS

keyword.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

Abaqus as the specified solver
Command Finder

Mesh Associated Data

Restarting Abaqus analyses in NX

What is it?

You can now restart Abaqus solutions from NX. For example, you can solve a solution that uses
saved data from a previous analysis of the same finite element model. For complex solutions that
contain multiple steps, you want to run the analysis in stages rather than analyze all steps within a
lengthy, single solve. Running an analysis in stages allows you to examine the results and confirm
that the solution is proceeding as you expected before you continue with the next step.

Note

When you restart a solution, you cannot change any of the basic model definition data
associated with that solution, such as the mesh or the associated materials.

You can use new options to:

• Write out the necessary information to restart the analysis at a later time.

• Read in existing restart files so that you can restart the analysis.

Files required to restart a solution

To restart an analysis, you must first request that the files required for a restart be written out when
you first solve a solution. These restart files allow you to complete an analysis to a certain point in the
solve and then restart and continue the analysis in a subsequent solve.

Abaqus requires the following files for a restart:

• Restart file (.res)

• Analysis database (.mdl and .stt)

• Part (.prt)

• Output database (.odb)
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• Linear dynamics and substructure database (.sim)

Writing out the necessary information to later perform a restart

Use the new Restart Output Control options on the Output tab in the Solution Step dialog box to
write out restart information for a given step. You can:

• Indicate that the restart output is the same as restart data requested in a previous step

• Use the new Restart modeling object to define the options that control the restart of an analysis.

You can write out restart information from the following types of Abaqus steps:

• General

• Static Perturbation

• Visco

• Implicit Dynamics

The options in the Restart dialog box correspond to the options for the Abaqus *RESTART keyword.

Reading existing restart information into a solution

To restart an analysis, you must read in the appropriate, existing restart information to your current
solution. Use the options on the new Restart tab the Solution dialog box to specify the restart
information to read in. For example, you can:

• Specify the name of the solution that you want to restart.

• Indicate whether you want to restart from the last available step or increment.

• Specify whether you want to resume the initial analysis or re-run the analysis from the beginning.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver

Structural as the specified analysis type
Command Finder

Modeling Objects
Location in dialog box Type→Restart
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Time-varying forces or adjustments for Bolt Pre-loads

What is it?

When you define a Bolt Pre-Load in the Abaqus environment, you can define a pre-tension load to
simulate the loading of bolts in a structure. When you create a Bolt Pre-Load, you must specify the
amount of the pre-tension force or the tightening adjustment for the bolt.

You can now use a field to define a force or tightening adjustment that varies with time for both 1D
and 3D bolts. If you use a field, NX writes out a both *CLOAD and an *AMPLITUDE keyword when you
export or solve the solution.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

Abaqus as the specified solver

Structural as the specified analysis type
Command Finder

Bolt Pre-Load
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Defining the material orientation of 3D elements with a field

What is it?

You can now define the material orientation vector of Abaqus 3D elements using a spatial field.
This means that you can use the Spatial Field option to define the spatially varying distribution of
orientation angles on the layers of Abaqus composite solid continuum elements and composite
shell elements from within NX.

In previous releases, the Spatial Field option was available only when you imported an Abaqus input
file that used the *DISTRIBUTION keyword to define material orientation vector data for solid elements
as a field.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

Abaqus as the specified solver
Command Finder

Mesh Associated Data
Location in dialog box Material Orientation Method list→Spatial Field

Cohesive behavior now supported

What is it?

When you define contact in the Abaqus environment, you can now model cohesive behavior for the
contacting surfaces. In Abaqus, cohesive behavior is a generalized traction-separation behavior
for surfaces. Cohesive behavior is defined as a surface-based contact property for contact pairs.
Surface-based cohesive behavior is primarily intended for situations in which the interface thickness
is negligibly small. For example, you can use cohesive behavior when you model the following:

• The delamination at interfaces in terms of traction versus separation.

• Two sticky surfaces that come into contact with each other during an analysis. Sticky surfaces are
surfaces or parts of surfaces that are not initially in contact but which may bond together when
they come into contact with each other. Subsequently, the bond may damage and fail.

Surface-based cohesive behavior has the following characteristics:

• It allows you to specify cohesive data, such as the fracture energy as a function of the ratio of
normal to shear displacements at the interface.

• It assumes a linear elastic traction-separation law prior to damage.

• It assumes that the failure of the cohesive bond is characterized by progressive degradation of
the cohesive stiffness, which is driven by a damage process.

• It allows specification of post-failure cohesive behavior if failed nodes re-enter contact.
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Defining cohesive behavior for contact pairs

You can use the new Cohesive Behavior modeling object to define properties for the surface-based
cohesive behavior. For example, you can define the traction-separation response behavior as well as
specify the set of nodes affected by the cohesive behavior. After you define the Cohesive Behavior
modeling object, select the new Include Cohesive Behavior check box in the Contact Pair dialog
box to include the modeling object in the solution.

Defining damage modeling

When you include cohesive behavior in a solution, you can also include damage modeling to simulate
the degradation and eventual failure of the bond between two cohesive surfaces. You specify damage
behavior as part of the interaction properties for the surfaces. Cohesive surfaces can have only one
damage initiation criterion and only one damage evolution law.

• Use the Damage Initiation modeling object to specify parameters to define the initiation of
damage. Damage initiation occurs at the beginning of degradation of the cohesive response at a
contact point. You can use options in the Damage Initiation dialog box to define the damage
initiation criteria, such as the maximum separation or stresses.

• Use the Damage Evolution modeling object to specify the material properties that define the
evolution of damage. For example, you can define the evolution of damage in terms of the energy
required for failure (fracture energy) after the initiation of damage.

• Use the Damage Stabilization modeling object to specify the viscosity coefficients for the
damage model. These coefficients are used in the viscous regularization scheme for the damage
model.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Command Finder

Modeling Objects
Location in dialog box Type→Cohesive Behavior

Support for nodal temperature output

What is it?

You can use the new Structural Output Requests dialog box to report nodal temperature data in a
structural solution. On the Thermal tab, select NT-Nodal Temperature. This option corresponds to
the Abaqus NT output variable which outputs all temperature values at a given node.

• For continuum elements, there is only one temperature value per node (NT11).

• For shell and beam elements, there are multiple temperature values per node (NT11, NT12,
and so on).
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Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Command Finder

Modeling Objects
Location in dialog box Type→Abaqus Structural Output Requests

Specifying temperature units on import and export

What is it?

In this release, you can control the units used for temperatures in your model during import and
export. This gives you the flexibility to define temperatures in a different unit system, such as Kelvin,
than the rest of your model, which may be in metric or British units. In the Import Simulation or
Export Simulation dialog box, use the new Specify temperature units list to select the unit system
to use for temperatures in the model.

In previous releases, for example, if the imported unit system for your model was British units, NX
imported all temperature values in the input file as °F. Similarly, if the imported unit system was metric,
all temperature values were interpreted as °C.

Where do I find it?

Import Simulation dialog box

Application Advanced Simulation
Prerequisite A Simulation file is the displayed part and the work part

Abaqus is the specified solver
Menu File→Import→Simulation

File→Export→Simulation

Improvements for appending and merging Abaqus data

What is it?

This release contains improvements when you use the Append Merge option in the Solver Deck
Append dialog box to import data. Now, if your source Abaqus input file has a different analysis type
or a different setting from the destination NX FEM or Simulation file for the 2D Solid Option, NX
now imports, appends, and merges the data. In previous releases, depending on the combination of
the type of analysis and the 2D Solid Option setting in the source and destination files, NX often
could not import and append the data.

Where do I find it?

Application Advanced Simulation
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Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver
Menu File→Append→Simulation

Abaqus axisymmetric contact analysis (10.0.1)

What is it?

This release includes expanded support for contact analyses in the Abaqus environment. You
can now perform a number of different types of contact analyses in axisymmetric structural and
thermal models. In previous releases, contact analyses in the Abaqus environment were limited to
non-axisymmetric models.

The following table summarizes the commands that are now available for axisymmetric structural
and thermal solutions:

Abaqus
element

Description Analysis types
supported

Corresponding Abaqus
keywords

Edge-to-Edge

Contact

Defines contact
conditions between
selected polygon edges
or element edges.

Axisymmetric structural *CONTACT PAIR

*SURFACE

Contact
Interference

Defines time-dependent
allowable interferences
for contact pairs and
elements.

You can use Contact
Interference to model
interference fits (press
fits) when there are large
overclosures between the
contacting surfaces in
the initial configuration of
the model. The defined
contact interferences
can result in stresses
and strains as the solver
resolves the overclosure
between the contacting
surfaces.

Axisymmetric structural *CONTACT PAIR

*CONTACT INTERFERENCE
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Abaqus
element

Description Analysis types
supported

Corresponding Abaqus
keywords

Contact with

Clearance

Defines precise clearance
or overclosure values
for the nodes on the
slave (target) surface
in a contact pair. An
overclosure value allows
you to specify any
initial penetration for
the contacting surfaces.

Axisymmetric structural *CONTACT PAIR

*CLEARANCE

Surface-to-Surface
Thermal
Conductance

Models conductive
heat transfer between
proximate or contacting
surfaces. You can model
the conductive heat
transfer as a function of:

• The clearance
between the
contacting surfaces.

• The contact pressure
at the interface
between the
contacting surfaces.

• Both the clearance
and the contact
pressure.

Axisymmetric thermal *GAP CONDUCTANCE

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver

Axisymmetric Structural or Axisymmetric Thermal as the analysis type

General Analysis or Heat Transfer as the solution type
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ANSYS support enhancements

Support for ANSYS rigid bodies

What is it?

In ANSYS, you can use rigid bodies to simulate multi-body dynamic analyses. A rigid body consists
of a set of rigid body nodes, defined by contact elements, and a single pilot node, defined by a target
element. The motion of the rigid body is controlled by the degrees-of-freedom at the pilot node.

Beginning in this release, you can use new options in the Region dialog box to define rigid bodies.

Specifying a region type and a pilot node

In the Region dialog box, when you select No from the Use ESURF list, you can use the options in
the Region Type and Pilot Node group to define the rigid body.

• Use the Region Type list to indicate whether the region is rigid or flexible.

• Use the Select Pilot Node option to designate a node to serve as the pilot node.

In ANSYS, a rigid body cannot exist by itself. It must be in contact with or be connected to other
bodies through contact elements. The requirements for defining a rigid body differ depending upon
whether your solution is static or dynamic.

• In a static solution, you must create one Structural Contact definition that contains a Source
Region and a Target Region.

o The Source Region must be a Flexible type of region.

o The Target Region must be a Rigid type of region and contain a specified Pilot Node.

• In a dynamic solution, you should generally create two Structural Contact definitions, although
only one is required by ANSYS.

Specifying the KEYOPTs for the target elements

New TARGE170 KEYOPTs options have been added to the CONTA174ET modeling object dialog
box. Use these options to specify options for the target elements, such as whether ANSYS should
automatically constrain the target nodes.

Where do I find it?

Simulation Region

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Structural as the specified analysis type
Command Finder

Simulation Region

5-168 What's new in NX

Chapter 5: CAE



CAE

CONTA174ET modeling object

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Structural as the specified analysis type
Command Finder

Modeling Objects
Location in dialog box Type→ list CONTA174ET

Update of ANSYS element offerings

What is it?

In recent ANSYS releases, a number of elements have become obsolete and have been replaced by
updated, enhanced versions. In this release, a number of the elements available in the ANSYS solver
environment in NX have been updated to reflect those changes.

Obsolete ANSYS element Obsolete element removed
from NX?

Replacement element now
available in NX

SOLID92 Yes SOLID187
SOLID45 Yes SOLID185
SOLID95 Yes SOLID186
BEAM4/BEAM44 No BEAM188
LINK8/LINK10 No LINK180
SHELL57 Yes SHELL131
SHELL63 Yes SHELL181
SHELL91 Yes SHELL132/SHELL281
SHELL93 Yes SHELL132/SHELL281
SHELL99 Yes SHELL132/SHELL281
CONTAC12/CONTAC52 No CONTA178
PLANE42 Yes PLANE182
PLANE82 Yes PLANE183

Migration of legacy elements

How NX imports these obsolete or legacy elements depends on whether the elements have
associated KEYOPTS in the ANSYS input file.

• If an element has associated KEYOPTS, then NX imports the legacy element.

• If an element does not have associated KEYOPTS, then NX automatically migrates the element
to the appropriate replacement element. For example, NX migrates a SOLID45 element to a
SOLID185 element.
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A new Keyopts option has been added to the Mesh Associated Data dialog box to help you migrate
obsolete elements to their replacements. For a legacy element, you can use this option to assign the
appropriate replacement KEYOPTS modeling object to the element.

New customer defaults for legacy elements

This release also includes new customer defaults that you can use to facilitate the import of older
ANSYS input files that may contain these obsolete or legacy elements. For each type of legacy
element, you can use these options to specify whether they should be imported as the corresponding
replacement element type or as legacy element type.

Where do I find it?

Mesh Associated Data

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and the work part

ANSYS as the specified solver
Simulation Navigator Right-click a mesh→Edit Mesh Associated Data

Customer defaults

Menu File→Utilities→Customer Defaults
Location in dialog box Simulation→ANSYS→Legacy Elements tab

New customer defaults for ANSYS element KEYOPTS

What is it?

Use the new ANSYS KEYOPTS customer defaults to set the default values for the KEYOPTS options
for the following element types:

• BEAM188

• SHELL131 and SHELL132

• SHELL181 and SHELL281

• PLANE55

• PLANE77

• PLANE182 and PLANE183

• SOLID185

• SOLID186

• SOLID187

• SOLID226 and SOLID227
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In ANSYS, you use KEYOPTS to specify additional options for elements. In NX, you specify KEYOPTS

for ANSYS elements in the appropriate element type Modeling Object dialog box. For example,
for BEAM188 elements, you use the BEAM188ET dialog box to set KEYOPTS, such as the linear
interpolation scheme to use.

In previous releases, the default values for ANSYS KEYOPTS were always set to their ANSYS default
value.

Where do I find it?

Menu File→Utilities→Customer Defaults
Location in dialog box Simulation→ANSYS→KEYOPTS tab

Support for transient thermal analysis

What is it?

You can use the new Transient Thermal solution type to analyze temperatures and other thermal
quantities over time. In previous releases, the ANSYS environment in NX supported only steady-state
thermal analyses. Within a transient thermal analysis, you can include multiple transient steps that
include time-varying (or constant) loads and constraints.

Defining an initial temperature for the solution

In a Thermal Transient analysis, you must first define the initial temperature value for all nodes
before you analyze how that temperature changes over time. To define the initial temperature:

• If you know the initial temperature values:

o You can use the Uniform Initial Temperature option in the Solution dialog box to apply a
uniform temperature to all nodes.
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o You can create an Initial Temperatures simulation object to apply different initial
temperatures to selected nodes. For those nodes, the temperature value you specify in
the Initial Temperatures dialog box overrides the value you specify in the Uniform Initial
Temperature box.

• If you do not know the initial temperature values, you can include a Steady State Thermal step
in your analysis immediately before the Transient step to calculate the temperature values.

Specifying parameters to control time increments

In addition to specifying the initial temperatures, you must also use the new Transient Parameters
modeling object to define the time increment options.

Defining solution options

You can use options in the Solution dialog box to define options for the transient thermal solution.
For example, you can define the following:

• Whether the loads should be ramped or stepped during the analysis, or whether the software
should determine this automatically.

• Nonlinear transient solution options, which correspond to the ANSYS THOPT command.

• How often ANSYS outputs the solution results.

Using a transient time table

If you set the Automatic Time Stepping option to On in the Transient Parameters dialog box, you
can create a Transient Time Table modeling object to define an array of key times at which the time
stepping changes. Use a Transient Time Table when the time stepping is not constant.

The options in this dialog box correspond to the ANSYS TSRES array command.

Where do I find it?

Transient Thermal

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Thermal as the specified Analysis Type

Transient Thermal as the specified Solution Type

Transient Parameters and Transient Time Table modeling objects

Application Advanced Simulation
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Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Thermal as the specified Analysis Type

Transient Thermal as the specified Solution Type
Command Finder

Modeling Objects

Support for transient dynamic analysis

What is it?

You can now perform ANSYS transient dynamics analyses in Advanced Simulation. You use
transient dynamic analysis, also called time-history analysis, to determine the dynamic response of
a structure when time-dependent loads are applied. You can use a transient dynamic analysis to
determine the time-varying displacements, strains, stresses, and forces in a structure as it responds
to a combination of loads.

Note

In a transient dynamic analysis, the time scale of the loading is such that the inertia or damping
effects are considered to be important.

NX supports the following methods to perform an ANSYS transient dynamic analysis:

• The full method.

• The mode superposition method.

The following table summarizes these two method.

Solution
method

Description Support for
nonlinearities?

Full Method Uses the full system
matrices to calculate
the transient response,
with no matrix reduction.

Yes

Solutions can
include all types
of nonlinearities,
such as plasticity,
large deflections,
and large strains.

Mode
Superposition

Sums the factoredmode
shapes (eigenvectors)
from a modal analysis to
calculate the structure's
response.

No

This solution can
be used only for
linear systems.

Where do I find it?

Application Advanced Simulation
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Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Structural as the specified Analysis Type

Transient Dynamic-Full Method or Transient Dynamic-Mode
Superposition as the specified Solution Type

Support for thermal-structural multiphysics analysis

What is it?

Use the new Coupled Fields Thermal-Structural solution type to perform coupled thermal-structural
analyses in the ANSYS structural environment. NX currently supports coupled-field analysis using
the direct method. The direct method typically involves one analysis that uses a coupled-field type of
element that contains all necessary degrees-of-freedom. ANSYS handles the coupling by calculating
element matrices or element load vectors that contain all necessary terms.

For more information, see the ANSYS Coupled-Field Analysis Guide.

Supported elements and properties

In this initial release, the Coupled Fields Thermal-Structural solution offers more complete element
support for the structural portion of the solve than for the coupled portion of the solve and more
limited support for the thermal portion of the solve. Currently, you can use all structural elements (0D,
1D, 2D, 3D) available in NX for the structural solve. However, you can only use SOLID226 (20-node
hexadedral) or SOLID227 (10-node tetrahedral) elements to perform coupled fields analysis. These
are the only types of elements that can, for example, accept both thermal and structural types of loads
and boundary conditions and compute heat transfer.

Supported loads and constraints

The following thermal loads, constraints, and simulation objects have been added to the ANSYS
structural environment to facilitate Coupled Fields Thermal-Structural analyses:

• Thermal Constraints and Convection

• Heat Flux, Radiation and Heat Generation

• Automatic Thermal Coupling and Manual Thermal Coupling

Note

ANSYS issues a warning message in the diagnostic file if your input file contains loads or
constraints that are applied to the wrong element types. You cannot define thermal loads,
constraints, and simulation objects on structural elements. You can apply thermal loads only to
SOLID 226 and SOLID227 elements.

In a Coupled Fields Thermal-Structural solution, you use the Structural Contact dialog box to
define both structural and thermal contact. You use the CONTA174 Real Constants modeling
object to define the appropriate options for both structural and thermal contact in a Coupled Fields
Thermal-Structural solution.
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Specifying options for the solution and steps

When you define a Coupled Fields Thermal-Structural solution, use the options on the new
Multi-Fields Parameters tab in the Solution dialog box to specify the following:

• Options to control the stagger iterations that the software performs. A stagger iteration is an
iteration in which the implicit coupling of the individual physics solutions takes place. These
options correspond to the ANSYS MFITER command.

• Options to control the relaxation values for the load transfer variables at a surface or volume
interface. These options control how much of the change in a load is transferred in each stagger
iteration and correspond to the ANSYS MFRELAX command.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Structural as the specified Analysis Type

Coupled Thermal Fields-Structural as the specified Solution Type

Data compaction options for import

What is it?

This release includes changes to how ANSYS handles extended data verification during import
and new options for compacting imported data.

Extended data checking now occurs on all imported files

When you import an ANSYS input file, NX now always performs extended data checking. For
example, NX checks for the existence of each node on a given element in your input file. In previous
releases, you used the Extended data checking option in the Import Simulation dialog box to
control whether the software performed the more comprehensive level of data validation.

New data compaction options

You can use the new Data Compaction options in the Import Simulation dialog box to access a
number of options that let you control how the software writes out the ANSYS input file.

• Use the new Import MPCs as Multi-MPCs option to improve the import performance for models
that contain a large number of multi-point constraints. When you select this option, NX imports
the individual MPCs as a single Multi-MPC type of Manual Coupling constraint instead of
numerous individual CE type of Manual Coupling constraints. This option offers faster import
times for a large model at the expense of a more detailed representation of your input file in NX.

This release also includes a new Number of MPCs for Multi-MPC Creation customer default.
Use this default to specify the threshold number of multi-point constraints that a solver input file
must contain before NX imports them as Multi-MPC couplings instead of individual CE couplings
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• Use the Compact displacement coordinate systems option to improve import performance
for models that contain numerous NROTAT commands. By default, NX creates a displacement
coordinate system for every NROTAT command during import. This can result in numerous,
duplicate displacement coordinate systems in your NX model. Select this option to have NX
identify identical nodal rotations and compact them into a single displacement coordinate system.
If the rotation angle between nodes is less than or equal to the specified Material orientation
comparison angle option, NX compacts the associated displacement coordinate systems.

• Use the Compact SHELL/PLANE element physical properties option to improve import
performance for models that have shell or planar elements with variable thickness values. Models
that have varying thickness values often contain a very large number of physical property tables,
which correspond to the ANSYS Real Constants and the SECDATA command. When you select
this option, NX combines the individual property tables and stores the thickness data either as a
thickness field or as element associated data.

Where do I find it?

Import Simulation dialog box

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver
Menu File→Import→Simulation

Number of MPCs for Multi-MPC Creation customer default

Menu File→Utilities→Customer Defaults
Location in dialog box ANSYS→General tab

Specifying temperature units on import and export

What is it?

You can now control the units used for temperatures in your model during import and export. This
gives you the flexibility to define temperatures in a different unit system, such as Kelvin, than the
rest of your model, which may be in metric or British units. In the Import Simulation or Export
Simulation dialog box, use the new Specify temperature units list to select the unit system to
use for temperatures in the model.

In previous releases, for example, if the imported unit system for your model was British units, NX
imported all temperature values in the input file as °F. Similarly, if the imported unit system was metric,
all temperature values were interpreted as °C.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver
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Menu File→Import→Simulation

File→Export→Simulation

ANSYS command support enhancements

What is it?

This release includes support for a number of new ANSYS commands.

Command Description Import support Export support Supported
parameters

ALPHAD Defines the
mass matrix
multiplier for
damping.

Yes Yes VALUE

ANTYPE, TRANS Specifies
that the
solution is
transient.

Yes Yes All other
parameters
(Status, LDSTEP,

SUBSTEP, Action)
are not currently
supported by NX.

BETAD Defines the
stiffness
matrix
multiplier for
damping.

Yes Yes VALUE

DELTIM Specifies
the time step
sizes to use
for a solution
step.

Yes Yes DTIME, DTMIN,

DTMAX, Carry

Carry is not
currently
supported in NX.

DMPRAT Specifies
a constant
damping
ratio

Yes Yes Ratio,

IC Specifies
initial
conditions
at nodes.

Yes Yes NODE, Lab, VALUE,

VALUE2, NEND,

NINC

NENED, NINC are
not currently
supported by NX.
Use the ANSYS
default value for
these parameters
of NENED=1 and
NINC=1.
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KBC Specifies
stepped
or ramped
loading
within a
solution
step.

Yes Yes KEY

LVSCALE Scales
the load
vector in a
Transient
Dynamic-Mode
Superposition
solution.

Yes Yes FACT

The LDSTEP

parameter is
not currently
supported in NX.
Use the ANSYS
default value
LDSTEP=1/

MDAMP Defines the
damping
ratio as the
function of
a mode in a
Transient
Dynamic-Mode
Superposition
solution.

Yes Yes STLOC, V1, V2,

V3, V4, V5, V6

MFITER Specifies
the number
of stagger
iterations
for a
Coupled-Fields
Thermal-Structural
solution.

Yes Yes MAXITER, MINITER,

TARGET

MFRELAX Specifies
the
relaxation
values for a
Coupled-Fields
Thermal-Structural
solution.

Yes Yes Lab, VALUE,

Option

NSUBST Specifies
the number
of substeps
within a
solution
step.

Yes Yes NSBSTP, NSBMX,

NSBMN

Note

Carry is not
currently
supported
in NX.
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THOPT Specifies
options for
nonlinear
Transient
Thermal
solutions.

Yes Yes Refopt,

REFORMTOL,

NTABPOINTS,

TEMPMIN, TEMPMAX,

--,

The ALGO

parameter is
not currently
supported in NX.
Use the ANSYS
default value
ALGO=0.

TINTP Defines
integration
parameters
for transient
solutions.

Yes Yes GAMMA, ALPHA,

DELTA, THETA,

OSLM, TOL, --,

--, AVSMOOTH,

ALPHAF, ALPHAM
TSRES Defines an

array of key
times at
which the
time-stepping
strategy
changes
within the
solution
step.

Yes Yes Array of key times
or table of times or
ERASE

NX writes
TSRES,ERASE

before it writes
a new array of key
times.

TRNOPT Specifies
options for
transient
solutions.

Yes Yes Method=FULL or
Method=VT only

TINOPT=NMK or
TINOPT=HHT

for Transient
Dynamic-Full
Method solutions

MSUP,,,,,NMK

for Transient
Dynamic-Mode
superposition
solutions. This
option is not
currently available
in the NX user
interface, but NX
writes this option
out when you
export or solve the
ANSYS input file.
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Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the

work part

ANSYS as the specified solver
Menu File→Import→Simulation

File→Export→Simulation

ANSYS axisymmetric contact analysis (10.0.1)

What is it?

This release includes support for contact analyses in ANSYS axisymmetric structural and thermal
solutions. In previous releases, contact was supported only in non-axisymmetric solutions.

Axisymmetric structural solutions

You can now use the Structural Contact command to analyze contact between the edges of planar
elements in axisymmetric models. You use the Structural Contact and the Region dialog boxes to
define contact and sliding between a 2D target edge and a deformable surface. When you export or
solve the solution, the software creates the appropriate CONTA172 elements to define the deformable
surface and TARGE169 elements to define the target surface.

Axisymmetric thermal solutions

You can now use the Thermal Contact command to define thermal contact conduction between
contacting surfaces in axisymmetric models using the edges of planar elements. You use the
Thermal Contact and the Region dialog boxes to define the contact between the edges, as well as
select the edges, points, or nodes that define the contacting edges.

After you define the contacting surfaces, use the CONTA174/172 Real Constants dialog box to
define the required thermal contact properties. You can define the following properties:

• Thermal contact conductance (TCC), which allows you to take into account the conductive heat
transfer between the contact and target surfaces.

Note

Currently, NX supports only a constant Thermal contact conductance value. You cannot
vary the Thermal contact conductance with temperature, pressure, or time.

• The Stefan-Boltzmann constant (SBCT), which you can use to model radiative heat transfer. If
you do not specify a value for the Stefan-Boltzmann constant, the radiation effect is excluded
from the thermal contact calculations.

• The Radiation view factor (RDVF), which you can use to define the radiation view factor for
near-field radiation.
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Where do I find it?

Structural Contact

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Axisymmetric Structural as the analysis type

Linear Statics or Nonlinear Statics as the solution type
Command Finder

Structural Contact

Thermal Contact

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Axisymmetric Thermal as the analysis type

Steady State Thermal as the solution type
Command Finder

Thermal Contact

Constraint equation support in Abaqus and ANSYS thermal solutions (10.0.1)

What is it?

You can now create constraint equations between the temperature degrees-of-freedom of thermal
elements in both the Abaqus and ANSYS thermal environments. In previous releases, you could only
create constraint equations in the Abaqus and ANSYS structural environments.

Constraint equations for Abaqus thermal solutions

In the Abaqus thermal environment, use the new Manual Coupling command to define the
independent and dependent coupling parameters between selected nodes. When you export or solve
your model, NX creates the appropriate *EQUATION commands in your Abaqus input file.

Constraint equations for ANSYS thermal solutions

In the ANSYS thermal environment, the Manual Thermal Coupling command has been enhanced to
allow you to create constraint equations as well as define sets of coupled degrees-of-freedom. Use
the new CE option in the Type list of the Manual Thermal Coupling dialog box to define coupling
between the temperature degrees-of-freedom within the model. When you export or solve your
model, the software creates the appropriate CE keywords in your ANSYS input file.
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Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus or ANSYS as the specified solver

Thermal as the analysis type
Command Finder

Manual Coupling (Abaqus)

Manual Thermal Coupling (ANSYS)

LS-DYNA support enhancements

LS-DYNA keyword support enhancements

What is it?

This release includes improved import and export support for the following LS-DYNA keywords:

Keyword Import support Export support Description
*CONTROL_BULK_VISCOSITY Yes Yes Globally resets the

default values for bulk
viscosity coefficients.
This can be useful when
modeling shock wave
propagation.

*CONTROL_OUTPUT Yes Yes Sets a variety of
output parameters,
such as an option to
update reference node
coordinates for beam
elements, and the option
to specify the maximum
number of times a
given error or warning
message prints to the
output file.

*CONTROL_SHELL Yes Yes Specifies options that
control the response of
shell elements during an
analysis.

*CONTROL_SOLID Yes Yes Specifies options that
control the response of
solid elements during an
analysis.

*CONTROL_MPP_DECOMPOSITION_SHOW Yes Yes Allows the display of the
final decomposition.
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Keyword Import support Export support Description
*CONTROL_MPP_DECOMPOSITION_TRANSFORMATIONYes Yes Specifies the type of

transformation to apply
to the decomposition
during the solution.

*DATABASE_EXTENT_BINARY Yes Yes Specifies that LS-DYNA
should write the
output database to
the D3PLOT, D3PART,
and D3THDT files.

*DATABASE_BNDOUT Yes Yes Specifies that LS-DYNA
should create a
boundary condition
forces and energy output
file in ASCII format.

*DATABASE_ELOUT Yes Yes Specifies that LS-DYNA
should create an
element data output
file in ASCII format.

*DATABASE_GLSTAT Yes Yes Specifies that LS-DYNA
should create a global
data output file in ASCII
format.

*DATABASE_MATSUM Yes Yes Specifies that LS-DYNA
should create a material
energies output file in
ASCII format.

*DATABASE_NODFOR Yes Yes Specifies that LS-DYNA
should output nodal
force groups data to the
nodal point data output
file.

*DATABASE_RBDOUT Yes Yes Specifies that LS-DYNA
should create a rigid
body data output file in
ASCII format.

*DATABASE_RCFORC Yes Yes Specifies that LS-DYNA
should create a resultant
interface data output file
in ASCII format.

*DATABASE_SLEOUT Yes Yes Specifies that LS-DYNA
should create a sliding
element interface output
file in ASCII format.
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Keyword Import support Export support Description
*PART_COMPOSITE_TSHELL Yes Yes Provides a simplified

method of defining a
composite material
model for thick shell
elements. This
eliminates the need for
user-defined integration
rules and part IDs for
each composite layer.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and work part

LS-DYNA as the specified solver
Menu File→Import→Simulation

File→Export→Simulation

Access to advanced solver options

What is it?

You can use the new Edit Advanced Solver Options button in the Solve dialog box to access a
number of options that let you control how the software writes out the LS-DYNA keyword file. For
example, you can control the following:

• The name and location of the LS-DYNA keyword file.

• The real data filter, which controls whether all data with an absolute value smaller than the
specified filter is written to the LS-DYNA keyword file as 0.0.

• Whether all data or selected types of data is exported to the LS-DYNA keyword file.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and work part

LS-DYNA as the specified solver
Simulation Navigator Right-click solution→Edit Advanced Solver Options

Support for global damping

What is it?

Use the new Damping modeling object to define mass-weighted nodal damping that applies:

• Globally, to the nodes of deformable bodies.
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• To the center of mass of rigid bodies.

You can use the options in the Damping dialog box to globally damp low frequency structural modes
as well as rigid body modes. For example, you can use options to:

• Select a table-based field to define the loading curve that defines the system damping constant.

• Specify scaling factors on the global X, Y, and Z translational and rotational damping forces.

After you create a Damping modeling object, you can use the new Damping tab in the Solution
dialog box to specify which Damping modeling object to include in the solution.

The options in the Damping dialog box correspond to the LS-DYNA *DAMPING_GLOBAL keyword.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and work part

LS-DYNA as the specified solver
Command Finder

Modeling Objects
Location in dialog box Type list →Damping

Expanded support for *CONTROL and *DATABASE keywords

What is it?

This release includes improved support for the LS-DYNA *CONTROL and *DATABASE keywords.

Improved support for the *CONTROL keyword

This release includes expanded support in NX for the LS-DYNA *CONTROL keyword. The Controls
modeling object dialog box has been updated with a number of new options. For example, you can:

• Use the options on the new Bulk Viscosity tab to change the default values for bulk viscosity
coefficients. This can be useful when you model shock wave propagation.

• Use the options on the new Output tab to set a variety of output parameters for LS-DYNA. For
example, you can specify options to update reference node coordinates for beam elements and to
control the maximum number of times a given error or warning message prints to the output file.

• Use the options on the new Shell tab to specify options for shell elements. For example, you can
set a maximum allowable for warp value for shell elements. If the warp value for shell elements in
your model exceeds this limit, LS-DYNA prints a warning message.

For a list of all newly supported *CONTROL keywords, see Selectively importing and exporting LS-DYNA
data.

Improved support for the *DATABASE keyword

This release also includes expanded support for the LS-DYNA *DATABASE keyword. The Database
modeling object dialog box has been updated with a number of new options. For example, you can:
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• Use the options on the Extent Binary tab to control some of the data written to the LS-DYNA
binary output databases (d3plot, d3thdt, and d3part). You can, for example, choose to include
output at additional integration points for shell and solid elements. You can also control whether
stress or strain tensor data is written to the binary databases.

• Use the options on the General Option tab to control which ASCII output databases are created
by LS-DYNA during the solve.

For a list of all newly supported *DATABASE keywords, see Selectively importing and exporting
LS-DYNA data.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part

LS-DYNA as the specified solver
Command Finder

Modeling Objects
Location in dialog box Type→Controls or Database

Selectively importing and exporting LS-DYNA data

What is it?

You can now selectively import and export LS-DYNA data from NX.

• In the Import Simulation dialog box, use the options in the new Selective Import group to
control which specific commands NX imports from the specified input file. For example, you can
clear the Materials check box if you do not want to import any LS-DYNA materials keywords.

• In the Export Simulation dialog box, use the options in the new Export Options group to control
which parts of your NX model file are exported to the LS-DYNA keyword file.

Additionally, you can use the new Import unsupported keywords option in the Import Simulation
dialog box to import LS-DYNA keywords that are not currently supported in NX as either commented
or uncommented user defined text. For example, you can use this new option to import LS-DYNA
load and constraints keywords as uncommented user defined text. If you later solve your LS-DYNA
solution from NX, LS-DYNA should solve the file and produce correct results.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and work part

LS-DYNA as the specified solver
Menu File→Import→Simulation

File→Export→Simulation
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Merging parts of an LS-DYNA input file into an existing NX model

What is it?

You can now use options in the Solver Deck Append dialog box to merge entities within an existing
LS-DYNA input file into an existing NX model. These options allow you to import portions of an input
deck into an existing model, as long as the missing portions of the input file already exist in NX.

For example, you can:

• Import only elements from an input file into an NX FEM that already contains nodes.

• Import group definitions that reference nodes and elements where the nodes and elements
already exist in NX.

• Import loads and constraints into a model that already contains a mesh.

In previous releases, you could append an LS-DYNA solver input file into an existing NX model only if
the input file being appended was a complete, valid, standalone file.

Controlling import behavior

You can use the options in the Import Behavior list to control how NX imports and appends the data
from the LS-DYNA input file:

• Select Append to import a solver input data file into an existing FEM or Simulation file and
append the solver data to the existing data. The solver input data file that you import must be
complete and valid.

• Select Append Merge to import data from an incomplete solver data input file into an existing
FEM or Simulation file and merge that data into the existing NX file. The solver data input file
that you import does not need to be complete.

When you use the Merge Entities option to append data, NX does not modify any entities that
were present in NX prior to the merge. For example, NX does not modify the following:

o Solution attributes.

o Values in existing loads, boundary conditions, simulation objects, or modeling objects.

o The content of existing NX groups.

Ability to create a new solution

Use options in the Create Solution list to control whether the source LS-DYNA input file data is
appended into a new solution in NX. In previous releases, the appended entities were not placed in
a new solution.

• Select No if you do not want to create a new solution. All loads and boundary conditions are
placed in the appropriate containers in the Simulation Navigator, but they are not referenced
in the current solution. Any appended modeling objects are also not referenced in the current
solution.
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• Select Yes to create a new solution. All loads and boundary conditions are placed in the
appropriate containers in the Simulation Navigator and referenced in the current solution. Any
appended modeling objects are also referenced in the new solution.

Options for handling data conflicts

This release also includes options that let you control how NX handles conflicts between nodes,
materials, and physical property data in the LS–DYNA input file and the destination FEM or
Simulation file.

• Select Ignore Deck Data if you do not want to append an entity from the solver input file when it
conflicts with an existing entity in the NX destination file. For example, if both the source solver
input file and destination NX file have a coordinate system with an ID of 15, NX does not append
the coordinate system from the solver input file.

• Select Modify Using Deck Data to replace the node, material, or physical property data in the
NX destination file with the data from the source solver input file.

• Select Append Deck Data to specify a numerical offset to increment the label (ID) when conflicts
occur. If NX detects a conflict between an entity in the source input file and the destination NX
file, it uses the offset to change the ID of the entity in the source input file during the append.
The software also updates any references to that entity in the source file. For example, if you
append an ELEMENT_SHELL(4) element that originally referenced nodes 1 and 2, and those
nodes are renumbered with an offset of 1000 because of a conflict, the software updates the
ELEMENT_SHELL(4) element to reference nodes 1001 and 1002.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the displayed part and work part

LS-DYNA as the specified solver
Menu File→Append

Inflated laminates in LS-DYNA (10.0.1)

What is it?

The Extrude Laminate and Fill Laminate commands are now supported in the LS-DYNA
environment.

The extruded 3D mesh consists of ELEMENT_TSHELL wedge or hexahedral elements and the
ply drop-offs consist of ELEMENT_SOLID tetrahedral, wedge, or hexahedral elements. Because
LS_DYNA does not support pyramids, pyramids are split into tetrahedral elements.

For both commands, NX creates a 3D mesh collector that has a Solid Laminate physical property
assigned to it. NX automatically sets the Stacking Recipe in the Solid Laminate Modeler dialog
box to Inherited from Layup.

All the plies of the extruded solid laminate have the same ply failure theory and inter-laminar failure
theory that you selected in the Laminate Modeler dialog box.

5-188 What's new in NX

Chapter 5: CAE



CAE

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM within the LS-DYNA solver environment.

Command Finder Extrude Laminate or Fill Laminate

Samcef solver environment

Samcef solver environment

What is it?

This release provides support in NX Advanced Simulation of the new Samcef solver environment.
When you work in the Samcef environment, you can:

• Create a Samcef model, export it, and perform a Samcef linear static, modal, buckling, or
nonlinear static analysis. You can then post-process the results using NX Post-processing.

• Preview the real contact and glue conditions computed by Samcef, using the Ancillary Display
mode.

• Specify materials such as progressive composite damage material models.

• Create cohesive elements to model the interface between two layers, define a damage interface
material and analyze phenomena such as delamination.

• Import a Samcef model or post-process results from other Samcef analysis types that are not yet
supported in the NX Samcef solver environment.

Supported element types

NX supports a selection of Samcef 0D, 1D, 2D, and 3D elements and their associated physical
properties:

• 0D lumped mass, grounded bushing, and spring elements.

• 1D beam and rod elements, as well as 1D connection elements (rigid links and averaged
kinematic constraints).

• 2D Mindlin thin shell, Heterosis shell, 2D membrane or shell membrane, metallic or composite.

• 3D solid and solid shell, metallic and composite elements.

3D cohesive elements.

NX supports linear and quadratic elements, true pyramid transition (Tet to Hex transition), and mixed
order transition.

NX automatically groups the elements in mesh collectors and meshes according to their types,
physical properties, and materials.
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NX Laminate Composites (NXLC)

The Samcef environment is fully coupled with NX Laminate Composites, including:

• 2D and 3D laminates definitions (multi-layered elements).

• Inflation process to create 3D laminates.

• Composite materials management.

NX Laminate Composites also generates the Samcef 3D cohesive elements. You can use cohesive
elements to model the interface between two layers and phenomena such as delamination.

You can also use cohesive elements to compute interlaminar stresses (glue modeling) and get
accurate results between plies.

Cohesive elements are 3D elements with the same topology as classical brick and wedge elements,
but they can have a zero thickness. You can create cohesive elements with the inflation process of a
composite definition.

For more information, see Samcef solver support in NX Laminate Composites and Cohesive layers in
the Advanced Simulation online Help.

Support for materials

You can use isotropic, orthotropic, and elastoplastic materials. You can also define the following
progressive composite damage models for:

• General orthotropic ply (Samcef UD Ply damage).

• Enhanced ply (NCF) (Samcef Enhanced UD Ply damage).

• Woven fabrics material (Samcef Woven Ply damage).

For more information, see Samcef damage properties

NX also supports the damage interface material model for cohesive elements. For more information,
see Samcef Damage Interface material in the Advanced Simulation online Help.

Supported loads and constraints

NX supports many loads, such as nodal force, pressure, speed, acceleration, and enforced
temperature. You can also define constraints, such as fixation, enforced displacements and rotations,
plane of symmetry, or manual coupling.

For more information, see Boundary conditions for Samcef solutions in the Advanced Simulation
online Help.
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Supported contacts and glue conditions

NX supports the following glue conditions:

• Nodes-to-Surface gluing.

• Solid-to-Edge gluing.

• Edge-to-Edge gluing.

• Surface-to-Surface gluing.

• Edge-to-Surface gluing.

NX supports the following contact conditions:

• Surface-to-Surface contact.

• Edge-to-Surface contact.

• Rigid-Flexible contact.

Ancillary Display preview for contact and glue conditions

When you solve a model that contains either contact or glue conditions, Samcef internally creates
contact or glue elements. You can understand where those elements are created by using the
Ancillary Display mode to preview in NX the real contact and gluing conditions as estimated by
Samcef at the initial stage.

For instance, in a contact between 2 surfaces of a forming stamp, you can preview the real contact
area computed by Samcef:

For more information, see Previewing contact and glue element locations (Samcef) in the Advanced
Simulation online Help.

Supported analysis types

When you create a Simulation file with Samcef as the specified solver, you can perform only a
structural analysis.

Supported solution types

NX supports the following Samcef solution types:
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Solution type Description
Linear Static Lets you perform a linear static solution of a structure. Samcef can take

into account load cases, gluing, and small sliding contact conditions.
Modal Lets you compute natural frequencies and vibration modes, as well as

deformed shapes and the corresponding modal stresses.
Nonlinear Static Lets you perform a nonlinear solution to analyze critical conditions such

as plasticity. You can take into account gluing, large sliding contacts, and
time-dependent loads. You can control the nonlinear computation by
using strategy parameters such as automatic time step definition, initial
static computation parameters, maximum iteration number, or energy and
force thresholds.

Composite models are handled as well.
Buckling Lets you perform a buckling solution to determine buckling loads and

buckling mode shapes of a linear elastic structure.

Support of User Defined Text

In the Solution, you can add specific text to include solver commands or options that are not yet
supported. This text will be appended to your solver input file.

For more information, see Customizing a Samcef input file with user defined text in the Advanced
Simulation online Help.

Post-processing of results

You can post-process results from a Samcef analysis directly in NX Post-processing (.des / .fac files):

• You can post-process all the classical structural results as stresses, strains, shell resultants,
and beams results.

• For laminates, you can display in-ply stresses and strains, out-of-ply stresses, damage results,
delamination, and native failure criteria results.

• You can display results in an absolute, material, native, or user-defined coordinate system.

• You can create XY graphs to plot results of a same type across a sequence of time steps or load
cases, for example, but also plot a single result across a range of nodes or elements.

• You can also post-process results from many other Samcef analysis types, such as thermal
analyses.

Note

To post-process Samcef results, you must activate these Customer Defaults:

1. Set the Additional Results File Extension option to DES.

2. Select the Read Unknown Results option.

Import of Samcef models

You can import a structural Samcef model into NX from the following Samcef files:
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• ASCII formatted files (.dat), also known as Samcef Bank files.

• Binary formatted files database (.sdb), also known as Samcef SDB files.

You can import the nodes, elements, physical properties and materials. The import supports units
conversion and can create groups or regions. Elements are automatically grouped in mesh collectors
and meshes according to their types, physical properties, and materials.

NX does not import Samcef composite data such as the plies (.PLI) and the laminates (.LAM).

NX stores unsupported data in User Defined Text objects.

For more information, see Import overview in the Advanced Simulation online Help.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM or Simulation file as the work part and displayed part

Samcef as the specified solver

Samcef solver support in NX Laminate Composites

What is it?

You can access most NX Laminate Composites commands and functionality in the Samcef solver
environment.

All laminate commands are supported except the following:

• Solid Laminate Physical Property

• Ply Materials

Ply IDs in all laminate physical properties and global layups must have unique values. In other solver
environments, ply IDs in different laminate physical properties can have the same values.

In the Samcef environment, you can create cohesive layers between extruded plies to model
delamination. See Cohesive layers for more information.

Where do I find it?

Application Advanced Simulation

Prerequisite

A FEM file as the work part and displayed part

Samcef as the specified solver

Samcef support enhancements (10.0.1)

This release includes a number of improvements to the Samcef solver environment.
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Creating and solving solutions

• A new Compute curvature for Mindlin shells and beams option has been added to the
Advanced Parameters tab in the Solution dialog box for all Samcef solutions. When you select
this option, Samcef introduces a curvature based on nodes into the element by computing the
shell’s curvature from mean nodal normals.

• In the Advanced Solver Options dialog box, use the new Sorted Data (Nodes/Elements)
option to sort the nodes and elements labels in the Samcef input file when you export or solve
your solution.

• On x86_64 Linux and Windows 64-bit operating systems, you can use two versions of the Samcef
solver: the i4 version, which uses 32-bit integers and is limited to 8GB of memory, and the i8

version, which uses 64-bit integers and is limited to 16TB of memory. Samcef automatically
uses the i8 version of the solver, which improves performance on large models while remaining
compatible with results from the i4 version of the solver.

• When you restart a solution that has existing results, the process by which the software deletes
existing result files and any intermediate files has been improved.

NX Laminate Composites

This release contains improved support for Samcef models in the NX Laminate Composites toolset.

• You can now use the Ply Materials command to assign material properties to laminate
plies. This command was not supported for Samcef models in the NX 10 release.

• You can now use the Advanced Post Report command to quickly identify critical element
and ply data over many solutions. The enveloping, filtering, and sorting tools help you to find the
critical element and ply data that you want without reviewing all the solver ply data.

Post-processing

In the Post Processing Navigator:

• The listing and names of the Samcef stress and strain result types in the Post Processing
Navigator are now more clear. (1) shows an example of Samcef results listed in the Post
Processing Navigator in NX 10. (2) shows the same results listed in the NX 10.0.1 release.
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• You can now load results from Samcef analyses faster than in previous releases. This
improvement is most noticeable when you load results from large models and can be up to 50%
faster, depending on the size of your model.

Importing Samcef data

• The time that it takes to import large Samcef input files that contain numerous Region definitions
has been greatly reduced.

• When you import a Samcef input file that contains groups of faces and edges, NX now imports
them as either a Surface Region or an Edge Region.

NX Thermal and Flow, Electronic Systems Cooling, and Space Systems Thermal
enhancements

General capabilities

Solution Monitor enhancements

What is it?

• The Solution Monitor is now used by the NX Multiphysics and NX Nastran solvers.

• The Solution Monitor now displays text output for each solver on a separate tab when you run a
coupled NX Multiphysics analysis.

o The NX Multiphysics tab displays the text output for the coupled solver.

o The NX Thermal tab displays the text output for the thermal solver.

o The NX Nastran tab displays the text output for the NX Nastran solver.
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• You can copy and paste the displayed text output. In previous versions, the displayed text output
was not selectable.

• The user interface of the Solution Monitor is refreshed and the command names are more
intuitive. The commands now have tooltips describing their functionality.

Where do I find it?

Application Advanced Simulation, Design Simulation

Prerequisite

NX Nastran, NX Multiphysics, NX Thermal and Flow, NX Space Systems
Thermal, or NX Electronic Systems Cooling as the selected solver
environment

Command Finder Solve
Simulation Navigator Right-click a solution node→Solve

Expression and 4D field support for boundary conditions

What is it?

The thermal solver supports expressions and 4D fields defined on boundary conditions. The
expressions can contain variables, fields, and functions that the thermal solver can evaluate at solve
time. See Expressions for more information.

The flow solver supports only 4D fields that are defined on boundary conditions.

You can now define the magnitude of certain boundary conditions as a function of both space and
another independent variable. For example, you can define a total conductance in the Thermal
Coupling simulation object to vary in space and with temperature.

A 4D field is either a heterogeneous table or a table of fields. A heterogeneous table is one where
the dependent variable is a function of both space and a non-spatial quantity, for example, time. A
table of fields is constructed by defining a distinct spatial field for each value of the independent
non-spatial variable.

Why should I use it?

This enhancement provides the ability to:

• Use solver-evaluated quantities when you define thermal boundary conditions. You can also
define interdependencies between boundary conditions, for example, when you want to define
the outlet temperature of one Thermal Stream load as the input temperature of another.

• Define boundary conditions that vary both in space and time simultaneously. Previously, the
magnitude could vary spatially and the spatially-varying magnitude was scaled as a function of
time. Now, at each node, your magnitude can vary in time independently of other nodes.
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Aligning source and target models for mapping

What is it?

The mapping solver now can automatically align source and target models if both models have
the following three named points defined: MAP1, MAP2, and MAP3. The three points in each
model must correspond to each other. Before it maps quantities, the mapping solver automatically
transforms the source model to line up the mapping points with those in the target model.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Mapping Thermal-Flow
NX Space Systems Thermal Mapping Thermal

Mapping Thermal-FlowNX Thermal and Flow
Axisymmetric Mapping Thermal

NX Multiphysics Mapping Thermal

Where do I find it?

Application Advanced Simulation

Prerequisite
Corresponding MAP1, MAP2, and MAP3 named points defined in source
and target models

Command Finder Solve
Simulation Navigator Right-click a mapping solution node→Solve

Thermal capabilities

Defining a thermal stream with a radial coordinate system

What is it?

You can define convection caused by radial thermal streams over surfaces. The stream flows radially
over the surface starting from the origin of the specified cylindrical coordinate system.

The thermal solver creates a 1D duct with mass flow elements on the selected regions and, using
convection thermal coupling, connects the 1D elements to the nearest thermal solid elements that lie
in the same radial band. The 1D duct is shown in blue in the following figure.
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You can set the radial Thermal Stream load type based on whether you want the thermal stream to
convect to a single surface or to two surfaces.

In addition to specifying the region, the fluid material, the stream conditions, and the heat transfer,
you also specify the cylindrical coordinate system. In the structural multiphysics solution, you only
specify the pressure.

Why should I use it?

The load provides an automated way to include the effects of convection and advection in a thermal
model. It improves your efficiency by regrouping many thermal simulation boundary conditions
in a single command.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Structural Multi-Step Nonlinear
Thermal Thermal

NX Multiphysics

Coupled Thermal-Structural (Multi-Step
Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite The specified solver must be NX Multiphysics or NX Thermal and Flow.

Command Finder Thermal Stream
Simulation Navigator Right-click the Load container node→New Load→Thermal Stream
Location in dialog
box

Type list→One-Sided Stream on Faces (Cylindrical Components) or
Two-Sided Stream on Faces (Cylindrical Components)
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Boundary Condition ID

What is it?

You can now insert the boundary condition ID into a boundary condition name by including the
symbol %%ID. For example, if you create a thermal void with an ID of 6 and set the name to Void —

%%ID, the name appears as Void — 6.

You can also pass the boundary condition ID as an argument of some built-in functions when you
define boundary conditions using the expressions.

You can do this for any type of boundary condition that includes the boundary condition ID in its dialog
box. Currently, these boundary conditions are:

• Thermal Convecting Zone

• Thermal Stream

• Thermal Void

Built-in functions with the boundary condition ID as an argument

In the following functions, “i” represents the boundary condition ID value.

Built-in function Description

STI(i) Returns the total absolute or relative inlet
temperature of the stream i.

STO(i) Returns the total absolute or relative outlet
temperature of the stream i.

VT(i) Returns the total absolute or relative temperature
of the void i.

ZT(i) Returns the total absolute or relative temperature
of the convecting zone i.

SMO(i) Returns the outlet mass flow of the stream i.

STMO(i) Returns the outlet metal temperature of the
stream i.

SP(i) Returns the pressure of the stream i.
VP(i) Returns the pressure of the void i.
ZP(i) Returns the pressure of the convecting zone i.
SSV(i) Returns the swirl velocity of the stream i.
VSV(i) Returns the swirl velocity of the void i.
ZSV(i) Returns the swirl velocity of the convecting zone i.
SA(i) Returns the surface area of the stream i selection.
VA(i) Returns the surface area of the void i selection.

ZA(i) Returns the surface area of the convecting zone
I selection.

MIX(i1,i2,...,i10) Returns the temperature from mixing the flows of
two or more streams, i1, i2, up to i10.

MMIX(i1,i2,...,i10) Returns the mass flow from mixing the flows of
two or more streams, i1, i2, up to i10.
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Why should I use it?

You can use the boundary condition ID to define interdependencies between boundary conditions; for
example, to model flow recirculation of thermal streams, you define the outlet temperature of one
thermal stream as a function of the input temperature of another stream.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Structural Multi-Step Nonlinear
Thermal Thermal

NX Multiphysics

Coupled Thermal-Structural (Multi-Step
Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics or NX Thermal and Flow as the specified solver.

Command Finder

Thermal Convecting Zone or Thermal Stream or Thermal Void

Simulation Navigator
Right-click the Load container node→New Load→Thermal Convecting
Zone or Thermal Stream or Thermal Void

Location in dialog
box Name group→Boundary Condition ID

Solid Motion Effects simulation object enhancement

What is it?

Use the Spinning - All Elements type of Solid Motion Effects simulation object to model the
thermal effects of a spinning model. All elements in the model spin together.

You select the spinning axis, and specify the number of calculations per spin, N. The thermal solver
calculates the view factors and thermal couplings that result from NX spinning the model N times,
each time rotating the spinning model by 360/N degrees. The thermal solver then averages the view
factors and thermal couplings of these N positions.

The view factors include the following:

• Solar, earth, and albedo view factors from orbital heating.

• Heat flux view factors from radiative heating.

• Black body and ray-traced view factors from the deterministic and hemicube methods.

• Ray-traced view factors, radiative couplings, and heat loads from the Monte Carlo method.
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Note

Best accuracy is obtained when N is greater than the number of elements around the
circumference of the spinning part. This is especially true for thermal coupling calculations.

The Spinning type of Solid Motion Effects simulation object from the previous releases is now
called Spinning - Selected Elements.

Why should I use it?

The Spinning - All Elements type of Solid Motion Effects simulation object can be used, for
example, to model a spinning spacecraft that spins rapidly around a specified axis.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow NX Advanced Thermal/Flow with

ESC
NX Space Systems Thermal Thermal Space Systems Thermal

Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation

Command Finder Solid Motion Effects

Simulation Navigator
Right-click the Simulation Object container node→New Simulation
Object→Solid Motion Effects

Location in dialog
box Type list→Spinning - All Elements or Spinning - Selected Elements

Varying capacitance for Void Non Geometric Element modeling object

What is it?

You can now define a time-varying or temperature-varying capacitance when you create a Void
Non-Geometric Element modeling object. To define the capacitance, you can specify the
capacitance value or the volume value. Both quantities can vary with time or temperature.

In previous releases, you could specify only a constant capacitance value.

Why should I use it?

You can use time-varying capacitance, for example, to model the capacitance of fuel in aircraft wings.
The fuel mass and thus the capacitance varies with time over a flight profile.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics or NX Thermal and Flow as the specified solver.

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
Location in dialog
box

Type list→Void Non-Geometric Element→Create→Calculation Method
group

Adaptive time stepping enhancement

What is it?

The new adaptive time stepping scheme handles the sharp changes in temperature at boundary
conditions better than the previous scheme. When there are no abrupt changes in boundary
conditions, it accelerates the simulation without losing accuracy. The time step size calculation is
now based on the estimated error between the analytical solution and the simulation. The error is
the difference between a fit quadratic function and a linear variation through three consecutively
computed temperature values for two consecutive time steps.

When there are abrupt temperature changes in the model, as seen in the example, the adaptive time
stepping scheme adapts by performing smaller time steps around the times when the abrupt changes
occur. The blue curve represents the time-varying heat load that is applied to the boundary condition
and each red + represents the temperature value at one point of the boundary condition for the
transient run. The +’s that are close to each other indicate that the time steps are smaller at those
times to better capture the changes in the heat load.
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You specify the temperature error tolerance, the minimum time step size, and the maximum time
step size.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Space Systems Thermal Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Axisymmetric Thermal Axisymmetric Thermal

Advanced Axisymmetric Thermal

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box

Transient Setup node→Time Integration Control group→Time Step
Option list→Automatic

Local temperature error estimate result sets

What is it?

You can now recover local temperature error estimate results. The thermal solver generates
temperature error estimate results which estimate the local spatial discretization errors due to the
mesh used for the simulation of conduction.

After you solve the model, the following result types appear under the solution node in the Post
Processing Navigator:

• Temperature Error Estimates - Nodal

• Temperature Error Estimates - Elemental

• Time of Maximum Error Estimates - Nodal

• Time of Maximum Error Estimates - Elemental

• Maximum Temp Error Estimates - Nodal

• Maximum Temp Error Estimates - Elemental

The last four result types are written only for transient runs. They are displayed under the Time
Invariant node in the Post Processing Navigator.
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The error estimate is measured in units of temperature difference.

The elemental error estimate, εT, is the maximum temperature difference of all boundary elements
computed as follows:

εT = max |TBE – fBE(T1, T2, ..., TN)|

where:

• TBE are the calculated boundary element
temperatures

• Ti are the N smoothed nodal temperatures

• N is the number of nodes

• The fBE function uses element shape
functions to interpolate the nodal
temperatures to the boundary element

Why should I use it?

The adaptive meshing solution process uses the maximum local temperature error estimates to
refine the mesh for conduction thermal analysis.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Space Systems Thermal Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Axisymmetric Thermal Axisymmetric Thermal

Advanced Axisymmetric Thermal

Where do I find it?

Application Advanced Simulation

Command Finder Solution
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Simulation Navigator Right-click a solution node→Edit

Location in dialog
box

Results Options node→Thermal group→ Local Temperature Error
Estimate

Envelope results for thermal post processing

What is it?

Time invariant results from transient thermal solutions are now located under the Time Invariant
node in the Post Processing Navigator.

iron
Solution 1

Thermal
Increment 1, 0.0 sec
...
Increment 61, 600.000 sec
Time Invariant

Max Temperature - Elemental
Min Temperature - Elemental
Time at Max Temperature - Elemental
Time at Min Temperature - Elemental

The time invariant thermal results include the following:

• Maximum and minimum elemental temperature over the complete transient run and the times
at which they occur.

• Maximum thermal error estimates at each element over the complete transient run and the
times at which they occur.

• Absorbed, incident, reflected, or transmitted radiative fluxes at each element when these values
are constant over the complete transient run.

In previous releases, these results were displayed in the first or last time step.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal
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Thermal Thermal

Advanced Thermal
Axisymmetric Thermal Axisymmetric Thermal

Advanced Axisymmetric Thermal
Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite Loaded results file that contains transient thermal results.

Convective heat flux results

What is it?

You can now recover convective heat flux results on 2D shell elements. You request nodal, elemental,
or nodal and elemental types of results from the Convective Heat Flux Results Location list.

After you solve the model, depending on your request, either or both of the following result types
appear under the solution node in the Post Processing Navigator:

• Convective Heat Flux - Nodal

• Convective Heat Flux - Elemental
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Why should I use it?

Convective heat flux results help you analyze the results of your thermal simulation.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal
Thermal Thermal

Advanced Thermal
Axisymmetric Thermal Axisymmetric Thermal

Advanced Axisymmetric Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box Results Options node→Thermal group→ Convective Heat Fluxes

Swirl velocity results

What is it?

You can now recover swirl velocity results on 2D shell elements or on 1D axisymmetric elements.
You request nodal, elemental, or nodal and elemental types of results from the Swirl Velocity
Results Location list.

After you solve the model, depending on your request, either or both of the following result types
appear under the solution node in the Post Processing Navigator:

• Swirl Velocity on Walls - Nodal

• Swirl Velocity on Walls - Elemental
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The thermal solver computes swirl velocities when you define Thermal Stream, Thermal Convective
Zone, or Thermal Void loads, or Duct Flow Boundary Conditions simulation objects of type
One-Sided Total Temperature Effects or Two-Sided Total Temperature Effects.

Why should I use it?

These result sets help you analyze the behavior of your thermal model.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box Results Options node→Thermal group→ Swirl Velocities

Results Location options

What is it?

The thermal solver can output the results at elements, at nodes, or at elements and nodes for
additional results sets. In the previous release, the thermal solver output only elemental results
for these results sets.

When you request one of the following results sets, you can now specify the location of the results.

On the Thermal tab:

• Total temperature

• Free and forced convection coefficient
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On the 1D Flow tab:

• Velocity

• Swirl velocity

• Pressure

• Density

• Mass flow

• Reynolds number

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal
Thermal Thermal

Advanced Thermal
Axisymmetric Thermal Axisymmetric Thermal

Advanced Axisymmetric Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box Results Options node→Thermal group or 1D Flow group

Heat transfer coefficient magnitude for edge interface resistance

What is it?

You can now specify the heat transfer coefficient for an Interface Resistance simulation object of
type Edge Interface.

The resistance is calculated as:

1/(heat transfer coefficient x area)

At an edge interface, the area is calculated as follows:
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area = (the length of the edge) x (the minimum shell thickness)

Why should I use it?

This improvement lets you define the resistance magnitude at an edge interface by specifying the
heat transfer coefficient, which is a value that is often available in handbooks.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal
Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation

Command Finder Interface Resistance

Simulation Navigator
Right-click the Simulation Objects node→New Simulation
Object→Interface Resistance

Location in dialog
box

Type list→Edge Interface→Magnitude group→Type list→Heat Transfer
Coefficient

Multiple Fluid material

What is it?

The new Multiple Fluid material type lets you define a primary fluid material and up to five additional
fluid materials.

The thermal solver uses the specified primary fluid material properties during computation. The
additional fluid material number can be passed as an argument to some CAE functions, such as fluid
plug-ins, and also to user-defined functions. See User-defined functions for expressions for more
information on plug-in functions.

You define the Multiple Fluid material type in the following loads and modeling object:

• Thermal Convecting Zone load

• Thermal Stream load
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• Void Non-Geometric Element modeling object

Supported solvers and analysis types

Solver Analysis Type Solution Type
Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)

Where do I find it?

Application Advanced Simulation
Prerequisite NX Multiphysics or NX Thermal and Flow as the specified solver.

Defining the multiple fluid material

Command Finder Manage Materials
Location in dialog
box Type list→Multiple Fluid→ Create

Specifying the multiple fluid material in loads

Command Finder Thermal Convecting Zone or Thermal Stream

Simulation Navigator
Right-click the Load container node→New Load→Thermal Convecting
Zone or Thermal Stream

Location in dialog
box Fluid Materials list

Specifying the multiple fluid material in the modeling object

Command Finder Modeling Objects
Simulation Navigator Right-click the Modeling Objects node→Modeling Objects
Location in dialog
box

Type list→Void Non-Geometric Element→Create→Environment
group→Fluid Materials list

PCB Component and Printed Circuit Board simulation object support

What is it?

In NX Space Systems Thermal solver environment, you can create:

• Printed Circuit Board and PCB Component simulation objects.
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• A PCB Stack physical property along with the PCB Layer and PCB Via modeling objects.

Why should I use it?

These new features let you easily define the thermal resistor models for printed circuit boards (PCBs)
and electronic components in spacecraft applications.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal

Where do I find it?

Simulation objects

Application Advanced Simulation

Command Finder Printed Circuit Board or PCB Component

Simulation Navigator
Right-click the Simulation Objects node→New Simulation
Object→Printed Circuit Board or PCB Component

PCB Stack physical property

Application Advanced Simulation

Command Finder Physical Properties
Menu Insert→Physical Properties
Location in dialog
box Type→PCB Stack→Create

Orbit Visualizer enhancements

What is it?

The Orbit Visualizer now does the following:

• Keeps the spacecraft in view when you zoom, pan, or rotate the model.

• Lets you keep either the spacecraft or the planet in the center of the view with the new Look
at view option.

• Displays elements of each mesh of the spacecraft model in a random and different color.

• Lets you make the element edges visible or invisible with the new Element Edges display option.
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Visible element edges Invisible element edges

Why should I use it?

You can distinguish the different components of the spacecraft model by their color.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Space Systems Thermal Thermal Space Systems Thermal

Where do I find it?

Application Advanced Simulation

Command Finder Orbital Heating

Simulation Navigator
Right-click the Simulation Objects node→New Simulation
Object→Orbital Heating

Location in dialog
box View group→Display

Automatic computation of view factors for flow surface elements

What is it?

The solver can now automatically create a radiation enclosure with all the flow surface elements in
the model. To enable this functionality, select the Create a radiation enclosure from all flow
surface elements check box.

The software splits the flow surface elements into two groups:

• The radiating top side region contains the flow surface elements convecting from the top.

• The radiating bottom side region contains the flow surface elements convecting from the bottom.

Note: The top side of an element is in the direction of the element’s normal.

NX uses the following:

• The hemicube method to create the radiation enclosure.

• A medium (128 x 128) view factor accuracy.

• The global radiation parameter element subdivision method for element subdivision.
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Why should I use it?

This option makes the task of creating a radiation enclosure that includes all the flow surface
elements in your model more efficient. You do not have to create a radiation simulation object and
define all the flow surface elements.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

Where do I find it?

Application Advanced Simulation
Simulation Navigator Right-click a solution node→Edit Solver Parameters

Location in dialog
box

Radiation Parameters node→View Factor Calculation group→Create a
radiation enclosure from all flow surface elements

Convergence graph enhancements

What is it?

The Convergence window now plots residual convergence graphs for the condensation variables as
well as for the thermal, flow, and coupled variables. The condensation convergence variables are
Water Cumulation and Mass Flow Imbalance.

In previous releases, the Convergence window plotted residual information only for the thermal,
flow, and coupled variables.

Supported solvers and analysis types

Solver Analysis Type Solution Type
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Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation
Prerequisite An open simulation file

Command Finder Solve
Simulation Navigator Right-click the Solution node→Solve
Location in dialog
box Solution Monitor dialog box→Graph→Convergence

Ignoring radiative environment in radiation modeling

What is it?

When you define a radiative ambient and set a radiative environment temperature, and clear the
Include Radiative Environment check box in the Radiation dialog box, the solver now ignores
any radiative exchange between the enclosure parts and the environment.

In the previous release, the solver automatically modeled radiative exchange between any part of the
enclosure and the environment even if you cleared this check box.

Why should I use it?

Although you may have modeled the radiative environment in the enclosure, you can now exclude
the environment in radiation modeling.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

NX Space Systems Thermal Thermal Space Systems Thermal
Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
Thermal ThermalNX Multiphysics
Coupled Thermal-Structural (Multi-Step

Nonlinear)
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Where do I find it?

Application Advanced Simulation

Command Finder Radiation
Simulation Navigator Right-click Simulation Objects→New Simulation Object→Radiation
Location in dialog
box Parameters group→Include Radiative Environment

Flow capabilities

Parallel flow solver enhancements

What is it?

The parallel flow solver now supports the following:

• Homogeneous gas mixture and tracer fluids

• High speed flows (fully coupled pressure-velocity parallel flow solver scheme)

• Shear stress transport (SST) and K-omega turbulence models

• Non-Newtonian fluids

You can also restart from a previous solution, and run the parallel flow solver using just one process.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box Solution Details node→Flow Solver Selection list→Parallel Solver

5-216 What's new in NX

Chapter 5: CAE



CAE

Two-phase, immiscible fluid simulation enhancements

What is it?

You can now do the following:

• Solve two-phase, immiscible fluid simulations in coupled thermal-flow analyses.

• Simulate fluid flow problems for a mixture of any two immiscible fluid constituents.

• Simulate open volume enclosures.

• Specify the surface tension.

• Specify the tracked fluid area fraction of the mixture at ambient condition.

Immiscible fluid mixture

In previous versions, the fluid constituents were limited to a liquid and a gas. Now, you can also
specify two liquids or two gases, as long as the two fluids are immiscible.

In the Immiscible Fluid Mixture modeling object, you define one fluid as the tracked fluid and
the other as the complementary fluid.

You also specify the surface tension between the tracked fluid and the complementary fluid.

When you post process the results, a volume fraction value close to one indicates that the mixture
is mostly composed of the tracked fluid whereas a value close to zero indicates that the mixture is
mostly composed of the complementary fluid.

Open volume enclosures

To simulate an open volume enclosure, you specify the tracked fluid area fraction of the mixture
that enters the enclosure in the following ways:

• Specify it locally, for each inflow boundary condition, when you specify the Inlet Flow type, the
Opening type, or the Static Pressure type of Flow Boundary Condition simulation object.

• Specify it globally, for all inflow boundary conditions, in the Ambient Conditions node of the
Solution dialog box.

The mixture leaves the enclosure on faces where you specify the Outlet Flow type, the Opening
type, the Convective Outflow type, or the Static Pressure type of Flow Boundary Condition
simulation object. The flow solver computes the tracked fluid area fraction for the mixture that
leaves the enclosure.

In previous versions, the two-phase, immiscible fluid mixture was restricted to a closed container
such that the volume of the mixture was constant.

Additional text changes

The following option names have changed to support the enhanced functionality.
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Pre-NX 10 name NX 10 name Command name and location
in dialog box

Heterogeneous Gas-Liquid
Mixture modeling object

Immiscible Fluid Mixture
modeling object Modeling Objects→Type

list

Initial Gas-Liquid Mixture - 3D
Flow type

Initial Immiscible Fluid
Mixture - 3D Flow type Initial Conditions

constraint→Type list

Humidity and Mixtures group Humidity, Tracer Fluids, and
Mixtures group Solution→Ambient

Conditions node

Specify Fraction option Homogeneous Gas Mixture
option

Solution→Ambient
Conditions node→Humidity,
Tracer Fluids, and Mixtures
group→Mixture list

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow NX Advanced Thermal/Flow with

ESC
Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

These functionalities are available in Advanced Simulation when you use the parallel flow solver.

Specifying a two-phase, immiscible fluid mixture

Command Finder Modeling Objects
Location in dialog
box Type list→Immiscible Fluid Mixture→Create

Setting the tracked fluid area fraction of the mixture entering the fluid enclosure

Command Finder Flow Boundary Condition

Simulation Navigator
Right-click the Simulation Object container node→New Simulation
Object→Flow Boundary Condition

Location in dialog
box Type→Inlet Flow, Opening, or Static Pressure→Mixture group

Setting the tracked fluid area fraction of the mixture at ambient condition
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Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box

Ambient Conditions node→Humidity, Tracer Fluids, and Mixtures
group→Mixture list→Immiscible Fluid Mixture

Particle tracking enhancements

What is it?

You can now do the following:

• Solve only a particle tracking simulation.

• Specify particle impact types.

• Request particle impact and pass-through reports.

• Set new particle tracking controls.

Particle tracking simulation

You can solve steady state particle tracking simulation using the flow field from the solved steady
state solution. If you have a solved flow analysis, you can do the following:

• Add Particle Injection simulation objects.

• Modify Flow Surface and Screen simulation objects.

• Modify particle tracking options in the 3D Flow node of the Solution dialog box and in the 3D
Flow Solver node of the Solver Parameters dialog box.

After you modify your solution, select the Solve Steady State Particle Tracking Simulation Only
check box and solve the solution again. The flow solver solves only the particle tracking equations.

Particle impact types

The flow solver can simulate particles that stick to the walls or that rebound. You can set the particle
impact type in the following ways:

• Set it individually for each flow surface in the corresponding Flow Surface dialog box. You
can define particle tracking options only in the Embedded Flow Surface and Boundary Flow
Surface types.

• Set it globally for all flow surfaces in the Solution dialog box.

When you specify the rebound particle impact type, you must define the coefficient of restitution. The
coefficient of restitution indicates how much energy the particle loses when it hits the wall. The
specified value must be greater than or equal to zero and less than or equal to one.
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Particle impact and pass-through reports

You can request a particle impact report in the Flow Surface simulation object and a pass-through
report in the Screen simulation object. Only the Embedded Flow Surface and Boundary Flow
Surface types have this option.

When you request the reports, the flow solver generates the ParticleAndImpactTrackingSummary.dat
file which contains two tables:

• The Particle Tracking Summary table lists the number of injected and ejected particles in total
for your model and per boundary condition.

• The Particle Surface Impact and Screen Pass-Through Tracking Report table lists the
number of particles that impact walls in your model per injection boundary condition and the
number of particles that pass through screens per injection boundary condition.

The file is generated in the simulation’s run directory.

Optionally, you can output particle impact and pass-through results to the ParaView format. See
ParaView output option.

Particle tracking controls

New options are available in the flow solver parameters for particle tracking simulation.

Steady State
Simulation Time
list

Specifies the particle tracking simulation time. You can match the injection
duration or specify an alternate total time for the particle tracking simulation.
The value that you specify must be greater than the injection duration.

Neglect Stochastic
Drag Terms option

Neglects the Brownian and turbulent diffusivity terms in the particle tracking
equations. Usually, you select this check box in conjunction with the Use
Cunningham Correction Factor check box.

Use Cunningham
Correction Factor
option

Applies the computed Cunningham correction factor to the particle traction
force estimate. The Cunningham correction factor represents the reduction
in the force exerted upon the particle by the flow due to the breakdown of
the no-slip condition on the particle surface. The no-slip condition is invalid
when the mean free path of the fluid molecules is of the same order as the
particle length scale. This option is valid only for ideal gases. The flow solver
computes the correction factor using the following constants that you specify:

• Sutherland constant for the viscosity of the gas

• Slip correction reference temperature, pressure, and dynamic viscosity of
the gas

In addition, the following table lists the name changes in the 3D Flow Solver node of the Solver
Parameters dialog box.

Pre-NX 10 name NX 10 name
Steady State Particle Controls group Particle Tracking Controls group
Injection Duration box Steady State Injection Duration box
Output Option list Steady State Output Option list
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow NX Advanced Thermal/Flow with

ESC
Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

These functionalities are available in Advanced Simulation when you use the serial flow solver.

Simulation objects

Command Finder Flow Surface or Screen

Simulation Navigator
Right-click the Simulation Object container node→New Simulation
Object→Flow Surface or Screen

Location in dialog
box Particle Tracking group

Solution options

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit

Location in dialog
box

Restart node→ Perform Restart→Options group→ Solve Steady
State Particle Tracking Simulation Only

3D Flow node→Flow Surface Parameters group

Particle tracking controls

Simulation Navigator Right-click a solution node→Edit Solver Parameters
Location in dialog
box 3D Flow Solver node→Particle Tracking Controls group

ParaView output option

What is it?

You can now output results to the ParaView format. When you request output in ParaView format,
NX can create the following ParaView files. The number of ParaView files created depends on
the solution.

• The flow_solid.vtu file contains the nodal solution field for a steady state run.

• The flow_solid_M.vtu files contain the nodal solution field at the output time M for a transient
run. NX creates one file for each output time.
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• The partdata_N.vtp files contain the coordinates of the particle positions at the particle tracking
output time N. NX creates one file for each output time. These files are generated for a particle
tracking simulation.

• The paraview_SiteName_N.vtp files contain the position coordinates of all particles injected from
the site SiteName at the particle tracking output time N. NX creates one file for each particle
injection site and output time. These files are generated for a particle tracking simulation with
requested particle impact or pass-through reports.

• The paraview_SiteName_TrackingName_N.vtp files contain the position coordinates of particles
injected at site SiteName which contact the tracking site TrackingName at the particle tracking
output time N. NX creates one file for each particle injection site that has a particle in contact
with the tracking site, and for each output time. These files are generated for a particle tracking
simulation with requested particle impact or pass-through reports.

The files are generated in the simulation’s run directory.

SiteName is the name of the Particle Injection simulation object. TrackingName is the name of the
Flow Surface or Screen simulation object from which you request the reports. See Particle tracking
enhancements.

Why should I use it?

The ParaView format allows you to import your results into the ParaView third party software for
post processing of injected particles.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit
Location in dialog
box Results Options node→Optional Output Format group→ ParaView
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Non-Newtonian model quantity results

What is it?

You can now recover shear rate and dynamic viscosity results on 3D elements when you use
non-Newtonian fluids in your model.

After you solve the model, the following results types can appear under the Solution node in the
Post Processing Navigator:

• Shear Rate - Elemental-Nodal

• Dynamic Viscosity - Elemental-Nodal

Shear rate Dynamic viscosity

Why should I use it?

The display of shear rate and dynamic viscosity results can help you analyze models with
non-Newtonian fluids.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow NX Advanced Thermal/Flow with

ESC
Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation
Prerequisite You must define a non-Newtonian fluid and use the parallel flow solver.

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit

Location in dialog
box

Results Options node→3D Flow group→ Non-Newtonian Model
Quantities
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Restart option for the parallel flow solver

What is it?

You can now restart a flow or coupled thermal-flow solution that you previously solved using the
parallel flow solver. You can restart only those solutions for which you created backup files. You
request the creation of backup files from the Create Backup Files list. The following options are
available.

For Paused
or Completed
Solution

Creates backup files for both steady state and transient solutions when you
pause the solution or when the solution finishes.

At Specified
Number of
Iterations

Creates a backup file for a steady state solution at every N number of
iterations. N is the value that you specify in the Number of Iterations box.

At Results
Sampling Times

Creates a backup file for a transient solution at each results sampling time.
You set the sampling times on the Transient Setup node in the Results
Sampling group.

Never Does not create backup files. You cannot restart solutions if you use this option.

The parallel flow solver backup files are flow.restart and flow.struct. They contain all the necessary
information for restarting the simulation from the point at which the backup files were updated. The
information they contain includes, but is not limited to, flow field variables, mass flow rates, and
gradient vectors. NX creates the files in same run directory that contains all the other flow solution
files.

You cannot modify the original mesh of the model for which you want to restart the solution. You can
however make the following changes to your solution:

• Add or remove boundary condition simulation objects.

• Modify the boundary condition values.

• Modify the time step size, relaxation factors, time integration accuracy, and advanced parameters.

• Change the flow type, for example, from incompressible to high speed flow.

• Change the turbulence model.

• Change the number of processes for a parallel run.

• Add meshed geometry or flow enclosures as long as the original mesh is not altered in anyway,
for example, by reordering nodes or elements.

Note

You cannot restart solutions using the parallel flow solver that were solved using the parallel
flow solver from previous NX releases or using the serial flow solver.

Why should I use it?

Perform a restart when you want to:
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• Pause, inspect, and if necessary modify your solution before continuing the solve.

• Restart your solution with incremental changes in the boundary conditions.

• Restart a simulation that diverged or crashed previously.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation
Prerequisite You must use the parallel flow solver.

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit

Location in dialog
box

(To create backup files) Restart node→Parallel Flow Solver Restart
Backup File Options group→Create Backup Files

(To restart from backup files) Restart node→ Perform Restart

CGNS results file options (10.0.1)

What is it?

You can now request transient flow results in the CGNS format to be written in one of the following
ways:

• One CGNS results file: The results file contains results from all transient output times.

• Multiple CGNS results files: Each results file contains results from one transient output time.

In previous releases, NX always wrote a single CGNS results file containing results from all transient
output times.

Why should I use it?

You can now obtain the results from each transient output time in its own CGNS results file. You do
this by requesting multiple CGNS files. You can continue to request a single CGNS file that contains
all the results from all transient output times.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit

Location in dialog
box

Results Options page→Optional Output Format group→CGNS
→Transient Results list

NX Laminate Composites

Samcef solver support in NX Laminate Composites

What is it?

You can access most NX Laminate Composites commands and functionality in the Samcef solver
environment.

All laminate commands are supported except the following:

• Solid Laminate Physical Property

• Ply Materials

Ply IDs in all laminate physical properties and global layups must have unique values. In other solver
environments, ply IDs in different laminate physical properties can have the same values.

In the Samcef environment, you can create cohesive layers between extruded plies to model
delamination. See Cohesive layers for more information.

Where do I find it?

Application Advanced Simulation

Prerequisite

A FEM file as the work part and displayed part

Samcef as the specified solver
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Cohesive layers

What is it?

You specify cohesive layers between plies of your global layup. For each cohesive layer, you need to
specify a damage interface material.

Global Ply ID Composition Thickness Angle Status Description Solid Property

3 PPG-5H-3K 1 0 Up-to-date

c5 Cohesive1 0 0
Cohesive
Layer

Cohesive
Layer

2 PPG-5H-3K 1 0 Up-to-date

c4 Cohesive1 0 0 Cohesive
Layer

Cohesive
Layer

1 PPG-5H-3K 1 0 Up-to-date

When you inflate the laminate, NX creates meshes of a layer of cohesive elements between layers of
ply meshes. Each cohesive mesh is stored in a separate mesh collector that points to a Cohesive
Property physical property. The physical property stores the material that you specified for the
cohesive layer.

3D Collectors
PART (laminate shell)1–Extrusion
PART (laminate shell)1–Ply1
PART (laminate shell)1–Ply2
PART (laminate shell)1–Ply3
PART (laminate shell)1–Junction4
PART (laminate shell)1–Junction4
PART (laminate shell)1–Junction5
PART (laminate shell)1–Junction5

Why should I use it?

Use the cohesive layers to model delamination in the Samcef solver environment.

Where do I find it?

Creating cohesive layers

Application Advanced Simulation
Prerequisite You must work in the FEM within the Samcef solver environment.

Command Finder Global Layup
Location in dialog
box Layup Definition group→Create New Cohesive Layer

Inflating laminates
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Application Advanced Simulation
Prerequisite You must work in the FEM within the Samcef solver environment.

Command Finder Extrude Laminate or Fill Laminate

Import Fibersim Zones

Use the Import Fibersim Zones command to import the zones from a Fibersim HDF5 file onto
selected polygon faces or 2D elements. The zones must point to a laminate that is associated to
the same part geometry that is meshed in NX.

When you import Fibersim zones, NX creates:

• One mesh and one mesh collector for each zone.

• One laminate physical property for each Fibersim laminate specification.

• One material table for each Fibersim material specification, if you request it.

• Curves that represent the zone boundaries, if you request this.

Each mesh collector points to one of the created laminate physical properties. NX moves elements
from the existing NX mesh into the newly created meshes. The existing NX mesh is empty after
the import.

In the Import Zones dialog box, you can specify if you want to overwrite existing materials, laminate
physical properties, or mesh collectors.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder Import Fibersim Zones

Import layups from Fibersim

What is it?

You can now import layups directly from an NX part containing Fibersim data, without passing through
an HDF5 file. You specify the Fibersim laminate that you want to import from the Fibersim Objects
list in the Import Layup dialog box.

The import works only when the following conditions are met:

• Fibersim 14 or above must be installed.

• The PATH environment variable includes the path to the NX folder in the Fibersim installation
folder. It is the same path as defined in the UGII_VENDOR_DIR environment variable.

• The Use Fibersim API Import customer default is selected.

5-228 What's new in NX

Chapter 5: CAE



CAE

• The NX part containing Fibersim data is loaded. The part file must contain an NX Laminate
Composites ply export object. This object defines the laminates and the components to be
exported. You define it in Fibersim using File→Export→Analysis – Ply→NX Laminate
Composites.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Where do I find it?

Application Advanced Simulation

Command Finder Import Global Layup
Location in dialog
box File Type list→Current Fibersim Part

Editing multiple laminate physical properties

You can edit multiple laminate physical properties or solid laminate physical properties at the same
time.

For the selected physical property tables, you can modify:

• Solver properties

• Laminate properties, including:

o Stacking recipe

o Zone angle tolerance

o Reference plane location for 2D laminate properties

o Reference temperature

o Ply and interlaminar failure theories including user-defined failure theories, interlaminar
allowables, shear stress for bonding, and normal stress for bonding

• Ply Layup. You can reverse either the plies and their ply IDs or just the plies keeping the original
ply ID sequence.

• Ply IDs. You can relabel the ply IDs using one of the following:

o A start label and an increment between ply IDs. NX relabels the existing ply IDs starting with
the given start label and increments each subsequent ply ID by the increment value.

o An offset. NX relabels the existing ply IDs by offsetting their old value by the specified offset.

The following table lists the significance of icons that can be displayed in front of each property in the
Multiple Edit Laminate Properties dialog box.
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Icon Hover text Description

No Change

Indicates that the value currently
defined for this property is the
same for all the selected laminate
physical properties.

No Change

Indicates that the value currently
defined for this property is
different for two or more of
the selected laminate physical
properties.

Apply Change
Indicates that the change you
made for this property will be
applied when you click OK.

<Laminate physical property
name>:<property name>

Indicates that the value of
this property for all physical
properties will be the same as
for the named laminate physical
property, after you click OK.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder Physical Properties

Location in dialog
box

Select multiple laminate physical properties or multiple solid laminate

physical properties→Edit

Expressions support for ply thickness, ply angle, and layup offset

What is it?

When you use an expression to define the value of the ply thickness, ply angle, or layup offset, NX
now updates this value if you change the expression.

Note

NX Laminate Composites does not support expressions that point to fields.

In previous releases, if you used expressions to define these values, the constant value computed
the first time was always used even if you subsequently changed the value of the expression.

Where do I find it?

Ply thickness and ply angle

Application Advanced Simulation
Prerequisite A FEM as the work part
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Command Finder

Laminate Physical Property or Global Layup or Solid

Laminate Physical Property

Location in dialog
box

(Laminate Modeler or Solid Laminate Modeler dialog box) Ply Layup

tab→Thickness or Angle→click and choose Formula

(Layup Modeler dialog box) Layup Definition group→Thickness or

Angle→click and choose Formula

Layup offset

Application Advanced Simulation
Prerequisite A FEM as the work part

Simulation Navigator
Right-click the Layup Offset node→Create User Defined Layup Offset
Rule

Location in dialog
box Bottom Fiber Distance→click and choose Formula

Relabel global ply IDs

What is it?

Use the Relabel Ply IDs command to change the global ply IDs for all global plies of selected layups.

You can relabel ply IDs by specifying one of the following:

• A start label and an increment between ply IDs. NX relabels the existing ply IDs starting with the
given start label and increments each subsequent ply ID by the increment value.

Note

Symmetric and repeated plies need to have consecutive ply IDs. In this case, the
increment value should be one.

• An offset. NX relabels the existing ply IDs by offsetting their old value by the specified offset.

Why should I use it?

You can now make post-processing results easier to understand by relabeling the global ply IDs in
your FEM structure.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Simulation Navigator
Right-click the Layups node or one or more global layup nodes→Relabel
Ply IDs
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Inflated laminates in LS-DYNA (10.0.1)

What is it?

The Extrude Laminate and Fill Laminate commands are now supported in the LS-DYNA
environment.

The extruded 3D mesh consists of ELEMENT_TSHELL wedge or hexahedral elements and the
ply drop-offs consist of ELEMENT_SOLID tetrahedral, wedge, or hexahedral elements. Because
LS_DYNA does not support pyramids, pyramids are split into tetrahedral elements.

For both commands, NX creates a 3D mesh collector that has a Solid Laminate physical property
assigned to it. NX automatically sets the Stacking Recipe in the Solid Laminate Modeler dialog
box to Inherited from Layup.
All the plies of the extruded solid laminate have the same ply failure theory and inter-laminar failure
theory that you selected in the Laminate Modeler dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM within the LS-DYNA solver environment.

Command Finder Extrude Laminate or Fill Laminate

New laminate material options for LS-DYNA

What is it?

This release includes new options in the Laminate Modeler and the Solid Laminate Modeler dialog
boxes that control how NX exports the laminate material to LS-DYNA.

• Use the new Shell/Solid Formulation option to specify the shell or solid formulation output
format when you export the laminate to the LS-DYNA solver.

o Select Layered to export the laminate as layered properties.

o Select Homogenous to export the laminate as unlayered, homogeneous properties with
equivalent orthotropic materials. With this option, NX computes the equivalent properties of a
single ply. Exporting 3D laminates as homogeneous properties rather than layered properties
may shorten the solution time. The homogeneous approach is suitable for balanced and
symmetric laminates

• Use the new NX Orthotropic Materials Mapping option to map the NX orthotropic material
to an appropriate LS-DYNA material type, such as *MAT_ORTHOTROPIC_ELASTIC (MAT_002) or
*MAT_COMPOSITE_LAYUP (MAT_116).

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file as the displayed part and work part

LS-DYNA as the specified solver
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Command Finder
Laminate Physical Property or Solid Laminate Physical Property

Location in dialog box Solver Properties group

Laminate Modeler dialog box enhancement

What is it?

The groups in the Laminate Modeler dialog box are rearranged to reduce clutter, allow for more
visible plies, and for ease of use. The Ply Layup and Ply Sketcher groups are now tabs in the dialog
box. All other groups are located on the left side of the dialog box.

Ply Layup tab
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Ply Sketcher tab

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder

Laminate Physical Property or Solid Laminate Physical Property

Adjusting the font in Ply Sketcher

What is it?

You can now set the font type and size for your layup information on the Ply Sketcher tab in the
following dialog boxes:

• Laminate Modeler dialog box

• Solid Laminate Modeler dialog box

• View Laminate dialog box

• View Laminate — Zone # dialog box

You set the font type and size in the Visualization Preferences dialog box. In previous releases, NX
set the font automatically and you could not modify it.

Where do I find it?

Visualization Preferences dialog box
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Application All

Command Finder Visualization Preferences
Location in dialog
box Color/Font tab

Laminate Modeler dialog box and Solid Laminate Modeler dialog box

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder

Laminate Physical Property or Solid Laminate Physical Property

View Laminate dialog box and View Laminate — Zone # dialog box

Application Advanced Simulation

Command Finder View Laminate
Simulation Navigator (FEM) Right-click the Zones or Zone # node→View Laminate

Element-nodal results in laminate post reporting

What is it?

When the results from the structural solver are element-nodal results, you can now output the
laminate post reporting results as element-nodal results.

In previous versions, NX averaged the element-nodal results for each element before it used them
to compute the laminate post reporting results.

Why should I use it?

You can display the results from the laminate post reporting in the same way as you display the
structural results.

Where do I find it?

Application Advanced Simulation
Prerequisite Element-nodal structural results

Command Finder Spreadsheet Report or Graphical Report

Simulation Navigator
Right-click the Spreadsheet Report node or the Graphical Report
node→Edit

Location in dialog
box Options tab→Input Selection group→Element Nodal Results
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Multithreaded draping process

What is it?

To improve the draping performance for the woven and unidirectional solvers, you can enable
multithreading which uses shared-memory parallelization.

Set the number of execution threads using the Number of Execution Threads for Multithreading
customer default. Multithreading is enabled when the number of execution threads is greater than one.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder Update Global Layups and Zones

Simulation Navigator
Right-click the Layups node or one or more layup nodes or one or more
ply nodes→Update

Specifying ply directions using a coordinate system

What is it?

When you align fibers for draping, in the Draping Data dialog box, you can now specify a coordinate
system instead of a vector.

For the unidirectional draping solver, the primary fiber direction is aligned with the X-axis (1).

For the woven draping solver, the primary fiber direction is aligned with the X-axis (1) and the
secondary fiber direction is aligned with the Y-axis (2).

5-236 What's new in NX

Chapter 5: CAE



CAE

Why should I use it?

You have more flexibility when you define the ply directions for draping. In particular, you can select a
coordinate system that corresponds to an imported Fibersim rosette.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part
Simulation Navigator Right-click a global ply node→Edit
Location in dialog
box Solver list→Woven or Unidirectional→Direction Option list→CSYS

Reversing the stacking sequence

What is it?

You can now easily reverse the stacking sequence of a layup with the introduction of the new Reverse

Stacking Sequence command. You can reverse the plies and their global ply IDs (1), or reverse
the plies but keep the original ply ID sequence (2).
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In previous releases, reversing the ply sequence and optionally the IDs was more of a manual
operation because this command did not exist.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder

Laminate Physical Property or Solid Laminate Physical Property

or Global Layup

Location in dialog
box

(Laminate Modeler or Solid Laminate Modeler dialog box) Ply Layup

tab→Reverse Stacking Sequence

(Layup Modeler dialog box) Layup Definition group→Reverse Stacking

Sequence

Viewing fiber orientations on multiple plies

What is it?

You can now display the fiber orientations for multiple plies at the same time. NX superposes the
fiber orientations of each ply.
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Example

The fiber orientations of ply (1) and ply (2) are superposed when you request the fiber
orientations for both plies at the same time.

In previous versions, you could view fiber orientations only for one ply at a time.

Why should I use it?

You can compare the orientations of one or more plies.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part
Simulation Navigator Right-click multiple global ply nodes→View Fiber Orientations

Grouping of unmapped Fibersim elements

What is it?

When you import plies of a Fibersim ply-based laminate onto selected polygon faces or 2D elements,
NX creates a group of unmapped elements for those elements that have no mapped ply data.

Groups
1 - Unmapped Elements
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Where do I find it?

Application Advanced Simulation

Command Finder Import Layup

Ply description in the spreadsheet

What is it?

When you export or import a ply layup to or from a spreadsheet application, the ply description is
also exported or imported.

In previous releases, for each ply, only the material name, ply thickness, and ply angle were imported
or exported.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM as the work part

Command Finder

Laminate Physical Property or Global Layup or Solid

Laminate Physical Property

Location in dialog
box

(Laminate Modeler or Solid Laminate Modeler dialog box) Ply Layup

tab→Export Layup to Spreadsheet or Import Layup from

Spreadsheet

(Layup Modeler dialog box) Layup Definition group→Export Layup to

Spreadsheet or Import Layup from Spreadsheet

Generating multiple graphical reports

What is it?

You can now generate results from multiple graphical reports at the same time.

In previous releases, you could generate results for only one graphical report at a time.

Why should I use it?

You save time when you want to generate results for multiple graphical reports.

Where do I find it?

Application Advanced Simulation
Prerequisite You must select multiple graphical nodes in the Simulation Navigator.
Simulation Navigator Right-click multiple graphical report nodes→Generate Result File
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More failure metric results for maximum stress and maximum strain criteria (3D)

What is it?

NX now provides all six failure index values for solid laminate plies that have a specified maximum
stress or maximum strain criterion. The following table lists the equations used to compute these
values.

Failure index value Maximum stress criterion Maximum strain criterion
F1 σ1/XT if σ1>0

σ1/XC if σ1<0

ε1/XTε if ε1>0

ε1/XCε if ε1<0
F2 σ2/YT if σ2>0

σ2/YC if σ2<0

ε2/YTε if ε2>0

ε2/YCε if ε2<0
F3 σ3/ZT if σ3>0

σ3/ZC if σ3<0

ε3/ZTε if ε3>0

ε3/ZCε if ε3<0
F4 |τ12/S12| | 12/Sε12|
F5 |τ13/S13| | 13/Sε13|
F6 |τ23/S23| | 23/Sε23|

For maximum stress criterion:

• XT and XC are the maximum allowable stresses in direction 1 in tension and compression.

• YT and YC are the maximum allowable stresses in direction 2 in tension and compression.

• ZT and ZC are the maximum allowable stresses in direction 3 in tension and compression.

• S12 is the maximum allowable in-plane shear stress.

• S13 and S23 are the maximum allowable 13 and 23 shear stresses.

For maximum strain criterion:

• XTε and XCε are the maximum allowable strains in direction 1 in tension and compression.

• YTε and YCε are the maximum allowable strains in direction 2 in tension and compression.

• ZTε and ZCε are the maximum allowable strains in direction 3 in tension and compression.

• Sε12 is the maximum allowable in-plane shear strain.

• Sε13 and Sε23 are the maximum allowable 13 and 23 shear strains.

In previous releases, for both criteria, NX Laminate Composites provided only one value of the failure
index. That value was the maximum of the six failure indices.

Where do I find it?

Application Advanced Simulation

Prerequisite
The ply failure theory must be set to Max Stress or Max Strain for solid
laminates.
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Command Finder Spreadsheet Report or Graphical Report

Simulation Navigator
Right-click the Spreadsheet Report node or the Graphical Report
node→Edit

Location in dialog
box

Options tab→Output Control group→ Failure Index or Strength Ratio
or Margin of Safety

Durability

Saving geometry in durability results files

What is it?

When you run a durability solution process, NX can now generate the solver results in BUN files,
which contain the geometry. To enable this functionality, set the Save Geometry in Results Files
customer default.

In previous versions, NX generated durability solver results only in BUD files.

BUN files are larger in size than BUD files.

Why should I use it?

NX Post Processing can use either BUD or BUN files to display durability result sets. If you use BUD
files, you need to load the parent solution result file to display durability result sets.

Because BUN files also contain geometry you can display durability results in NX Post Processing
without loading the parent solution result file.

Where do I find it?

Application Advanced Simulation

Command Finder Customer Defaults
Location in dialog
box

Simulation→NX ADVANCED DURABILITY→Solver Parameters
tab→Save Geometry in Results Files check box

Post-processing

General post-processing enhancements

What is it?

This release includes a number of general enhancements to NX Post-processing. These include:

• NX Multiphysics results support

• Global text formatting preferences for post views

• Support for Kelvin
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• Graphing enhancements

• New averaging options

• New derived results for worst principal stress

• Samcef results support

NX Multiphysics results support

In NX Multiphysics solutions, the structural and thermal results are listed together under the same
solution in the Post Processing Navigator. You can right-click a result node and choose Load to
load the specific results file, or right-click the Solution node and choose Load All to load all of
the results for that solution.

Global text formatting for post views

You can now specify global text formatting preferences for all post views using the new Post
Processing Preferences dialog box. These preferences override the Legend Text options for
individual post views in the Post View dialog box.
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Support for Kelvin

You can now display and manipulate results in Kelvin in NX Post-processing, when you have one
or more results files loaded.

Graphing enhancements

You can now select Include Intersections in the Graph dialog box to create a smooth graph of the
changes in data values between points. This new option is available when the graph Type is set to
Path and the Define by Path option is selected.

New averaging options

Two new averaging options are added to the Multiple Reduction dialog box: Weighted Average and
Integral. When you select either of these options, you can define the type of weighted averaging (for
example, Area, Volume, or Length) based on the selection type. For example, if you select Faces
as your selection type, you can define your weighted average by Area. In addition, the Average
option has been renamed to Arithmetic Mean.

New derived results for worst principal stress

For stress results at nodes on elements, NX Post-processing now derives the worst principal stress
tensor component. The worst principal stress is the principal stress component with the largest
absolute value.
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Samcef results support

You can now display results from Samcef in NX Post-processing. You can:

• Import Samcef results into NX. The results are listed under the Results node in the Simulation
Navigator.

• Create post-processing displays of the Samcef results in NX, such as contour plots and
animations. You can also use the results manipulation capabilities with the Samcef results.

Where do I find it?

Post Processing Preferences dialog box

Application Advanced Simulation
Command Finder Post Processing Preferences
Menu Preferences→Post Processing

Multiple Reduction dialog box

Application Advanced Simulation
Command Finder

Results Multiple Reduction
Menu Tools→Results→Multiple Reduction

Generating results with result probes and variables

What is it?

This release provides a new way to display results with two new commands:

• Result Probe
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• Result Variables

Result Probe

Use the Result Probe command to generate customized results by using scalar expressions.

The result probe is associated with a solution. You can define a result probe either before or after
solving the model.

To use a results probe, the model must be solved. When you are ready to generate results, in the
Simulation Navigator, right-click the results probe and select the type of output required, which
can be contour plots, XY graphs, fields, or text. The results probe evaluates the results, and then
generates the output.

Result probes are stored in the Simulation file.

Result variables

Use the Result Variables command to define variables that you can use as input to a result probe.

To define a result variable, you must specify the following:

• A result type such as displacement, temperature, etc.

• A location, which can be nodal, elemental, or element nodal.

• A result type component such as X,Y,Z, Von mises, etc.

You can optionally specify shell-specific and beam-specific options, averaging, complex options, and
the output coordinate system.

A result variable can be used to define a formula for a result probe. A result probe is associated with a
solution, and it specifies results, load cases, iterations, or geometry to be used to generate the results.

The result variable is not associated with any solution. It is saved in a Simulation file. You can use a
result variable in multiple solutions and result probes.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and work part

Results
Command Finder

Result Probe or Result Variables
Simulation Navigator Right-click the solution node or the Result Probes node→New Result

Probe.
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Teamcenter Integration for Simulation

Additional file types supported as named reference

What is it?

There are new types of solver files that you can save to Teamcenter.

These solver types are supported as named references when you use Teamcenter Integration
with Teamcenter 10.1.3, Teamcenter 11.1, or later releases. If you are using an older release of
Teamcenter, your Teamcenter administrator can add these file types to the named references to
support these solvers.

Solver File Type
NX Nastran Nastran results (.f56)

SAMCEF workflow (.samx)
Bank file (.dat)
Database file (.sdb)
Complementary database file (.adb)
Results file (.res)
Storage file (.u18)
Descriptive file (.des)
Post-processing file (.fac)
Log file (.log)

SAMCEF

Diagnostic file (.dia)
Input deck and results for acoustics solvers (.sdb)

Acoustics Command file (.cmd)
Solver input file (.minp)
Contact tessellation input (.off)
Solver result file (.mres)
Solver information file (.minf)

Virtual Lab

Model representation (.mxml)
Log file (.mplg)

NX Multiphysics Input deck (.mpdat)

Assigning custom item types for CAE parts during import

What is it?

When you use the Import Assembly into Teamcenter command, if you have custom item types for
CAE parts, you can now select the item types for the type of file you import. You select the item types
from the following columns in the Import Assembly into Teamcenter dialog box:

• The Item Type column for the master part file.

• The CAEGeometry Item Type column for the idealized part file.

• The CAEModel Item Type column for the FEM file.
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• The CAEAnalysis Item Type column for the simulation file.

The Import customer defaults control the default item types assigned during import.

Where do I find it?

Customer Default

Application Advanced Simulation, Design Simulation

Command Finder Customer Defaults
Location in dialog
box Teamcenter Integration for NX→ Import/Export Assembly→ Import

Command

Application Advanced Simulation, Design Simulation

Command Finder Import Assembly into Teamcenter

Adding related CAE parts during export

What is it?

When you export an NX assembly from Teamcenter, and there are related CAE parts, you can
now add those CAE models to the export assembly operation. To add the CAE models, select the
appropriate option for CAE under Related Parts on the Non Masters/Associated Files tab in the
Export Assembly dialog box. The available options are:

• Simulations, FEMs, and Idealized Parts

• FEMs and Idealized Parts

• Idealized Parts

The default setting is None.

Where do I find it?

Application Advanced Simulation, Design Simulation
Command Finder

Export Assembly in Teamcenter

Save As enhanced to replace CAE Clone

What is it?

The Clone CAE Parts command is removed, as its functionality is now available with the Save As
command. To clone your CAE parts using the Save As command:

5-248 What's new in NX

Chapter 5: CAE



CAE

1. Make the part you want to clone the work part.

• To clone the simulation, make the simulation file the work part.

• To clone the FEM, make the FEM the work part.

2. In the Save Parts As dialog box, set the Save As Scope field to Selected Parts.

3. Select the parts that you want cloned from the Loaded Parts list.

Note

You can generate new items or revisions for the idealized part and master part only if they
are fully loaded.

Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite A FEM or simulation as the work part
Command Finder

Save As
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Support for non-master CAE items is removed

What is it?

NX 5 introduced the Simulation Process Management data model. In this data model, NX saves the
master part file, idealized part file, FEM file, and simulation file into separate item revisions. Starting
with NX 10, you must use the Simulation Process Management data model.

Prior to NX 5, the old Teamcenter data model saved the CAE files as datasets under a master CAD
item revision. If you are using the old Teamcenter data model, you must migrate legacy data prior
to accessing that data with NX 10. To do this, you can use the ugnx_caemigrate_tc command-line
utility in NX 9 or an earlier release.

NX Open for CAE

Python

What is it?

The Python programming language is added as a language binding for NX Open. This allows NX
users to record and replay NX workflows in the Python language. Advanced users can create or
extend NX Open Python journals to develop NX Open applications in Python. These applications can
use any of the features of the Python programming language including classes, looping constructs,
control statements, and callbacks. Python journals can be recorded and replayed on Windows,
Linux, and Mac.

Some of the features provided with NX Open Python include:

• Block Styler support with Python code generation of saved dialog boxes

• Same NX Open API as in the other supported languages

• Wrappers implemented in Python for the NX Open UF API

Why should I use it?

You can use the Python programming language for multi-platform journal recording and replaying
in NX.

Where do I find it?

Application NX Open
Command Finder Journal
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Design Simulation

General capabilities

Identifying objects by color

In the Simulation Navigator, the Color column lets you view and modify colors of various entities in
the graphics window.

You can view and modify colors for the following entities:

• Polygon bodies

• Meshes

• Boundary conditions

These include loads, constraints, and Simulation objects.

To modify the color of an object, double-click the color in the Color column.

To assign a series of different colors to multiple boundary conditions, select the boundary conditions
or a folder containing multiple boundary conditions. Right-click and select Sequence Display Colors.

Original colors Colors after using Sequence Display Colors

To modify the colors in the sequence, in the Customer Defaults dialog box, choose
Simulation→Boundary Conditions, and click the Sequence Display Colors tab.

Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite Boundary conditions applied to the model
Simulation Navigator Right-click multiple boundary conditions→Sequence Display Colors

Solution Monitor enhancements

What is it?

• The Solution Monitor is now used by the NX Multiphysics and NX Nastran solvers.
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• You can copy and paste the displayed text output. In previous versions, the displayed text output
was not selectable.

• The user interface of the Solution Monitor is refreshed and the command names are more
intuitive. The commands now have tooltips describing their functionality.

Where do I find it?

Application Advanced Simulation, Design Simulation

Prerequisite

NX Nastran, NX Multiphysics, NX Thermal and Flow, NX Space Systems
Thermal, or NX Electronic Systems Cooling as the selected solver
environment

Command Finder Solve
Simulation Navigator Right-click a solution node→Solve

Support for non-ASCII characters

What is it?

You can now use multi-byte characters to name files and enter data in the Advanced Simulation,
Design Simulation, and Motion applications. For example, you can use multi-byte characters in the
names of:

• All Motion objects, such as joints and drivers.

• Solutions, solution steps, or subcases.

• CAE related files, such as FEM and Simulation files.

In NX, your specified locale controls the language used in the user interface as well as the code
set for storing character data. For example, if your locale is set to China, you can enter Chinese
character data in the NX user interface.

The graphic shows Chinese characters in the Simulation Navigator.
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NX follows the Unicode international standard to store multi-byte character data, using UTF–8
encoding. Although NX supports the use of multi-byte characters, many third party software packages
that interface with NX, such as finite element solvers, support only ASCII character data.

Caution

NX does not provide an error message if the solver receives unsupported characters. You
must verify that your solvers will support your desired locale before implementing localization.

Solver support for multi-byte characters

Solver Unicode support Solve with
non-ASCII
entities

Solve with
non-ASCII file

names

Export with
non-ASCII file
names and
entities

Import
with

non-ASCII
file names

and
entities

NX
Nastran

No Yes Yes Yes Yes

MSC
Nastran

No No No Yes Yes

Abaqus No No Yes Yes Yes
ANSYS No No No Yes Yes
NX
Nastran
Design

No Yes Yes Yes Yes

NX
Multiphysics
(Structural)

No Yes Yes N/A Yes

NX
Multiphysics
(Thermal/Mapping/Coupled)

No No No N/A Yes

NX
Thermal/Flow
(Thermal/Advanced
Thermal,Flow/Advanced
Flow,
Coupled
Thermal-Flow,
Axisymmetric
Thermal)

No No No No Yes

NX
Thermal/Flow
(Mapping/Axisymmetric
Mapping)

No Yes Yes No Yes

LS-DYNA No Yes Yes Yes Yes
UNV No N/A N/A Yes Yes
Shape
Optimization

No No No N/A N/A
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Solver Unicode support Solve with
non-ASCII
entities

Solve with
non-ASCII file

names

Export with
non-ASCII file
names and
entities

Import
with

non-ASCII
file names

and
entities

Topology
Optimization

No No No N/A N/A

Durability No No Yes N/A N/A
Geometry
Optimization

No Yes Yes N/A N/A

Adaptivity No Yes Yes N/A N/A
NX
Motion
Co-Simulation

No No No N/A N/A

NXMotion
Recurdyn

No Yes Yes N/A N/A

NXMotion
ADAMS

No Yes Yes N/A N/A

Solutions

Making copies of subcases and steps

What is it?

You can now make copies of subcases or steps using the Clone Multiple command.

When you use this command:

• The cloned copies include the loads and constraints from the original subcase or step.

• The name of each cloned copy includes the original entity plus a numerical suffix.

• The last copy created becomes the new active subcase or step.

Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite A Simulation file as the work part and displayed part
Simulation Navigator Right-click a subcase or step → Clone Multiple

Editing boundary condition-step association using a spreadsheet

What is it?

You can now export boundary condition-step associations to a spreadsheet, make changes in the
spreadsheet, and then import the associations back into NX. In previous versions, you could export
the associations, but you could not import them back into NX.
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With this release, use these steps:

1. To edit your data in a spreadsheet, in the Step/Subcase Manager dialog box, right-click in an
empty area of the Step/Subcase List table and choose Edit in Spreadsheet.

2. Make your changes and save the spreadsheet as a comma-separated values (CSV) file.

3. To import your edited file, in the Step/Subcase Manager dialog box, right-click in an empty area
of the Step/Subcase List table and choose Import from CSV.

This release also adds the Export to CSV command, which lets you export the association data from
NX to a file in the comma-separated values format.

Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite A Simulation file as the work and displayed part

At least one active solution that contains multiple steps or subcases
Simulation Navigator Right-click a selected solution→Step Manager or Subcase Manager

(Nastran)

Boundary conditions

Temperature load enhancements

What is it?

You can now define a temperature load by importing temperature results. You do this using a
Temperature — External Time Unassigned type of Temperature load. You can import constant
temperatures from Nastran, Abaqus, ANSYS, and NX Thermal results files.

Corresponding Nastran syntax

The new types of Temperature load correspond to different NX Nastran bulk data entries.

• If you select the Temperature — External Time Assigned type, NX creates the DTEMPEX bulk
data entry.

• For all other types, NX creates the TEMP bulk data entry.
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Where do I find it?

Application Design Simulation
Prerequisites Structural as the specified analysis type
Command Finder

Temperature Load

Post-processing

General post-processing enhancements

What is it?

This release includes a number of general enhancements to NX Post-processing. These include:

• Support for Kelvin

• Graphing enhancements

• New derived results for worst principal stress

Support for Kelvin

You can now display and manipulate results in Kelvin in NX Post-processing, when you have one
or more results files loaded.

Graphing enhancements

You can now select Include Intersections in the Graph dialog box to create a smooth graph of the
changes in data values between points. This new option is available when the graph Type is set to
Path and the Define by Path option is selected.

New derived results for worst principal stress

For stress results at nodes on elements, NX Post-processing now derives the worst principal stress
tensor component. The worst principal stress is the principal stress component with the largest
absolute value.
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Functions and Graphing

Plotting a stacked graph

What is it?

You can plot multiple functions to multiple subgraphs of a new graph. You do this from the XY
Function Navigator, using the Plot(XY) in Stack command.

What's new in NX 5-257

CAE



Chapter 5: CAE

Zooming to a specified window in a stacked graph

You can zoom in on the subgraphs to view smaller ranges of data. To do this, use the Zoom by X
Only and Zoom by Y Only commands.

• Zoom by Y Only zooms in on only the subgraph that you choose.

• Zoom by X Only zooms in on all subgraphs that have the same type of abscissa data.

To expand all subgraphs back to their full ranges, choose No Window.

Example:

Suppose you plot a stacked graph where one function has an X range of 0 to 10 seconds, a second
function has a range of 0 to 20 seconds, and two additional functions have X values of frequency. If
you use the Zoom by X Only function to the range of 0 to 3 seconds on either of the time subgraphs,
both of them will zoom to that range. The frequency functions continue to show their full range.

Maximum Function Count

You can control how many subgraphs you can create in one graph, using the Maximum Canvas
Count on a Stacked Plot preference. NX creates the subgraphs starting from the bottom of the
screen, and matches the order in which you select the functions. If you select more functions than
allowed, a warning appears, and NX plots only the functions that you selected up to the maximum
number allowed.
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Why should I use it?

You can display multiple functions simultaneously using any one of the following commands:
Plot(XY) in Stack, Plot(XY), Plot(XYZ), and Overlay. The advantage of using the Plot(XY) in Stack
command is that it is the only one that allows you to include functions that have unique abscissa
units, and it allows you to zoom in on a single function.

Where do I find it?

Plot(XY) in Stack

Application Advanced Simulation
XY Function Navigator Right-click selected multiple functions → Plot(XY) in Stack

XY Plot Preferences

Menu File → Preferences → XY Plot
Location in dialog box XY Plot Preferences dialog box → Maximum Canvas Count on a

Stacked Plot

Plotting 2D functions to a 3D graph

What is it?

You can plot multiple 2D functions to unique XY planes of a 3D graph. You do this using the Plot(XYZ)
command. Each function you select must have identical data types for every axis.
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You select one of the following options from the Z-Axis Definition command to define the XY plane
on which NX places each function.

Selection Order Plots the function to a Z value that represents the order in which you selected
the functions.

General Value Uses the Z General Value data attribute for each function.

RPM value Uses the Z RPM value data attribute for each function.

Time Value Uses the Z Time Value data attribute for each function.

Order Value Uses the Z Order Value data attribute for each function.

Note

You can only use the Z-Axis Definition command to control the placement of AFU records.
NX places all other record types in the selection order.

Creating 3D graphs when using the Plot(XY) command

When you plot complex functions using the Plot(XY) command, you can create a 3D graph using the
3D Argand option. NX plots the real and imaginary components of the ordinate to the X-axis and
Y-axis respectively, and the abscissa to the Z-axis.
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Zooming in on graphs

You can use the new Zoom by Z Only command as well as Zoom by X Only and Zoom by Y Only
to zoom into a window of a 3D graph.

Note

You cannot use the Zoom by Rectangle command on a 3D graph. You cannot use the Zoom
by Y Only command on a 3D graph, if your Graph Style is set to Surface.

Editing the display options

More display options are available for 3D graphs than for 2D graphs. You can choose the Surface
graph style to connect your functions into a singular surface.

For functions plotted to a Line graph style, you can define the direction of the lines.
• X— Plots the curve as a line that connects the data points on each XY plane.

• Z— Plots the curve as a series of lines that connect the data points from each XY plane to the
next one.

• X&Z — Plots the curve as both a line that connects the data points on each XY plane, and a
series of lines that connect the data points from each XY plane to the next one.

Line graph style, X direction Line graph style, Z direction

Bar graph style Surface graph style

Where do I find it?

Application Advanced Simulation
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Prerequisite Multiple AFU records must be selected
XY Function Navigator Right-click selected records → Plot(XYZ)

Capturing an image from a graph

What is it?

Use the Capture Image command to save an image of a plotted graph. You can save your image in
the following formats:

• JPG

• TIFF

• PNG

NX saves the image to a directory that you select. To capture your image with a white background,
use the Use White Background option.

Where do I find it?

Application Advanced Simulation
Prerequisite A graph plotted to the main graphics window
Command Finder

Image Capture

Save to AFU command renamed

What is it?

The Save to AFU command is renamed to Save Graph, as you can now save the graph to a CSV
file as well as to an AFU file.

Where do I find it?

Application Advanced Simulation
Prerequisite A graph plotted to the main graphics window
Command Finder

Save Graph

Plotting unlimited number of functions to a single 2D graph

What is it?

NX no longer limits the number of records you can plot to a single graph.

To improve performance, there is a Maximum Legend Count on a Graph preference. When you
create a graph with more functions than the quantity specified by this preference, NX disables
synchronized tracking and does not display the graph legend.
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Where do I find it?

Application Advanced Simulation
XY Function Navigator Right-click a function → Plot(XY)→ XY Plot Preferences

Location in dialog box Maximum Count→ Maximum Legend Count on a Graph

Editing multiple functions simultaneously

What is it?

You can select multiple functions in the XY Function Editor and edit them simultaneously.

The AFU records are listed in the order in which you select them. The first record in the list is initially
the active record. A wrench icon indicates the active record. You can edit just the active record or
all of the records in the list. Double-click a different record to make it active.

Each field in the XY Function Editor is preceded by one of the following icons representing the
attributes status:

• indicates that the selected functions have the same value.

• indicates that the selected functions have mixed values.

• indicates that a change will be applied after you enter in a new value.

To modify only the active record, click the Apply Change — Active Record button. To modify all of
the records that include the modified fields, click the Apply Change — Applicable Record button.

Where do I find it?

Application Advanced Simulation
XY Function Navigator Right-click multiple selected functions → Edit

Additional math operations available for functions

What is it?

The Single Math command now includes the following math operations.

Independent Integration Performs an integration of the function. Ordinate
data of type Acceleration becomes Velocity, and
of type Velocity becomes Displacement.

The number of data points in the function is one
less than in the original function.
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Independent Differentiation Performs a differentiation of the function. Ordinate
data of type Displacement becomes Velocity, and
of type Velocity becomes Acceleration.

The number of data points in the function is one
less than in the original function.

Frequency Integration Used only for functions with abscissa data of type
Frequency.

Performs an integration of the function. Ordinate
data of type Acceleration becomes Velocity, and
of type Velocity becomes Displacement.

The resultant integral is a complex function.
Frequency Differentiation Used only for functions with abscissa data of type

Frequency.

Performs a differentiation of the function. Ordinate
data of type Displacement becomes Velocity, and
of type Velocity becomes Acceleration.

The resultant derivative is a complex function.

Where do I find it?

Application Advanced Simulation
Command Finder

Single Math

Updating axis limits of graphs when using overlays

What is it?

NX can automatically update the limits of a plotted graph when you overlay a new function onto it. To
enable this functionality, set the Update Axis Limits for Overlaying Plot preference in the XY Plot
Preferences dialog box. If you do not want an automatic update but would like to apply the update
when you need to, use the Fit Axis Limits command to update the axis.

If you applied a zoom window to the graph, the axis limits will change but the zoom will continue to
be observed. You can use the No Window command to update the display to show the new full
axis limits.

Where do I find it?

Update Axis Limits for Overlaying Plot

Application Advanced Simulation
Location in dialog box XY Plot Preferences dialog box → Overlay group → Update Axis Limits

for Overlaying Plot check box

Fit Axis Limits
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Application Advanced Simulation
Prerequisite A function plotted that exceeds the current axis limits
Command Finder

Editing → Right-click the graph background → Fit Axis Limits

Managing graphics windows

What is it?

On Windows machines, there are new options for managing the display of multiple graphics windows.
The new Graphics Window Manager lists all of your independent graphics windows with options to
control their screen position.

Close Closes the selected window.

Make Floating Restores a docked graphics window to float independently in the foreground.

Make Current Docks the selected window in front of the main graphics window.

Make Main Graphics
Window Current

Moves the main graphics window in front of any docked graphics windows.

You can also tile or cascade your graphics windows. Use the following commands in the Window
drop-down list to tile or cascade your separate graphics windows as well as your main graphics
window:

• Cascade

• Tile Horizontally

• Tile Vertically

Where do I find it?

Application Advanced Simulation
Prerequisite One or more graphs plotted to separate graphics windows
Command Finder Graphics Window Manager

General functions and graphing enhancements

What is it?

• You can maximize the display of independent graph windows.

• You can move the display of a graph from an independent graph window to be superimposed on
the NX graphics window. To do this, use the Send to NX Window command.

• The Curve Options dialog box is now named Display Options. The thickness options have
increased to include 9 standard thicknesses.

What's new in NX 5-265

CAE



Chapter 5: CAE

• The spacing of dashed lines is now based on the plot’s dimensions. In previous releases, this
was based on the distance between data points, which could make dashed lines appear solid
when data points were close together.
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Check-Mate

Check-Mate checkers and functions

What is it?

Check-Mate is enhanced to include the new function, mqc_checkWeldPointConnectedParts. You can
find it in the mqc_weld_checker_func.dfa source file.

The following new Check-Mate checkers are provided with this release.

Checker name Categories
Number of Hidden Objects Get Information→Modeling
Connected Parts Welding→Weld Point

The following checkers have been enhanced.

Checker name Categories Enhancement
Report Solid Body
without Density Setting

Get
Information→Modeling

Adds an option to include sheet bodies.

Report Solid Body with
Default Density Setting

Get
Information→Modeling

Adds an option to include sheet bodies.

Report Solid Body with
Specified Density Setting

Get
Information→Modeling

Adds an option to include sheet bodies.

Report Out-of-Date
Features

Get
Information→Modeling

Adds an option to check internal features.

The following functions have been moved from mqc_checker_func.dfa to mqc_obsolete_func.dfa.

• mqc_checkViewScale

• mqc_checkViewNames

• mqc_checkCategoryLayer

• mqc_checkLayerCategory

• mqc_checkRequiredCategory

• mqc_checkCategoryObjectMapping

• mqc_checkRefSetsCsysName

• mqc_checkObjectInCategory
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• mqc_checkRequiredRefSets

• mqc_checkRefSetsObjectType

The mqc_report_blanked_entity function, which was in the Get Information→Modeling category, is
now hidden in the Set Up Tests dialog box. It is replaced by the mqc_report_hidden_objects function
because the obsolete term blanked entity has been replaced by the term hidden object in NX.

The hidden checker is only invisible in the category list box of the Tests tab in the Set Up Tests dialog
box. If you have already used the hidden checker, you are not affected by this change.

Please see the ugcheckmate.dat file in the Check-Mate kit for additional details.

Where do I find it?

Resource bar HD3D Tools →Check-Mate

CMM Inspection Programming NX 9.0.1 — NX 10.0

CMM general enhancements

General enhancements — NX 9.0.1

View Vector name change

When you set the tolerance type to Perpendicularity or Parallelism in the Tolerance
Operation dialog box, the View Vector group is renamed Tolerance Zone Width Direction. The
new name better reflects the DMIS standard for this vector: “[The] direction vector along which the
view dependent parallel [or perpendicular sic] plane tolerance zone width is to be applied.”

Coordinate tolerance nominal values displayed

To support CMM software that requires DMIS CORTOL values to evaluate coordinate tolerances, the
Tolerance Operation dialog box now shows the nominal X, Y, or Z axis value of the feature center
point in the currently aligned Part Coordinate System (PCS).

Improved graphics when defining a PCS from datums

When you define an alignment command in the Alignment dialog box using the Define PCS from
Datums alignment type, NX now indicates which feature is assigned to which letter. In previous
releases, NX only highlighted the feature assigned to the datums after you set the alignment direction
or origin. The datum feature is now highlighted when you select it from the Datum Letter list or type
its value in the Datum Letter box.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming
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Prerequisite

• To define a tolerance operation, create an appropriate inspection feature.

• To create a PCS from datums, create appropriate inspection features
and datums from those features.

Command Finder

Perpendicularity

Parallelism

Coordinate Tolerance

Alignment

General enhancements — NX 9.0.2

Overriding direct dimension tolerance values defined in PMI

Direct dimension tolerance values defined in a master model may not reflect the design intent.
For example, an acceptable angle on the part may be 89.998 degrees instead of the 90 degrees
prescribed in a drawing, with acceptable measurement variation causing the angle tolerance to fail. In
the Tolerance Operation dialog box, in the Parameters group, you can override direct dimension
Nominal, Upper, and Lower tolerance values linked to PMI.

When you override these values, the Inherited icon changes to a Locally defined icon to
indicate that the PMI value has been overridden. To recall the PMI value, click the unlock icon and
choose Inherited from PMI.

Collision avoidance progress bar

When you run collision avoidance on inspection paths, a progress bar reports the percentage
complete and displays each action.

Performing analysis... 28% PATH_CYLINDER_TOP - Find Sensor

Where do I find it?

Initial release NX 9.0.2
Application CMM Inspection Programming

Prerequisite

• To define a dimensional tolerance operation, create an appropriate
inspection feature.

• To apply collision avoidance, in the Inspection Navigator, select one
or more inspection paths.

Command Finder Collision Avoidance
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General enhancements — NX 9.0.3 MP1

New method added to the NX Open API

A GetRoot method has been added to the InspectionSetup class to return the root of the specified
branch root, such as the Machine or Program group name.

Feature selection when adding tolerances

In previous versions, when you added a tolerance to a highlighted feature in the Inspection
Navigator, the highlight jumped to the newly added tolerance. To add additional tolerances to the
feature, you had to highlight the feature again.

The feature now remains highlighted after you add a tolerance. After you add a tolerance to a feature,
you no longer have to reselect the feature before you add an additional tolerance. The selection
highlight remains on the feature and does not move to the tolerance you create.

Modifying duplicate feature names

In previous versions, if you entered a duplicate inspection feature name in a feature dialog box, NX:

1. Displayed a message stating that the name was already in use.

2. Closed the feature dialog box when you closed the message.

3. Applied a default name to the feature.

To change the default name, you had to double-click it in the Inspection Navigator and enter your
preferred name.

After you close the message, the feature dialog box now remains open with the duplicate name intact
so that you can modify the text to create a unique name.

Pattern features

You can now pre-select features in the Inspection Operation Navigator to create a pattern feature.
For example, you can select all hole features in your model. NX populates the feature list with
the selected features.

You can modify the feature list before you complete the pattern. If you select other operation types by
mistake, NX does not add them to the feature list.

Where do I find it?

Initial release NX 9.0.3 MP1
Application CMM Inspection Programming

Path statuses in the Inspection Navigator

What is it?

The Path column in the Inspection Navigator now provides additional status information.

Icon Meaning
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• Next to an inspection feature, this icon indicates that there is no path or construction
for the feature.

• Next to an inspection path, this icon indicates that the path contains no measurements.
Next to an inspection path, this icon indicates that:

• The total number of points in the path is greater than zero but less than the minimum
number of points specified for the feature type in the DMIS 5.2 standard.

• The path consists of a single arc scan on a cylinder, cone, or torus.

• The path consists of a single line scan on a plane, cylinder, or cone.

Why should I use it?

Review the Path column to quickly identify potential program problems.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming
Prerequisite You must create inspection features and paths.
Inspection Navigator Path column

DMIS Equator and mirroring postprocessors

What is it?

Special postprocessors are available, including one for use with the Equator 300 included in the
machine library.

There are also three DMIS 3.0 postprocessors that work with CMM Inspection Execution to mirror
coordinates and vectors from symmetrically opposite parts such as two car doors.

• DMIS 3.0 Mirror XZ Plane

• DMIS 3.0 Mirror YZ Plane

• DMIS 3.0 Mirror XY Plane

Versions of these postprocessors for NX 8.5.3 and NX 8.5.2 are also available from GTAC.

Why should I use it?

Mirroring DMIS content reduces the amount of work required to apply tolerances to symmetrical
sides of a part or assembly.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming
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Prerequisite You must define mirrored sensors in your inspection program.

Command Finder Post Process

Tip type and tool selection

What is it?

A Sensor Tip Type list has been added to the Sensor group in many dialog boxes. From the
Inspection Method dialog box, this list allows you to specify a preferred sensor tip for each type of
inspection feature. When you create or generate inspection path sub-operations, CMM Inspection
Programming selects the preferred tip for each feature type by default.

Sensor tip types include the following.

• Any in the Inspection Method dialog box allows CMM Inspection Programming to determine
the appropriate tip for the feature type, in accordance with the default or selected feature type’s
sensor strategy. When selected in the Link PMI and Create Paths dialog boxes, the application
uses the preferred tip from the feature methods.

• Sphere uses a spherical tip.
• Cylinder uses a cylindrical tip for sheet metal

edge and surface measurements.

Why should I use it?

Setting an appropriate default sensor type for each type of inspection feature in the Inspection
Method dialog box is faster than setting or resetting the sensors manually in each inspection path
sub-operation.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming
Prerequisite You must load the probes specified in your inspection methods.

Location in dialog
box

Sensor group in the following dialog boxes:

• Inspection Method

• Create Sub-Operation

• Link PMI

• Create Paths
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Sub-operation inheritance from feature methods

What is it?

Inspection paths created using the Link PMI and Create Paths dialog boxes now inherit
sub-operation types from inspection feature methods.

Feature Type Supported Sub-operation types
Cylinder Point Set, Scan Helix
Circle Point Set, Scan Arc, Scan Curve, 5–axis Scan Curve
Arc, line Point Set, Scan Arc, Scan Curve, 5–axis Scan Curve
Curve Point Set, Scan Curve, 5-axis Scan Curve

Note

• If the default sub-operation type in the method is set to Scan Arc or Scan Helix, the
methods’s Scan Mode value determines whether the path uses 3-axis or 5-axis motion.

• If the default sub-operation type is Scan Line, Scan Curve, or 5-axis Scan Curve, the
Scan Mode value in the method is ignored.

Why should I use it?

When you specify a default sub-operation and scan mode value for each inspection feature’s method,
you can quickly generate inspection paths with the appropriate sub-operations from the Link PMI and
Create Paths dialog boxes.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming

Inspection Navigator
Home tab→Top Border bar→Method View →double-click the feature
method

Collision avoidance enhancements

What is it?

Two groups in the Collision Avoidance dialog box are enhanced.

Avoidance Methods group

Two options are added to the Avoidance Methods group.

• Move Measurement Point moves measurement points to safe locations on plane, cylinder,
and cone inspection features if they are causing collisions because they are too close to other
geometry.
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• Delete Measurement Point deletes measurement points from any inspection feature if no
avoidance solution can be computed.

Avoidance methods have also been reordered in the Collision Avoidance dialog box to better reflect
the order in which they are logically executed.

Collision Detection Settings group

You can now directly modify Maximum Length Increment, Maximum Angular Increment, and
Faceting Tolerance parameters, and they will correctly represent the values used in collision
avoidance. In previous releases, you had to set these values in other dialog boxes, and the values
did not always reflect the values used in collision avoidance.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming

Prerequisite
You must select at least one inspection path in the Program Order view of
the Inspection Navigator.

Command Finder Collision Avoidance
Inspection Navigator Right-click the path→Collision Avoidance

Data analysis options

Ability to save loaded analysis data

What is it?

You can now access your analysis data from Group folders in the Part Navigator. You must first
load the data from one or more measurement (.mea or .dml) files to a layer and give your data a
group name that helps you identify your data in the Part Navigator.

Why should I use it?

You can now save and organize data from multiple data files to:

• Compare differences in measurement results.

• Use NX measurement tools to display deviations and create annotations for reports.

• Delete problem measurement points that cause tolerances to fail.
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Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming

Prerequisite
You must load an .mea or .dml file and in the Inspection Navigator, select
the inspection features and tolerances for which you want to save data.

Command Finder Save Analyze Data to Layer
Inspection Navigator Right-click a selected area and choose Save Analyze Data to Layer

Creating annotations for data analysis

What is it?

When you save analysis data to an inspection program, measurement points and lines become
accessible from the Part Navigator. You can:

• Select features or tolerance groups in the Part Navigator to identify deviations between nominal
points and their actual measured locations.

• Use NX measurement commands to measure the deviations and create annotations for reports.

Why should I use it?

Annotations support the visualization of problems and large deviations from nominal values in your
programs.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming
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Prerequisite
You must save analysis data from an .mea or .dml file to your inspection
setup program.

Ribbon bar Part Navigator tab →Groups folder

Deleting problematic analysis measurement points

What is it?

You can now delete problematic analysis measurement points that are incorrectly causing tolerances
to fail. To do this, you can select the points either in the Inspection Navigator or the graphics
window, and then use the Delete Analyze Points command.

Why should I use it?

Some analysis points may be outliers or lie too close to an edge and cause false readings because
they are causing probe collisions with nearby geometry. When you delete such points, you improve
statistical accuracy.

Where do I find it?

Initial release NX 9.0.1
Application CMM Inspection Programming

Prerequisite

You must load measurement data and save that data to a Part Navigator
layer.

In the Inspection Navigator, you must select the inspection feature that
contains the points that you want to delete.
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Command Finder Delete Analyze Points

Inspection Navigator
Right-click the inspection feature that contains the points that you want to
delete and choose Delete Analyze Points.

Creating plane and cylinder features from multiple faces

What is it?

You can create a single plane feature from multiple coplanar faces, and a single cylinder feature
from multiple coaxial surfaces that together form a partial cylinder. When you define a point set
sub-operation for either feature in the Inspection Path dialog box, each face gets a separate UV grid.

The same logic applies if a tolerance is linked to multiple coplanar faces or coaxial surfaces in
PMI. When you link to PMI, the faces or surfaces are generated as single features, and a single
inspection path is applied.

Why should I use it?

When you create single plane and cylinder inspection features from multiple faces, you avoid the
need to create multiple general surface features and individual inspection paths for those features.

Where do I find it?

Application CMM Inspection Programming
Command Finder Plane, Cylinder

Location in dialog
box

Creating a single plane feature from multiple coplanar faces:

Plane Inspection Feature dialog box→Geometry group→Select Plane or
Base Point

Creating a single cylinder feature from multiple coaxial faces:

Cylinder Inspection Feature dialog box→Geometry group→Select
Cylinder or Base Point
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Specifying user-defined events (UDEs)

What is it?

You can specify user-defined events (UDEs) to create dialog boxes that let you quickly insert custom
code into your post-processed DMIS inspection programs. If you use UDEs, you do not have to
write the same code in each program.

When you post process your program, the manufacturing output manager (MOM):

1. Looks for event parameters generated from UDE dialog boxes. Dialog box parameters are
defined in a ude.cdl file.

2. Handles these event parameters to output custom DMIS code. Event handlers are defined
in a ude.tcl file.

ude.cdl→ude.tcl→Custom DMIS code

Why should I use it?

A custom code event might include a command that CMM Inspection Programming does not support,
or a complex function that otherwise takes too much work to define for every inspection program.
UDEs make custom code reusable.

Where do I find it?

Initial release NX 9.0.2
Application CMM Inspection Programming

Prerequisite

Define your dialog boxes in the ude.cdl file and event handlers in the ude.tcl
file, using a text editor. Restart NX to insert them into your inspection
programs.

Inspection Navigator
Right-click the object before which you want the event to
occur→Object→Start Events or End Events

Inspection Navigator default object name improvements

The default names and structure of objects in the Inspection Navigator, including inspection
features, paths, constructed and extract features, and tolerances, are improved.

Inspection feature names

In previous versions, all default inspection feature names used the following string:

INSP_FEAT_<feature type>_<sequence number>

<sequence number> was blank for the first feature of the same type, and began with _1 for the
second.

The string is now changed to:

<feature type><sequence number>.

The sequence number begins at 1 for each feature type.
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Example

FEATURES
PLANE1
PLANE2
CYLINDER1
PLANE3
CYLINDER2

Inspection path names

In previous versions, inspection paths manually defined in the Inspection Path dialog box followed
this default format:

PATH_<feature name>

Path operations created using multi-feature path creation followed this format:

<feature name>_PATH

The path names now follow the latter format regardless of which command you use to create the
paths.

Example

FEATURES
PLANE1
CYLINDER1

INSPECTION_PATHS
PLANE1_PATH
CYLINDER1_PATH

NX sets the operation name in the Inspection Path dialog box to this format every time you select
the feature, and overrides any previous name you entered. You can modify it after it is set and NX
retains these modifications unless you select a different feature in the dialog box.

Constructed feature and extracted feature names

In previous versions, the default Operation Name:

• In the Constructed Feature dialog box was INSP_CONST.

• In the Extract Feature dialog box was INSP_EXTRACT.

Constructed feature and extract feature operation names now derive from the name in the dialog
box’s Design Feature Name text box, with the text strings _CONST or _EXTRACT appended. The
name of the constructed or extract feature updates if you modify the Design Feature Name.
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Example

Name of an existing feature selected from
the Select Design Feature list in the Extract
Feature dialog box if the Design Feature
Mode = Select Existing, or a manually
defined name if the Design Feature Mode =
Create New:

MY_PT1

Constructed feature name:

MY_PT1_CONST

Name of an existing feature selected from
the Select Design Feature list in the Extract
Feature dialog box:

TOP_PLANE1

Extract feature name:

TOP_PLANE1_EXTRACT

Tolerance operation names

Default tolerance operation names now use the following format:

<feature name>_<dmis tolerance token string>

Example

If a feature is named CYLINDER1 and a diameter tolerance is created, the tolerance is by
default named CYLINDER1_DIAM.

DMIS tokens include the following.

ANGL CPROFL FLAT RAD
ANGLB CPOFS PARLEL STRGHT
ANGLR CRNOUT PERP SYM
CIRLTY CYLCTY POS TRNOUT
COMPOS DATDEF PROFL WIDTH
CONCEN DIAM PROFP
CORTOL DISTB PROFS

Where do I find it?

Initial release NX 9.0.3 MP1
Application CMM Inspection Programming

MCOSMOS postprocessor (10.0.1)

What is it?

MCOSMOS, the Mitutoyo Controlled Open Systems for Modular Operation Support postprocessor,
is now available as part of the standard installation for NX 10.0.1. It is not necessary to download
the files from GTAC.
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Where do I find it?

Application CMM Inspection Programming
Command Finder Postprocess
Location in dialog
box Postprocess dialog box→Postprocessor group→MITUTOYO MCOSMOS

CMM general enhancements (10.0.1)

What is it?

You can fit one or more selected objects to the graphics window view.

Where do I find it?

Application CMM Inspection Programming
Prerequisite Select the objects in the Inspection Navigator.

Top Border bar View tab→Orientation group→Fit View to Selection
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General enhancements

Bill of Material enhancements

What is it?

The existing Bill of Material command is enhanced.

Using templates

You can use templates to define the related part information.

You can define the following parameters in the template.

Display Name Specifies the display names of the BOM list items which are displayed as
column titles in the Bill of Material dialog box.

Attribute Name Specifies the attribute name of the BOM list items. Only the attribute values
that you specify in the template are displayed in the BOM list. If you do not
specify a value for an attribute, the attribute will not be shown in the BOM list.

Key Field Lets you specify if the corresponding attribute is to be used as a key field
attribute or not. The components which have the same key field are grouped
together and shown in one row in the BOM list.

Locked Specifies if you can modify the value of an attribute in the BOM list.

Filter Specifies if you want to use the value of an attribute as a filter string.

For example, if the Display Name attribute has a string value set to SUPPLIER,
then the attribute will be shown in the BOM list and you can also use the
attribute value to filter the BOM data.

If you do not define the Display Name for the filter attributes, for example the
MW_COMPONENT_NAME in the template, the attribute will not be shown in
the BOM UI.
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Note

The cells shown in gray cannot be used as they will be deleted when you export the BOM. You
can enter user information at the top of the template.

Changing values

You can change the value from the predefined alteration list in the specified column by defining a
common data template. There are four types of lists in common data template, and you can define
them by setting LIST_TYPE to values as shown in the following table.

List Type Output

0
The BOM list with the parameters is displayed in
the dialog box. No comparison will be executed.

1

The BOM list with the parameters is displayed
in the dialog box, and you can enter information
in a string box as well. No comparison will be
executed.

2

The BOM list with the parameters is displayed
in the dialog box, and if the value of a cell is
not in the BOM list, that particular cell will be
highlighted.

3

A string of the BOM is exported instead of
displaying the BOM list in the dialog box. You
can enter information in a cell. If the values that
you enter are found in the list then that particular
cell is highlighted.

Other enhancements

You can now also do the following:

• Generate different BOM lists by switching templates in the Bill of Material dialog box.

• Export the data in a particular row in the BOM list. To do this, select the check box at the
beginning of the row.

• Quickly recognize modified information in the BOM list.

If you modify a row in the BOM list, the particular row is highlighted in blue.

• Filter BOM data based on specific attributes which are defined in the BOM template.
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Why should I use it?

These enhancements help you to generate BOM with a formatted bill of material template in Excel.
You can specify different part attributes in different columns of the template, specify one or more part
attributes to be a key field, a lock status, or to filter the column.

Where do I find it?

Application Mold Wizard, Progressive Die Wizard, and Electrode Design

Command Finder Bill of Material

Added functionality in Face Color Management

What is it?

• Color bitmaps identify the colors and attributes for the current part. The information is drawn
from your specified color spreadsheet. The bitmaps are available in a separate column in the
Face Color Management dialog box.

• Colors and attributes can be applied to non-circular holes.

• A new Select Sub-Hole Face Automatically option is available to help you select complex
holes more efficiently.

• The Show Face Without Any Manufacturing Information and Show Face With Same

Manufacturing Information options are available as buttons instead of check boxes.

Why should I use it?

Because colors are associated with manufacturing methods, the ability to assign colors to objects is a
valuable way to provide instructions for downstream applications, including drawings.

Where do I find it?

Application Mold Wizard, Progressive Die Wizard, Electrode Design

Command Finder Face Color Management

Electrode Design

Create Box

Use this command to create a block or cylinder which envelopes the selected objects. This command
replaces the previous box feature based on Knowledge Fusion.
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You should use this command when you want to create a block or a cylinder which envelopes the
contour with selected faces, edges, curves, points, solid bodies or facet bodies.

Where do I find it?

Application Mold Wizard, Progressive Die Wizard, and Electrode Design

Command Finder Create Box

CAM Data Preparation

Guided Extension enhancements

What is it?

You can now also select the edges of a solid body to create surface extensions. In previous releases,
you could only select a sheet body.

You can:

• Extend the edges of a solid body tangentially to the selected face and select the direction in
which you want to create the surface extension. To do this, in the Type group, select Tangent

to Face and click Change Faces Side .
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• Extend the curves or edges of a solid body or sheet body perpendicular to a specified vector.
To do this, in the Type group, select Vector.

You can also edit the surface extension you create. To do this, double-click the Guided Extension
feature in the Part Navigator.

Model History
Linked Datum Coordinate System (0)
Linked Body (1) “UM_PROD_BODY”
Work Piece(2)
Linked Body (3) “UM_INSERT_BOX”
Feature Group (8) “patch_set1”
Extracted Region (9) “CAVITY_EXTRACT_REGION”
Extracted Region (10) “CORE_EXTRACT_REGION”
Guided Extension (11)
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Where do I find it?

Application Modeling

Prerequisite
The Change Faces Side option is available only when you set Type to
Tangent from Face.

Command Finder Guided Extension

Location in dialog
box

• Type group→Type list→Tangent from Face or Vector

• Base Profile group→Change Faces Side

Mold Wizard

Create Box

Use this command to create a block or cylinder which envelopes the selected objects. This command
replaces the previous box feature based on Knowledge Fusion.

You should use this command when you want to create a block or a cylinder which envelopes the
contour with selected faces, edges, curves, points, solid bodies or facet bodies.

Where do I find it?

Application Mold Wizard, Progressive Die Wizard, and Electrode Design

Command Finder Create Box
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Stock Size enhancements

What is it?

Stock Size is enhanced with a smart object in NX. It now allows being modified with six clearances
in six directions. It also provides an option to set zero a clearance value automatically if there are
extreme faces in selected body in the specified direction.

Why should I use it?

You should use it when you want to calculate the stock (block or cylinder) size which envelopes the
contour with selected solid bodies.

Where do I find it?

Application Mold Wizard and Progressive Die Wizard

Command Finder Stock Size
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Standard parts reuse enhancement

What is it?

You can now browse and select standard parts in the Reuse Library when you use the following
commands:

• Standard Parts

• Mold Base Library

• Slide and Lifter Library

• Sub-insert Library

• Cooling Component Part Library

In previous releases, the standard parts were displayed within these dialog boxes which made the
dialog boxes unwieldy. Now these dialog boxes are smaller and take up less design space as the
standard parts are displayed in the Reuse Library.

To open the standard parts in the Reuse Library, you can click Select Item in the dialog box
of the respective command. After you select a part from the Reuse Library, its parameters are
populated in the respective dialog box. You can change these parameters before you place the
standard part in your design.

Where do I find it?

Standard Parts command

Application Mold Wizard

Command Finder Standard Parts
Location in dialog
box Standard Part Management dialog box→Select Item

Mold Base Library command

Application Mold Wizard

Command Finder Mold Base Library
Location in dialog
box Mold Base Library dialog box→Select Item

Slide and Lifter Library command

Application Mold Wizard

Command Finder Slide and Lifter Library
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Location in dialog
box Slide and Lifter Design dialog box→Select Item

Sub-insert Library command

Application Mold Wizard

Command Finder Sub-insert Library
Location in dialog
box Sub-insert Design dialog box→Select Item

Cooling Component Part Library command

Application Mold Wizard

Command Finder Cooling Standard Part Library
Location in dialog
box Cooling Component Design dialog box→Select Item

Motion Simulation commands

What is it?

The Tooling Motion Simulation command is removed.

Use the following commands to set up the kinematic model, define the cam, define the lifter, define
user defined motion, and run the simulation.

Motion Preprocess

Use this command to set and load the kinematic model, and mount the sheet metal or plastic parts
of the die or the mold on the kinematic model.

Why should I use it?
You can use this command to prepare your motion simulation data.

You can:

• Clone a predefined kinematic model for tooling into your current assembly or a directory
you specify.

• Change the kinematic model. NX displays a message window to confirm whether you want to
remove the current kinematic model and add another one. If you click Yes, you must mount
the components again and redefine the cams.

• Generate control data and import it to a kinematic model according to the die settings. You
can also change to different control data and re-read the control data.

Where do I find it?
Application Mold Wizard and Progressive Die Wizard
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Command Finder Motion Preprocess

Define Cam

Use this command to create, edit, or delete a linear cam, a rotary cam, a rocker cam, a user-defined
cam, or cushion programming. You can select solid bodies, sheet bodies, or faceted bodies that have
solid or sheet bodies associated with it, and use them to define the cam.

Why should I use it?
A predefined kinematic model contains kinematic data about basic cam actions. You can use this
command to define the kinematic data for various types of cams. NX automatically calculates and
stores the cam data in the kinematic model.

Where do I find it?
Application Mold Wizard and Progressive Die Wizard

Command Finder Define Cam

Define Lifter

Use this command to create, edit, or delete a generic lifter or a lifter on a lifter. You can select
solid bodies, sheet bodies, or faceted bodies that have solid or sheet bodies associated with it, and
use them to define the lifter.

Why should I use it?
A predefined kinematic model contains kinematic data about basic lifter actions. You can use
this command to define the kinematic data for various types of lifter actions. NX automatically
calculates and stores the lifter data in the kinematic model.

Where do I find it?
Application Progressive Die Wizard and Mold Wizard

Command Finder Define Lifter

User Defined Motion

Use this command to add user defined motion data to your kinematic model.

Why should I use it?
You can define:

• Linear movement along a specific vector.

• Angular movement about a specific axis.

The motion curve is a set of 360 values, one for each timing angle 0-359, that determines how far
to move along or about the axis at each point of the simulation. You can use the simple motion
curves created by NX, or supply your own values using a comma separated values (CSV) file.
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Where do I find it?
Application Progressive Die Wizard

Command Finder User Defined Motion

Run Simulation

In Progressive Die Wizard, use this command to view an animation that shows the kinematics of
all the automatic and user-identified components in the model.

Why should I use it?
You can:

• View the die components and sheet metal parts within the model and check for collisions
and interference.

• Detect and analyze the collision at each angle of the simulation.

Where do I find it?
Application Mold Wizard and Progressive Die Wizard

Command Finder Run Simulation

Cooling enhancements

What is it?

Cooling Circuits
Classification of cooling fittings is introduced, once an inlet is selected, the circuit will search
the intersected channels if they have the same MW_COOLING_CHANNEL_TYPE attribute
according to the inlet channel.

New color setting is set to cooling circuit channels.

You can specify if you want to create a concept symbol or create a component directly.

These enhancements let you flexibly add the classified cooling standard parts. Different color can
be set to channels in a circuit. Adding parts directly can reduce the time to add component.

Cooling Fittings
Classification of cooling fittings is introduced. You can now specify if you want to create a concept
symbol or directly create a component.

These enhancements let you flexibly add the classified cooling standard parts. Adding parts
directly can reduce the time to add component.

Direct Channel
You can now create cooling baffle or cooling channel directly by selecting the specific type.

This enhancement helps you to specify the channel type can create a baffle direction.
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Define Channel
Classification of cooling fittings is introduced. You can define the channel into the type by reading
the register file definition.

You can flexibly define the channel into the classified types.

Where do I find it?

Application Mold Wizard

Command Finder

Cooling Circuits

Cooling Fittings

Direct Channel

Define Channel

Design Ejector Pin

Use the Design Ejector Pin command to command to insert standard ejector components in to
your mold assembly.

You can:

• Search and select your ejector components from the Reuse Library.

• Search for sleeve regions to install sleeve pins and recommend ejector length automatically.

• Specify points for positioning ejector positions.

• Edit X and Y ejector pin position values.

• Quickly edit and remove ejectors.

• Assign symbols to ejector pins.

Where do I find it?

Application Mold Wizard

Command Finder Design Ejector Pin
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Design Parting Surface enhancement

What is it?

You can now use surface extensions to design the parting surface. The surface extensions can
be created using connected curves or edges of solid bodies or sheet bodies. To do this, use the
Guided Extension option.

In the example, a parting surface for the core region is designed by creating a surface extension
using the connected curves shown.

Why should I use it?

Use the Guided Extension method when you want to create a parting surface without additional
trimming, or in circumstances that the other methods, such as Extrude or Bounded Plane cannot
create parting surfaces successfully.

Where do I find it?

Application Mold Wizard

Command Finder Design Parting Surface

Location in dialog
box

Create Parting Surface group→Method subgroup→Guided Extension
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Progressive Die Wizard

Standard parts reuse enhancement

What is it?

You can now browse and select standard parts in the Reuse Library when you use the Standard
Parts Library command.

In previous releases, the standard parts were displayed within these dialog boxes which made the
dialog boxes unwieldy. Now these dialog boxes are smaller and take up less design space as the
standard parts are displayed in the Reuse Library.

To open the standard parts in the Reuse Library, you can click Select Item in the Standard
Part Management dialog box. After you select a part from the Reuse Library, its parameters are
populated in the dialog box. You can change these parameters before you place the standard part
in your design.

Where do I find it?

Application Progressive Die Wizard

Command Finder Standard Parts
Location in dialog
box Standard Part Management dialog box→Select Item

Shim

What is it?

Use the Shim command to extrude a shim body from the selected face of a piercing die insert
or punch.

No Shim Shim added

Why should I use it?

The punch and die insert wear out with time. Use this command to add a shim at the top or bottom of
the insert or punch in order to maintain the correct height.
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Where do I find it?

Application Progressive Die Wizard

Command Finder Shim

Stripper Venting

What is it?

Use the Stripper Venting command to cut a venting hole in the stripper plate.

Why should I use it?

You can use this command to cut a venting hole in the stripper plate during high-speed stamping.

Where do I find it?

Application Progressive Die Wizard

Command Finder Stripper Venting
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Hem Fixer

What is it?

Use the Hem Fixer command to add a gap between the base body and the hem flange.

Why should I use it?

You cannot unform a flange if there is no gap between the flange and base sheet body. Use this
command to add a gap between them.

Where do I find it?

Application Progressive Die Wizard

Command Finder Hem Fixer

Unfolding Simulation

What is it?

Use the Unfolding Simulation command to simulate unfolding of a bend face.

Why should I use it?

You can use this command to check the interference of bend faces with other components during
unfolding process.

Where do I find it?

Application Progressive Die Wizard

Command Finder Unfolding Simulation
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Backing Pad

What is it?

Use the Backing Pad command to design backing pads for punch and die inserts in casting dies.

Where do I find it?

Application Progressive Die Wizard

Command Finder Backing Pad

Slug Retention

What is it?

Use the Slug Retention command to design a slug retention in die openings.

What's new in NX 7-17

Tooling Design



Chapter 7: Tooling Design

Why should I use it?

Slugs that become dislocated in stamping operations can damage either the stamped part or the die.
The slug retention hole helps to keep the slugs from coming out of the die openings.

Where do I find it?

Application Progressive Die Wizard

Command Finder Slug Retention

General Insert

What is it?

Use the General Insert command to create outside-insert for punch or die insert.
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Where do I find it?

Application Progressive Die Wizard

Command Finder General Insert

Concurrent Design enhancement

What is it?

You can now:

• Add a task description as an attribute in the task component.

• Save all the master model components, if you are the task owner.

Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Command Finder Concurrent Design Management

Strip Layout enhancement

What is it?

You can now add a description of the process that is performed on each station.
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To add a description, right-click a station name in the Strip Layout Navigator and choose Add
Process Description.

NX also displays the station number inside the circle of each station.

Why should I use it?

You can provide additional information about the process that is performed on any station.

Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Command Finder Strip Layout

Burring Insert Design enhancement

What is it?

You can now design:

• A punch and die to create non-circular burring holes in the product.

• A punch for burring holes without defining a blank.
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Why should I use it?

Non-circular burring holes are very common in electronic parts. Use this enhancement to generate
such burring holes.

Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Command Finder Burring Insert Design

Location in dialog
box

Burring Insert Design dialog box→Burring Insert group→Circular or
Non-circular

Burring Insert Design dialog box→Burring Insert group→Create without
blank

Universal Unform enhancements

What is it?

You can now define a Bend Allowance Formula (BAF) in a spreadsheet. NX uses the user defined
BAF to calculate the developed length of bend faces.
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Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Command Finder Universal Unform
Location in dialog
box

Universal Unform dialog box→Define Bend group→Developed Length
Calculation

Direct Unfolding enhancements

What is it?

You can now define a Bend Allowance Formula (BFA) in a spreadsheet. NX uses the user defined
BAF from the spreadsheet to calculate the developed length of bend faces.

Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Command Finder Direct Unfolding
Location in dialog
box

Direct Unfolding dialog box→Define Neutral Factor group→Developed
Length Calculation

Prebend enhancement

What is it?

When you create a prebend, NX now combines the two Extrude and Divide Face features into a
single Prebend feature in the Part Navigator.

Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Command Finder

Direct Unfolding

Bend Operation

Component Drawing enhancement

What is it?

You can now pass the selected part attributes to the Master Model drawing part.

Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard
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Command Finder Component Drawing

Create Box

Use this command to create a block or cylinder which envelopes the selected objects. This command
replaces the previous box feature based on Knowledge Fusion.

You should use this command when you want to create a block or a cylinder which envelopes the
contour with selected faces, edges, curves, points, solid bodies or facet bodies.

Where do I find it?

Application Mold Wizard, Progressive Die Wizard, and Electrode Design

Command Finder Create Box

Stock Size enhancements

What is it?

Stock Size is enhanced with a smart object in NX. It now allows being modified with six clearances
in six directions. It also provides an option to set zero a clearance value automatically if there are
extreme faces in selected body in the specified direction.
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Why should I use it?

You should use it when you want to calculate the stock (block or cylinder) size which envelopes the
contour with selected solid bodies.

Where do I find it?

Application Mold Wizard and Progressive Die Wizard

Command Finder Stock Size

Motion Simulation commands

What is it?

The Tooling Motion Simulation command is removed.

Use the following commands to set up the kinematic model, define the cam, define the lifter, define
user defined motion, and run the simulation.
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Motion Preprocess

Use this command to set and load the kinematic model, and mount the sheet metal or plastic parts
of the die or the mold on the kinematic model.

Why should I use it?
You can use this command to prepare your motion simulation data.

You can:

• Clone a predefined kinematic model for tooling into your current assembly or a directory
you specify.

• Change the kinematic model. NX displays a message window to confirm whether you want to
remove the current kinematic model and add another one. If you click Yes, you must mount
the components again and redefine the cams.

• Generate control data and import it to a kinematic model according to the die settings. You
can also change to different control data and re-read the control data.

Where do I find it?
Application Mold Wizard and Progressive Die Wizard

Command Finder Motion Preprocess

Define Cam

Use this command to create, edit, or delete a linear cam, a rotary cam, a rocker cam, a user-defined
cam, or cushion programming. You can select solid bodies, sheet bodies, or faceted bodies that have
solid or sheet bodies associated with it, and use them to define the cam.

Why should I use it?
A predefined kinematic model contains kinematic data about basic cam actions. You can use this
command to define the kinematic data for various types of cams. NX automatically calculates and
stores the cam data in the kinematic model.

Where do I find it?
Application Mold Wizard and Progressive Die Wizard

Command Finder Define Cam

Define Lifter

Use this command to create, edit, or delete a generic lifter or a lifter on a lifter. You can select
solid bodies, sheet bodies, or faceted bodies that have solid or sheet bodies associated with it, and
use them to define the lifter.

Why should I use it?
A predefined kinematic model contains kinematic data about basic lifter actions. You can use
this command to define the kinematic data for various types of lifter actions. NX automatically
calculates and stores the lifter data in the kinematic model.
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Where do I find it?
Application Progressive Die Wizard and Mold Wizard

Command Finder Define Lifter

User Defined Motion

Use this command to add user defined motion data to your kinematic model.

Why should I use it?
You can define:

• Linear movement along a specific vector.

• Angular movement about a specific axis.

The motion curve is a set of 360 values, one for each timing angle 0-359, that determines how far
to move along or about the axis at each point of the simulation. You can use the simple motion
curves created by NX, or supply your own values using a comma separated values (CSV) file.

Where do I find it?
Application Progressive Die Wizard

Command Finder User Defined Motion

Run Simulation

In Progressive Die Wizard, use this command to view an animation that shows the kinematics of
all the automatic and user-identified components in the model.

Why should I use it?
You can:

• View the die components and sheet metal parts within the model and check for collisions
and interference.

• Detect and analyze the collision at each angle of the simulation.

Where do I find it?
Application Mold Wizard and Progressive Die Wizard

Command Finder Run Simulation

Die Engineering

Using a new die surface in an existing stamping die workflow

This workflow shows how to use a new or modified die surface in an existing stamping die workflow.
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Addendum Section enhancements

What is it?

You can improve the quality of the addendum section by specifying a point on the intersecting curve.

NX uses the specified point as a reference point and displays a temporary point on the addendum
section. You can use this temporary point to verify the quality of the addendum section.

You can also measure the distance between the start point of the addendum section curve and the

trim point. To do this, use the new Measure Distance button on the General tab in the Section
Parameters dialog box.

Where do I find it?

Application Die Engineering and Engineering Die Wizard
Prerequisite You must be in the Modeling application.

Command Finder Addendum Section
Graphics window Right-click an addendum section feature→Edit Addendum Section
Location in dialog
box Section Parameters dialog box→General tab→Measure Distance
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Develop Trim Line enhancements

What is it?

You can generate the trim line profile using the FEM method that uses the One-Step solver.

When you use this command, you can also:

• Select sheet material either from the NX material library or local material library.

• Define density, thickness, Poisson’s ratio, Yield stress, and so on.

• Specify solver parameters such as convergence level, iteration steps, and so on to increase
the accuracy of the trim line profile.

Where do I find it?

Application Die Engineering and Engineering Die Wizard
Prerequisite You must be in the Modeling application.

Command Finder Develop Trim Line

Stamping Output enhancements

What is it?

You can update a die surface in OmniCAD or another CAD tool, import the surface into NX, and use it
in the next stamping operation without changing the existing stamping die workflow.

Use the new Stamping Output command to modify or create a stamping output feature that uses
the imported die surface. The stamping output feature includes the legacy surface and the new
die surface.

To use the new die surface in the next stamping operation, you must update existing dependent
features such as pierce and trim tasks that use the legacy die surface. Use the Process Update
Manager command to manage the existing pierce and trim tasks.

Why should I use it?

To meet manufacturing requirements, you can use an updated die surface from another CAD tool in an
existing stamping die workflow. This capability helps to reduce design time and increase productivity.

Where do I find it?

Application Die Engineering
Prerequisite You must be in the Modeling application.

Command Finder Stamping Output
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Process Update Manager

Use the Process Update Manager command to display and update existing pierce and trim tasks
after you modify the stamping output feature.

In a stamping die workflow, when you modify the stamping output feature using a new die face, you
must update the existing pierce and trim tasks that use the old die face.

When you use the Process Update Manager command, you can:

• Select the type of task that you want to update. Depending on the selected pierce or trim task
type, NX maps the existing tasks to the new die face and displays a list in the dialog box. The
list includes the name of the task, the stamping operation associated with the task, and the
status of the task.

• Update the existing tasks by selecting each task from the list. NX changes the status of the
updated tasks to Completed.

• View and compare the old and new die faces in the graphics window by setting the display
status of the die faces.

• View existing tasks for a single operation or all stamping operations.

Where do I find it?

Application Die Engineering
Prerequisite You must be in the Modeling application.

Command Finder Process Update Manager

Stamping Carryover enhancements

What is it?

You can copy a stamping output feature that includes existing and new die surfaces, from the
previous stamping operation to the current stamping operation.

This helps you to perform die engineering tasks on a new die surface and quickly complete the
new design workflow.

Where do I find it?

Application Die Engineering
Prerequisite You must be in the Modeling application.

Command Finder Stamping Carryover
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OmniCAD for NX

OmniCAD commands enhancements

What is it?

You can morph objects in the NX CAD environment using the following integrated OmniCAD
commands. When you use these commands, NX now creates features for each of these commands.

OmniFree
Transformer

Use this command to morph objects using points and curves as constraints.

OmniMesh
Transformer

Use this command to morph objects using CAE Meshes, STL files, or point
clouds.

To edit a feature, double-click it in the Part Navigator.

Where do I find it?

Application OmniCAD for NX

Prerequisite
To use OmniCAD commands, you must run the InstallSentinel.bat file
which is available in the ugii/omnicad directory.

Command Finder OmniFree Transformer , OmniMesh Transformer

Flow Blend (10.0.1)

Use the Flow Blend command to create constant or variable blends along complex faces.

You can:

• Blend complex faces that have a small curvature.

• Patch the blended faces to the original body.

• Smoothen variable blends.
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Where do I find it?

Application OmniCAD for NX

Prerequisite
To use OmniCAD commands, you must run the InstallSentinel.bat file
which is available in the ugii/omnicad directory.

Command Finder Flow Blend

Weld Assistant

Fillet Weld enhancements

What is it?

The Fillet Weld command has the following workflow and selection enhancements.

Workflow enhancements

When you create a fillet weld, you can now:

• Create a single weld that goes around an inside corner.
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You can also select the face of an existing fillet weld as a face in the face set.

• Create a continuous weld.

To do this, use the Roll Around option. Continuous welds let you complete the welding in a
single operation.

The example shows a continuous weld which bridges the corners and rolls from the top of a
plate to the side of the plate.

• Create non-associative fillet welds.

To do this, clear the Associative check box. When fillet welds are non-associative, NX does
not automatically update them when the WAVE linked geometry changes.

Selection enhancements

When you create a fillet weld, you can now:

7-32 What's new in NX

Chapter 7: Tooling Design



Tooling Design

• Let NX automatically select the edge sets of the bodies to be welded when a gap exists between
two face sets.

To do this, use the Extend Edges option. This option helps you to avoid errors in manual
selection.

• Specify the distance over which the fillet weld can continue if a small gap exists in the face.

To do this, use the Face Fill Gap option. This option helps you to eliminate the selection of
multiple edges or the creation of additional fillet welds.

Face Fill Gap = 2 Face Fill Gap = 3

To change the default distance value, use the Face Fill Gap Distance customer default.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click

Find Default .

Where do I find it?

Application Modeling

Command Finder Fillet Weld
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Location in dialog
box

Face Sets group:

Extended Edges

Construction Method→Roll Around

Settings group:

Face Fill Gap

Associative

Weld Point Wizard

What is it?

TheWeld Point Wizard replaces theWeld Point dialog box and provides additional functionality.

Moving weld points

You can move an existing weld point to a new location, and maintain its ID and attributes. To do
this, use the Select Reuse Features check box.

If the weld point reuse feature is not mapped as desired, you can also specify a weld point feature
from which you want to map. To do this, use the Select Mapping Feature option.

Creating single weld point features

You can create single weld point features without the weld feature set. To do this, use the Create
Single Features check box.
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Create Single Features =

Model History
Resistance Spot(6) “WLD1”
Resistance Spot(7) “WLD2”
Resistance Spot(8) “WLD3”

Create Single Features =

Model History
Linked Face (3)
Linked Face (4)
Resistance Spot(5)

Point Element (5) ”WLD1”
Point Element (5) ”WLD2”
Point Element (5) ”WLD3”

When you create weld point features, NX:

• Maintains connected part information for each weld through the connected part occurrences
instead of through the linked faces. This reduces the need to use the Connected Face Finder
command.

A weld point does not go into a retained state if the link to a parent face is broken.

• Displays weld point locations before you generate the weld points.

• Infers creating geometry of each weld point without a feature set.

Automatic updates and editing welds

You can automatically update weld locations by associating a weld point with its creation data. To do
this, use the Automatic Update check box.

You can also edit multiple welds regardless of how they were created.

Why should I use it?

When you use the wizard, you have greater flexibility when you create weld point features, and
better visual feedback of these features. You can also create multiple weld points simultaneously
without creating a feature set.

Where do I find it?

Application Modeling

Command Finder Weld Point Wizard

Solid Weld Point Display

Use the Solid Weld Point Display option to display a weld point as a solid or a point.
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Solid Weld Point Display turned on Solid Weld Point Display turned off

To change the shape and dimensions of the weld point display, use the Point Locator customer
defaults. You can also specify unique colors for two panel, three panel, and four panel welds.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Where do I find it?

Application Modeling

Command Finder Solid Weld Point Display

Converting legacy welds

Use the Convert Legacy Weld Points weld utility to convert pre-NX 10 weld point features to the
same style as the weld point features that are created by the Weld Point Wizard.

When you run the Convert Legacy Weld Points weld utility, NX:

• Converts single weld point features to an NX 10 single weld point feature. NX does not create
a grouping feature.

• Deletes the pre-NX 10 feature set and any hidden linked faces. NX creates a reference to the
connecting component to retain the connected part information.

• Maintains associativity of the mirrored and translated weld point features.

• Uses the Legacy Welds (pre NX10) customer defaults to set the size of the custom weld points
that are generated as solids, and maintains the color.

• Uses the Point Locator customer defaults for weld points that are generated without a solid.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .
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Note

You cannot use this utility to convert pre-NX 5 weld points. To convert the pre-NX 5 weld
points, you can do the following:

1. Export the locations of the weld points to a CSV file using the Export CSV command.

2. Import the same CSV file using the Import CSV command.

Where do I find it?

Application Modeling

Prerequisite
Set the Point Locator customer defaults similar to the Legacy Welds (pre
NX10) customer defaults.

Command Finder Weld Utilities
Location in dialog
box Convert Legacy Weld Points check box

Converting legacy welds (10.0.1)

When you run the Convert Legacy Weld Points weld utility, you can specify if you want to
simultaneously convert all or selected pre-NX 10 weld point features. To do this, use the All in
Work Part option or the Selected Only option.

Where do I find it?

Application Modeling

Prerequisite

Set the Point Locator customer defaults similar to the Legacy Welds (pre
NX10) customer defaults.

To select the Selection Scope options, you must select the Convert
check box.

Command Finder Weld Utilities

Location in dialog
box

Convert Legacy Weld Points group→Convert check box

Selection Scope subgroup→All in Work Part or Selected Only

Weld Advisor enhancements

What is it?

The Weld Advisor command provides additional functionality.

• If the faces required for a Weld Advisor check are not available, NX automatically finds the
faces needed for the check.

What's new in NX 7-37

Tooling Design



Chapter 7: Tooling Design

• NX displays different icons for faces based on whether Connected Face Finder is used to find
the faces or if existing faces are used in the Weld Advisor check.
Connected Face Finder faces used in Weld
Advisor check Existing faces used in Weld Advisor check

Connected Face Sets

Connected Face Set 1
Connected Face Set 2

Connected Face Sets
Connected Face Set 1
Connected Face Set 2

Why should I use it?

These enhancements help you to save design validation time.

Example

If you import weld points using the Import CSV command, you need not use the Connected
Face Finder command to find the faces required for the Weld Advisor check.

Where do I find it?

Application Modeling

Command Finder Weld Advisor

Joint Mark enhancements

What is it?

NX now provides the following functionality.

Selecting custom points

You can select from any of the following custom symbols to represent the joint mark.

Ellipse

Half circle

Line

In previous releases, you had to create custom symbols, and configure NX to display the custom
symbols in the Reuse Library.

Creating joint marks through translation

You can create joint marks by translating existing joint marks. To do this, use the Translate option.
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Moving joint marks

You can move an existing joint mark to a new location, and maintain its ID and attributes. To do this,
use the Select Reuse Feature option.
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If the joint mark reuse feature is not mapped as desired, you can specify a joint mark to map the
feature from when you move a joint mark. To do this, use the Select Mapping Feature option.
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Displaying the coordinate system

You can display the coordinate system when you create joint marks. To do this, use the Show
Coordinate System check box.

Show Coordinate System =
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Show Coordinate System =

Where do I find it?

Application Modeling

Command Finder Joint Mark

Location in dialog
box

Method step→Method group→Method list→Translate

Review/Edit step→Redefine Locations group→Select Reuse Features,
Select Mapping Feature

Settings step→Settings group→Show Coordinate System check box

Structure Welding

Skip welding joint

What is it?

When you use the Welding Joint command, you can now create welding joints that are split into
segments that have skips or spaces between them. These joints are called skip joints. You can
specify the length for the segments and the spacing distance between the segments.

Example

The example shows skip welding joints used to weld multiple plates. Each weld segment has a
length of 1500 mm, and is spaced at 1000 mm from the previous segment.
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Where do I find it?

Application Modeling

Command Finder Welding Joint
Location in dialog
box

Welding Joint→Create/Modify step→Split Joints group→Split joints
list→Skip

Inheriting welding characteristics

What is it?

You can specify whether a welding joint inherits welding characteristics from the parent welded
plate or pipe when you:

• Weld plates designed in Ship Design.

• Weld pipes designed in Routing.

You can also change the value of a selected characteristic. To do this, double-click the cell in the
Inherit column of the characteristic’s row, and update the value.

Where do I find it?

Application Modeling and Routing

Command Finder

(Modeling) Welding Joint

(Routing) Pipe Welding Joint
Location in dialog
box

Welding Joint or Pipe Welding Joint→Create/Modify step→Welding
Characteristics group
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Weld attributes in 4GD

When you create a weld design feature in 4GD, you can add custom attributes to the feature from
Teamcenter using Attribute Groups and Managed Attribute Groups.

To do this, you must set the following Welding Characteristics customer default:

HasAttributeGroup = TRUE

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

If you change weld attributes in Teamcenter, you must load the part fully to synchronize the changes
to the weld design feature.
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NX to JT

Support for assembly level color and translucency overrides in JT files

What is it?

When you export an NX assembly to a JT file, NX now exports the color and translucency overrides
applied on the components and bodies inside the component of an assembly to the assembly JT file.

When you view the assembly JT file in a JT viewer such as Teamcenter Visualization, you can see the
correct representation of an assembly in terms of color and translucency applied on the components
or bodies inside the components at the assembly level.

The following example shows the display difference between an assembly exported to a JT file
in versions earlier to NX 10 and from NX 10.
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Pre-NX10 NX10

Note

Color or translucency overrides applied on individual faces of bodies inside components
are not preserved in the assembly JT file.

Where do I find it?

Command Finder Export JT File
Command line Command line application ugtopv invoked with the –honour_structure option

8-2 What's new in NX

Chapter 8: Data translation



Data translation

Support for NX lightweight representation in JT files

What is it?

You can now export an NX lightweight representation, also known as a faceted representation, to a
JT file, as Level of Details (LODs) in the tessellated object. To do this, use the Use NX Lightweight
Representation option.

Why should I use it?

Because the NX to JT translator does not have to re-tesselate objects when you export lightweight
representations, processing time and memory requirements are improved.

Where do I find it?

Command Finder Export JT File
Location in the dialog
box

Export JT dialog box→Tessellation tab→Level of Details group→Use
NX Lightweight Representation

Support for ESKD standard entities in NX translators
What is it?

When you export data using the 2D Exchange Translator or the DXF/DWG translator, NX exports the
following ESKD data:

• ESKD symbols

• ESKD section lines

• Viewing direction reference arrows for projected views

• Dimensions with text above the stub style

• Limits and fits tolerance types

Where do I find it?

Command Finder

Export AutoCAD DXF/DWG File

Export 2D Exchange File

2D Exchange translator and AutoCAD DXF/DWG translator
enhancements
What is it?

When you use the 2D Exchange translator to export NX data to a 2D part file or use the AutoCAD
DXF/DWG translator to export data to the 2D format, the translator exports:
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• Wireframe edges with face colors.

• Pictorial and half-pictorial section lines.

• Newly added NX Drafting and GD&T symbols such as Independency, Continuous Feature,
Statistical, Orientation Constraint, Datum Translation, Fit Function, and Safety Compliance.

• Copyright, Registered Trademark, Farad and Centerline symbols added in NX using block font
characters.

The 2D Exchange translator also adds the following information about dimension translation to the
2D Exchange log file.

• Summary of dimensions available in input part.

• Summary of dimensions exported to the 2D part.

• Dimensions exported as grouped data.

The information about dimensions exported as grouped contains dimension type, measurement
values, the associated view of the dimension, the name of the drawing Sheet on which the
dimension exists, and the reason why the dimension is converted to grouped data.

Where do I find it?

Command Finder

Export 2D Exchange File

Export AutoCAD DXF/DWG File

Exporting center lines and center marks
AutoCAD DXF/DWG translator

When you export NX data that contains centerlines to DXF/DWG file, you can now create a
customized centerline font to match its display properties in NX. To do this, set the following keyword
in the settings file.

EXPORT_CENTERLINE_AS=CUSTOM

To get the exact display, you can also export the centerlines as block reference to DXF file. To do this,
set the following keyword in the settings file.

EXPORT_CENTERLINE_AS=BLOCK

You can use this option to export centerline as lines, arcs and/or splines with same display as that of
NX. A centerline font consists of a unique combination of dashes, gaps and long-dashes.

By default, the settings file does not contain this option. You must add this option to the settings file,
or else the translator exports the centerlines with the CENTER font to the DXF file

2D Exchange translator

You can now export linear 3D Centerline, linear PMI Centerline, and PMI Center Marks as real in the
2D part. The exported centerlines retain the properties such as display, dimension, and association.
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When you export drawings to the 2D part file, the translator exports:

• Linear 3D and PMI centerlines as 2D centerlines.

• PMI Center Marks as Center Marks in the 2D part.

Where do I find it?

Command Finder

Export AutoCAD DXF/DWG File

Export 2D Exchange File

Support for PMI data in NX translators

What is it?

When you export data using the 2D Exchange Translator or the DXF/DWG translator, NX exports
the following PMI and additional data:

• PMI annotations

• Specialized PMI

• Security markings

• Section views

Where do I find it?

Command Finder

Export AutoCAD DXF/DWG File

Export 2D Exchange File

Support for international characters in NX data translators

What is it?

NX supports international characters for the following entities:

• Names of files, objects, interface labels, and options in the settings file

• Attribute titles and values

• Messages in the log file

Note

Before you export data to CAD tools that do not support international characters, you must
replace non-English characters with English characters in the parts, and rename the parts
in NX.
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Support for multifield keys in NXJT and MCAD translators

What is it?

You can now export multifield key based NX items to other CAD formats. NX generates names for the
output and log files using multifield key values.

Multifield keys

Multifield keys are identifiers assigned to each object to ensure their uniqueness in the database. The
unique identifier is composed of a domain name and a combination of the object’s properties. For
example, the default multifield key for item business objects is Item{item_id}. For more information,
see Teamcenter Help.

8-6 What's new in NX

Chapter 8: Data translation



Chapter 9: System administration

Internationalization and Localization

Using local language in NX applications

What is it?

You can now enter part names, attributes, parameters, file names, design notes, and so on in all local
language in NX applications.
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Overriding geometry in 4GD

What is it?

4GD is enhanced in the following ways:

• The Assembly Cut, Promote, Define Deformable Part, and Deform Component commands
are now available.

• You can create an override part for a reuse design element or subordinate in the context of the
collaborative design.

You can use the Create Override Part command to create an empty override part. After you create
an override, you can choose the shape you want to edit in the Assembly Navigator.

Why should I use it?

Use these commands when you want to change the shape of an object in the context of the
collaborative design.

Where do I find it?

Command Finder

Assembly Cut

Promote

Define Deformable Part

Deform Component

Create Override Part

Sorting 4GD components in the Assembly Navigator

What is it?

You can now sort components in the Assembly Navigator if you are working in a 4GD environment.
In a workset, you can sort partitions, subsets, and design elements by alphabetical, alphanumerical,
and chronological order. You can also create a user-defined order for design elements and subsets.
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Why should I use it?

Sorting 4GD objects in the Assembly Navigator can make it easier to find and focus on the objects
of most interest. Being able to sort 4GD objects lets you:

• Find design elements (DE) more easily.

• Put the subset of most interest at the top of a list.

• Group related design elements together.

• Find new design elements in a subset.

Where do I find it?

Prerequisite You must be in a Teamcenter environment and have 4GD installed.
Command Finder Reorder Components
Menu Assemblies→Navigator Order→Edit Orders in Part

Mirror Assemblies Wizard
What is it?

If you are in a Teamcenter environment, you now use the business logic set up for your site when
you create new mirror parts using the Mirror Assembly Wizard (MAW). The MAW also supports
the new Teamcenter multi field key attributes.

The new items created in Teamcenter for any newly created mirror parts will be of the same type
as the source parts being mirrored. When you mirror a part or assembly, you create a new part or
assembly, not a new revision.

Note

You can no longer change the item type for mirrored parts with the Mirror Assembly Wizard.

Why should I use it?

You can rename all the new objects and their attributes, including Teamcenter multi field attributes, at
one time in a single mirroring process. You can see and validate all the attributes as you mirror them.

Where do I find it?

Prerequisite You must be in a Teamcenter environment.
Command Finder Mirror Assembly

Visual Reports
What is it?

There are three new out of the box visual reports for 4GD objects:
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• Design Model Element Has Higher Revision ID

Use this report to display the list of Design Model Elements (DE) with higher revision ID that
are currently loaded in your session.

• Design Model Element Source Item Revision Has Higher Revision

Use this report to display the list of Design Model Elements (DE) with higher revisions that
are currently loaded in your session.

• Compare Realized Objects in Two Subsets

Use this report to display the list of Design Model Elements (DE) that are currently loaded in your
session and the names of two loaded subsets for the reporting scope.

Where do I find it?

Prerequisite You must be in a Teamcenter environment and have 4GD installed.
Command Finder Start Visual Reporting

Resource bar HD3D Tools→Visual Reporting

Modifying a subset using a Teamcenter option set

What is it?

The Subset Navigator now includes the options that are listed in the active Teamcenter transfer
option set. The transfer option set contains global search options that are applied to the entire
subset search recipe. You can modify your subset search results by changing the status of one or
more of these options.

Why should I use it?

You can configure the search results of a recipe in different ways without modifying the contents
of your recipe.

Where do I find it?

Prerequisite
You must be in 4GD, in the subset task environment, and have an active
subset search recipe.

Resource bar Subset Navigator
Location in dialog
box Recipe group

What's new in NX 10-3

4th Generation Design (4GD)



Chapter 10: 4th Generation Design (4GD)

Weld attributes in 4GD
When you create a weld design feature in 4GD, you can add custom attributes to the feature from
Teamcenter using Attribute Groups and Managed Attribute Groups.

To do this, you must set the following Welding Characteristics customer default:

HasAttributeGroup = TRUE

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

If you change weld attributes in Teamcenter, you must load the part fully to synchronize the changes
to the weld design feature.
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System Navigator enhancements
The System Navigator is enhanced so that you can:

• Manually edit letter codes and index for logical models.

• Restore the index of logical nodes with the Reapply Naming Rule command.

Where do I find it?

Application Mechatronics Concept Designer

Resource bar System Navigator

Physics Navigator enhancements
The Physics Navigator is enhanced so that you can:

• Change the owner of physics objects between the top assembly and parts within the assembly.

• Find the owner component for an object that is selected in the physics navigator.

• Select an object in the physics navigator and make the owner component the work part.

In addition, collision bodies are now displayed as a child of the rigid body.

Where do I find it?

Application Mechatronics Concept Designer

Resource bar Physics Navigator

Exchange rigid bodies during simulations
Use the Object Transformer command to exchange rigid bodies during a simulation. Use this
with an Object Source to change rigid bodies in an assembly line. Trigger the exchange using
a Collision Sensor.

Where do I find it?

Application Mechatronics Concept Designer
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Command Finder Object Transformer

Collision Body enhancements
Use Collision Body enhancements to do the following:

• Set collision bodies to stick together during simulations.

• Create a cylinder collision shape to detect contact between geometry during simulations.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Collision Body

Collision Sensor enhancements
Use the Highlight on Collision check box to indicate when a collision sensor detects contact with a
rigid body having a matching collision category.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Collision Sensor

Joint motion restrictions
Apply motion limits directly to joints. You can specify linear or angular limits. Use this enhancement to
stop angular motion after less than or greater than one full rotation.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder

Hinge Joint

Sliding Joint
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Curve on Curve Joint
Use the Curve on Curve Joint command to create a joint for a rigid body that moves along guide
curves that have a single intersection. Use gravity to initiate motion. Use the curve on curve joint to
simulate objects rolling or sliding along a curve.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Curve on Curve Joint

Point on Curve Joint
Use the Point on Curve Joint command to create a joint between two bodies. The attachment
moves along the connected curve with the selected point being a reference that moves along the
curve. The axis begins at the point and the offset is the distance between the point and zero point.
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In this model, the orange bracket moves in a linear motion along the green line. A Point on Curve
Joint is used for joint 3 so that the dark green point traces the white curve as the orange bracket
moves along the green line. Joint 1 lets the point move vertically when necessary. Joint 2 lets
the point move horizontally when necessary.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Point on Curve Joint

Path constraint joint
Use the Path Constraint Joint command to restrict spatial motion of rigid bodies based on the desired
orientation and position. You can use this to simulate the movement of parts and robotic motions.

Where do I find it?

Application Mechatronics Concept Designer
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Command Finder Path Constraint Joint

Spring Damper
Use the Spring Damper command to apply a spring force to exert force or torque on a joint. Set the
relaxed position parameter to specify the position where the force is zero.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Spring Damper

Display Changer
Use the Display Changer command to change the display properties of a rigid body during a
simulation. Attach a display changer to a collision sensor to set the display property of the triggered
body, including color, translucency, and visibility.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Display Changer

View simulation enhancements
Simulations are enhanced so that you can:

• Set the time scale to speed up or slow down runtime simulations.

• Create snap shots of a simulation to be used as restart points. Use this so that you do not have
to view the simulation from the 00:00 time stamp.

• Increment simulations by operation, time based intervals or run simulations until a designated
operation.

• View the start time, the stop time and the current time of a simulation in the sequence editor.

Where do I find it?

Application Mechatronics Concept Designer
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Command Finder

Time Scale

Snap Shot

Forward One Step

Forward One Operation

Runtime Inspector enhancements
Use Runtime Inspector enhancements to do the following:

• Choose parameters that you want to graph during simulations.

• Export parameter graphical data as .csv files.

• Add objects to the runtime inspector view by right-clicking, and then from the list choosing Add to
Inspector.

• View and select the simulation restart times that you created using the Snap Shot command.
Use this so that you do not have to view simulations from the 00:00 time stamp.

Where do I find it?

Application Mechatronics Concept Designer

Resource bar Runtime Inspector

Cam Profile enhancements
Use the Cam Profile command to create motion relationships. The command is enhanced so that
you can:

• Select different transversal segments, including third order polynomials, fifth order polynomials,
sixth order polynomials, and modified acceleration sine, to connect motion segments in a cam
profile.

• Use the Optimize command to select a transversal segment based on velocity, acceleration, or
jerk characteristics.

• Edit transversal segment properties in the table view, including the transversal segment type,
slopes, curvature, jerk, lambda, and optimization type.

• Use the multiple cam profile table to add, edit, and delete cam profiles in a model.
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Cyclic and relative cyclic behavior

• Cyclic behavior runs the same motion profile multiple times. Use cyclic behavior when the slave
value is the same at the master axis minimum and maximum value. Motion segments are not
restricted by the master axis minimum and maximum value. You can wrap motion segments so
that part of the segment is applied at the beginning and part is applied at the end.

• Relative cyclic behavior runs the same motion profile multiple times. The slave value at the end of
the first cycle is the slave value at the start of the next cycle. Motion segments are not restricted
by the master axis minimum and maximum value. You can wrap motion segments so that part of
the segment is applied at the beginning and part is applied at the end.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Cam Profile

Transport Surface enhancements
Transport Surface is enhanced so that you can:

• Apply actuators to transport surfaces as you do for joints. Applying actuators lets you control
transport surfaces with operations and runtime expressions. Use the start position subgroup with
position actuators to set the initial position of a conveyor.

• Use transport surfaces with curved planar surfaces.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder

Speed Control

Position Control

Electronic Cam enhancements
Electronic Cam is enhanced so that you can:

• Use a runtime parameter to control the slave axis by setting the master to Signal.

• Minimize disturbances on the physical axis by setting the master axis to Virtual Axis.

• Select an existing Transport Surface as the slave axis.
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Where do I find it?

Application Mechatronics Concept Designer

Command Finder Electronic Cam

Operation enhancements
Use the Operation command to create time and event based changes. The command is enhanced
so that you can:

Export time based data

Use this to export timing and operations data including

• Step number

• Number of preceding operations

• Operation start time

• Duration of the operation

• Total time elapsed at the end of an operation

• Conditional objects and parameter names assigned to operations

Use new operator syntax

Use this to change runtime parameter values when a condition is met. Use the new operators to
do the following:

• += X : Use this to increment by the value X.

• —= X : Use this to decrement by the value X.

• *= X : Use this to multiply by X.

• ! : Use this to apply a boolean NOT.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Operation

ECAD integration enhancements
ECAD integration is enhanced so that you can:
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• Associate an ECAD project to a root logical.

• View an ECAD schematic.

• Export Device Lists with Page Macro information in native NX and Teamcenter Integration.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder

Import from ECAD

Export to ECAD

SCOUT integration enhancements
SCOUT integration is enhanced so that you can import and export to SCOUT 4.4 and SCOUT 4.5.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder

Export Cam Profile

Import Cam Profile

SIZER integration enhancements
SIZER integration is enhanced so that you can:

• Export data from linear or rotary actuators.

• Trigger the export of motor data with an operation or based on time.

• Import and export .csv or .mdix formats.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder

Export Motor Profile

Import Selected Motors
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Shared memory signal mapping enhancements
Use the SHM mapping command to read and write to local memory locations. Do this to
communicate with the SIMIT program. The command is enhanced so that you can:

• Select the SHM name from a list of names that are already saved in the part file.

• Set the update time unit as milliseconds, seconds, minutes or hours.

• Use automatic signal mapping by creating signals with the same data types, name and matching
IO types.

• Export the signal name, type, address and initial value as a SIMIT text files.

• Set Mechatronics Concept Designer as the master during co-simulations with SIMIT.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder SHM Signal Mapping

Tag Form and Tag Table

Tag Form

Use the Tag Form command to define properties for object source instances and rigid bodies. You
can change the property value or assign a different physics parameter during simulation.

Tag Table

Use the Tag Table command to create multiple instances of a tag form. Use the tag table to set
different values for each tag form instance. Use this to alternate tag form values or create parameter
sequences.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder

Tag Form

Tag Table
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Read-Write Device

Read-Write Device

Use the Read-Write Device command to assign values determined by tag forms and tag tables.
Trigger the device in read mode to retrieve tag values from the rigid body. Trigger the device in
write mode to assign a value to a rigid body.

Where do I find it?

Application Mechatronics Concept Designer

Command Finder Read-Write Device
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Line Designer application overview

What is it?

Use the Line Designer application to quickly design and visualize layouts of production lines in NX.
You can associate the production layout design to manufacturing planning using the unified Siemens
platform. This close integration lets you optimize the manufacturing process by specifying each
production step, down to individual manufacturing resources such as robots or fixtures.

Why should I use it?

Lay out the Production Concept
Line Designer is a complete production layout solution for manufacturing engineers. The
parametric engine in NX enables you to efficiently work manufacturing components and to easily
accommodate any changes. The fully classified equipment library is managed by Teamcenter, a
complete solution for data and process management. Using the unified platform, you can search,
view and retrieve components across a fully classified library, directly from NX.

An Integrated Solution
A unified platform for product, tool, and production system design supports your entire workflow -
from product and line design, and all the way to virtual commissioning. After creating a production
line design with Line Designer, you can validate the manufacturing process using Tecnomatix
Process Simulate. With Tecnomatix virtual commissioning solutions, you can correct PLC codes
in a virtual environment before using them on real equipment.

Visual Reporting and Documentation
With HD3D Visual Reporting, you can browse PLM data in an interactive navigator to view details.
Visual reports can be configured to display color-coded information about the manufacturing
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equipment, including component type, design changes, suppliers, investment cost and build
dates. Visual reports can also be managed and distributed, to benefit the entire enterprise.

Where do I find it?

Application Line Designer
Prerequisite Line Designer license
Command Finder Line Designer

Line Designer enhancements in NX 10.0.1
• Added support for Drag & Drop of resources from History Navigator and Teamcenter Navigator to

the graphics window.

• Improved mouse button menus.

o Removed commands that are not applicable in Line Designer 4GD.

o Removed low-use commands; rearranged order for frequent access; added high-use
commands.

o Streamlined Smart Component shortcut menus.

• Added new command for disconnecting connected components.

• Enhanced Show/Hide and reference sets so that their state is saved with the workset.

• For 4GD mode, added the Replace Source Part command to the Plant Navigator context menu
for resource instances. In BVR mode, the Replace Component command is applicable.

• Added an option in the connector definition for a robot that reverses the direction of propagation.
If the source connector has this option enabled, then dropping the robot onto the connector of an
existing instance of a riser causes the diameter from the robot to be propagated to the riser.

• Added Type and Effectivity columns to Plant Navigator. Note: In BVR mode, values in Plant
Navigator columns only appear if the column is enabled in the Assembly Navigator.

• Provided a script to install Line Designer template parts to Teamcenter.
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Fast placement coordinates pop-up (10.0.1)

What is it?

The Fast Placement capability in Line Designer has been enhanced:

• Added Z-coordinate to the coordinate pop-up.

• Added capability to edit X, Y, Z coordinate values in the coordinate pop-up.

Why should I use it?

You can use the coordinate display and editing capability to more precisely place components even
while in the Fast Placement mode.

Where do I find it?

Application Line Designer
Prerequisite Fast Placement mode must be enabled.

Disconnect Components (10.0.1)

What is it?

The Disconnect Components command removes a connection between components that was
created with the Connect Components command.

• If assembly constraints between the components exist, the assembly constraints are removed.

• Position and expression values of the components are not changed.

Why should I use it?

Disconnect components if you want to replace one of the components or change its location relative
to the other component.

Where do I find it?

Application Line Designer

Command Finder

Disconnect Components
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Drag and drop resources (10.0.1)

What is it?

In addition to adding resources to a layout from the Reuse Library, you can now drag and drop
resources from the History Navigator and Teamcenter Navigator to the graphics window to create
a new instance.

Why should I use it?

With this capability, you can take advantage of ready accessibility to existing resource instances
when adding similar instances.

Where do I find it?

Application Line Designer
Navigator Resource instances listed in the History Navigator and History Navigator.
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Python
What is it?

The Python programming language is added as a language binding for NX Open. This allows NX
users to record and replay NX workflows in the Python language. Advanced users can create or
extend NX Open Python journals to develop NX Open applications in Python. These applications can
use any of the features of the Python programming language including classes, looping constructs,
control statements, and callbacks. Python journals can be recorded and replayed on Windows,
Linux, and Mac.

Some of the features provided with NX Open Python include:

• Block Styler support with Python code generation of saved dialog boxes

• Same NX Open API as in the other supported languages

• Wrappers implemented in Python for the NX Open UF API

Why should I use it?

You can use the Python programming language for multi-platform journal recording and replaying
in NX.

Where do I find it?

Application NX Open
Command Finder Journal

SNAP
What is it?

Simple NX Application Programming (SNAP) is improved to provide additional capabilities when
writing SNAP programs. The major enhancements are:

• Topology functions – These new functions let you get detailed information about the topology of a
body (the way in which faces and edges are connected together). The topology functions help
you write programs that analyze the shape and structure of solid bodies. For example, you can
write programs to find holes, or fillets, or other types of features.

Also, there are new Shell, Loop, Fin, and Vertex SNAP objects, which extend the existing Body,
Face, and Edge topology objects. There is a suite of approximately 20 new enquiry functions that
let you find out how these various objects are connected together. For example, you can find all
the faces in a shell, all the fins meeting at a vertex, and so on.
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• Temporary display functions – These functions let you draw temporary objects in the NX graphics
window. You can draw markers, lines, circles, polylines, and text.

The temporary display functions let you provide graphical prompting or feedback to the users of
your programs, which often makes them easier to understand. The user can easily erase the
temporary objects after they have served their purpose.

• New documentation – The SNAP and NX Open for GRIP Users guide is added that describes
SNAP (and to a lesser extent, NX Open) from the point of view of a GRIP user. If you already
know GRIP, this guide enables you to easily find corresponding functions in SNAP and NX Open.

In addition, there are other enhancements including new functions to:

• Calculate points on a B-surface very quickly

• Create curves that replicate the shapes of edges

• Analyze the convexity across an edge

• Check whether a point lies inside a body or a face

• Convert between degrees and radians

• Access the NX Work View and other standard NX views

Why should I use it?

You can write programs that can provide additional functionality and features.

Where do I find it?

The SNAP and NX Open for GRIP Users guide is in the Programming Tools section of the NX Help.

Detailed descriptions of the new functions with examples are in the SNAP Reference Guide. The new
functions can be found in the following namespaces and classes:

• Topology objects and functions: new Snap.Topology namespace; additions to Snap.NX.Body,
Snap.NX.Face, and Snap.NX.Edge

• Temporary display functions: Snap.Draw class

• Fast calculation of points on a B-surface: Snap.Geom.Surface.Bsurface.Position

• Create curves from edges: Snap.NX.Edge.ToCurve

• Analyze edge convexity: Snap.NX.Edge.Convexity

• Point containment: Snap.NX.Body.ContainsPoint and Snap.NX.Face.ContainsPoint

• Convert between degrees and radians: Snap.Math class

• Work view: Snap.Globals.WorkView

• NX standard views: Snap.NX.View.Standard class
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UTF-8 character encoding

What is it?

NX now internally stores all character data in the UTF-8 character encoding. On Windows, the NX
user interface also supports UTF-8, which enables you to set your user interface to the language of
your choice. On Linux, the user interface is restricted to support characters that are in your locale
and also supported by the fonts in the Ugnx10 resource file. For additional information, see UTF-8
encoding supported.

NX Open also supports the use of UTF-8 character encoding and NX Open programs can send and
receive UTF-8 data. By default, NX Open supports handling data in the user’s locale. To convert your
program to send and receive all data as UTF-8, use the following function:

UF_TEXT_set_mode(UF_TEXT_ALL_UTF8)

When you use this function, ensure you have modified your program to properly handle UTF-8
data that is passed.

In addition, buffer lengths for most character buffers are modified to support the new NX buffer
lengths for UTF-8.

Why should I use it?

You can create programs using UTF-8 character encoding.

Where do I find it?

Application NX Open

GRIP supports internationalized characters

What is it?

GRIP now supports non-ASCII strings in addition to ASCII strings, which enables GRIP to support
internationalized characters. Mixed ASCII and non-ASCII strings are also supported.

Internationalized characters are applied in NX Open GRIP programs by using a source file with a
UTF-8 starting byte order mark (BOM), thereby enabling GRIP programs to use any character.
The BOM is a series of bytes at the beginning of a text file that specifies the encoding of the data
contained in the text file and a specific BOM signature marks the text file as containing UTF-8 data. If
this signature is not present, the file contains locale data.

Without the UTF-8 BOM file, GRIP programs can still use any characters in the user’s locale.
However, GRIP was not enhanced to the new character-based string lengths provided for UTF-8
functionality and GRIP programs still enforce byte-based limits on data. For example, string variables
are limited to 256 bytes.

The following functions are enhanced to enable GRIP programs to support internationalized
characters while still providing existing behavior when dealing with ASCII data.

CHRSTR – Supports any Unicode value for a string. ASCII values still return the ASCII character.
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LENF – Returns the length of a string in characters. There is no function to return the length
of a string in bytes.

SUBSTR – Expects the position to be based on the number of characters and the length to
extract to be based on a number of characters.

REPSTR – Uses a character count to find and search character strings, no matter how many
bytes are in a character.

Why should I use it?

You can create GRIP programs using internationalized characters.

Where do I find it?

Application NX Open GRIP

Block UI Styler

New properties for blocks

You can set additional properties for the following blocks:

Block Property name Description

Enumeration block EnableRecentOptions Displays recently used options at
the top of the drop-down list.

Angular Dimension block MinRadius Specifies the minimum radius of
the angular dimension handle
that NX allows on screen.

NX sets the default value of
the m_minRadius attribute of the
angular dimension interpreter
object to 1.05. The MinRadius
property lets you override the
default value.
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Explorer block TreeWidth Specifies the width of the
navigation tree.

Changing a displayed part

You can use the Block UI Styler to create a dialog box which lets you change the displayed part. After
you perform other operations in the new displayed part, you can return to the original displayed part.

You can choose one of many NX Open APIs to change the displayed part. Some of these APIs may
delete undo marks that are set by dialog framework.

Example

The PartCollection::SetDisplay API deletes the undo marks set by dialog framework but the
UF_PART_set_display_part API does not delete the undo marks.

NX supports changing the displayed part through the following APIs:

• An API which does not delete undo marks in the Update, OK, and Apply callbacks.

• An API which deletes undo marks in the OK and Apply callbacks.

If you use an API which deletes undo marks in an Update callback, you must revert to the original
displayed part within the same callback. You can change the displayed part in the Update callback,
and perform operations in the new displayed part within the same callback. If the displayed part is
different after an Update callback execution, NX reverts to the original displayed part and closes the
dialog box. NX displays the following message before closing the dialog box.

The displayed part was changed and the dialog’s undo mark was erased. When the undo mark is erased, a change of displayed part is allowed only within an OK or Apply callback. NX has changed the displayed part back to the original and will close (cancel) the dialog.

If an API deletes the undo mark, NX cannot roll back to the undo mark set when the dialog box was
invoked. NX cancels the dialog box and displays the following message:

When a dialog is cancelled, NX normally rolls back to the undo mark that was set when the dialog was invoked. The undo mark set for this dialog was erased when the displayed part was changed, so a rollback to revert any actions performed on the dialog could not occur.

If you change the displayed part or perform any similar operation which deletes undo marks created
by the dialog framework, what NX does depends on whether you use the Cancel or OK button to
close the dialog box:
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• If you use the Cancel button, NX cannot perform undo as the necessary undo mark is not
available in NX.

• If you use the OK button, NX deletes all undo marks and you cannot undo operations with
the Undo button.

Operation performed
or conditions

Result when a secondary dialog
box is displayed after a primary
dialog box operation

Result when only the primary
dialog box is displayed

A secondary dialog box is displayed
after the displayed part is changed
through a callback in the primary
dialog box. NX deletes all undo marks
when the original displayed part is
changed.

The primary dialog box remains open
when displayed part is changed. NX
deletes all undo marks from when the
original displayed part is changed.

Cancel clicked
immediately after
changing the displayed
part

When you click Cancel in the
secondary dialog box immediately
after changing the displayed part, NX
does the following:

• Closes the secondary dialog box.

• Retains your original displayed
part. No undo is performed for
actions in the original displayed
part.

When you click Cancel in the dialog
box immediately after changing the
displayed part, NX does the following:

• Closes the primary dialog box.

• Retains both, the original and the
new, displayed parts. No undo
is performed for actions in both
displayed parts.

Cancel clicked in
the dialog box after
performing operations

When you click Cancel in the
secondary dialog box after performing
operations in the new displayed part
that create new objects, or session
updates, NX does the following:

• Closes the secondary dialog box.

• Applies Undo for operations
performed in the new displayed
part.

When you click Cancel in the dialog
box after performing operations in the
new displayed part that create new
objects, or session updates, NX does
the following:

• Closes the dialog box.

• Does not apply Undo for
operations performed in the
original or new displayed part.

OK clicked in the dialog
box

When you click OK in the secondary
dialog box, NX does the following:

• Closes the secondary dialog box.

• Displays the primary dialog box.

When you click OK in the dialog box,
NX does the following:

• Closes the dialog box.

Apply clicked in the
dialog box

When you click Apply in the
secondary dialog box, NX commits
the actions performed and relaunches
the dialog box.

When you click Apply, NX commits
the actions performed and relaunches
the dialog box.
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Selection blocks in
dialog box

If your primary dialog box contains
selection blocks, when you open the
dialog box with the original displayed
part, the selection blocks display the
same selection count as before.

If your dialog box contains selection
blocks, the selection blocks display
the selection count from the original
displayed part, even if the selected
objects are not available in the new
displayed part. NX highlights objects
selected through the selection blocks
when the original displayed part is
restored.

Note

The dialog framework does not support the usage of APIs that change the displayed part and
delete undo marks in the OK and Apply callbacks.
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Browse all 10.0.1 enhancements
Modeling
> Edge Blend Enhancements
(10.0.1)

Manufacturing General
> IPW rendering improvements
(10.0.1)
> IPW tolerances moved into the
part (10.0.1)
> Generating the IPW with the
operation (10.0.1)

Manufacturing Milling
> Cavity Mill Cutting Parameters
(10.0.1)
> Flowcut Region Management
(10.0.1)
> Corner smoothing for Z-level
non-steep cut patterns (10.0.1)
> Adding center passes in
Flowcut operations (10.0.1)
> Using Steep Overlap and
Follow Periphery in Flowcut
operations (10.0.1)
> Boundary projection for Area
Milling (10.0.1)
> Minimum cut length for Area
Milling (10.0.1)
> Cut region overlap in Area
Milling (10.0.1)
> Divide a cut region using a line
(10.0.1)
> Creating gouge free traverse
moves in Zlevel operations
(10.0.1)
> Create smooth noncutting
motions in Zlevel operations
(10.0.1)
> Tilt Tool Axis enhancements
(10.0.1)
> Completely machine both sides
of a blade without edge rolling
(10.0.1)

Manufacturing Postprocessing
> Post Configurator (10.0.1)

Manufacturing Feature Based
Machining
> Feature recognition for coaxial
interrupted holes (10.0.1)
> Feature recognition
enhancements (10.0.1)

Advanced Simulation
> Solver version support (10.0.1)
> Abaqus axisymmetric contact
analysis (10.0.1)
> ANSYS axisymmetric contact
analysis (10.0.1)
> Constraint equation support
in Abaqus and ANSYS thermal
solutions (10.0.1)
> CGNS results file options
(10.0.1)
> Inflated laminates in LS-DYNA
(10.0.1)

CMM Inspection Programming
> MCOSMOS postprocessor
(10.0.1)
> CMM general enhancements
(10.0.1)

Weld Assistant
> Converting legacy welds
(10.0.1)

OmniCAD
> Flow Blend (10.0.1)

Data translation
> Exporting crosshatching as
grouped geometry (10.0.1)
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Manufacturing Hole Machining
> Radial Groove Milling (10.0.1)
> Drilling interrupted holes
(10.0.1)
> Controlling the width for zig and
zig zag hole patterns (10.0.1)
> Reduce transition motions
and machining time for drilling
programs (10.0.1)
> Controlling non cutting moves
for an optimized program group
(10.0.1)
> Tracking points for chamfering
tools (10.0.1)
> Controlling retract moves for
canned drilling cycles (10.0.1)
> Feature group enhancements
(10.0.1)
> Feature recognition
enhancements (10.0.1)
> Allowed violations of part
geometry (10.0.1)

Manufacturing ISV
> Axis dynamic capabilities in the
Machine Tool Navigator (10.0.1)
> Channels settings moved
(10.0.1)
> Toolpath verification and
analysis consolidation (10.0.1)

Line Designer
> Line Designer enhancements in
NX 10.0.1
> Fast placement coordinates
pop-up (10.0.1)
> Disconnect Components
(10.0.1)
> Drag and drop resources
(10.0.1)

Edge Blend enhancement (10.0.1)
When creating an Edge Blend with variable radius points, you can now specify that the radius
function has zero slope at each end of the blended edge chain.
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Zero Slope Radius Function at Chain Ends

Zero Slope Radius Function at Chain Ends

Where do I find it?

Application Modeling

Command Finder Edge Blend
Location in dialog
box Settings→Zero Slope Radius Function at Chain Ends

IPW rendering improvements (10.0.1)

What is it?

Needle count defaults for rendering the IPW are higher counts than in earlier releases. This is
now practical due to increased performance in NX and much more capable computers than were
available when the defaults were created.

Needle Count Option Previous versions NX 9.0.3, NX 10.0.1 and later
Coarse 200 350
Medium 350 500
Fine 500 1000
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Menu Menu→Preferences→Manufacturing
Location in dialog
box Geometry tab→In Process Workpiece Tolerances

IPW tolerances moved into the part (10.0.1)

What is it?

When you have a part that requires IPW settings that are different from those set by the IPW
Tolerances group in the customer defaults, Chordal Tolerance, Tolerance Mode, Needle Distance,
and Needle Count, you can now override the defaults in the Manufacturing Preferences dialog
box. These settings are saved with your part.

The customer defaults now serve only to establish default tolerance values for the Manufacturing
Preferences dialog box.

Why should I use it?

Part-specific preferences are useful when you have parts that require special settings, for example a
few large parts that require a higher needle count than your other parts.

You can change the IPW tolerances and see the effect without having to restart your NX session.

You can create template parts that have specific settings for the various types of parts with which
you deal regularly.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Menu Menu→Preferences→Manufacturing
Location in dialog
box Geometry tab→In Process Workpiece Tolerances

Generating the IPW with the operation (10.0.1)

What is it?

A new customer default, Generate IPW with Path, lets you generate the in-process workpiece (IPW)
as you generate an operation. NX saves the IPW with the operation.
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Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Why should I use it?

Saving the IPW with the operation saves time when you do the following:

• Use the Verify Tool Path→3D Dynamic method.

• Select the Show Thickness by Color option or the Workpiece→Show 3D option.

• Generate operations that use the previous IPW.

You can:

• Visually inspect the operation result as soon as it is generated.

• Immediately verify the tool path to check for collisions with the IPW.

Where do I find it?

Initial release NX 9.0.3 MP2
Application Manufacturing

Customer Defaults Search for Generate IPW with Path

Cavity Mill Cutting Parameters (10.0.1)

What is it?

When you create a tool path that uses the Follow Periphery cut pattern, the Legacy options in the
More tab in the Cutting Parameters dialog box are no longer available when you set the Pattern
Direction to Automatic.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Location in dialog
box

Cutting Parameters dialog box→Strategy tab→Pattern Direction list→
Automatic
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Flowcut Region Management (10.0.1)

What is it?

In a Flowcut operation, you can create, visualize, edit, and save cut regions without generating the
tool path. Cut Region options will be available in the Flow Cut geometry group.

You Can:

• Generate the tool path based on the saved cut regions within the operation.

• View the regions graphically.

• Import inactive regions from previous sessions into the current session.

When changes are made to the parameters of a region, NX displays a message and marks the region
with an Invalid icon in the region list until the operation is regenerated.

Why should I use it?

Because you can edit cut regions before you generate the operation, overall processing time can
be reduced.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Flowcut Operation
Location in dialog
box Flow Cut Operation dialog box
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Corner smoothing for Z-level non-steep cut patterns (10.0.1)

What is it?

You can smooth corners in Flow Cut operations with Zig, ZigZag, or ZigZag with Lifts patterns for
non-steep regions. To do this, you:

1. Set steep regions to Zlevel.

2. Set the Smoothing cutting parameter to All Passes.

3. Specify a radius size to be applied to the corners.

4. Generate the operation.

Corner Smoothing Corner Smoothing

Why should I use it?

When you machine hard material, or machine at high speeds, consider adding fillets to all corners.
Corner fillets can do the following:

• Prevent a sudden change in direction and cutter deflection which can cause excessive stress on
the machine tool and cutter.

• Aid in tool path generation for Nurbs output because smooth transitions are easier to blend into
Nurbs than sharp corners.

The Smoothing option gives you better control of tool path output for finishing operations and
improves machining efficiency.

Where do I find it?

Initial release NX 9.0.3 MP2
Application Manufacturing
Location in dialog
box

Flowcut Reference Tool operation→Cutting Parameters→Corners
tab→Path Shape in Corners group→Smoothing→All Passes
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Adding center passes in Flowcut operations (10.0.1)

What is it?

When you machine corners in Flow Cut operations, you can reduce or remove scallops. To do this,
use the Add Center Passes option. This option creates a center pass in the region when space
between offset passes produces a larger than desired gap that results in a scallop.

Add Center Passes Add Center Passes Added paths highlighted.

Why should I use it?

This option helps you to improve surface finish when you machine corners.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Flowcut Operation
Location in dialog
box

Flow Cut Drive Method dialog box→Non-steep Cutting and Steep
Cutting groups

Using Steep Overlap and Follow Periphery in Flowcut operations
(10.0.1)

What is it?

You can overlap the cutting motions between steep and non-steep regions in Flow Cut operations.
Use the Steep Overlap option to specify the distance or a percentage of the tool diameter overlap.
Additionally, you can use a Follow Periphery pattern for both steep and nonsteep regions.
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No Steep Overlap Steep Overlap set at 0.100”

Why should I use it?

When you overlap the cut motions, you can sometimes achieve a smoother finish.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Prerequisite
Flowcut operation using a Zlevel steep pattern with a Follow Periphery
non-steep pattern.

Location in dialog
box Flow Cut Drive Method dialog box→Steep Cutting group

Boundary projection for Area Milling (10.0.1)
As you define or edit a boundary with the Tool Position option set to Contact, the outer boundary of
the contact position is dynamically calculated and shown on all surfaces through the part.

The following images show arbitrary curves used to define a boundary that contains the cutter within
a small area of the part.

The boundary curves contain the toolpath in the
area shown.
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When the Trim Boundaries dialog box is open,
and the Tool Position option is set to contact,
NX displays the tool contact boundary on all part
surfaces. The boundary that is displayed on the
surface that is being cut shows you the actual cut
area.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Prerequisites

Operations must use the Area Milling drive method.

In geometry groups, the Geometry Subtype option must be set to
MILL_AREA.

In the Trim Boundaries dialog box, in the Boundaries group, the Tool
Position option must be set to Contact.

Minimum cut length for Area Milling (10.0.1)

What is it?

In Area Milling operations, you can now specify a minimum cut length for the steep Zlevel pattern.

Minimum cut length: 0.000” Minimum cut length: 2.300”

Use the Minimum Cut Length option to determine which toolpaths to keep in the current operation.
NX removes tool path cutting motions that are smaller than your specified minimum cut length, and
cuts the Zlevel pattern with no holes or gaps.
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Area Milling operation
Location in dialog
box

Area Milling Drive Method dialog box→Drive Settings group→Steep
Cutting

Cut region overlap in Area Milling (10.0.1)

What is it?

You can overlap the cutting motions between steep and non-steep regions in Area Milling operations.
Use the Overlap Steep and Non-Steep Regions option to specify the distance by which the
regions overlap.

Zero overlap applied A .050” overlap applied

In the example shown, a .050” overlap has been applied. The .050” distance is divided by 2 and the
regions are extended towards each other by .025” while following the part geometry.

Why should I use it?

When you overlap the cut regions, you can sometimes achieve a smoother finish.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Area Milling operation
Location in dialog
box

Area Milling Drive Method dialog box →Steep Containment group
→Overlap Steep and Non-steep Regions
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Divide a cut region using a line (10.0.1)
What is it?

In Area Milling operations, you can divide a cut region using a line with additional options. Use the
Divide by Line option to create and control the placement of the line. You can:

• Create points that NX uses to create the line.

• Project the line on to the part.

• Preview the division. If the regions are not what you expect, you can change the line.

After you create the line, NX can create a plane that slices through the line and divides the cut region.

To specify how you want the plane to be oriented, use one of the following Divide Plane options:

Tool Axis

Use this option to project
the plane is projected
through the current tool
axis.

Normal to Tool Axis

Use this option to project
the plane perpendicular
to the tool axis.

Dynamic

Use this option if you
want to project the plane
using an angle that you
specify. You can either
enter a value or drag the
angel handle. The angle
is referenced from the
tool axis.

The cut region before any divisions. The cut region after using the
Tool Axis Divide Plane option.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
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Prerequisite Area Milling operation
Location in dialog
box [Area Milling operation] Cut Regions dialog box

Creating gouge free traverse moves in Zlevel operations (10.0.1)

What is it?

In Zlevel operations, for traverse moves, you can now avoid potential collisions between the cutter
and the part or IPW. To do this, you set a safe clearance value and then apply it.

• To set the value, use the Safe Clearance Distance option.
• To apply the value, use the Apply Safety Clearance to Direct option.

If you do not set a Safe Clearance Distance value, NX notifies you that a potential collision could
occur.

Apply Safety Clearance to Direct Apply Safety Clearance to Direct

A 0.300” distance is used.

Option name change

In the Non Cutting Moves dialog box, on the Transfer/Rapid tab, on the Transfer Type list, the
Lowest Safe Z option is now named Direct / Previous Plane Backup.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Zlevel operation
Location in dialog
box

[Zlevel operation]→Path Settings→Non Cutting Moves→Transfer/Rapid
tab→Between Regions and Within Regions groups
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Create smooth noncutting motions in Zlevel operations (10.0.1)

What is it?

You can override the engage, retract, and stepover motions within a region for Zlevel operations. To
do this, use the Override with Smooth Connections option on the Smoothing tab. NX outputs a
smooth continuous motion along a spline that is generated between cutting motions. You can specify
the following parameters on the Smoothing tab:

• The length and height of the smooth engage and retract motions

• Maximum stepover and part safe clearance

• The distance of the smoothing region

• The tolerance

Override with
Smooth Connections

Override with
Smooth Connections

When machining electrodes for example, NX will apply safe clearances to Negative Part Stock values
for traverse moves. NX also creates consistent, smooth stepover lifts off the part for each pass. If a
smooth engage is not possible, NX notifies you and uses a plunge motion instead.

If you are not satisfied with the automatic start point of the tool path, you can specify the start point for
the region on the Start/Drill Points tab.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Zlevel operation
Location in dialog
box Non Cutting Moves dialog box→Smoothing and Start/Drill Points tabs
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Tilt Tool Axis enhancements (10.0.1)

What is it?

There are new usability enhancements that keep the latest tool axis settings stored in the following
cases:

• If you generate a tool path using the OK command, and then stop it.

• If you generate a tool path and then use the UNDO command.

The Tilt Tool Axis dialog box now groups the options logically on the Tilting, Clearance, and
Machine Tool Characteristic tabs.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Command Finder Tilt Tool Axis

Completely machine both sides of a blade without edge rolling
(10.0.1)
In multi blade operations, the Blade Edge option controls where the path stops following the blade
geometry, and begins extensions that are not driven by the blade shape. You can now use the new
No Curling edge trimming option to prevent the cutter from curling over the blade edges. This is
helpful in the following cases:

• For blades with sharp corners at the trailing edge, the path follows the pressure and compression
sides, and extends tangentially without any curling around the sharp corners.

• For blades that are highly curved around the part axis, NX prevents fast changes in the path
direction as the path moves from the pressure side to the leading edge.

• For operations with the cut levels depth mode set to Offsets from Hub, when a cut level reaches
the shroud height, NX extends the path beyond the top edge of the blade without curling around
the blade.

For roughing and hub finish operations, NX automatically adds a small tangential extension so that all
passes of a cut level extend the same distance from the rotary axis.

For all operations, you can also enter an Extension value to extend the path tangentially. NX adds
any user specified extension after the automatic extension.
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The following examples show how the No Curling option automatically controls the tool path at the
leading and trailing blade edges. The stepovers are exaggerated to show detail.

Blade Edge = Along Blade
Direction

Blade Edge = Along Part
Axis

Blade Edge = No Curling
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Multi Blade operation

Location in dialog
box

[Multi blade operation] dialog box→Drive Method group→edit drive method

Blade rough, hub finish operations:

Multi Blade Rough Drive Method or Hub Finish Drive Method dialog
box→Leading Edge group

Blade finish operations:

Blade Finish Drive Method dialog box→Cut Periphery
group→Leading Edge subgroup

Blend finish operations:

Blend Finish Drive Method dialog box→Cut Periphery
group→Trailing Edge subgroup

Radial Groove Milling (10.0.1)

The Radial Groove Milling operation combines groove milling and hole milling to machine a
sequence of circular grooves with a T-cutter. The operation cuts in a circular pattern with multiple
radial and axial passes.

Your workflow can include multiple operations. Create a roughing operation that leaves stock on the
floor, ceiling, and side, and then remove the remaining material in a subsequent finishing operation.

You can manually select the groove geometry from within the operation, or use previously recognized
groove features within a feature group. NX updates the tool path when you regenerate if there are:

• Dimensional changes
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• Sequence changes

You can add grooves to the sequence or remove grooves from the sequence.

The Radial Groove Milling operation uses the same level sequencing options that are available
in Groove Milling. For Radial Groove Milling operations, the ceiling is the face closest to the
direction that the tool approaches from.

Ceiling to Floor Floor to Ceiling

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite T-cutter tool, enclosed groove

Command Finder Create Operation

Location in dialog
box

Create Operation dialog box→Type list→hole_making→Operation

Subtype group→Radial Groove Milling
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Drilling interrupted holes (10.0.1)

Use the Sequential Drilling operation to drill a sequence of coaxial holes.

You can:

• Create a feature group geometry parent first, or specify the geometry from within the operation.

• Set the cycle tracking point.

• Drill with or without chip break.

For the chip break cycle, you can also specify a clearance and retract for each hole segment.

• Slow the feed rate when the tool enters material, and again when the tool breaks through
material. Use the First Cut and Last Cut options to specify the distance and feed rates for
entering (1) and leaving (2) material.
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Interrupted hole features

For a Sequential Drilling operation, the Motion Output option is set to Interrupted Moves. This
tells NX to ignore empty spaces when it creates the feature geometry.

Hole feature

Motion Output = Machine Cycle

Hole feature

Motion Output = Interrupted Moves

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Command Finder Create Operation

Location in dialog
box

Create Operation dialog box→Type list→hole_making→Operation

Subtype group→Sequential Drilling

Controlling the width for zig and zig zag hole patterns (10.0.1)
When you optimize a machining sequence, the default tolerance that NX uses for zig and zig zag hole
patterns can create additional passes when the holes are not aligned. Use the Band Width option
to specify a width that is large enough to include nearby holes in each pass. NX applies half of the
specified value to both sides of the pass center line.
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Band Width = 1 mm (default value)

Band Width = 40 mm

The first hole in each pass determines the center line for the pass. NX calculates the band width from
this center line, and the band width determines which holes to include in the pass. If you reverse the
machining order, a hole that was previously included in the pass could be excluded. NX machines
only those holes whose center lines fall within the band width.

In this example, the center lines of holes 2 and 3 are within the band width for the pass. NX includes
holes 1, 2, and 3 in the pass.

When the order is reversed, the center line of hole 2 is not within the band width for the pass. NX
includes only holes 1 and 3 in the pass.
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Note

You must enter the Band Width value each time you optimize the sequence.

The options in the Sequence group in the Hole or Boss Geometry and Feature Geometry
dialog boxes always display the default settings. The sequencing options are actions that NX
executes when you click Reorder List. NX saves the resulting sequence without saving
the settings.
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Where do I find it?

Initial release NX 9.0.3 MP2
Application Manufacturing

Prerequisite
Hole machining sequence with the Optimization option set to Primary
Direction.

Location in dialog
box

Hole or Boss Geometry or Feature Geometry dialog box→Sequence
group→Band Width

Reduce transition motions and machining time for drilling programs
(10.0.1)
You can now optimize drilling operations across multiple features and workpieces to minimize
transition motions and machining time within a program.

• Reorder operations to minimize tool changes.

• Create optimization groups for further optimization and verification.

• Apply operation level sequencing at the optimized group level.

• Generate and verify tool paths at the optimized group level. The Optimize NC dialog box
includes the standard operation tool path actions.

Before optimizing

Operation Navigator, Geometry view

WORKPIECE
FG_STEP1HOLE

SPOT_DRILLING
DRILLING_UP
DRILLING_FINISH

FG_STEP1HOLE_STEP1POCKET
SPOT_DRILLING_2
DRILLING_UP_2

Operation Navigator, Program Order view

PROGRAM
SPOT_DRILL Contains two

operations
SPOT_DRILLING
SPOT_DRILLING_2

DRILL
DRILLING_UP
DRILLING_FINISH
DRILLING_UP_2

What's new in NX 14-23

Browse 10.0.1 enhancements



Chapter 14: Browse 10.0.1 enhancements

After optimizing

Operation Navigator, Geometry view

WORKPIECE
FG_STEP1HOLE

SPOT_DRILLING
DRILLING_UP
DRILLING_FINISH

FG_STEP1HOLE_STEP1POCKET
SPOT_DRILLING_2
DRILLING_UP_2

Operation Navigator, Program Order view

PROGRAM
SPOT_DRILL

OPTIMIZED_NC
SPOT_DRILLING
SPOT_DRILLING_2

DRILL
DRILLING_UP
DRILLING_FINISH
DRILLING_UP_2
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Operation Navigator Right-click the program→Object→Optimize

Controlling non cutting moves for an optimized program group
(10.0.1)
When you optimize multiple drilling operations at the program level, NX creates an optimized program
group, OPTIMIZED_NC. You can now specify non cutting moves for this program group, and these
moves override the non cutting moves defined in the individual operations.

By default, NX uses the non cutting moves defined in the first operation for the optimized program
group. You can use the default settings, or change the non cutting move settings for this program
group.

Operation Navigator, Program Order view

PROGRAM
SPOT_DRILL

OPTIMIZED_NC
SPOT_DRILLING
SPOT_DRILLING_2

DRILL
DRILLING_UP
DRILLING_FINISH
DRILLING_UP_2

Where do I find it?

Initial release NX 10.0.1
Application Manufacturing
Operation Navigator Right-click the program→Object→Optimize
Location in dialog
box Optimize NC dialog box→Non Cutting Moves

Tracking points for chamfering tools (10.0.1)
A tracking point is the internal reference point on the tool that NX uses to calculate tool paths.

Chamfer milling tools have two system-defined tracking points at the center line and three
system-defined tracking points at the shoulder.
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Spot drills and countersinking tools have an added tracking point in the middle of the chamfer.

You can also define additional tracking points anywhere on the tool to use in your operation.
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Chamfer milling tool
Location in dialog
box

Chamfer milling tool dialog box→More tab→Tracking group→Tracking
Points→Tracking Points dialog box

Controlling retract moves for canned drilling cycles (10.0.1)
You can choose how NX outputs the retract moves for the canned cycles in a drilling operation.
To do this, use the Retract Output Mode option. Select the setting that matches the output to
your controller requirements.

• Clearance Only outputs the retract level as part of the canned cycle only when the retract
level is equal to the clearance level. In all other cases, NX turns off the cycle and generates an
explicit move to the calculated retract point.

• Clearance Initial outputs the retract level as part of the canned cycle when the retract level is
equal to the clearance level or equal to the initial level.

• Always outputs the retract level as part of the canned cycle for postprocessors that can handle
this input. The cycle includes the final retract.

When the tool reaches the bottom of a hole, NX returns the tool to one of the following positions:

1. The initial level, which is the G98 position.

The initial level is defined as the last Z position before NX begins the cycle.

2. The defined R-plane, which is the G99 position.
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The R-plane is the plane at which the drilling operation begins. NX defines the R-plane and the
clearance plane relative to the cycle level. For a constant clearance, if the cycle level changes,
so does the R-plane.

Note

The initial level does not change when drilling in G99 mode.

3. A Z value on or above the R-plane that is based on the noncutting moves settings.

The following examples show how the Retract Output Mode option affects the tool paths when using
the Lowest Safe Z, Clearance – Tool Axis, and Direct options for transferring between holes. The
holes are machined from left to right, omitting holes 7, 8, 15, and 16.

• Yellow = Departure

• Blue = Approach

• Green = Explicit traverse outside of the cycle

• Red = Implicit traverse within the cycle

Lowest Safe Z

For the Lowest Safe Z examples, at the 6th hole, the retract level is below the clearance level, and
also below the initial level. At the 14th hole, the retract level is below the clearance level, but at
the initial level.

For the Clearance Only option, NX outputs a CYCLE/OFF statement at the 6th, 14th, and final holes.

Clearance Only, 3 cycles

For the Clearance Initial option, NX outputs a CYCLE/OFF statement at the 6th and final holes.
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Clearance Initial, 2 cycles

For the Always option, NX outputs a CYCLE/OFF statement at the final hole.

Always, 1 cycle

Clearance – Tool Axis

For these examples, the clearance is to the bounding box.

Clearance Only, 14 cycles

Clearance Initial, 2 cycles
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Always, 1cycle

Direct

Clearance Only, 7 cycles

Clearance Initial, 2 cycles

Always, 1 cycle
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Operation Type = hole_making
Location in dialog
box

[Drilling operation] dialog box→Machine Control group→Retract Output
Mode list

Feature group enhancements (10.0.1)
You now have the same control when using an automatic feature group that you have in a manually
defined HOLE_BOSS_GEOM geometry group. Operations within the feature group geometry
parent hierarchy also use the sequence defined in the feature group. In the Feature Group dialog
box, you can:

• Optimize the sequence of features within the group automatically, using one of the Optimization
options.

• Reorder the sequence of features within the group manually.

In the list, select one or more features and use the arrows to move the features as required.

• Reverse the machining direction of selected features.

When this dialog box is open, you can change the orientation of a single feature using the dynamic
manipulator.

You can control the preview color of the feature sequence using the Feature Sequence customer
default.

Tip

To find a customer default, choose File→Utilities→Customer Defaults, and click Find

Default .

If needed, you can still access the legacy classification dialog box.
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Optimize the feature sequence

Closest Primary Direction = X

Reverse machining direction

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Operation Navigator Double-click the feature group

Feature recognition enhancements (10.0.1)
NX now recognizes coaxial interrupted holes. The feature type is
HOLE_ROUND_INTERRUPTED_STRAIGHT.

14-32 What's new in NX

Chapter 14: Browse 10.0.1 enhancements



Browse 10.0.1 enhancements

NX now recognizes radial grooves. The feature type is GROOVE_INS_RAD_RECT.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Machining Feature
Navigator Right-click in the background→Find Features

Allowed violations of part geometry (10.0.1)
In the path settings for an operation, when you check for gouges, NX normally reports a gouge and
does not generate a gouging tool path.

For some situations, you implicitly authorize a gouge to the modeled body by defining a machining
feature that is not explicitly modeled. In these situations, NX generates a tool path and does not
report gouges within a defined feature volume. For authorized gouges, NX gouge checking reports No

gouged motions found.

The following are examples of implicitly authorized gouges.

Tapping and thread milling

Typically, you model only the tap diameter of a hole or the maximum thread diameter of a boss. NX
creates the feature volume during the machining feature recognition process.
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Tapped hole volumes Thread mill boss volume Thread mill hole volume
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Chamfering holes

You need not model the chamfer.

Chamfer volumes

Drilling holes at points

You can specify a hole feature at a point, without modeling the hole.

Modeled points Hole feature volumes
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Engraving

When you engrave text using Planar Text and Contour Text operations, the text to be cut exists
only as a 2D note. There is no corresponding feature volume, and the operation dialog box does not
contain a gouge checking option. No gouge is reported when you run a gouge check.

2D drafting note Tool path

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Prerequisite Feature volumes must be defined for the operation.

Operation
Navigator

Right-click operation→Gouge Check

Right-click operation→Tool Path→Verify→Replay→Gouge and Collision
Settings

Operation dialog box

Generate

Verify→Replay→Gouge and Collision Settings
Tool Path Editor
dialog box Analyze Tool Path group→Gouge and Collision Check

Simulation Control
Panel dialog box

For tapping and thread milling only:

Simulation Settings group→Simulation Settings →Simulation
Settings dialog box→Collision Detection group→Specify Collision Pairs

→Specify Collision Pairs dialog box→specify the part and the tool

Axis dynamic capabilities in the Machine Tool Navigator (10.0.1)

What is it?

Dynamic properties of axes are now stored in a common location, the NX machine tool assembly.
You enter the properties from the Machine Tool Navigator, using the Edit→Axis command. The
Machine Tool Navigator is available in the Manufacturing and Machine Tool Builder applications.

The following properties are new in NX.
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For rotary axes and spindles For linear axes
Max Acceleration [deg/s^2]

Max Deceleration [deg/s^2]

Jerk Limit [deg/s^3]

Jump Velocity [deg/s]

Kv

Fine Precision [deg]

Coarse Precision [deg]

Max Acceleration [mm/s^2]

Max Deceleration [mm/s^2]

Jerk Limit [mm/s^3]

Jump Velocity [mm/s]

Kv

Fine Precision [mm]

Coarse Precision [mm]

Units of mm for linear axes are shown. For English units, in replaces mm.

When you retrieve a machine tool model, NX checks whether machine tool axis and channel data has
ever been modified or imported, and notifies you if the data has not been updated.

You can import axis dynamic and channel data from an MCF file or enter it manually. You will receive
a one-time message that the link between the kinematic model and the MCF is broken, and that
simulation will use the axis dynamic data in the part file.

Why should I use it?

• You do not have to enter the same information in multiple applications.

• You can enjoy the relative ease of using the Machine Tool Builder application, without having
to learn the more advanced Machine Configurator dialog box in the common simulation
environment (CSE).

Where do I find it?

Initial release NX 9.0.3 MP1

Application

Manufacturing

Machine Tool Builder
Prerequisite An open NX assembly that contains a machine tool kinematic structure

Machine Tool Navigator

Right-click the root node→Import Axis and Channel Data

Right-click an axis node→Edit→Axis→Dynamic Properties group

Channels settings moved (10.0.1)

What is it?

You can now assign axes to channels in the Machine Tool Navigator in NX.

You can still assign a device or a tool holder to a channel to a in the Edit Machine Component dialog
box; however, the options to rename, add, or delete a channel are consolidated in the Channel
Configuration dialog box.
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Why should I use it?

• You no longer have to use the Machine Configurator dialog box of the common simulation
environment (CSE) to assign axes to channels.

Where do I find it?

Initial release NX 9.0.3 MP1

Application

Manufacturing

Machine Tool Builder

Prerequisite An open NX assembly that contains a machine tool kinematic structure
Machine Tool
Navigator Right-click the root node → Channel Configuration

Toolpath verification and analysis consolidation (10.0.1)

What is it?

In previous releases, new functionality was added beside existing functionality. This resulted in some
duplication and confusion over which command to use for a given task. Some older functions are
now hidden by default in the Tool Path Verification dialog box.

2D Dynamic tab

The 2D Dynamic tab is now hidden. This protects you from issues that might arise if, for example, a
collision occurs but is not visible in the selected 2D view.

To restore the 2D Dynamic tab, select the Show 2D Dynamic Page customer default.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

3D Dynamic tab

To ensure maximum reliability, on the 3D Dynamic tab, the Facetted Solid options are hidden.

We recommend that you click Show Thickness by Color to check the amount of excess material
that remains on the part.

We recommend that you use the following methods for gouge checking:

• Right-click an operation in the Operation Navigator and choose Tool Path→Gouge Check.

• In the Tool Path Verification dialog box, on the Replay tab, click Gouge and Collision Settings.

To restore the Facetted Solid options, select the Enable Facetted Solid for Gouges and Excess
customer default.
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Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing

Post Configurator (10.0.1)
Use the Post Configurator to create postprocessors for the following controllers in an efficient way:

• Sinumerik 840D

• Fanuc 18i

• Heidenhain iTNC 530

• Generic

You can create a new post processor that is based on a loaded kinematic machine model. If the CAM
setup does not contain a kinematic model, you must set it up manually.
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Why should I use it?

The Post Configurator offers a new way of creating postprocessors based on the established
manufacturing output manager (MOM) architecture. If you create post processors, you can use and
configure the included post libraries. There are three stages of licenses available for NX CAM users.

Basic
This license is available for all NX CAM users. It allows you to:

• Run a postprocessor that was created with Post Configurator.

• Edit parameters to which access is granted by the post processor developer.

Advanced
The license is intended for machine tool manufacturers and field service technicians.

It is available for all NX CAM users who currently own a Post Builder license. In addition to do the
tasks that you can do with the basic license you can:

• Create a new post processor.

• Edit your post processor using the Post Configurator dialog box.

Full
The post developer license.

The license must be purchased. It is designed for Siemens Professional Services staff, Siemens
partners, and NX CAM users who are heavily involved in creating post processors. In addition to
the tasks that you can do with the advanced license, you can also:

• Edit the Tcl code.

• Encrypt your post processors.

• Limit the running of a post processor to a specific Sold-To ID.

• Define an expiration date for your post processors.

Note

When you create post processors using the Post Configurator, you can edit them only in the
Post Configurator. If you created post processors using the Post Builder, you will not be
able to edit them in the Post Configurator.

Where do I find it?

Application Manufacturing

Ribbon Home tab→Tools drop-down→Post Configurator
Menu Menu→Tools→Post Configurator
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Feature recognition for coaxial interrupted holes (10.0.1)
NX first tries to recognize a sequence of coaxial interrupted holes as the appropriate STEPx feature
so that the machining process is the same for holes with and without interruptions. If NX does not
recognize a sequence of coaxial interrupted holes as a regular stepped feature, it classifies the feature
as HOLE_ROUND_INTERRUPTED_STRAIGHT. The machining process is different for these holes.

In the following examples, both features consist of coaxial cylinders that extend through multiple
flanges.

STEP2HOLE

The lowest flange contains a STEP2HOLE
feature. The additional cylinders that extend
through the remaining flanges have the same
diameter as the largest STEP2HOLE diameter.

HOLE_ROUND_INTERRUPTED_STRAIGHT

The lowest flange contains a STEP1HOLE
feature. In this case, the diameters of the
additional cylinders in the remaining flanges
do not match the diameter of the STEP1HOLE
feature. This hole requires a different machining
process than a STEP1HOLE feature.

You can use both STEPx and HOLE_ROUND_INTERRUPTED_STRAIGHT features as input for
the Sequential Drilling operation.

Where do I find it?

Initial release NX 10.0.1
Application Manufacturing
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Machining Feature
Navigator Right-click in the background→Find Features

Feature recognition enhancements (10.0.1)
NX now recognizes coaxial interrupted holes. The feature type is
HOLE_ROUND_INTERRUPTED_STRAIGHT.

NX now recognizes radial grooves. The feature type is GROOVE_INS_RAD_RECT.

Where do I find it?

Initial release NX 9.0.3 MP1
Application Manufacturing
Machining Feature
Navigator Right-click in the background→Find Features

Solver version support (10.0.1)
For each released version of NX, the following tables list the supported solver versions for import,
export, and the post-processing of results. Note:

• The version listed in the Import ASCII and Import Binary rows is the solver version that was
generally available when the NX version was released. In general, the import of the solver ASCII
and binary files should be upwards compatible. Therefore, you should be able to import them into
the most recent version of NX. However, in general:
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o ASCII files are backwards compatible for import into NX. If you import an ASCII file from a
newer version of the solver than is officially supported, the software simply ignores any new
fields/options that aren't supported in the current NX release.

o Binary files are not backwards compatible. For example, you can import a binary file created
by NX Nastran 5.0 into NX 6.0.2, but you might not be able to import a binary file created by
NX Nastran 6.1 into NX 5.

• The version listed in the Export ASCII rows is the solver version that was available when the
NX version was tested. In general, the exported solver input file is upwards compatible for that
solver. Backwards compatibility is not guaranteed. For NX Nastran, the Model Setup Check
function in Advanced Simulation tries to flag potential version incompatibility issues.

• The version listed in the Post-processing Results rows is the version of the solver results
that was tested in the listed NX version. In general, results from earlier solver versions are
also supported.

NX 10 releases

Solver File Type NX 10 NX 10.0.1
Import ASCII (.dat) 10 10
Import Binary (.op2) 10 10
Export ASCII (.dat) 10 10NX Nastran
Post-processing of Results (.op2,
.xdb)

10 10.1

Import ASCII (.dat) 2013.1 2014
Import Binary (.op2) 2013.1 2014
Export ASCII (.dat) 2013.1 2014MSC Nastran
Post-processing of Results (.op2,
.xdb)

2013.1 2014

Import ASCII (.inp) 6.13 6.13
Import Binary N/A N/A
Export ASCII (.inp) 6.13 6.13
Post-processing of Results (.fil) 6.14 6.14-1

Abaqus

Post-processing of Results (.odb) 6.13-5 6.13-5
Import ASCII (PREP7, CDB) 15.0 15.0
Import Binary (.rst, .rth) 15.0 15.0
Export ASCII (.inp) 15.0 15.0ANSYS

Post-processing of Results 15.0 15.0
Import ASCII 971R6.0 971R6.0
Import Binary N/A N/A
Export ASCII (.k) 971R6.0 971R6.0LS-DYNA

Post-processing of Results 971R7.1 971R7.1

Permas Post-processing of Results (.res,
.post)

13 13
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Solver File Type NX 10 NX 10.0.1
Import ASCII (.dat) 16.1 (build 16.1-02) 16.1 (build 16.1-02)
Import Binary (.sdb) 16.1 (build 16.1-02) 16.1 (build 16.1-02)
Export ASCII (.dat) 16.1 (build 16.1-02) 16.1 (build 16.1-02)SAMCEF
Post-processing of Results (.des,
.fac)

16.1 (build 16.1-02) 16.1 (build 16.1-02)

NX 9 releases

Solver File Type NX 9 NX 9.0.1 NX 9.0.2 NX 9.03
Import ASCII (.dat) 9 9 10 10
Import Binary (.op2) 9 9 10 10
Export ASCII (.dat) 9 9 10 10NX Nastran
Post-processing of
Results (.op2)

9 9 10 10

Import ASCII (.dat) 2013 2013 2013.1 2013.1
Import Binary (.op2) 2013 2013 2013.1 2013.1
Export ASCII (.dat) 2013 2013 2013.1 2013.1MSC Nastran
Post-processing of
Results (.op2)

2013 2013 2013.1 2013.1

Import ASCII (.inp) 6.12 6.12 6.12 6.12
Import Binary N/A N/A N/A N/A
Export ASCII (.inp) 6.12 6.12 6.12 6.12
Post-processing of
Results (.fil)

6.12-1 6.12-1 6.13-4 6.13-4Abaqus

Post-processing of
Results (.odb)

6.12 6.12 6.12 6.13-2

Import ASCII (PREP7,
CDB)

14.5 14.5 15.0 15.0

Import Binary (.rst, .rth) 14.5 14.5 15.0 15.0
Export ASCII (.inp) 14.5 14.5 15.0 15.0ANSYS

Post-processing of
Results

14.5 14.5 15.0 15.0

Import ASCII 971R6.0 971R6.0 971R6.0 971R6.0
Import Binary N/A N/A N/A N/A
Export ASCII (.k) 971R6.0 971R6.0 971R6.0 971R6.0LS-DYNA
Post-processing of
Results

971R6.0 971R6.0 971R7.1 971R7.1

Permas Post-processing of
Results (.res)

13 13 13 13
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NX 8 releases

Solver File Type NX 8 NX 8.0.1 NX 8.0.2 NX 8.0.3 NX 8.5 NX 8.5.1 NX 8.5.2
Import ASCII
(.dat)

8 8 8.5 8.5 8.5 8.5 8.5

Import Binary
(.op2)

8 8 8.5 8.5 8.5 8.5 8.5

Export ASCII
(.dat)

8 8 8.5 8.5 8.5 8.5 8.5NX
Nastran

Post-processing
of Results
(.op2)

8 8.1 8.5 8.5 8.5 8.5 9

Import ASCII
(.dat)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2012.1

Import Binary
(.op2)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2012.1

Export ASCII
(.dat)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2012.1MSC
Nastran

Post-processing
of Results
(.op2)

2011.1 2011.1 2012.1 2012.1 2012.1 2012.1 2013

Import ASCII
(.inp)

6.10 6.10 6.10 6.10 6.12 6.12 6.12

Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.10 6.10 6.10 6.10 6.12 6.12 6.12

Post-processing
of Results (.fil)

6.11 6.11 6.11 6.12-1 6.12-1 6.12-1 6.12-1Abaqus

Post-processing
of Results
(.odb)

6.10-EF1 6.11 6.11 6.11 6.12 6.12 6.12

Import ASCII
(PREP7, CDB)

13 13 14 14 14 14 14.5

Import Binary
(.rst, .rth)

13 13 14 14 14 14 14.5

Export ASCII
(.inp)

13 13 14 14 14 14 14ANSYS

Post-processing
of Results

13 13 14 14 14 14 14

Import ASCII 971R5.0 971R5.0 971R5.0 971R5.0 971R6.0 971R6.0 971R6.0
Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.k)

971R5.0 971R5.0 971R5.0 971R5.0 971R6.0 971R6.0 971R6.0LS-DYNA

Post-processing
of Results

971R5.0 971R5.0 971R5.0 971R5.0 971R6.0 971R6.0 971R6.0
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NX7 releases

Solver File Type NX 7 NX 7.5 NX 7.5.1 NX 7.5.2 NX 7.5.3 NX 7.5.4 NX 7.5.5.
Import ASCII
(.dat)

6.1 7.0 7.0 7.1 7.1 7.1 8

Import Binary
(.op2)

6.1 7.0 7.0 7.1 7.1 7.1 8

Export ASCII
(.dat)

6.1 7.0 7.0 7.1 7.1 7.1 8
NX
Nastran

Post-processing
of Results

6.1 7.0 7.1 7.1 7.1 7.1 8

Import ASCII
(.dat)

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1

Import Binary
(.op2)

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1

Export ASCII
(.dat)

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1
MSC
Nastran

Post-processing
of Results

2008r1 2008r1 2008r1 2008r1 2010 2010 2011.1

Import ASCII
(.inp)

6.8-1 6.9–1 6.9–1 6.9-1 6.10 6.10 6.10

Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.8-1 6.9 6.9 6.9 6.10 6.10 6.10

Post-processing
of Results (.fil)

6.8-EF2 6.9.2 6.9.2 6.10-1 6.10-1 6.10-1 6.11-1Abaqus

Post-processing
of Results
(.odb)

6.8-EF2 6.9-EF1 6.9-EF2 6.9-EF2 6.10-EF1 6.10-EF1 6.10-EF1

Import ASCII
(PREP7, CDB)

12 12.1 12.1 12.1 13 13 13

Import Binary
(.rst, .rth)

12 12.1 12.1 12.1 13 13 13

Export ASCII
(.inp)

12 12.1 12.1 12.1 13 13 13ANSYS

Post-processing
of Results

12 12.1 12.1 12.1 12.1 12.1 12.1

Import ASCII N/A N/A N/A N/A N/A N/A N/A
Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.k)

971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1LS-DYNA

Post-processing
of Results

N/A N/A 971R3.2.1971R3.2.1971R3.2.1971R3.2.1971R3.2.1
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NX 6 releases

Solver File Type NX 6 NX 6.0.1 NX 6.0.2 NX 6.0.3 NX 6.0.4 NX 6.0.5
Import ASCII
(.dat)

6.0 6.1 6.1 6.1 6.1 7.0

Import Binary
(.op2)

6.0 6.1 6.1 6.1 6.1 7.0

Export ASCII
(.dat)

6.0 6.1 6.1 6.1 6.1 7.0
NX
Nastran

Post-processing
of Results

6.0 6.0 6.1 6.1 7.0 7.0

Import ASCII
(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import Binary
(.op2)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Export ASCII
(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1
MSC
Nastran

Post-processing
of Results

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import ASCII
(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Import Binary N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Post-processing
of Results (.fil)

6.7-5 6.8-1 6.8-3 6.8-EF2 6.8-EF2 6.8-EF2
Abaqus

Post-processing
of Results (.odb)

N/A N/A N/A 6.8-EF 6.8-EF2 6.9-EF2

Import ASCII
(PREP7, CDB)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Import Binary
(.rst, .rth)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Export ASCII
(.inp)

11 11 SP1 11 SP1 11 SP1 12.0 12.0ANSYS

Post-processing
of Results

11 SP1 11 SP1 11 SP1 11 SP1 12.0 12.1

Import ASCII N/A N/A N/A N/A N/A N/A
Import Binary N/A N/A N/A N/A N/A N/A
Export ASCII (.k) 971R2 971R2 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA
Post-processing
of Results

N/A N/A N/A N/A N/A N/A
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NX 5 releases

Solver File Type NX 5 NX
5.0.1

NX
5.0.2

NX
5.0.3

NX
5.0.4

NX
5.0.5

NX
5.0.6

Import ASCII
(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Import Binary
(.op2)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Export ASCII
(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1
NX
Nastran

Post-processing
of Results

5.0 5.0 5.1 5.1 5.1 5.1 6.0

Import ASCII
(.dat)

2005 2005 2007 2007 2007 2007 2007r1

Import Binary
(.op2)

2005 2005 2007 2007 2007 2007 2007r1

Export ASCII
(.dat)

2005 2005 2007 2007 2007 2007 2007r1
MSC
Nastran

Post-processing
of Results

2005 2005 2007 2007 2007 2007 2008r1

Import ASCII
(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1

Import Binary N/A N/A N/A N/A N/A N/A N/A
Export ASCII
(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1Abaqus

Post-processing
of Results

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.8-1

Import ASCII
(PREP7,
CDB)

10 10 11 11 11 11 11

Import Binary
(.rst, .rth)

10 10 11 11 11 11 11

Export ASCII
(.inp)

10 10 11 11 11 11 11
ANSYS

Post-processing
of Results

10 11 11 11 11 11 11 SP1

NX 4 releases

Solver File Type NX 4 NX 4.0.1 NX 4.0.2 NX 4.0.3 NX 4.0.4
Import ASCII (.dat) 4.0 4.1 4.1 5.0 5.0
Import Binary (.op2) 4.0 4.1 4.1 4.1 4.1
Export ASCII (.dat) 4.0 4.1 4.1 5.0 5.0NX Nastran
Post-processing of
Results

4.0 4.1 4.1 5.0 5.0

Import ASCII (.dat) 2005 2005 2005 2005 2005
Import Binary (.op2) 2005 2005 2005 2005 2005
Export ASCII (.dat) 2005 2005 2005 2005 2005

MSC
Nastran

Post-processing of
Results

2005 2005 2005 2005 2005
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Solver File Type NX 4 NX 4.0.1 NX 4.0.2 NX 4.0.3 NX 4.0.4
Import ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6
Import Binary N/A N/A N/A N/A N/A
Export ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6Abaqus
Post-processing of
Results

6.5-1 6.5-1 6.5-1 6.6 6.6-3

Import ASCII
(PREP7, CDB)

8 9 9 10 10

Import Binary (.rst,
.rth)

8 9 9 10 10

Export ASCII (.inp) 8 9 9 10 10
ANSYS

Post-processing of
Results

9 9 9 10 10

Abaqus axisymmetric contact analysis (10.0.1)
What is it?

This release includes expanded support for contact analyses in the Abaqus environment. You
can now perform a number of different types of contact analyses in axisymmetric structural and
thermal models. In previous releases, contact analyses in the Abaqus environment were limited to
non-axisymmetric models.

The following table summarizes the commands that are now available for axisymmetric structural
and thermal solutions:

Abaqus
element

Description Analysis types
supported

Corresponding Abaqus
keywords

Edge-to-Edge

Contact

Defines contact
conditions between
selected polygon edges
or element edges.

Axisymmetric structural *CONTACT PAIR

*SURFACE

Contact
Interference

Defines time-dependent
allowable interferences
for contact pairs and
elements.

You can use Contact
Interference to model
interference fits (press
fits) when there are large
overclosures between the
contacting surfaces in
the initial configuration of
the model. The defined
contact interferences
can result in stresses
and strains as the solver
resolves the overclosure

Axisymmetric structural *CONTACT PAIR

*CONTACT INTERFERENCE
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Abaqus
element

Description Analysis types
supported

Corresponding Abaqus
keywords

between the contacting
surfaces.

Contact with

Clearance

Defines precise clearance
or overclosure values
for the nodes on the
slave (target) surface
in a contact pair. An
overclosure value allows
you to specify any
initial penetration for
the contacting surfaces.

Axisymmetric structural *CONTACT PAIR

*CLEARANCE

Surface-to-Surface
Thermal
Conductance

Models conductive
heat transfer between
proximate or contacting
surfaces. You can model
the conductive heat
transfer as a function of:

• The clearance
between the
contacting surfaces.

• The contact pressure
at the interface
between the
contacting surfaces.

• Both the clearance
and the contact
pressure.

Axisymmetric thermal *GAP CONDUCTANCE

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus as the specified solver

Axisymmetric Structural or Axisymmetric Thermal as the analysis type

General Analysis or Heat Transfer as the solution type
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ANSYS axisymmetric contact analysis (10.0.1)
What is it?

This release includes support for contact analyses in ANSYS axisymmetric structural and thermal
solutions. In previous releases, contact was supported only in non-axisymmetric solutions.

Axisymmetric structural solutions

You can now use the Structural Contact command to analyze contact between the edges of planar
elements in axisymmetric models. You use the Structural Contact and the Region dialog boxes to
define contact and sliding between a 2D target edge and a deformable surface. When you export or
solve the solution, the software creates the appropriate CONTA172 elements to define the deformable
surface and TARGE169 elements to define the target surface.

Axisymmetric thermal solutions

You can now use the Thermal Contact command to define thermal contact conduction between
contacting surfaces in axisymmetric models using the edges of planar elements. You use the
Thermal Contact and the Region dialog boxes to define the contact between the edges, as well as
select the edges, points, or nodes that define the contacting edges.

After you define the contacting surfaces, use the CONTA174/172 Real Constants dialog box to
define the required thermal contact properties. You can define the following properties:

• Thermal contact conductance (TCC), which allows you to take into account the conductive heat
transfer between the contact and target surfaces.

Note

Currently, NX supports only a constant Thermal contact conductance value. You cannot
vary the Thermal contact conductance with temperature, pressure, or time.

• The Stefan-Boltzmann constant (SBCT), which you can use to model radiative heat transfer. If
you do not specify a value for the Stefan-Boltzmann constant, the radiation effect is excluded
from the thermal contact calculations.

• The Radiation view factor (RDVF), which you can use to define the radiation view factor for
near-field radiation.

Where do I find it?

Structural Contact

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Axisymmetric Structural as the analysis type

Linear Statics or Nonlinear Statics as the solution type
Command Finder

Structural Contact
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Thermal Contact

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

ANSYS as the specified solver

Axisymmetric Thermal as the analysis type

Steady State Thermal as the solution type
Command Finder

Thermal Contact

Constraint equation support in Abaqus and ANSYS thermal solutions
(10.0.1)

What is it?

You can now create constraint equations between the temperature degrees-of-freedom of thermal
elements in both the Abaqus and ANSYS thermal environments. In previous releases, you could only
create constraint equations in the Abaqus and ANSYS structural environments.

Constraint equations for Abaqus thermal solutions

In the Abaqus thermal environment, use the new Manual Coupling command to define the
independent and dependent coupling parameters between selected nodes. When you export or solve
your model, NX creates the appropriate *EQUATION commands in your Abaqus input file.

Constraint equations for ANSYS thermal solutions

In the ANSYS thermal environment, the Manual Thermal Coupling command has been enhanced to
allow you to create constraint equations as well as define sets of coupled degrees-of-freedom. Use
the new CE option in the Type list of the Manual Thermal Coupling dialog box to define coupling
between the temperature degrees-of-freedom within the model. When you export or solve your
model, the software creates the appropriate CE keywords in your ANSYS input file.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file as the displayed part and the work part

Abaqus or ANSYS as the specified solver

Thermal as the analysis type
Command Finder

Manual Coupling (Abaqus)

Manual Thermal Coupling (ANSYS)
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CGNS results file options (10.0.1)

What is it?

You can now request transient flow results in the CGNS format to be written in one of the following
ways:

• One CGNS results file: The results file contains results from all transient output times.

• Multiple CGNS results files: Each results file contains results from one transient output time.

In previous releases, NX always wrote a single CGNS results file containing results from all transient
output times.

Why should I use it?

You can now obtain the results from each transient output time in its own CGNS results file. You do
this by requesting multiple CGNS files. You can continue to request a single CGNS file that contains
all the results from all transient output times.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems Cooling Coupled Thermal-Flow Electronic Systems Cooling

NX Advanced Thermal/Flow with
ESC

Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Command Finder Solution
Simulation Navigator Right-click a solution node→Edit

Location in dialog
box

Results Options page→Optional Output Format group→CGNS
→Transient Results list

Inflated laminates in LS-DYNA (10.0.1)

What is it?

The Extrude Laminate and Fill Laminate commands are now supported in the LS-DYNA
environment.
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The extruded 3D mesh consists of ELEMENT_TSHELL wedge or hexahedral elements and the
ply drop-offs consist of ELEMENT_SOLID tetrahedral, wedge, or hexahedral elements. Because
LS_DYNA does not support pyramids, pyramids are split into tetrahedral elements.

For both commands, NX creates a 3D mesh collector that has a Solid Laminate physical property
assigned to it. NX automatically sets the Stacking Recipe in the Solid Laminate Modeler dialog
box to Inherited from Layup.

All the plies of the extruded solid laminate have the same ply failure theory and inter-laminar failure
theory that you selected in the Laminate Modeler dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM within the LS-DYNA solver environment.

Command Finder Extrude Laminate or Fill Laminate

MCOSMOS postprocessor (10.0.1)

What is it?

MCOSMOS, the Mitutoyo Controlled Open Systems for Modular Operation Support postprocessor,
is now available as part of the standard installation for NX 10.0.1. It is not necessary to download
the files from GTAC.

Where do I find it?

Application CMM Inspection Programming
Command Finder Postprocess
Location in dialog
box Postprocess dialog box→Postprocessor group→MITUTOYO MCOSMOS

CMM general enhancements (10.0.1)

What is it?

You can fit one or more selected objects to the graphics window view.
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Where do I find it?

Application CMM Inspection Programming
Prerequisite Select the objects in the Inspection Navigator.

Top Border bar View tab→Orientation group→Fit View to Selection

Converting legacy welds (10.0.1)
When you run the Convert Legacy Weld Points weld utility, you can specify if you want to
simultaneously convert all or selected pre-NX 10 weld point features. To do this, use the All in
Work Part option or the Selected Only option.

Where do I find it?

Application Modeling

Prerequisite

Set the Point Locator customer defaults similar to the Legacy Welds (pre
NX10) customer defaults.

To select the Selection Scope options, you must select the Convert
check box.

Command Finder Weld Utilities

Location in dialog
box

Convert Legacy Weld Points group→Convert check box

Selection Scope subgroup→All in Work Part or Selected Only

Flow Blend (10.0.1)
Use the Flow Blend command to create constant or variable blends along complex faces.
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You can:

• Blend complex faces that have a small curvature.

• Patch the blended faces to the original body.

• Smoothen variable blends.

Where do I find it?

Application OmniCAD for NX

Prerequisite
To use OmniCAD commands, you must run the InstallSentinel.bat file
which is available in the ugii/omnicad directory.

Command Finder Flow Blend

Exporting crosshatching as grouped geometry (10.0.1)

What is it?

You can now export crosshatching as grouped geometry to a 2D NX Part, DXF, or DWG file. To do
this, you must set the following keyword in the settings file.

CONVERT_CROSSHATCH_AS_GEOMETRY = yes

Note

This keyword setting overrides the default crosshatch mapping defined in the DXF/DWG and
2D Exchange translators.
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Why should I use it?

When the crosshatch pattern assigned to the crosshatching in the NX file is not available in AutoCAD,
the crosshatching display in AutoCAD may not match the display in NX. In this case, export the
crosshatching as grouped geometry to get the exact display in AutoCAD.

Where do I find it?

Command Finder

Export 2D Exchange File

Export AutoCAD DXF/DWG File

Line Designer enhancements in NX 10.0.1
• Added support for Drag & Drop of resources from History Navigator and Teamcenter Navigator to

the graphics window.

• Improved mouse button menus.

o Removed commands that are not applicable in Line Designer 4GD.

o Removed low-use commands; rearranged order for frequent access; added high-use
commands.

o Streamlined Smart Component shortcut menus.

• Added new command for disconnecting connected components.

• Enhanced Show/Hide and reference sets so that their state is saved with the workset.

• For 4GD mode, added the Replace Source Part command to the Plant Navigator context menu
for resource instances. In BVR mode, the Replace Component command is applicable.

• Added an option in the connector definition for a robot that reverses the direction of propagation.
If the source connector has this option enabled, then dropping the robot onto the connector of an
existing instance of a riser causes the diameter from the robot to be propagated to the riser.

• Added Type and Effectivity columns to Plant Navigator. Note: In BVR mode, values in Plant
Navigator columns only appear if the column is enabled in the Assembly Navigator.

• Provided a script to install Line Designer template parts to Teamcenter.

Fast placement coordinates pop-up (10.0.1)
What is it?

The Fast Placement capability in Line Designer has been enhanced:

• Added Z-coordinate to the coordinate pop-up.

• Added capability to edit X, Y, Z coordinate values in the coordinate pop-up.
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Why should I use it?

You can use the coordinate display and editing capability to more precisely place components even
while in the Fast Placement mode.

Where do I find it?

Application Line Designer
Prerequisite Fast Placement mode must be enabled.

Disconnect Components (10.0.1)
What is it?

The Disconnect Components command removes a connection between components that was
created with the Connect Components command.
• If assembly constraints between the components exist, the assembly constraints are removed.

• Position and expression values of the components are not changed.

Why should I use it?

Disconnect components if you want to replace one of the components or change its location relative
to the other component.

Where do I find it?

Application Line Designer

Command Finder

Disconnect Components

Drag and drop resources (10.0.1)
What is it?

In addition to adding resources to a layout from the Reuse Library, you can now drag and drop
resources from the History Navigator and Teamcenter Navigator to the graphics window to create
a new instance.

Why should I use it?

With this capability, you can take advantage of ready accessibility to existing resource instances
when adding similar instances.

Where do I find it?

Application Line Designer
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Navigator Resource instances listed in the History Navigator and History Navigator.
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